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C H A P T E R 1
Trimble® Accubid Classic Estimating

Trimble® Accubid® Classic Estimating software is a powerful, easy-to-use, computerized estimating

systems designed for electrical, mechanical, and structured cabling contractors. The software allows
you to create estimates from a comprehensive database that includes countless items and
assemblies. You can also create custom project-specific assemblies on-the-fly. Each item includes
labor units, labor factors, labor tracking codes and cost codes.

The Classic Estimating product includes various tiers - from the entry-level PowerBid to the
comprehensive Pro. 

Tip - At any time, you can upgrade to a different product level. You pay only the difference between
the two prices. Contact your Trimble Sales Representative for more information.

For more information click the following topics:

  Run Estimating Programs

  Screen Components

  Set Defaults

  Jobs

  Takeoffs

  Extension

  Bid Completion

  Bid Analysis

  Multi-User Support

  Reports

  Enter Information

  Screen Appearance

  Product Screens

  Toolbars
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Trimble MEP Client Services
Our Trimble MEP Client Services personnel are available when you need help with the software. You
can contact the Client Services Department by phone, e-mail, or through our website.

Tip - Before contacting us, we recommend you consult the online system help first, as it covers
solutions to many common issues and procedures.

Phone Support Telephone support is available Monday through
Friday, except major holidays. 

Toll Free Number: 1-800-361-3030.

Internet E-mail accubidsupport@trimble.com

Web Site mep.trimble.com

To benefit most Trimble MEP Client Services, please comply with the following guidelines before
making contact:

Please be at your computer when you call, as our representative may have to guide you through
the instructions step-by-step. 

You will also be asked to provide the following information:

The product name and version 

The operating system you are using 

A detailed outline of the problem, whether you can repeat the problem, and what you were
doing when the problem occurred.

If you call Trimble MEP Client Services after regular support hours, please leave a detailed message
on our voice mail system. We will review your request the next business day. 

mailto:accubidsupport@trimble.com
http://mep.trimble.com/
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C H A P T E R 2
Security Server/Licensing

Provided you followed the instructions in the Trimble® Accubid Classic Estimating Getting Started
Guide (included with your software), you should be ready to start using the software application. If you
encounter any problems, please refer to the guide for more information.

When you open the Trimble Classic Estimating program. you may see the following messages:

no security device detected

no material database detected

Click on the link(s) below to display detailed information on-screen. To close the text, click on the link
again. Note: If you want to print the topic, make sure the text you need is visible prior to printing.

No Security Device Detected

If you try to run a Trimble estimating program without either attaching a local security device or
linking to a network security server, a dialog displays with the following options:

Exit the program

Change the program security settings

Run the program in demo mode

If you are using a local security device and this message appears, the security device may not be
properly attached. If you want to link to a network security server:

1. Click the Change Settings option button. 

2. In the Security Device Settings dialog, you can indicate the location of a network security server 
or allow the program to search for one each time you run it. For more information, see Network
Security Server.

Tip - If you do not have access to a local security device or a network security server, you can
run the program in demo mode. The demo version of the product has certain important features
(such as save, print, and export) disabled.

No Database Detected

A material database is required to create jobs or run the online tutorial. If your estimating program
is unable to find a material database in any of the specified database folders, a dialog displays with
the following options:
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Restore Database
This option allows you to use a backup copy of a material database, if you have one you wish to
use, or import a previously existing database. For instructions, see Restoring Databases.

Connect to Database
This option allows you to connect to a material database that resides on a network. You must
provide the path of the material database. For instructions, see Sharing Files Across a Network.

Proceed without Database
This option allows you to use the program without a database; however, without a database, you
cannot create new jobs or open existing ones.

If you did not install a material database during the program installation, and you wish to do so now,
click Cancel then follow the instructions in the Getting Started Guide for installing databases.
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Network Security Server
The Trimble® Accubid Security Server program allows users on a network to access a security server
to which a local security device has been attached. Users linked to a network security server no
longer require a local security device to be attached to individual workstations. Once the Security
Server program is running, individual users can link to the server through the Security Device tab of
the Options dialog. For instructions on linking to a network security server, see below.

 Caution - The Security Server program should be installed by the network administrator, and only
on the computer designated as the security server. Refer to the Trimble® Accubid Classic Estimating 
Getting Started Guide for detailed instructions.

The Trimble® License Administrator program allows you to check/set the number of licenses available
on the security server.

Important Information

If your company has purchased a network license, rather than a single user license, a local security
device is not required to run your estimating program. You can link your program to a security server
on your network.

Link to a Network Security Server

1. Start your Trimble Accubid Classic Estimating program.

2. Click the Job menu and then Options.

3. In the Job Options dialog, click on the Security Device tab.

4. Click Use Remote Security Server.

5. There are two methods to creating your security server settings:

Manual Selection
Click Select a Security Server and enter the server name
OR
Click Browse and navigate to the location of the server on your network.
Click OK .

Automatic Selection
Make sure the Automatic Search for Security Server option selected.
Click OK.
Each time you run your estimating program, it will search your network for a security server with
the appropriate available license.

6. You will be prompted to exit and restart the program for the changes to take effect.
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License Administrator
You can use the License Administrator program to check or update the number of licenses available
on the network security server or your local security device and the Security Server to control the
security settings associated with your software.

Start License Administrator

Go to the Start menu / Programs / Trimble / License Administrator. The License Administrator
window opens.
OR
Right-click the Security Server icon in the Windows notification area. From the pop-up menu, click
License Administrator. The License Administrator window opens.

Click on the link(s) below to display detailed information on-screen. To close the text, click on the link
again. Note: If you want to print the topic, make sure the text you need is visible prior to printing.

Licenses Procedures

You can check the total number of licenses available on a network security server or on your local
security service, as well as the number of licenses currently in use, and how the license list is
sorted.

Licenses Available

1. In the License Administrator window, locate the computer you want to view licenses on.

2. Click Connect. 

The total number of licenses for each product is listed, along with the number of licenses currently
in use, the user and computer using those licenses, and the time stamp for that usage.

License Refresh Rate

Enter the number of seconds between refresh in the Refresh rate (sec) field.

List Display

In the View Licenses by field, Product or Connection. The License list will be sorted by your
selection.

Release Connections/Licenses

Release Active Connection

1. In the License Information pane, right-click on a connection currently active.

2. In the pop-up menu, click Release Connection. The connection to the security device and all
associated licenses will be released.
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Release Active License

1. In the License Information pane, right-click on a currently active license. 

2. In the pop-up menu, click Release License. The License is released.

License Updates 

Web License Update

1. In the License Administrator window, highlight the Product/License you wish to update. Click
the Web License Update. The Transmission Warning dialog opens.

2. In the Transmission Warning dialog, click Yes to continue with the update. The Web License
Update dialog displays and the progress bar indicates the status of the update.

File License Update

A file license update can only be performed after an MEP Client Services Representative
determines a set of circumstances is preventing you from updating your license on your own. You
must be in contact with a representative to use this feature.

Manual License Update

1. In the License Administrator window, highlight the Product/License you wish to update and click 
Manual License Update button. The Manual License Update dialog opens. Make note of the
Security Code.

2. Contact MEP Client Services to add or remove licenses to/from a security device. Provide the
Security Code to the representative. You will be given an Authorization Code.

3. Enter the Authorization Code into the field. Click Update. If the update is successful, a
Confirmation Code displays. Make note of this code and then click Finish.

Network Settings

1. In the License Administrator window, click Network Settings. The Network Settings dialog
opens displaying your current network settings.

2. Modify the appropriate entries associated with your network settings and then click OK.
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Sharing Files (Network)
If you’re on a network, you can share jobs and databases between multiple users. You can also share
extension views, report styles, and screen styles by storing these in a central shared location.

Click on the link(s) below to display detailed information on-screen. To close the text, click on the link
again. Note: If you want to print the topic, make sure the text you need is visible prior to printing.

Share Jobs

Multiple users on a network can share the same job folders and access the same job files. Note:
Multiple users cannot be in the same folder/job file at the same time. When you open a job stored
on a share directory, the job file becomes locked so that other users cannot open the same job and
overwrite your modifications.

To share jobs between multiple users, you must specify the appropriate job folder on each
workstation that will access the jobs. For more information, see Setting Job Folders.

Tip - To store jobs on another computer, the drive must be shared with full access rights.

Share Database Folders

To share a database folder between multiple users, you must designate the database folder on
each workstation requiring access. For more information, see Setting Database Folders.

Tip -To share a database folder located on another computer, the folder must be shared with
read access or full access.

When you create a new job or select a database for editing, only databases stored in directories
designated as database folders display in the database list.

Share Databases

Multiple users on a network can share database folders and access the same database
simultaneously. If you are sharing databases, keep the following in mind:

It must open in read-only mode.

If opened in read/write mode, the database cannot be accessed by any other user.  

When the database is opened in read-only mode, another user cannot open it in read/write
mode.

When the database is in use, it will not display in the database list when creating a new job
or selecting a database for editing.

If you try to open a job that uses the database and that database is open, you will be
prompted to select a different database.

To set your database options, proceed as follows:

1. Click the Settings menu / Options.
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2. In the Options dialog, click the Database tab. The Database tab displays.

3. On the Database tab, you can restrict database access in two different ways:

Takeoff Mode allows you to control the user’s ability to update the database during a
takeoff. 

Database Update Mode allows you to control the user’s ability to open the database for
editing.

In each method, select the appropriate options:

Single-User Database Mode allows the user to open and update the database, and
prevents other users from accessing the database. Note: Multiple users are not allowed
when this option is selected.

Multiple-User Database Mode provides multiple users with read-only database access.
Note: More than one user has access to the database in this mode.

Tip - If you click Prompt User for Database Access Mode, you will be asked how you
wish to open the database (read/write or read-only mode).

4. Click OK when you are done to apply your changes and exit the dialog (or on Apply to apply the
changes without exiting the dialog). You will be instructed to close your job or database so that
the changes you have made can take effect.

Tip -If you are accessing a database stored on another computer on your network, that folder
must be shared with the appropriate access rights or you may not be able to open the database.
Contact your IT professional if you need assistance with access rights.

Share Extension Views/Screen Styles/Report Styles

Under Options / File Locations, you can control where extension views, report styles, and screen
styles files are stored. Storing the style files or extension view files on a network drive allows
multiple users to share those settings.

1. Select the appropriate checkbox , and then click Browse.

2. Navigate to the location of the appropriate folder. Click on it.

3. Click to OK. 
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Job Folders

You can store jobs in one or more folders, anywhere on your hard drive, or network; however, only
those jobs stored in locations designated as job folders are listed on the job path lists throughout the
estimating application. Similarly, only jobs stored in locations designated as job folders display on the
Schedule screen.

1. Click Settings / Job Folders to open the dialog.

2. Depending on what you want to do, proceed as follows:

Add Job Folder Location

Select the checkbox  next to the appropriate folder. You can also click Select All.

Remove Job Folder Location 

Clear the checkbox  next to the appropriate folder.

 Tip - The folder continues to display in the list, but is no longer designated as a job folder.

Add Folder to the List

1. Click Add. The Directory Name dialog displays.

2. Enter the full path to the desired folder.
OR
Click Browse and navigate to the location of the folder you want to add. Click OK.

Remove Directory from the List

1. Click the folder you wish to remove. It will be highlighted. 

Tip - To select more than one directory, hold down the [Ctrl] key on your keyboard and click
each folder you want to remove. You can also click Select All.

2. Click Remove.
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Database Folders

You can store material databases in one or more folders, anywhere on your hard drive, or network;
however, only those databases stored in folders designated as database folders are listed on dialogs
throughout the estimating software application.

1. Click Settings / Database Folders to open the dialog.

2. Depending on what you want to do, proceed as follows:

Add Database Folder Location

Select the checkbox  next to the folders you want to use in your project. You can also click
Select All if you want all of the database folders available in your project.

Remove Database Folder Location

Clear the checkbox  next to the folders you do not want to use in your project.

Add Directory to the List

1. Click Add. The Directory Name dialog displays.

2. Enter the full path of the folder containing the database
OR
Click Browse and navigate to the location of your database.

Tip - If you are on a network and you want to store databases in a directory on another
computer, you can specify the computer name along with the folder name; for example, \\BIDS
\Estimating\Databases, Note: The folder must be shared!

Default Folder

You can move folders up or down within the Database Folders dialog by clicking the database and
then clicking the Move Up or Move Down buttons. Depending on the order the folders displays in the
list determines how items in the database display in your estimating software.

Remove Directory from the List:

1. Click the folder you wish to remove. The folder will be highlighted.

Tip - To select more than one folder, press the [Ctrl] key on your keyboard and click each folder
you want to remove.
OR
Click Select All.

2. Click Remove.
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C H A P T E R 3
Navigation/Defaults

The Time & Material Billing software includes menus, toolbars, and dialogs. This makes using the
software easy. 

You can access most commands from the menus.

The toolbars provide easy access to the more commonly used commands.

Dialogs allows you input data easily.

Menus
Refer to the topics for each individual menu.

Toolbars

Screen Styles
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Pop-Up Menus
Pop-up menus are menus that appear when you click with your right mouse button. Each pop-up
menu displays options specific to the screen component at which your pointer is currently positioned.
For example, if you click with your right mouse button over an entry in the audit trail in the Takeoff
screen, the pop-up menu displays options that allow you to manipulate that takeoff. Pop-up menus
provide a faster way of accessing the frequently used options that are also available within the pull-
down menus on the menu bar.

Within the database tree on the left side of the Takeoff screen, however, the right mouse button
returns you to the previous level, after you double click a takeoff line from the audit trail to view the
items that comprise the takeoff.



Classic Estimating Help Guide  - 33

Job Menu
The Job menu displays various options that allow you to create and control jobs.

For more information on individual Job menu options, click the button corresponding to the appropriate
option below.

  New

  Open

  Back Up

  Restore

  Export

Additionally, after you open a job, the following
options are available:

  Create Sub Job

  Merge

  Export via Integrator

  Launch ChangeOrder

  Print Preview

  Print

  Exit

  Merge

  Enhanced Job Merge
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New

The command creates a new job. Note:- Before you create a new job, you must have a database
installed on your system. For more information, see the Getting Started Guide.

You have the choice of creating a new database or using one of the current installed databases. The
database is stored separately from the job and can be assigned to any number of different jobs.

Tip - If you do not want to be asked this question each time you create a new job, select the Do

not ask  me again checkbox . The next time you create a job, the program will automatically
bypass the prompt and assume you wish to use an existing database. You can also enable or disable
the prompt from the Options/ General dialog. Clear the Prompt to create database when creating new

job checkbox .

In the New Database dialog:

If you click Yes to create a new database, the Select Database dialog opens prompting you to
select an existing database to use as the base. 

After you select a database and click OK, the Copy Database dialog opens. 

From this dialog, you must enter a description (up to 31 characters long) for the new database
in the Description field and a Folder location if you want it placed in a location other than the
default directory. 

Click Copy. After the new database is created, the New Job dialog opens.

If you click No, choosing to use an existing database, the New Job dialog opens. You must specify
a job number, material database, and job path.
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New Job Dialog

The New Job dialog allows you to specify a job name, job number, material database, and job path.

Go to Job / New. 

Click the New Job  button on the toolbar.

Double-click on the first empty row at the bottom of the Schedule screen job list.

The fields in this screen are:

Option Description

Enter the new job name The name of the new job. The job name
appears on the Job Schedule screen, and can
be up to 80 characters long.

Enter the new job number A unique job identifier. The job number is
combined with a .es9 extension to form the
name of the job file. The job number can
contain up to 255 characters, including
spaces, but cannot contain any of the following
characters: \ / : * ? " < > |

Select the database Choose a database to assign to the job. You
may wish to assign different databases for
different types of jobs. To select a different
database, click on the list box and select a
database from the drop-down list. Only
databases stored in directories designated as
database folders displays in the list. If a
database is already being used by another
user, or by an open job, then the database will
not appear in the list.

 Caution: Do not delete a database that has
been assigned to a job. If you try to open a job
and the assigned database is missing, a
message box will be displayed telling you the
name of the database that is missing. You will
also be given the option to choose a different
database. If you select a different database,
you may encounter difficulties if you try to re-
extend the job.

Select the job path The job path is the drive and directory where
your job information will be stored. If you have
installed the program on a network, or wish to
store the job information on a drive other than
the one displayed, click on the down arrow to
display other paths. Only those directories
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Option Description

identified as job folders using the Job Folders
option displays in this list.

After you have entered all required information, click OK. The Takeoff screen for the new job displays.
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Create Sub Job

Pro ONLY

From the Create Sub Job dialog, you can create one or more sub jobs that will be associated with and
ultimately merged into the current job. Master jobs and sub jobs form part of the Classic Estimation
software's Enhanced Job Merge feature that allows you to merge sub jobs into a master job and track
merge dates. This eliminates the possibility of a "double-merge." For more information, see Merging
Takeoffs from Sub Jobs.

The Create Sub Jobs dialog displays when you select the Job / Create Sub Job. 

Tip - Before you create a sub job, you must be in an open master job or regular job. You cannot
create a sub job within another sub job or from a default job. Once you create a sub job, the current
job will be designated as a master Job if it did not already have previous sub jobs.

From the Create Sub Jobs dialog, you can control the name and number of the sub job(s) by
specifying suffixes to be appended to the master job name and number. You can also change the
folder in which the sub jobs will be saved, and control whether takeoffs, typicals, designations,
temporary items, and temporary assemblies will be copied into the sub job(s). In all other respects,
each sub job will be a copy of the master job.

1. Open the job you will use as your master job. You can control whether takeoffs, typicals,
designations, temporary items, and temporary assemblies from the master job are incorporated
into the sub job(s), but in all other respects, each sub job will be a copy of the master job.

2. Go to Job / Create Sub Job. The Create Sub Jobs dialog displays.
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3. From the Create Sub Jobs dialog, specify the name and number suffixes to be appended to the
master job name and number to form each sub job name and number.

4. You can also change the folder in which the sub jobs will be saved, and control whether takeoffs,
typicals, designations, temporary items, and temporary assemblies are copied from the master job
into the sub job(s).

5. When you are ready to create the sub jobs, click on OK. You will be returned from the master job.
Master jobs and their associated sub jobs will always appear next to each other on the Job
Schedule screen, and will be designated by an 'S' for sub job, and an 'M' for master job in the Type
column.
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Open

This menu commands allows you to open an existing job. 

1. Click Job / Open. The Open Job dialog displays. 

2. Navigate to the location of the job you want to open.

Tip - The location defaults to the JOBDATA folder. If your jobs is located in a different folder,
navigate to that location.

3. Click on the job and then click Open OR double-click on the job. The Takeoff screen for the
selected job appears. 

Tip - You can also open a job by double-clicking on the row number to the left of the job name on
the Schedule screen’s job list.
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Backup

By default, Trimble estimating programs save a recovery copy of your job every 10 minutes. If you
experience a power failure or a system crash before you’ve saved your latest changes, the program
will ask you the next time you open the job whether you wish to restore the job from the recovery file.
If you click on Yes, the recovery copy will be used in place of the job file. If you click on No, the last
saved version of the job file will be used, and the recovery copy will be discarded.

Tip - To control the automatic recovery feature, select Options from the Settings menu, then click
on the File Location tab. From the File Locations tab, you can disable the automatic recovery feature,
control how often the recovery file is created, and change the location where the recovery file is saved.

Trimble estimating programs can also automatically create a backup copy of a job each time it is
saved. The backup copy is stored in the same folder as the job file but with an extension of .backup. If
you want to revert to the previously saved version of a job, you can rename the .backup file extension
to .es9 and the job displays on the Schedule screen. To turn the autobackup option on, go to the File
Locations tab in the Options dialog.

While the automatic recovery and automatic backup features provide crash protection and ability to
revert to a previously saved version of a job, you should also regularly back up your job data onto a
diskette, CD, or a network directory to protect your jobs from inadvertent modification or accidental
deletion.

Backup Single Job

1. While in the job, go to Job / Save As. 

Tip - Trimble recommends that you back your file up to a network location or other media.

2. Enter a File name and Job name.

3. In the Save Options pane, select the checkbox(es)  next to the options you want included in your
backup.

Backup Multiple Jobs

1. When you click on the Job / Backup, the Backup Jobs dialog opens.

2. Select the checkbox(es)  next to each of the jobs you want to back up. 

3. In the Backup Path field, click Browse to navigate to the location where you want to save the
backup file. 

Tip - Trimble recommends that you back your file up to a network location or other media.

4. Enter an Archive Name. This field determines the name of your electronic backup file. Trimble
recommends you use a name that is description enough that it will be recognized, for example, the
Bid ID.

5. If desired, you can also enter a Backup Description.

6. Click Backup to begin the process.
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Restore

1. Click Job / Restore. The Restore Jobs dialog opens.

2. Click Browse and navigate to the location of the backup file you want to restore. Click on the file.

3. Select a Restore Path from the list. This determines where your file will be restored to.

Tip - Only the directories you have specified as job folders display in the list. For more
information on specifying job folders, see Setting Job Folders. 

4. Once you have selected the file and location, click Restore to begin restoring your job data.
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Export

Trimble estimating products allow you to quickly export detailed information about a particular job as a
.CSV file or .MPX file for use in other applications, such as Lotus, MS Project or Primavera, or directly
to an Excel spreadsheet.

You can also copy cells from individual Trimble product screens to the Windows clipboard, then
paste them into Excel or other spreadsheet applications.

To export job summary information, select the Export option from the Schedule screen. From the
Export File dialog, you can specify the name and location of the .CSV file that will contain the
exported information.

1. Open the job you wish to export.

2. Click Job / Export.

3. In the Use Style list, click  and select the appropriate style from the list. This allows you to
control which columns are included in the export file. Select a screen or report style (depending on
whether screen styles or report styles are currently active). 

Tip - You control whether screen styles or report styles are currently active (currently being
used to control the display the information on screen) by selecting the View Using Screen Styles
or View Using Report Styles option from the View menu (or clicking on the corresponding button
on the Styles toolbar).

4. In the Export File dialog, select the checkboxes  next to the job items you want to export. 

Tip - If you want to export the job information as a Microsoft Project (.MPX) file, you can only
select any combination of Extension, Direct Labor, Subcontractors, and Quoted Materials.

5. If desired, select the checkboxes   next to the following:

Export headings

Export totals

Filter blank lines

6. Depending on the format you want to export to, click one of the following buttons:

Export to .csv Comma-separated variable format. Compatible
with a variety of programs.

Export to Excel Export the extension to Microsoft® Excel® as
an Excel workbook

Export to .mpx Microsoft ® Project native file format.

6. If you select either the Export to .csv or Export to .mpx, the Export File dialog appears. Specify the
name and location of the file to be created then click Save. 
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If you select the Export to Excel option, Microsoft Excel opens and the exported information
appears as a workbook.
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Print

This command prints the job information. 

When you select this command from the Schedule screen, you can print a list of jobs, complete
with job description, job number, date, status, etc. 

When you select this command from the Job Schedule screen, a Print dialog opens. From the
Print dialog, you can select the printer to be used, and the number of copies you wish to print.

If you select this option from any other job screen, a Print Reports dialog displays, allowing you to
select from a list of reports.
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Print Preview

When you select the Print Preview option, the Print Preview screen opens. The Print Preview option
allows you to see what your print jobs will look like before they are sent to the printer. 

Tip - This option is only available from job screens.

If there is more than one report available, these are combined into a single printed document
(with a page break between each report). 

To switch between the different reports, simply click Next Page or Prev Page buttons until the
window is displaying the appropriate report.

The following options are available in the Print Preview screen:

   Option Description

Print Click on this button to print the currently
displayed report(s).

Next Page If the current displayed report consists of
multiple pages, you can click on this button to
display the next page in the report.

Prev Page If the current displayed report consists of
multiple pages, you can click on this button to
display the previous page in the report.

Two Page If the current displayed report consists of
multiple pages, you can click on this button to
display two pages at a time side by side.

Zoom In Click on this button to magnify the report
being previewed.

Zoom Out Click on this button to reduce the
magnification of the report being previewed.

Close Click on this button to close the Print Preview
function and return to your previous screen.
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Export via Integrator

This command allows you to automatically create a .CSV file containing your grouped estimating
data. You can export data to Trimble® ConstructJob or to various accounting packages via the
Trimble® Accubid Integrator.

Tip - This option is not active until you group the extension.

For more information, consult the Trimble Accubid Integrator online help.
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Exit

This command closes the estimating product. If you have made changes to a job without first saving,
a prompt displays allowing to you save before exiting the program..

You can also close the program by double-clicking on the program control in the upper left corner of
the program window.
OR
Single-click the program control box and then click Close from the menu.
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Window Menu
The Window menu allows you to switch between currently opened program windows, and to
customize the size and arrangement of these windows.

To display the Window menu, click on the Window menu heading. For more information on individual
Window menu options, click on the button beside the appropriate option below.

  Cascade

  Tile

  Arrange buttons

  Window list
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Cascade

Arranges all currently opened windows so that they overlap.
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Tile

Arranges all currently opened windows so that they do not overlap.
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Arrange Icons

Arranges the minimized window buttons, if any currently appear at the bottom of the main program
window. This is helpful for bringing into view minimized buttons that are currently positioned beneath
another window.
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Window list

Allows you to switch to any of the currently active windows by clicking on the window name within
this list.
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Settings Menu
The Settings menu displays various options that allow you to create and control your software
screens, displays, and reports.

For more information on individual Settings menu options, click the button corresponding to the
appropriate option below.

  Job Folders

  Database Folders

  Power Substitution
Setup

  Defaults

  Screen Styles

  Report Styles

 Options
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Job Folders

Allows you to specify the directories in which job data can be stored. You can store jobs in one or
more directories, anywhere on your hard drive or network. However, only those jobs stored in
directories designated as job folders are listed on the Job Path list on the dialogs that appear when
you create a job or back up a job. Similarly, only jobs stored in directories designated as job folders
will be listed on the Schedule screen.

Initially, a job folder is specified as part of the program installation. However, you can, at any time,
specify different or additional job folders.

When you select this option, the Job Folders dialog appears. The job folders listed on the Job Folders
dialog are only considered job folders if the check box beside the job name is checked.

To select a directory so that it is designated as a job folder:

Click the check box beside the appropriate directory name so that a check mark appears. To select
all the directories listed, click the Select All button.

To deselect a directory, so that it appears on the list but is no longer designated as a job
folder:

Click the check box beside the appropriate directory so that a check mark no longer appears.

To add a directory to the list:

1. Click the Add button to display the Directory Name dialog.

2. From here, you can type the full path of the directory where you want to store jobs, or click the
Browse button and navigate through your directory structure or your network until you find the
appropriate directory.

To remove a directory from the list:

1. Click the directory you wish to remove. The directory should appear highlighted. To select more
than one directory, hold down the [Ctrl] key on your keyboard and click each directory to be
removed. To select all the directories click the Select All button.

2. Click the Remove button.
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Database Folders

Allows you to specify the directories in which material databases can be stored. You can override the
location and store your databases anywhere on your hard drive or network.

When you select this option, the Database Folders dialog appears. To be designated as a database
folder, the directory must not only appear on this Database Folders dialog, but must also be selected.
A database folder is selected if a checkmark appears in the check box beside the directory name on
this dialog.

To select or deselect a database folder, click the checkbox beside the directory name. To select all
the databases listed on this dialog, click the Select All button.

To add a new directory to the list, click the Add button. In the dialog that appears, you can type the
full path of the directory where you want to store databases, or you can click the Browse button and
navigate through your directory structure until you locate the appropriate directory.

To remove a directory from the list, click the check box beside the database folder you wish to delete.
To select more than one database directory, hold down the [Ctrl] key on your keyboard and click each
desired database folder. To select all, hold down the [Shift] key and click the first desired database
folder, then click the last desired database directory. Click the Delete button then click OK to exit the
dialog.
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Power Substitution Setup

Power Substitution is an advanced feature that allows users to not only substitute one item for
another but also any related components, for example straps and hangers, can automatically be
replaced along with the conduit they support.

From the Power Substitution dialog, you may select a Category, a From material type, and a To
material type and one or more Sizes.

To begin a power substitution you must select a category, a From group of items that will be
replaced, a To set of items that will do the replacing, and at least one size (using the associated
checkbox, or by clicking the Select All button).

Once you have made your selections, click Substitute to submit each group for examination at three
degrees of detail to determine if the items within the group match against the items in the selected
takeoffs.

If you have not previously created a Power Substitution set, or if you wish to create a new Power
Substitution set , click the Setup button to proceed to the Power Substitution Setup dialog.

If you wish to view notes that you have previously entered (on the Notes page) describing the selected
Power Substitution Set, click the View Notes button.
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Defaults

Uses the current job to create a new default job. The default job determines the initial values that are
automatically assigned to all new jobs, regardless of the database you choose for the job. Any
subsequent changes you make to the existing job will not affect the default job.

 Caution:  When you set an existing job as the default job, the takeoffs that appear in the existing
job are not saved as part of the default job. However, if you edit the default job directly and add
takeoffs, they will automatically appear in all subsequent jobs you create.
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Edit Default Job

Allows you to edit the default job. When you select this option, the Takeoff screen for the default job
appears. The job number will be default.es9. You can now change the job defaults by modifying the
values appearing on any of the available program screens. The values appearing on these screens
displays as initial values for any new jobs you create, regardless of the database you choose for the
job.

The default job shipped as part of your estimating program uses the following database, depending on
the industry and country you selected at installation time.

 US Canada

Electrical ELEC USA NECA IMP ELEC CDN NECA IMP

Mechanical MECH USA MECH CDN

VDV VDV USA VDV CDN

If the appropriate database is not on your system when you go to edit the default job, you will be
prompted to select a different database.

 Caution: When you set an existing job as the default job, the takeoffs that appear in the existing
job are not saved as part of the default job. However, if you edit the default job directly and add
takeoffs, they will automatically appear in all subsequent jobs you create.
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Delete Default Job

Deletes the default job. When you select this option, you will be asked to confirm your intention to
delete the default job.



60 - Classic Estimating Help Guide

Options

Invokes the Options dialog, which you can use to control a number of program features, including
autobackup, password protection, colors, database setup, file locations, and security setup. The
different options are grouped together on separate pages. To move from one page to another, click the
appropriate page tab. For example, to switch to the Database page, click the Database tab.

The following tabs are available from the Options dialog:

General

File Locations

Takeoff

Appearance

Job Schedule

Extension

Database

Security Device
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General

From the Options dialog, you can control a number of features of your job, including autobackup,
password protection, colors, database setup, file locations, and security setup. The different options
are grouped together on separate pages. To move from one page to another, click the appropriate
page tab. For example, to switch to the Database page, click the Database tab.

The following pages are available from the Options dialog:

General

File Locations

Takeoff

Appearance

Job Schedule

Extension

Database

Security Device

The following options are available from the General page:

Options Description

Program password protection Allows you to restrict access to the program.
With password protection, only users who know
your password will be able to use your program.
See Security Protection for more details.

Prompt to create database when creating
new job

Controls whether or not you are asked to create
a new database each time you create a new
job. If you wish to be asked each time you
create a new job, leave the check box selected.
If you click the checkbox so that a check mark
no longer appears, no prompt appears for each
new job you create, and the job uses an
existing database.

Round takeoff/extension items Controls whether the extension rounds takeoff
items to the nearest whole number. With this
option selected, a takeoff quantity of 6/10 would
be rounded to 1, while a takeoff quantity of 4/10
would be rounded to zero. To avoid having small
takeoff quantities rounded to zero in the
extension, you can turn the rounding on or off.

Enable item matching by database ID Select this checkbox to allow the program to
match items during a re-sync or job merge
function by comparing their database ID
numbers.
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Options Description

Spelling Click this button to set spell-checking options.
You can spell-check text on the Notes screen
by selecting the Check Spelling option from the
Edit menu.

Security Protection

Using password protection, you can restrict access to your estimating program. With password
protection enabled, only users who know your password will be able to use your program. 

Tip - By default, password protection is disabled.

1. Click Settings / Options. The Options dialog opens.

2. On the General tab, select the Program Password Protection checkbox .

3. In the Enter Password field, type in a password.

4. Reenter your password in the Confirm Password field.

Tip - Be sure to make note of your password.

5. Click on OK.

The next time the program is run, uses will be prompted to supply the password.

 Caution - If you cannot supply the password, you will be unable to open the program. If you your
password, contact MEP Client Services for assistance.
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File Locations

The File Locations tab allows you to control where style files and extension view files are stored. 

Tip - Storing the style files or extension view files on a network drive allows multiple users to share
the same settings.

Common style files Description

Acquire schedule screen style at startup Select the checkbox  and then click
Browse to navigate to the location of your
schedule screen styles.

Acquire job screen style at startup Select the checkbox  and then click
Browse to navigate to the location of your job
screen styles.

Acquire job report style at startup Select the checkbox  and then click
Browse to navigate to the location of your job
report styles.

Common Extension Views Description

Acquire extension views at startup Select the checkbox  and then click
Browse to navigate to the location of your
extension views.

Click OK when you are done.
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Takeoff

From the Takeoff tab, you can specify takeoff-specific program options.

The following options are available from the Takeoff page:

Options Description

Prompt for confirmation when aborting
takeoff

Controls whether you are prompted to confirm
when you click the Abort button to discard the
changes you have made to an existing takeoff
within the audit trail on the Takeoff screen. 

Tip - By default, the confirmation message
is enabled. To disable the message, click the
checkbox so that a check mark no longer
appears.

Show Catalog Number at Item level Controls whether the Catalog Number is
displayed at the item level when taking off
material from the item database on the Takeoff
screen. 

Tip - By default, the Catalog Number is
displayed. To disable this option, click the
check box so that a checkmark no longer
appears.

Enable LiveCount automatic launch Controls whether LiveCount is automatically
launched when you initiate a takeoff. LiveCount
must be selected as your measuring device
from the Probe Options dialog for this option to
take effect.

Highlight typical takeoffs on Audit Trail Control whether typical takeoffs appear
highlighted (green text rather than black text)
within the audit trail. You can control the color
used to highlight them from the Appearance
tab.
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Appearance

You can use the Appearance page on the Options dialog to control the foreground and background
colors used to represent different kinds of information in cells, as well as the overall color and
appearance of program screens. For example, you can control the color used to indicate that a field is
protected and cannot be modified.

The following options are available from the Appearance page:

Theme
You can choose from a list of themes that control the overall color and appearance of the program
screens.

Toolbar Size
Controls whether the buttons that appear on toolbar are large (24x24 pixels) or small (16x16
pixels).

Category
The category of data to be displayed using the specified colors. The following color categories are
available:

Category Applies to ...

Cell Editable Normal Regular editable cells.

Cell Non-Editable Normal Cell data that cannot be modified.

Cell Editable Grayed Default cell values that can be overridden.

Cell Non-Editable Grayed Cell values that cannot be overridden. These
include non-modifiable default values.

Cell Editable Highlight Pinned values that can be modified. For
example, where a value can be specified as
either a percentage or a fixed amount, the
specified (or “pinned”) value displays
highlighted.

Cell Non-Editable Highlight Pinned values that cannot be directly
modified. For example, values appear on the
Totals screen that have been carried forward
from previous screens appear highlighted but
can only be modified from the original
screen.

Cell Editable Alarm Cells with missing or incomplete data that
can you can modify directly. To control cell
alarms see the Extension page of the
Options dialog.

Cell Non-Editable Alarm Cells with missing or incomplete data that
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Category Applies to ...

cannot be directly modified, but can be
completed by entering the appropriate values
in other related fields. To control cell alarms
for certain fields on the Extension screen,
see the Extension page of the Options
dialog.

Cell Totals Alarm Column totals that include cells with missing
or incomplete data.

Typical Highlight Typical takeoffs within the audit trail.

Foreground
Determines the color of the text itself. To specify a different color, click on the list box and select
the desired color.

Background
Determines the color of the background that appears behind the text.

Reset Colors
Returns all color settings back to their original default values.

Disable Grid Hovering
Grid hovering occurs when the background of the row over which your pointer is positioned
changes color. Check this box to disable grid hovering.
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Job Schedule

You can use the Job Schedule page on the Options dialog to control how the Job Schedule screen
handles updates in order to optimize the speed of the display for refreshed information, and control
whether to display job alarms.  

The following options are available from the Job Schedule page:

Options Description

Rescan Options

Tip - This only applies to scanning the Job
Schedule after the initial load of the schedule
screen upon entering the application.

No Rescan
The Job Schedule will only reflect updates/
changes to jobs that the current user has
made.  Changes to existing jobs made by
other users will not be reflected on the Job
Schedule screen.  However, if a new job is
created by any user it will be reflected on the
schedule screen.

Optimized Rescan
The visible section of the Job Schedule will
update only the jobs which have been
modified or added.  The user should always
see all updates for any job made by any
user.  This is the default selection for this
function.

Full Rescan
This option will mean that the Job Schedule
will scan for all jobs regardless of whether or
not they have been opened, edited or created
new.

Show Job Alarms Controls whether jobs with cell-level alarms
will be displayed on the Job Schedule using
alarm colors (white text on a red
background).
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Extension

The Extension tab controls when cells on the Extension screen are alarmed (appearing by default with
a red background).

The following options are available from the Extension page:

Options Description

Activate Alarm when Net Cost is 0.00 and
Material Condition is

For an item with a Net Cost of 0.00, you can
control which material conditions will result in
the Net Cost cell appearing alarmed (with a
red background)

Activate Alarm when Labor is 0.00 and
Labor Condition is

For an item with a Labor value of 0.00, you
can control which labor conditions will result in
the Labor cell appearing alarmed (with a red
background)
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Database

From the Database page, you can control the ability of users to update the material databases from
the Takeoff screen. Restricting database access makes it possible for multiple users to open jobs
that share a single material database.

The following takeoff mode options are available from the Database page:

Options Description

Single-user database mode Allows you to open and update the database.
If you select this as the database mode, then
other users will be unable to open jobs that
use the same database at the same time as
you.

Multi-user database mode Allows you to open but not modify the
database. To allow other users to open jobs
that use the same database at the same time
as you, select the Multiple-User Database
Mode as the database mode.

Prompt user for database access mode Users will be asked when they try to access
the database whether they wish to open the
database in read & write or read-only mode.

After you click OK, you must close and restart your estimating program to have the changes take
effect.

Tip - If you accessing a database stored on another computer on your network, the directory in
which the database is stored must be shared with the appropriate access rights. Otherwise, the
database access mode you select may be ignored. For example, if you set the Takeoff Mode to
Single-User Database Mode (read and write access), and try to open a job that uses a database
stored in a directory that is shared with read-only access, then the database opens in read-only
mode.
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Security Device

The Security Server tab allows you to control whether the program accesses a local security device or
a network security server. If you try to run a Trimble program without either attaching a local security
device or linking to a network security server, you are prompted to:

exit the program

change the programs security settings

run the program in demo mode.

If your company has purchased a network license, rather than a single user license, then a local
security device is not required to run your estimating program. Instead, link your program to a security
server on your network. 

Tip - By default, the program assumes you are linking to a local security device. For information on
setting up a network security server, see the Getting Started Guide included with your software
purchase.

From the Security Device tab, you can choose from the following options to connect to a security
device:

Options Description

Connect to a local security device Connect to the local security device attached
to your workstation.

Connect to the first available network
security server

The program will search for security servers on
your network and will connect to the first one
found.

Connect to a specific network security
server

Connect to the network security server
selected in the Server Address list box.

Connect to a customized network security
server

Connect to the network security server
selected in the Server Address list box using
the parameters specified below.
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Report Styles

Allows you to create and modify report styles. Report styles are used to control which columns are
included in a particular job report. You can include or exclude columns from entire job screens, or just
include selected columns from different job screens. You can also control the order in which columns
are printed. As part of a report style, you can also control the font used in your report, as well as
headers and footers, page margins, and page orientation.

Report styles can only be used when printing job reports. They do not apply when printing job
summaries from the Job Schedule screen, database reports from the Database Manager module, or
price update reports from the Price Update screen.

For more information on using report styles, see Using Report Styles.
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Screen Styles

Allows you to create and modify screen styles. Using screen styles, you can control the columns that
appear on each job and database screen, the width of each column, and the fonts to use to display
information on the screens. (Job screens include any screens except the Schedule, Database
Manager, and Price Update screens.) You can create multiple screen styles, each with a different
combination of columns, column widths, and fonts, and easily switch back and forth between different
screen styles.

When you save a job, any changes you have made to the current screen style are saved as well.
Each time you open a job, the job automatically loads the last screen style used with this job. When
you create a new job, the current screen style serves as the default screen style for the new job. If a
screen style is shared by multiple jobs, any changes made to the style sheet from one job does affect
the style sheet in the other jobs that use it.

Though screen styles are primarily used to control the on-screen appearance of your estimating
program, they can, in some cases, to be used to determine the appearance and content of reports
such as database reports and job summaries. To control the appearance of other printed reports, you
use report styles.

For more information, see Using Screen Styles.
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Database Menu
The Database menu displays various options that allow you to modify and manipulate the material
database. To display the Database menu, click on the Database menu heading, or press [Alt] + [D] on
your keyboard. For more information on individual Database menu options, click on the button beside
the appropriate option below.

  Database Manager

  Price Update

  Select

  Print Quick Takeoff Codes
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Database Manager

When you select this option, the Database Manager program appears. appears, listing the name
and location of your existing databases. From the Database Manager program you can add or modify
categories, assemblies, and items.

For more information on the Database Manager, please consult the Database Manager's Online Help.



Classic Estimating Help Guide  - 75

Price Update

Selecting this option launches the Price Update module.

For more information on the Price Update, please consult the Price Update Online Help.



76 - Classic Estimating Help Guide

Select

Allows you to switch to a different material database. When you select this option, the Select
Database dialog appears. From this dialog, you can select the database you wish to use, then click
on OK. You can resize the columns in this dialog by dragging either of the lines that separate the
different column headings.

Tip - If you switch to a database that uses different materials, you may encounter errors when you
re-extend your job.
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Print Quick Takeoff Codes

Prints a report listing database items and the quick takeoff codes that have been assigned to them. 
Using quick takeoff codes, you can quickly take off items without navigating through the materials
database.

This option is only available from the Takeoff screen.



78 - Classic Estimating Help Guide

Bid Summary Menu
The Bid Summary menu provides options that allow you to create or modify different bid summaries,
and make adjustments to totals on the Final Pricing screen.

To display the Bid Summary menu, click on the Bid Summary menu heading, or press [Alt] + [B] on
the keyboard. For more information on individual Bid Summary menu options, click on the button
beside the appropriate option below.

  Modify

  Reload

  Combine
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Modify

Allows you to create a new bid summary, and modify or delete an existing one. You can create any
number of different bid summaries, each of which can include different combinations of drawing, area,
phase, system, and location breakdowns. When you switch between different bid summaries, the
extension changes to include only those breakdowns you chose to be part of the current bid summary.
Totals appearing on all screens other than the Takeoff screen will be similarly affected.

When you select this option, the Bid Summaries dialog appears. From there, you can create a new
bid summary, and modify or delete an existing one.
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Reload

On the Final Pricing screen, selecting Reload will overwrite any changes you have made to the
Modified values with the values appearing in the Calculated column.

On the Bid Breakdown screen or Graph screen, selecting Reload will update the bid breakdown to
reflect any changes you have made to values on the preceding screens. If you enter new values in any
of the Bid Breakdown screen cells, selecting Reload will reload the calculated values in place of those
you have specified.

On the Bid Breakdown screen, selecting Reload will also distribute the Quoted Material and
Subcontractors amounts between the different breakdowns according to the ratio you specify. For
example, if you enter a value of 2 for LIGHTING SYSTEM and 1 for the WIRING DEVICES under the
Quoted Material column, then click on Reload, the program will assign 2/3 of the quoted material
costs to LIGHTING SYSTEM and 1/3 to WIRING DEVICES.

Selecting this option is equivalent to clicking on the Reload button within the toolbar.
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Combine

Allows you to select one or more bid summaries to be combined into a single summary that you can
view or print. When you select this option, you are prompted to select the bid summaries you want to
combine. After you select the bid summaries to be combined, a price summary appears with columns
for each selected bid summary as well as a column displaying totals for all selected bid summaries.
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Graph Menu
The Graph menu displays various options that allow you to control the appearance and content of
graphs. To display the Graph menu, click on the Graph menu heading. For more information on
individual Graph menu options, click on the button beside the appropriate option below.

  Options

  Fonts

  Legend

  Reload
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Options

Allows you to control the appearance of the graph, including graph type, scale, and titles. When you
select this option, the Chart Properties dialog appears. This dialog arranges the different options into
separate pages. To move from one page to another, you click on the appropriate page tab at the top of
the dialog.

For information on individual dialog options, click on the appropriate page tab below:
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Fonts

Allows you to control the fonts used to display text within graphs. When you click on Fonts within the
Graph menu, a submenu appears. From the submenu, you can select the text element whose font
you wish to modify. After you select an option, the Fonts dialog appears. From this dialog, you can
select the font, font style, and point size you wish to use. 
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Legend

Determines whether a legend appears within the graph.
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Reload

On the Final Pricing screen, selecting Reload will overwrite any changes you have made to the
Modified values with the values appearing in the Calculated column.

On the Bid Breakdown screen or Graph screen, selecting Reload will update the bid breakdown to
reflect any changes you have made to values on the preceding screens. If you enter new values in any
of the Bid Breakdown screen cells, selecting Reload will reload the calculated values in place of those
you have specified.

On the Bid Breakdown screen, selecting Reload will also distribute the Quoted Material and
Subcontractors amounts between the different breakdowns according to the ratio you specify. For
example, if you enter a value of 2 for LIGHTING SYSTEM and 1 for the WIRING DEVICES under the
Quoted Material column, then click on Reload, the program will assign 2/3 of the quoted material
costs to LIGHTING SYSTEM and 1/3 to WIRING DEVICES.

Selecting this option is equivalent to clicking on the Reload button within the toolbar.
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Extension Menu
The Extension menu displays various options that allow you to view and manipulate the extension.

To display the Extension menu, click on the Extension menu heading, or press [Alt] + [X] on the
keyboard. For more information on individual Extension menu options, click on the button beside the
appropriate option below.

  Group

  Filter

  Views

  Clear View

  Re-Extend

  Labor Column

  Extension Next

  Extension Previous

  Collapse

  Expand

  Add Item

  Re-extension Lock

  Unit Price Defaults

  Material Adjustment Defaults

  Send to Supplier Link

  Export for Supplier Link

  Import from Supplier Link
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Group

Allows you to group the extension by job, drawing, area, phase, system, bid item, labor factor,
item, sort codes, or unit price (depending on which estimating program you are using). Initially, the
Extension screen is grouped by item, displaying a consolidated material list showing the quantity and
price for each individual item.

Tip - In previous versions, the less accurate term "sorting" was used instead of "grouping".

Grouping by system allows you to view total material costs and labor hours for each system. You can
double click the row heading (the number on the far left) of an entry to display the extended items
within that system. Grouping by unit price allows you to view total costs and labor hours for each
takeoff in your audit trail. You can double click the row heading of an assembly entry to display
quantities and prices for each item in the assembly.

When you select this option, the Group page of the Views dialog appears. From here, you select the
breakdowns to be used to group extension items. To do so, double click the appropriate option from
the left side of the Group page. Alternatively, you could single click the option, then click on the Add
button. You can group by multiple criteria in any order.

You can also click on the Filter tab to narrow the scope of the extension so that it displays only those
items that match the conditions you specify.

You can save a particular extension grouping, along with a particular extension filter, as a "view",
which can be selected from a list of saved views. The view will be in effect until you select a different
view, clear the view, or override the view by applying a quick view. For information on creating and
selecting views, see Working with Views.

The last selected view is automatically applied the next time you open the job. If you override a saved
view with a quick view, the extension will be displayed using the unfiltered and ungrouped
consolidated view the next time you open the job.

For more information, see Grouping the Job Extension.
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Filter

Allows you to narrow the scope of the extension according to the criteria you specify. You can
filter the extension by material condition, price, discount, labor condition, or labor. For example, you
may want to see only those takeoff items with a Budget material condition.

Filtering the extension does not alter the extension itself or your bid totals. If you wish to experiment
with alternate bids, and you're using Pro or BidWinner Plus, you create alternate bid summaries and
switch between them. For more information on alternate bid summaries, see Using Alternate Bid
Summaries.

When you select this option, the Filter page of the Quick View dialog appears. From the Filter page of
the Views dialog, you can specify the conditions by which the extension will be filtered. Only those
items that match the conditions you specify will be displayed within the extension. You can filter the
extension by material condition, price, discount, labor condition, labor hours, date, or price code. For
example, you may want to see only those takeoff items with a Budget material condition.

From here, you can also click the Group tab to group the extension by system, area, drawing, phase,
location, or labor factor.

You can save a particular extension filter, along with a particular extension grouping, as a "view",
which can be selected from a list of saved views. The view will be in effect until you select a different
view, clear the view, or override the view by applying a quick view. For information on creating and
selecting views, see Working with Views.

The last selected view is automatically applied the next time you open the job. If you override a saved
view with a quick view, the extension will be displayed using the unfiltered and ungrouped
consolidated view the next time you open the job.

For more information, see Filtering the Extension.
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Views

Allows you to save the extension filter and grouping settings as a "view" that you can select from a
list of saved views. You can create multiple views that you can quickly switch between. Views can
also be shared between multiple users on a network.

When you select this option, the Views dialog appears. From there, you can create one or more
views, and specify grouping and filtering options. After you have created multiple views, you can
switch between them by clicking on the drop down list within the Extension Views toolbar or the
Views dialog.

The view will be in effect until you select a different view, clear the view, or override the view by
applying a quick view (a view that is not saved). To apply a quick view, you select either the Group or
Filter option from the Extension menu, or click on the corresponding toolbar button. From the Quick
View dialog, you can choose temporary grouping and/or filter settings.

The last selected view is automatically applied the next time you open the job. If you override a saved
view with a quick view, the extension will be displayed using the unfiltered and ungrouped
consolidated view the next time you open the job.
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Clear View

Removes the current extension view. An extension view is a set of extension filtering and grouping
settings. For more information, see Working with Views.
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Re-Extend

Reapplies the item prices, discounts, labor, sort codes, adjustments, manufacturers (manufacturer
name, catalog number, price code, and reference number), and/or suppliers (supplier name and
supplier code) from the currently assigned database. Re-extending the job will normally reverse
changes you have manually made to the portion of the extension you are re-extending, except
changes made to quantities or descriptions, which are directly linked to the takeoffs. You can,
however, select cells within the Net Price column and lock them so that your changes are not lost
when the job is re-extended. For more information, see Re-Extending the Job.

If you make changes to the currently assigned database, you must re-extend the job in order for the
changes to be reflected on the Extension screen.

When you select this option, the Re-Extend dialog appears. From there, you can choose whether you
wish to update descriptions, pricing, discounts, adjustments, labor, sort codes, manufacturers, and
suppliers. For pricing, labor, sort codes, manufacturers, and suppliers, you can click the plus sign to
expand the tree and control exactly which elements will be updated as part of a re-extend.



Classic Estimating Help Guide  - 93

Labor Column

This option allows you to re-extend the extension using any of the pre-defined labor columns in your
database. Selecting this option results in a Select Labor Options dialog appearing. From this dialog,
you can choose the column you wish to use. A description of each column option appears below.

Labor Column Descriptions

Column Description

Column 1 Electrical: Labor hours for competitive bidding
(base rate).

Mechanical: Competitive labor units.

Column 2 Electrical: Labor hours for industrial applications
(base rate + 25%).

Mechanical: Change order labor units.

Column 3 Electrical: Labor hours for unique or special
conditions (base rate + 50%).

Mechanical: Industrial labor units.

Column 4 Electrical: NECA’s published labor column 1. If
you are not using a NECA database, this field
will have a value of 0.00.

Mechanical: MCAA labor units.

Column 5 Electrical: NECA’s published labor column 2. If
you are not using a NECA database, this field
will have a value of 0.00.

Mechanical: PHCC labor units.

Column 6 Electrical: NECA’s published labor column 3. If
you are not using a NECA database, this field
will have a value of 0.00.

Mechanical: intentionally left blank.

Tip -You should select Column 4, Column 5, or Column 6 only if you are an electrical user using a
NECA database or a mechanical user using an MCA database. Otherwise, your labor values will be
reduced to zeros.
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Extension Next

Moves you to the next extension grouping at the current level. If you are viewing items in one system,
choosing this option will display the item detail in the next system.
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Extension Previous

Moves you to the preceding extension grouping at the current level. If you are viewing items in one
system, choosing this option will display the item detail in the previous system.
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Expand

Moves you one level down in the extension, allowing you to see how the total on the current screen is
broken down at the next level. The extension can contain many levels of item information depending
on your group options and the takeoff breakdowns.

For example, if your extension is grouped by System and then by Item, and you are looking at the
system totals and you want to see individual items within a specific system, you can choose this
option (or press [Enter]) to view the items belonging to this job system.
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Collapse

Moves you one level up in the extension, allowing you to see how the total on the current screen is
broken down at the higher level. The extension can contain many levels of item information depending
on your group options and the takeoff breakdowns.

For example, if your extension is grouped by System and then by Item, and you are looking at the
items within a specific system, you can choose this option (or press the [Esc] key) to view this system
total along with the totals for the other job systems.
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Add Item

Allows you to add a takeoff item directly to the extension. The item you are taking off is automatically
added to the temporary item list. When you select this option, the Add Extension Item dialog
appears. From this dialog, you can provide a description for the new item, and select the breakdowns
to be used for the takeoff.

The takeoff now appears at the bottom of the extension. You can now modify the description, price,
unit, discount, net cost, labor, labor unit, material condition, and labor condition for the new item. To
do so, click on the appropriate cell, then type in the new value and press [Enter] to complete the
change. 

Double click on the row heading (the number on the far left) of the new takeoff to display the expanded
view for this item. From the expanded view, you can modify the quantity for this item. To do so, click
on the Qty cell, then type in the new value and press [Enter] to complete the change.
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Re-extension Lock

This option locks the Net Cost column or Labor column cells you have selected so that their values
are not updated during a re-extend. Re-extending the job normally reverses changes you have
manually made to the selected portion of the extension, except changes made to quantities or
descriptions, which are directly linked to the takeoffs.

To lock Net Cost or Labor column cells, select the cell or cells you want to lock. To select a single
cell, click on it. To select a range of cells, click on the first cell in the range then hold down your left
mouse button and drag your pointer over the remaining cells in the range and release your mouse
button. After you have selected the cells to be locked, click the Extension menu then select the Re-
extension Lock option (or right click and select Re-extension Lock).

The selected cells should now appear with a green background to indicate that they are locked. Also,
a check mark will subsequently appear beside the Re-extension Lock menu option.
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Unit Price Defaults

This option allows you to set the default values for selected columns that appear on the Extension
screen when it is sorted by unit price. When you select this option, the Unit Price Default Values
dialog appears.

Any changes you make to the default values will affect new takeoffs in the current job and all other
jobs, but will not affect any existing takeoffs.
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Material Adjustment Defaults

The Material Adjustment Default option in the Extension menu allows you to set the default values for
the Material Adjustment column on the Extension screen.
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Send to NetPricer Link

Available only to users who have installed the Supplier Link program, this feature allows you to launch
the Supplier Link application from within Estimating. Selecting this item from the Extension menu will
automatically export data from the current estimating job to a newly created Supplier Link job.

For more information, consult the Supplier Link online help.
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Export for NetPricer Link

The Export for Supplier Link option in the Extension menu allows you to convert and save the active
job's extension into .XML file format for later use in the Supplier Link program.
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Import from NetPricer Link

The Import from Supplier Link option in the Extension menu allows you to open, convert, and import
information from an .XML file created in the Supplier Link program.
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TakeOff Menu
The Takeoff menu displays various options that allow you to modify and manipulate takeoffs.

To display the Takeoff menu, click on the Takeoff menu heading, or press [Alt] + [T] on the keyboard.
For more information on individual Takeoff menu options, click on the button beside the appropriate
option below.

  Abort

  Next

  Finish

  Rename

  Reverse Takeoff

  Notes

  Quick Takeoff

  Modify Breakdown Description

  Modify Typical Description

  Modify Makeup Defaults

  Configure Probe

  Change Breakdown

  Power Substitution

  Substitute Items

  Substitute Assemblies
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Abort

Discards the modifications you have made to a takeoff. You can modify the takeoff at any time,
by adding components, changing quantities, modifying the takeoff description, and reassigning takeoff
breakdowns. For more information, see Modifying Existing Takeoffs.

Selecting this option is equivalent to clicking on the Abort button within the toolbar.
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Next

Displays the next materials list for the current takeoff. Selecting this option is equivalent to
clicking on the Next button within the toolbar.
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Finish

Saves the modifications you have made to a takeoff. You can modify the takeoff at any time, by
adding components, changing quantities, modifying the takeoff description, and reassigning takeoff
breakdowns. For more information, see Modifying Existing Takeoffs.

When you select this option, the Modify Takeoff Description dialog appears, prompting you to specify
a new takeoff description. To keep the existing description, click on OK or press the [Enter] key.

Selecting this option is equivalent to clicking on the Finish button within the toolbar.
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Rename

Allows you to change the selected takeoff description as it appears in the audit trail. From the Modify
Takeoff Description dialog that appears, you can make any changes that are necessary.
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Reverse Takeoff

Allows you to designate the takeoff as a takeoff with negative values. You can also make a takeoff
negative by clicking the Reverse Takeoff checkbox in the Measure/Edit Takeoff dialog.
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Notes

Displays a text box where you can enter reminders or explanations regarding the currently selected
takeoff, temporary item, or temporary assembly. After you have attached a note to a takeoff, item, or
assembly, a note button displays beside the takeoff in the audit trail, or the item or assembly within
the temporary items or assemblies list. To view the note, right click over the takeoff, temporary item,
or temporary assembly and select the Notes option.
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Quick Takeoff

Allows you to specify a quick takeoff code for a database item to be taken off. Instead of navigating
through the material database to select the takeoff material, you enter a quick takeoff code assigned
to an item in the database. Quick takeoff codes can be assigned to a database from the Database
Manager module. The code you assign cannot contain spaces and each code must be unique; no
duplicate codes are allowed. 

If the code you have entered corresponds to a quick takeoff code in the currently loaded database,
the Measure Takeoff dialog displays so you can specify the quantity for the material. 

To print a report listing the quick takeoff codes assigned to items in the current database, click the 
Database menu and select Print Quick Takeoff Codes from the Takeoff screen. You are prompted to
indicate whether you want to sort the items first by Description then by Quick Takeoff Code.
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Modify Breakdown Description

Allows you to modify or add to the list of drawing, area, phase, system, bid item, and labor factor
breakdowns (depending on which estimating product you are using). After the job is taken off and
extended, you can view the total estimate, total cost, and labor hours broken down by drawing, area,
phase, system, bid item, or labor factor.

Selecting this option is equivalent to clicking on the Drawing, Area, Phase, System, Bid Item, or Lb
Factor button, just above the Audit Trail Description heading. When you select this option, a Modify
dialog appears. From there, you can click on a blank line to add a new breakdown option, or click on
an existing breakdown option to modify it. For each option (except Labor Factor options), you can
specify a labor factor adjustment percentage using the Lab Adj (%) column (Pro, BidWinner Plus
only). Enter a positive value to increase labor, or a negative value to decrease labor.

After you have entered a new breakdown description or modified an existing one, press the [Enter] key
to save your changes.

After you have completed adding new breakdown options or modifying existing ones, click on OK to
exit the Modify dialog and return to the Takeoff screen.
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Modify Typical Description

Allows you to create a typical takeoff in which you can specify how many times you want the material
taken off in each drawing, area, phase, system, or location. Instead of taking off the same component
several times, you can design a typical takeoff, specify the number of times you want the material
taken off for each breakdown, then select the typical as the takeoff breakdown and measure your
material once.

When you click on the Modify Typical Descriptions option within the Takeoff menu, a submenu of
options appears. From the submenu, you can choose Drawing, Area, Phase, System, or Bid Item.
This is equivalent to clicking on the Typ button beside the Drawing, Area, Phase, System, or Bid Item
buttons. After you select the appropriate option, a Typical Modify dialog appears.

Under the Typical Description heading on the left side of the dialog, you enter an appropriate
description (e.g. ‘Typical Floors 2 thru 10’ ). Within the Count column beside the appropriate
breakdown description, you specify the number of times this typical takeoff is to appear in this
drawing, area, phase, system, or location.

Once you click on OK to exit the Typical Modify dialog and create the typical takeoff, the typical
displays at the bottom of the breakdown listing following your other breakdown descriptions. If you
select a typical takeoff as the takeoff breakdown, any takeoffs you complete will be repeated the
number of times specified in the typical’s Count column for each of the takeoff breakdowns defined as
part of the typical.

For more information on creating typical takeoffs, see Creating Typical Takeoffs.



Classic Estimating Help Guide  - 115

Modify Makeup Defaults

Allows you to set the default values for system-specific measurement variables that may appear on
the Measure Takeoff dialog when you are using a hot list. From the Makeup Adjustments dialog that
appears when you select this option, you can modify the existing defaults, then click on OK to accept
the new values.
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Configure Probe

Allows you to configure a measuring device so that it can work properly with the program. There are
several measuring devices that will interface with the program. Each device will plug into a serial port
on your computer and use a different interface.

When you select this option, the Probe Options dialog appears. From this dialog, you can select the
type of measuring device you are using and identify the serial port it uses. After you provide this
information and click on OK, you can use the probe to measure materials within a takeoff.
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Change Breakdown

Allows you to change the breakdown to which the selected takeoffs are assigned. Before you select
this option, you must select, within the audit trail list, the takeoffs to be reassigned. When you select
the Changing Breakdown option, the Change Breakdown dialog appears.

From this dialog, you can click on the description of the breakdown you want to change and select a
different breakdown. When you click on OK and exit the Change Breakdown dialog, the modified
takeoffs are automatically saved; you do not need to click on the Finish button or select the Finish
option.

For instructions on reassigning a single takeoff to a different takeoff breakdown, see Reassigning
Takeoff Breakdowns.
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Power Substitution

Pro only

Power Substitution is an advanced feature that allows you to not only substitute one item for another
but also any related components, for example straps and hangers, can automatically be replaced
along with the conduit they support.

From the Power Substitution dialog, you may select a Category, a From material type, and a To
material type and one or more Sizes.
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Substitute Items

Allows you to change a common component in a group of existing takeoffs. This is especially useful if
you need to change a material component after the job has been taken off, since it allows you to
substitute material in your existing takeoffs without having to delete or add takeoffs.

Tip - You cannot substitute items within takeoffs that are based on designations. To substitute
items within a designation, you must substitute items within the designation itself, thereby modifying
all takeoffs based on the designation.

Before you select this option, you must select, within the audit trail list, the takeoffs to be affected by
the change. To do this, click on the first takeoff description and then drag the mouse pointer over the
other takeoff descriptions. If the takeoffs you wish to select do not appear one after another, you could
set the Audit Trail filter to narrow down the takeoffs being displayed. If you want to change all takeoffs
in the current audit trail, click on the Audit Trail column heading.

After you select this option, the Item Substitution dialog appears. On the left side of the dialog, you
can select the item(s) you want to replace in the selected takeoffs. On the right side of the screen,
highlight the item(s) you want to substitute for the item(s) you selected on the left side of the screen.
If you select more than 1 item on the left side of the screen, you must select the same number on the
right. After you click on Substitute, the selected item(s) will be replaced.

The Range list box determines which takeoffs and designations are affected by the substitution. By
default, item substitution applies to the selected takeoffs, except those based on designations. Other
Range options include All Takeoffs (excluding Designations), Selected Designations, All
Designations, and All Takeoffs & Designations.
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Substitute Assemblies

Allows you to change a common assembly in a group of existing takeoffs. This is especially useful if
you need to change a material component after the job has been taken off, since it allows you to
substitute material in your existing takeoffs without having to delete or add takeoffs.

Tip - You cannot substitute assemblies within takeoffs that are based on designations. To
substitute assemblies within a designation, you must modify the designation itself, thereby modifying
all takeoffs based on the designation.

Before you select this option, you must select, within the audit trail list, the takeoffs to be affected by
the change. To do this, click on the first takeoff description and then drag the mouse pointer over the
other takeoff descriptions. If the takeoffs you wish to select do not appear one after another, you could
set the Audit Trail filter to narrow down the takeoffs being displayed. If you want to change all takeoffs
in the current audit trail, click on the Audit Trail column heading.

After you select this option, the Common Assembly Substitution dialog appears. On the left side of
the dialog, you can select the assembly (or assemblies) you want to replace in the selected takeoffs.
On the right side of the screen, highlight the assembly (or assemblies) you want to substitute for the
assembly (or assemblies) you selected on the left side of the screen. If you select more than 1
assembly on the left side of the screen, you must select the same number on the right. After you
click on Substitute, the selected assembly (or assemblies) will be replaced.
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Substitute Designations

Pro, BidWinner Plus only

Allows you to change a common designation in a group of existing takeoffs. This is especially useful if
you need to change a material component after the job has been taken off, since it allows you to
substitute material in your existing takeoffs without having to delete or add takeoffs.

Before you select this option, you must select, within the audit trail list, the takeoffs to be affected by
the change. To do this, click on the first takeoff description and then drag the mouse pointer over the
other takeoff descriptions. If the takeoffs you wish to select do not appear one after another, you could
set the Audit Trail filter to narrow down the takeoffs being displayed. If you want to change all takeoffs
in the current audit trail, click on the Audit Trail column heading.

After you select this option, the Designation Substitution dialog appears. On the left side of the dialog,
you can select the designation (or designations) you want to replace in the selected takeoffs. On the
right side of the screen, highlight the designation (or designations) you want to substitute for the
designation (or designations) you selected on the left side of the screen. If you select more than 1
designation on the left side of the screen, you must select the same number on the right. After you
click on Substitute, the selected designation (or designations) will be replaced.
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View Menu
The View menu displays various options that allow you to access the appropriate screen or window.

To display the View menu, click on the View menu heading, or press [Alt] + [V] on the keyboard. For
more information on individual View menu options, click on the button beside the appropriate option
below.

  Next

  Previous

  Schedule

  Job Info

  Notepad

  Takeoff

  Extension

  Direct Labor

  Incidental Labor

  Labor Factoring

  Labor Escalation

  Indirect Labor

  Subcontractors

  General Expenses

  Equipment

  Quoted Materials

  Final Pricing

  Price Summary

  Bid Breakdown

  Graph

  Quotepad

  Toolbars

  Filter & Sort

  Refresh

  View Using Report Styles

  View Using Screen Styles

  Calculator
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Next

Moves you to the next program screen. You can also move to the next screen by pressing [F2] on
your keyboard.
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Previous

Moves you to the previous program screen. You can also move to the previous screen by
pressing [F4] on your keyboard.
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Schedule

Takes you to the Job Schedule screen, which you can use to keep track of your bids. You can also
jump to the Job Schedule screen by selecting Schedule from the Window menu.
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Job Info

Takes you to the Job Information screen, where you can keep track of the contact, bid, and file
information for your job.
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Notepad

Takes you to the Notes screen, which provides a notepad in which you can record comments or
reminders.
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Takeoff

Takes you to the Takeoff screen, where you can choose your takeoff breakdown, select materials for
the takeoff, and enter the takeoff measurements.
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Extension

Takes you to the Extension screen, where you can view the job extension.
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Direct Labor

Takes you to the Direct Labor screen, where you can add and modify direct labor costs.



Classic Estimating Help Guide  - 131

Incidental Labor

Takes you to the Incidental Labor screen, where you can add and modify incidental labor costs.
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Labor Factoring

Takes you to the Labor Factoring screen, where you can adjust project labor for various factors related
to the job conditions.
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Labor Escalation

Takes you to the Labor Escalation screen, where you can provide for changes in labor rates over the
course of the job (e.g. scheduled increases for unionized labor).
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Indirect Labor

Takes you to the Indirect Labor screen, where you can incorporate non-field labor (e.g. supervisory or
clerical).
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Subcontractors

Takes you to the Subcontractors screen, where you can record your subcontractor quotes.



136 - Classic Estimating Help Guide

General Expenses

Takes you to the General Expenses screen, where you can add and modify general expenses.
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Equipment

Takes you to the Equipment screen, where you can record equipment costs.
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Quoted Materials

Takes you to the Quoted Materials screen, where you can record quotes for materials.
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Final Pricing

Takes you to the Final Pricing screen, where you can review the total cost of materials and labor, and
arrive at your selling price.
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Price Summary

Takes you to the Price Summary screen, where you can review the total cost of materials and labor.
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Bid Breakdown

Takes you to the Bid Breakdown screen, where you can view the total cost of your bid broken down
into various categories.
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Graph

Takes you to the Graph screen, where you can view a graphic illustration of the material costs and
labor hours.
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Quotepad

Takes you to the Quote Pad screen, where you can produce a formal quotation.
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Toolbars

The Toolbars menu control which toolbars appear. Some of these options are only available from
certain screens. The estimating products use the following toolbars:

Standard toolbar

Bid Summary toolbar

Styles toolbar

Formatting toolbar

Extension Views toolbar
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Bid Summary Toolbar

Controls whether the Bid Summary toolbar appears to the right of the standard toolbar. The options on
the Bid Summary toolbar allow you to select from or modify the list of bid summaries. If the toolbar is
already displayed, you can disable it by clicking on this option. To display the Bid Summary toolbar
after disabling it, click on this option again.
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Styles Toolbar

Controls whether the styles toolbar appears. Using the Styles toolbar, you can select screen styles or
report styles, and switch between the two.
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Formatting Toolbar

Controls whether the formatting toolbar appears. The formatting toolbar can be used to change the
format of text, such as making text bold or underlined.
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Extension Views Toolbar

Controls whether the Extension Views toolbar appears. From the Extension Views toolbar, you can
switch between different saved extensions views, or invoke the Views dialog so you can modify a view
or create a new one. An extension view is a combination of grouping and filtering options. By saving
extension filter and grouping settings as that view, you can create multiple views that you can quickly
switch between. Views can also be shared between multiple users on a network. For more
information, see Working with Views.
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Filter & Sort

You can select this option from the View menu on the Job Schedule screen and activate the sub
menu which gives you the choice to filter the schedule, sort the schedule, or return to the full view of
the job schedule.
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Filter Schedule

Allows you to restrict the jobs that appear on the Job Schedule screen according to the criteria you
specify. When you select this option from the View menu's Filter & Sort submenu, the Filter Job
Schedule Information dialog appears. From the Filter Job Schedule Information dialog, you can filter
the results that appear on the job schedule screen by Job Name, Job Number, Job Category,
Estimator, Job Path, Last Bid, Pricing, Labor Hours,  Status, Bid Creation Date, and Bid Due Date.
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Full View

If you have applied a filter to the Job Schedule screen, you may return the screen to its default display
results (all jobs, all columns), by selecting Full View from the Filter & Sort submenu of the View
menu.
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Sort Schedule

Allows you to control the order in which jobs appear on the Job Schedule screen. When you select
this option from the View menu's Filter & Sort submenu, the Sort Job Schedule Information dialog
appears. From the Sort Job Schedule Information dialog, you can sort  the jobs that appear on the job
schedule screen by Job Name, Job Number, Job Category, Estimator, Job Path, Last Bid, Pricing,
Labor Hours,  Status, Bid Creation Date, and Bid Due Date. You can also choose whether individual
fields will be sorted in ascending order or descending order, and in what order the fields will make their
sorts.
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Refresh

(Schedule screen only) Reloads all the job files and refreshes the Job Schedule screen.
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View Using Report Styles

Displays screens using the current report style in place of the current screen style. (The currently
selected report style is the style that was last selected from the Report Style Setup dialog.) To
change the current report style, click the drop-down list on the Styles toolbar. The Styles toolbar can
be displayed or hidden by selecting the Styles option from the Toolbars sub-menu under the View
menu.

Displaying a report style on screen also allows you to set the column widths for the report style. The
column width that appear on screen will be used when using the report style to print reports.

For more information, see Using Report Styles.
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View Using Screen Styles

Displays screens using the current screen style in place of the current report style. (The currently
selected screen style is the style that was last selected from the Screen Style Setup dialog.) To
change the current screen style, click the drop-down list on the Styles toolbar. The Styles toolbar can
be displayed or hidden by selecting the Styles option from the Toolbars sub-menu under the View
menu. For more information, see Using Screen Styles.
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Calculator

Not available in PowerBid

You can use the calculator to perform any of the standard operations for which you would
normally use a hand-held calculator. The calculator performs basic arithmetic, such as addition,
subtraction, multiplication and establishing square roots.



Classic Estimating Help Guide  - 157

Edit Menu
The Edit menu displays various options that allow you to manipulate selected categories, items,
assemblies, or text.

To display the Edit menu, click on the Edit menu heading, or press [Alt] + [E] on the keyboard. For
more information on individual Edit menu options, click on the button beside the appropriate option
below.

  Undo

  Cut

  Copy

  Paste

  Fill

  Move Up

  Move Down

  Delete

  Empty Designation(s)

  Database Find

  Find

  Replace

  Modify

  Add Items

  Delete Items

  Insert

  Adjustment

  Check Spelling



158 - Classic Estimating Help Guide

Undo

Allows you to undo your last text editing activity while working on the Notes screen QuotePad screen.
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Cut

Places the selected category, item, assembly, or text on the Windows clipboard, available to be
pasted into a different location using the Paste option. Once the category, item, assembly, or text is
pasted, it is removed from its original location. Selecting this option is equivalent to clicking on the
Cut button within the toolbar.

Using the Cut and Paste options together makes it easy for you to move items and assemblies to a
different location in the same database. Once moved, an assembly still includes the same items as
before. Similarly, an item moved using the Cut and Paste option continues to form part of the same
assemblies as before.

Before clicking on this option, select the category, item, assembly, or text to be cut. You can select
multiple categories, items, or assemblies to be cut by holding down your left mouse button and
dragging your pointer over the items to be selected. To be selected together, the items must appear
one after another.
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Copy

Copies the selected category, item, assembly, or text, and places it on the Windows clipboard.
Once on the clipboard, the duplicate category, item, assembly, or text can be pasted into a different
location using the Paste option. Selecting this option is the same as clicking the Copy button from
the toolbar.

Using the Copy and Paste options together makes it easy for you to create a duplicate category, item
or assembly in a different location in the same database. (You can copy and paste items from one
database to another, but you cannot copy assemblies between databases.) If you want to move items
to a different location in the database, you can use the Cut and Paste options.

The Copy and Paste options are also useful when creating new assemblies within the database. If you
need to create assemblies which are similar to existing assemblies in the database, you can copy
the assemblies then substitute selected items using the Substitute Items option, available from the
Edit menu on the Database Manager module.

Before clicking this option, select the category, item, assembly, or text to copy. To select multiple
categories, items, or assemblies to copy. hold down your left mouse button and dragging your pointer
over the items to select them. To select them together, the items must appear one after another.

 Caution: Do not move items within the database by copying, pasting, then deleting the original
item, as this may produce re-sync errors when you re-extend a job, and prevent assemblies from
linking to the appropriate items. Instead, move items within the database by cutting and pasting them.
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Paste

Inserts into a new location the category, item, assembly, or text that was previously cut or
copied. Selecting this option is equivalent to clicking on the Paste button within the toolbar.

The Paste option can be used with the Cut option to move items and assemblies to a different
location in the same database. Used with the Copy option, the Paste option lets you create a
duplicate category, item or assembly in a different location in the same database. You can also copy
and paste items (but not assemblies) between two different databases.

The Copy and Paste options are also useful when creating new assemblies within the database. If you
need to create assemblies which are similar to existing assemblies in the database, you can copy
the assemblies then substitute, add, or delete items. For more information, see Adding/Modifying
Assemblies.

Before selecting the Paste option, you must indicate the location where you wish to insert the
category, item, assembly, or text. For text, you simply click where you wish the text to appear then
select the Paste option. For categories, items, and assemblies, you must click on a blank row within
the left side of the screen before pasting. If you are pasting multiple categories, items, or assemblies,
there must be enough empty rows to accommodate the new items.
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Fill

Allows you to update a range of cells with a common value.

Before selecting this option, follow these steps:

1. Click on the first cell you want to change and drag the mouse up or down over the other cells you
want set to the same value. You can select any number of cells within the same column.

2. Type the value you want to appear in all highlighted cells.

3. Press the [Enter] key. The first cell has been updated. To apply the same change to all the selected
cells, select the Fill option. All cells within the highlighted column will be replaced by the value you
assigned to the first cell.
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Move Up

Move the selected designation, temporary item, or temporary assembly up one line within the list.
This option is only available from the Takeoff screen.
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Move Down

Move the selected designation, temporary item, or temporary assembly up one line within the list.
This option is only available from the Takeoff screen.
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Delete

Removes the selected job, item, assembly, category, takeoff, takeoff components, or text. The
information is not copied to the Windows clipboard. When you delete an item from the database, the
item is automatically removed from all applicable assemblies.

Selecting the Delete menu option is equivalent to clicking on the Delete button within the toolbar, or
pressing the [Delete] key on your keyboard. Before you select this option, you must click on or
otherwise select the item, assembly, category, takeoff, takeoff component, or text you wish to delete.
When you delete an item or assembly, you will be asked whether you are sure you wish to delete the
item or assembly.

When you delete a takeoff entry from the audit trail list, the takeoff remains in the list but appears
crossed out.

Deleted takeoff

You can restore the deleted takeoff by clicking on the Delete option or button again. You can
restore the deleted takeoff in this way at any point in the future, even after you have closed the
program and shut down your computer.

You can control whether deleted takeoffs are displayed within the audit trail by selecting or
deselecting the Show Deleted Takeoffs check box.
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Insert

New Row

Inserts an editable blank row above the currently selected row on the Direct Labor, Indirect labor,
Labor Factoring, Labor Escalation, Indirect Labor, Subcontractor, General Expenses, Equipment, and
Quoted Materials screens.

Cut/Copied Cells

Inserts the contents of a previously cut or copied row from the clipboard to a new row directly above
the currently selected row on the Direct Labor, Indirect labor, Labor Factoring, Labor Escalation,
Indirect Labor, Subcontractor, General Expenses, Equipment, and Quoted Materials screens.
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Empty Designation(s)

Removes the components from the current selected designation. This option is only available from the
Takeoff screen.
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Find

Allows you to search for a particular text string within the current grid. When you select this option,
the Find dialog appears. From the Find dialog, you can specify the text to be located, and control the
scope of the search and whether the search takes case into consideration. You can leave the dialog
open while you continue to work on your job.
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Database Find

Allows you to locate an item or assembly within the current database. You can select this option from
the Edit menu on the Takeoff screen. When you select this option, the Find Database Item/Assembly
Dialog appears. From this dialog, you can specify the search criteria and initiate the search. You can
search for partial or exact matches, and control whether spaces and upper or lower case is taken into
consideration.
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Replace

Allows you to find and replace text on the followings screens: Extension, all labor screens,
Subcontractors, General Expenses, Quoted Materials, and Bid Breakdown. When you select this
option, the Find & Replace dialog appears.

From the Find & Replace dialog, you can specify the text to be located and the replacement text, and
control the scope of the search and whether the search takes case into consideration. You can leave
the dialog open while you continue to work on your job.

For numeric fields, the search string must match the contents of the entire cell in order for the
replacement to take place. For alphanumeric fields, partial matches are permitted (unless the Match
Whole Word option is enabled).
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Modify

Allows you to modify the selected item, assembly, category, takeoff, or takeoff component.
Selecting this option is equivalent to clicking on the Modify button within the toolbar.

Before choosing this option, you have to click on or otherwise select the item, assembly, category,
takeoff, takeoff description, or takeoff component you wish to modify. When you select this option, the
appropriate dialog or entry fields appear.
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Add Items

Allows you to add items to a range of assemblies in the database. Before choosing this option, you
should select the range of assemblies you wish to modify within the Takeoff screen. To select the
range of assemblies, navigate through the database until the appropriate assemblies (or categories of
assemblies) are displayed, then hold down your left mouse button and drag your pointer over the
assemblies you wish to modify.

After selecting the range of assemblies to be modified, you can select the Add Items option from the
Edit menu. The Add Items to Assemblies dialog displays, displaying the item database along the left
side of the dialog, and a list of items to be added along the right side.

On the left side of the Add Items to Assemblies dialog, navigate through the database hierarchy until
you reach the item you wish to add to the selected assemblies. Double click on the item to be added,
so that it appears on the item list along the right side of the dialog. Repeat this step for each item you
wish to add to the selected assemblies.

Once all the items you wish to add are listed on the right side of the Add Items to Assemblies dialog,
check that the Base, Factor 1, and Factor 2 values are correct, then click on OK. You will be
prompted to confirm your intention to add the items to the selected assemblies. Click on OK to
confirm.
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Delete Items

Allows you to remove items from a range of assemblies in the database. Before choosing this option,
you should select the range of assemblies you wish to modify within the Takeoff screen. To select the
range of assemblies, navigate through the database until the appropriate assemblies (or categories of
assemblies) are displayed, then hold down your left mouse button and drag your pointer over the
assemblies you wish to modify.

After selecting the range of assemblies to be modified, you can select the Delete Items option from
the Edit menu. The Delete Items from Assemblies dialog displays, displaying the item database along
the left side of the dialog, and a list of items to be removed along the right side.

On the left side of the Delete Items from Assemblies dialog, navigate through the database hierarchy
until you reach the item you wish to remove from the selected assemblies. Double click on the item to
be removed, so that it appears on the item list along the right side of the dialog. Repeat this step for
each item you wish to delete from the selected assemblies.

For each item to be removed, you can control whether all occurrences of the item are removed, or
only those based on length, count, or absolute value. To do so, click on the Base cell and select All,
Len, Cnt, or Abs from the drop-down list.

Once all the items you wish to delete are listed on the right side of the Delete Items from Assemblies
dialog, click on OK. You will be prompted to confirm your intention to delete the items to the selected
assemblies. Click on OK to confirm.
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Insert

Allows you to create a new designation, temporary item, or temporary assembly and insert it above
the currently selected designation, temporary item, or temporary assembly. This option is only
available from the Takeoff screen.
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Adjustment

Allows you to specify a percentage adjustment to be applied to the currently selected cell. This option
is only available from the Final Pricing screen. When you select this option, an Adjustment dialog
appears. From this dialog, you can enter a percentage figure (without the percent sign), then click OK
to apply it to the currently selected cell.
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User Defined Adjustments

Ranges

Allows you to specify different percentages to be applied to the user-defined adjustments as the value
of the job increases. This option is only available from the Final Pricing screen. When you select this
option, the User Defined Adjustment Ranges Calculated (%) dialog appears. From this dialog, you
can specify different adjustment percentages for different dollar ranges.

Descriptions

Allows you to modify the descriptions for the three user-defined adjustments and the global taxes
appearing on the Final Pricing screen. When you select this option, the Adjustment Descriptions
dialog appears. From this dialog, you can overwrite the existing descriptions.
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Check Spelling

Allows you to check the spelling of text that has been entered into your job. You can select this
option from the Edit menu on the Notepad screen, or from the Quote Pad screen. When you select
this option, you must select either All Text , or Selected Text, to activate the Spelling Checker.



178 - Classic Estimating Help Guide

Labor Calculations

Pro, BidWinner Plus only

Allows you to control whether labor overhead and markup costs are calculated as a percentage
marked up from the total cost, or as dollars per hour. This option is only available from the Final
Pricing screen with either the Labor Markup or Labor Overhead cell selected.

When you select this option, the Labor Calculations dialog appears.
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Help Menu
The Help menu allows you to invoke the program’s online help, get instructions on using help, or view
information about the version of the product you are using.

Click the Help menu to open the various options available.

For more information, click the appropriate link below.

  Help

  What's This?

  Visit Trimble MEP

  Contact Support

  Online Support

  About
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Help

Starts the program’s online help. From the Help window that appears you can navigate through the
help Contents, click the Index tab to view an alphabetical list of index keywords, or click the Search
tab and search for a particular word.

You can also press [F1] to access the online help.
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What's This?

Changes your pointer to a help pointer that you can use to click on program components to display
the corresponding help topic.
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Product Support

Select Product Support from the Help menu to automatically generate an e-mail to Trimble's
knowledgeable product support staff.
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About

Displays a window showing the version number of your Trimble® Accubid Classic Estimating product
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Toolbars
Toolbars provide a quick way to access frequently used program functions. Estimating products use
the following toolbars:

Standard toolbar

Bid Summary toolbar

Styles toolbar

Formatting toolbar

Extension Views toolbar

When you position your pointer over a toolbar button, a brief description of the button appears on
screen.

You can enable or disable certain toolbars by selecting the appropriate option from the Toolbars
submenu under the View menu.

Docked vs. Floating Toolbars

Normally, toolbars appear docked below the menu bar. However, you can undock any toolbar so that
it appears in a separate window as a floating toolbar. To undock a toolbar, position your pointer
between or beside an button on the toolbar, then drag and drop the toolbar onto the program screen.

When enabled, the Style toolbar initially appear undocked as floating toolbars. To dock a floating
toolbar so that it appears below the menu bar, simply drag on the window’s title bar and drop it below
the menu bar.
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Standard Toolbar

The standard toolbar provides quick access to common program functions. If you position your mouse
pointer over a toolbar button and wait a second or two, the function represented by the button will be
displayed in a tool tip. If a toolbar button appears “grayed” out, that option is not currently appropriate
or available.

When you position your pointer over a toolbar button, a brief description of the button appears on
screen.

Docked vs. Floating Toolbars

Normally, the standard toolbar appears docked below the menu bar. You can, however, undock the
toolbar so that it appears in a separate window as a floating toolbar. To undock a toolbar, position
your pointer between or beside an button on the toolbar, then drag and drop the toolbar onto the
program screen.

To dock a floating toolbar, simply drag the window's title bar and drop it back onto the area below the
menu bar.
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Bid Summary Toolbar

Pro, BidWinner Plus only

The Bid Summary toolbar provides options to allow you to select from or modify the list of available bid
summaries. You can control whether the Bid Summary toolbar is being displayed by selecting the Bid
Summary Toolbar option from the View menu. For more information on alternate bid summaries, see 
Using Alternate Bid Summaries.
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Styles Toolbar

Using the Styles toolbar, you can select and modify screen styles or report styles, and switch
between using screen styles or report styles to control the display of information on-screen.

Screen styles allow you to control the columns that appear on job screens and the Job Schedule
screen, as well as the fonts used to display information on these screens. You can create multiple
screen styles, each with a different combination of columns, column widths, and fonts, and easily
switch back and forth between different screen styles.

Report styles are normally used to control which columns are included in a particular job report. Using
the Styles toolbar, you can apply the current report style in place of the screen style to determine
which columns are displayed on job screens.

To display the Styles toolbar, click the View menu, then click Toolbars and select Styles. With the
Styles toolbar displayed, you can switch between whether the toolbar is displaying screen styles or
report styles by clicking on the second button on the toolbar. To access the Styles Setup dialog for
either screen styles or report styles, click the first button.

To select the appropriate screen or report style, click on the drop down list and choose a style. By
default, the last style you selected from this toolbar or from the Styles Setup dialog is automatically
selected and applied.

To close the screen styles toolbar, click the View menu, then click Toolbars and select Styles.

Normally, the Screen Styles toolbar appears as a floating toolbar. You can, however, dock the Screen
Styles toolbar beside the standard toolbar below the menu bar. To dock the toolbar, simply drag the
window's title bar and drop it back onto the area below the menu bar.
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Formatting Toolbar

The buttons on the Formatting Toolbar change the format of text, such as making text bold or
underlined. To format text, select it, and then click the appropriate button on the format bar. You can
also drag the format bar to any location in the window.

Docked vs. Floating Toolbars

Normally, a toolbar appears docked below the menu bar. You can, however, undock the toolbar so
that it appears in a separate window as a floating toolbar. To undock a toolbar, position your pointer
between or beside an button on the toolbar, then drag and drop the toolbar onto the program screen.
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Extension Views Toolbar

From the Extension Views toolbar, you can switch between different saved extensions views, or
invoke the Views dialog so you can modify a view or create a new one. An extension view is a
combination of grouping and filtering options. By saving extension filter and grouping settings as that
view, you can create multiple views that you can quickly switch between. Views can also be shared
between multiple users on a network. For more information, see Working with Views.

To display the Extensions Views toolbar, select the Extensions Views option under Toolbars in the
View menu.

To switch to a different extension view, select the appropriate view name from the drop-down list.
To create a new view or modify an existing one, click the Edit Extension Views button within the
toolbar.

To close the Extension Views toolbar, click the View menu and select Extensions Views option
under Toolbars. This will close the toolbar, but the extension view will continue to be in effect.

The view will be in effect until you select a different view, or override the view by applying a quick view
(a view that is not saved). To apply a quick view, you select either the Group or Filter option from the
Extension menu, or click on the corresponding toolbar button. From the Quick View dialog, you can
choose temporary grouping and/or filter settings.
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Screen Styles
Using screen styles, you can control the content and fonts of job screens, and the Job Schedule
screen. You can control the columns that appear, the width of the columns, and the fonts to use to
display the information. (Job screens include any screens except the Schedule screen) You can
create multiple screen styles, each with a different combination of columns, column widths, and fonts,
and easily switch back and forth between different screen styles.

Though screen styles are primarily used to control the on-screen appearance of your estimating
program, they can, in some cases, be used to determine the appearance and content of reports such
as database reports and job summaries. To control the appearance of other printed reports, you use 
report styles.

Trimble estimating programs maintain separate sets of screen styles for the following:

Job screens

Job Schedule screen

The screen styles you create while displaying a job screen will be available on any other job screen,
but will not be available on the Job Schedule screen. Once created, a screen style can be accessed
and updated from any job. Any changes made to a screen style from one job will apply to any jobs
that use that style.

When you save a job, any changes you have made to the current screen style are saved as well.
Each time you run your estimating program, the program will automatically open the screen style in
use the last time you displayed the Job Schedule screen. Each time you open a job, the job
automatically loads the last screen style used with this job. When you create a new job, the current
screen style serves as the default screen style for the new job.

 Tip - If a screen style is shared by multiple jobs, any changes made to the style sheet from one
job does affect the style sheet of the other jobs that use it.

If you're on a network, you can share screen styles between multiple users. To do so, specify a
shared location for the screen style files on the File Locations page of the Options dialog.

For more information on using screen styles, see one of the following topics:

Manage Screen Styles
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Manage Screen Styles

Using screen styles, you can control the appearance and content of job screens, the Job Schedule
screen, and the Database Manager module. If you do not create a screen style, the default screen
style is used. The default screen style includes all possible columns

Create Screen Style

To create and define screen styles, you use the Screen Style Setup dialog. The Screen Style
Setup dialog is accessed in different ways depending on whether you are creating screen styles for
job screens, the Job Schedule screen, or the Database Manager module.

1. Switch to the screen whose appearance you wish to control. For example, switch to a job screen
such as the Takeoff screen or the Extension screen if you wish to create a screen style that
determines the appearance of job screens.

2. Display the Screen Style Setup dialog. 

3. Do one of the following: 

To access the Screen Style Setup dialog, you can click on the Edit Screen Styles button
within the Screen Styles toolbar,

From a job screen, click the Settings menu, and select Screen Styles. 
From the Job Schedule screen,  click the Settings menu, and select Screen Styles.
From the Database Manager screen,  click the Settings menu, and select Screen Styles.

4. Click the Add button and the Add Style dialog displays.

5. Enter the name of the new style in the first field.

6. Click the second field, and select the style to use as the basis for the new style. You can model
the new style after an existing style or the default style (which includes all columns).

7. Click OK. The new style you created now appears as the currently selected style in the Screen
Style Setup dialog.

From the Screen Style Setup dialog, you can change the column setup or screen fonts. To change
column widths on any job screen, click OK to exit the Screen Style dialog, then jump to the
appropriate screen and adjust the appropriate column(s).

Tip - To reset column widths to their default state, click the Reset Widths button. You are then
asked whether you wish to reset column widths for all screens, or just for the screen currently
selected on the Column Setup page within the Screen Style Setup dialog.

Switch to a Different Style
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The default screen includes all columns on all screens. If you have already created one or more of
your own screen styles, you can easily switch to a different screen style.

1. Click on the View menu and select the View Using Screen Styles option, or click on the View
Using Screen Styles button in the Styles toolbar.

2. Click  to select a different screen style from the list.

Include/Exclude Columns

From the Screen Style Setup dialog, you can control which columns appear on job screens, the
Job Schedule screen, or the Database Manager module.

1. Display the Screen Style Setup dialog for job screens, the Job Schedule screen, or the
Database Manager module.

2. Click the Column Setup tab if it is not already selected.

3. Select the appropriate screen style from the Style Name list box. The left side of the Column
Setup tab displays the columns currently excluded from the screen style, while the right side
displays the columns currently included in the style. At first, the lists appear collapsed so that
only screen names are displayed. To view the columns included or excluded for each screen,
click the plus sign to the left of the screen name. A column list should appear as a branch
beneath the screen name.

4. To exclude a column/screen, click the column from the right side of the dialog, then click the
Remove button. Click a column/screen from the left side of the dialog to include it, then click the
Add button. To exclude all columns/screens, click the Remove All button. To include all
columns/screens, click the Add All button.

To include or exclude a column/screen, double click it from the appropriate side of the dialog.
For example, if a column/screen appears on the right side of the dialog (and is therefore
included in the current screen style), double clicking the column would move it to the left side
of the dialog (thereby excluding it from the screen style).

To change the order in which columns appear on each screen, you can drag and drop the
column to a new location under the same screen name on the right side of the Screen Style
Setup dialog. Alternatively, you can click a column name, then click the Move Up or Move
Down button to reposition the column.

To prevent future changes to column location, select the column and click the Freeze Cols
button. To alter a previously frozen column, select the column and click the Unfreeze button.
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5. Click OK.

Freeze/Unfreeze Columns

As part of a screen style, you can control the number of columns along the left side of the screen
that remain stationary when you scroll within the screen to view hidden columns.

Freeze Columns

1. Display the Screen Style Setup dialog for job screens, the Job Schedule screen, or the
Database Manager module.

2. Click the Column Setup tab if it is not already selected.

3. Click the last of the columns that you wish to remain stationary. For example, if you want the
first 3 columns to remain stationary, then click the 3rd column.

4. Click the Freeze Cols button. The currently selected column, along with any columns preceding
that column on the same screen, are now frozen, and will not move when you scroll within the
screen.

Unfreeze Columns

1. Display the Screen Style Setup dialog for job screens, the Job Schedule screen, or the
Database Manager module.

2. Click the Column Setup tab if it is not already selected.

3. Click the first of the columns that you wish to unfreeze. For example, if the first 5 columns are
frozen and you want to unfreeze columns 3 to 5, then click column 3.

4. Click the Unfreeze button. The currently selected column, along with any columns following that
column on the same screen, becomes unfrozen.

Screen Fonts

From the Fonts tab on the Screen Style Setup dialog, you can choose the font to be used on
screen for the currently selected screen style.

1. Click the Fonts tab.

2. Select the appropriate screen style from the Style Name list box.

3. Select the appropriate font, point size, and style. Depending on the typeface, style options may
include Normal, Bold, Italic, and Bold Italic.
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Screen Style Setup Dialog

The Screen Style Setup dialog allows you to define screen styles for job, schedule, and Database
Manager screens. You can control the columns displaying on each job screen, the width of each
column, and the fonts used to display information on each job screen. (Job screens include any
screens except the Schedule, Database Manager, and Price Update screens.) For more information
on screen styles, see Using Screen Styles.

Though screen styles are primarily used to control the on-screen appearance of your estimating
program, they can, in some cases, to be used to determine the appearance and content of reports
such as database reports and job summaries. From the Page Setup tab, you can set various printing
parameters, including headers and footers, page margins, and page orientation.

The following components appear on the Screen Style Setup dialog:

Style Name
Lists the available screen styles, and displays the currently selected screen style.

Add
Click on this button to create a new screen style. From the Add Style dialog that appears, enter
the name you wish to use to identify the new screen style, then select the style to be used as the
basis for the new style. You can model the new style after an existing style or the default style
(which includes all columns).

Delete
Click this button to remove the current screen style. You will be prompted to confirm your desire
to delete the style.

Rename
Click this button to rename the current screen style. You cannot, however, rename the default
screen style. From the Edit Style Name dialog that appears, enter the new name, then click on
OK.

Column Setup
From the Column Setup tab, you can control which columns appear on each screen for the
current screen style. The left side of the Column Setup tab displays the columns currently
excluded from the screen style, while the right side displays the columns currently included in the
style. At first, the lists appear collapsed so that only screen names are displayed. To view the
columns included or excluded for each screen, click on the plus sign to the left of the screen
name. A column list should appear as a branch beneath the screen name.

To exclude a column, click the column from the right side of the dialog, then click the Remove
button. To include a column, click it from the left side of the dialog, then click the Add button.
To exclude all columns, click the Remove All button. To include all columns, click the Add All
button.

You can also double click to include or exclude a column. For example, if a column appears on
the right side of the dialog (and is therefore included in the current screen style), double click
the column to move it to the left side of the dialog (thereby excluding it from the screen style).

Fonts
From the Fonts tab on the Screen Style Setup dialog, you can choose the font to be used on job
screens, the Job Schedule screen, or the Database Manager module. You can select the
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typeface, point size, and type style. Depending on the typeface you select, type style options
may include Normal, Bold, Italic, and Bold Italic.

Page Setup (Schedule Style and Database Manager Style Setup only)
If you do not wish to use the default settings for printed reports, the Page Setup tab allows you to
customize the appearance of your printed reports. From this tab you can set various printing
parameters, including headers and footers, page margins, and page orientation. Once you have
set up your page, your printed report should reflect the customized settings you made on this
page. The following options are available:

Option Description

Margins Determines the left, right, top, and bottom
margins of your page (measured in inches).
These values default to the smallest margins
allowed by the currently selected printer.

Header / Footer Determines the information printed at the top
and bottom of each page. You can choose to
have the date, time, page #, and/or a solid
dividing line printed in the header or footer
area. To enable any of these print options,
click the appropriate check box so that a
checkmark or an X appears, if one is not
already there. You can also specify text to
print in the header and footer areas. If you
want job information (such as the database
name) to print, you can include one or more 
field codes, each enclosed within angle
brackets. The valid field codes depend on the
type of report you are printing. Orientation
Controls how to print the page; portrait or
landscape.

Add
Click this button to add the currently selected screen or column to the screen style.

Add All
Click this button to add all screens to the screen style.

Remove
Click this button to remove the currently selected screen or column from the screen style.

Remove All
Click this button to remove all screens from the screen style.

Move Up
Click this button to move the currently selected screen or column name up one position in the
hierarchy.

Move Down
Click this button to move the currently selected screen or column name down one position in the
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hierarchy.

Freeze Cols
You can use this button to stop columns from moving when you use the scroll bar to scroll within
a screen. If you click this button, the currently selected column, along with any columns
preceding that column (on the same screen), remain stationary when you scroll.

Unfreeze
You can use this button to unfreeze columns so that they move when you use the scroll bar to
scroll within a screen. If you click this button, then the currently selected column, along with any
columns following that column on the same screen, remain unfrozen.

Reset Widths
Reset column widths to their default state. When you click this button, you are asked whether
you wish to reset column widths for all screens, or just for the screen currently selected on the
Column Setup tab within the Screen Style Setup dialog.

Reset Order
Resets the order of columns within each screen to their default state.
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C H A P T E R 4
Jobs

Within your Trimble estimating program, each job represents a separate estimate. For more
information on working with jobs, click the button beside one of the following topics:

  Setting Job Folders

  Creating a New Job

  Creating a Sub Job

  Copying an Existing Job

  Using Job Templates

  Opening a Job

  Closing a Job

  Saving a Job

  Exporting Job Information

  Renaming a Job

  Deleting Jobs

  Backing Up Jobs

  Restoring a Job

  Merge Takeoffs from Jobs

  Job Defaults

   Printing Job Reports
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Set Defaults
You can set job defaults to determine the initial values that are automatically assigned to all new jobs,
and specify the directories in which jobs can be stored. For more information on setting defaults, click
on the button beside one of the following topics:

  Setting Job Defaults

  Setting Job Folders

  Setting Database Directories
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Job Defaults

By setting job defaults, you can determine the initial values that are automatically assigned to all new
jobs. You can set specific overheads, taxes, labor allocations, etc. You can override any default value
during a takeoff for a particular job. The defaults are simply intended to save you time by providing
initial values when you begin a new job. You can edit the existing default job or create the new default
job from an existing job.

Edit Default Job

1. Click the Settings menu, select Defaults, then click the Edit Default Job option. The Job Info screen
for the default job appears. The job file name is Default.es9.

 Tip - The default job shipped as part of your Trimble estimating program uses the following
database, depending on the country you selected at installation time.

 USA Canada

Electrical ELEC USA NECA IMP ELEC CDN NECA IMP

Mechanical MECH USA MECH CDN

VDV VDV USA VDV CDN

If the appropriate database is not on your system when you go to edit the default job, you will be
prompted to select a different database.

2. Modify values appearing on any of the available program screens. The values appearing on these
screens displays as initial values for any new jobs you create, regardless of the database you
choose for the job. The default values can include labor rates, takeoff breakdowns, expenses, etc.

Tip - If you want to prevent the default job from being modified, you can use Windows Explorer
to set the file properties of the default job (Default.es9) to read-only.

Use an Existing Job as the Default Job

To create the default job using an existing job:

1. Open the job you wish to use as your default job.

2. Click the Settings menu, select Defaults, then click the Set as Default option. All the information
associated with this job (except takeoffs) now appear as the initial values for any new jobs you
create.

Delete Default Job

Click the Settings menu, select Defaults, then click the Delete Default Job option. You are asked to
confirm your intention to delete the default job.
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Job Directories

You can store jobs in one or more folders, anywhere on your hard drive, or network; however, only
those jobs stored in locations designated as job folders are listed on the job path lists throughout the
estimating application. Similarly, only jobs stored in locations designated as job folders display on the
Schedule screen.

1. Click Settings / Job Folders to open the dialog.

2. Depending on what you want to do, proceed as follows:

Add Job Folder Location

Select the checkbox  next to the appropriate folder. You can also click Select All.

Remove Job Folder Location 

Clear the checkbox  next to the appropriate folder.

 Tip - The folder continues to display in the list, but is no longer designated as a job folder.

Add Folder to the List

1. Click Add. The Directory Name dialog displays.

2. Enter the full path to the desired folder.
OR
Click Browse and navigate to the location of the folder you want to add. Click OK.

Remove Directory from the List

1. Click the folder you wish to remove. It will be highlighted. 

Tip - To select more than one directory, hold down the [Ctrl] key on your keyboard and click
each folder you want to remove. You can also click Select All.

2. Click Remove.
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Database Directories

You can store material databases in one or more folders, anywhere on your hard drive, or network;
however, only those databases stored in folders designated as database folders are listed on dialogs
throughout the estimating software application.

1. Click Settings / Database Folders to open the dialog.

2. Depending on what you want to do, proceed as follows:

Add Database Folder Location

Select the checkbox  next to the folders you want to use in your project. You can also click
Select All if you want all of the database folders available in your project.

Remove Database Folder Location

Clear the checkbox  next to the folders you do not want to use in your project.

Add Directory to the List

1. Click Add. The Directory Name dialog displays.

2. Enter the full path of the folder containing the database
OR
Click Browse and navigate to the location of your database.

Tip - If you are on a network and you want to store databases in a directory on another
computer, you can specify the computer name along with the folder name; for example, \\BIDS
\Estimating\Databases, Note: The folder must be shared!

Default Folder

You can move folders up or down within the Database Folders dialog by clicking the database and
then clicking the Move Up or Move Down buttons. Depending on the order the folders displays in the
list determines how items in the database display in your estimating software.

Remove Directory from the List:

1. Click the folder you wish to remove. The folder will be highlighted.

Tip - To select more than one folder, press the [Ctrl] key on your keyboard and click each folder
you want to remove.
OR
Click Select All.

2. Click Remove.
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Specify File Locations

From the Options dialog, you can control where automatic recovery files, style files, and extension
view files are stored. Storing the style files or extension view files on a network drive will allow multiple
users to share the same settings.

To specify where recovery files, style files, and extension view files are to be stored, follow
these steps:

1. Display the Options dialog by clicking the Settings menu and selecting Options.

2. Click on the File Locations tab.

3. From the File Location page, click the appropriate check box (for example,  Acquire Extension
Views at Startup) so that a check mark appears.

4. Click Browse and select the location of the directory or folder where the file is to be stored.

5. Click to OK to accept the changes and exit the Options dialog

The next time you run the program, the file(s) will be loaded from the location(s) you have specified.
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Manage Jobs
Before you create a new job, you must have a material database installed on your system. If you
already have a Trimble program installed on your computer, you can use the existing database(s).
Otherwise, for information on installing a materials database, see the Estimating Products Getting
Started Guide.

Create New Job

double click the empty row at the bottom of the Schedule screen’s job list.

click the Job menu and select the New option.

By default, regardless of the method you use, you are asked whether you wish to create a new
database for this job. In earlier versions of Pro, individual material databases were created for each
job. In this version, you have the choice of creating a new database or using one of the current
installed databases. In either case, the database is stored separately from the job, and can be
assigned to any number of different jobs.

 Tip - If you do not want to be asked this question each time you create a new job, click the "Do
not ask me again" check box. The next time you create a job, the program will automatically bypass
the prompt and assume you wish to use an existing database. You can also enable or disable the
prompt from the Options dialog. To do this, select or clear the Prompt to Create Database When
Creating New Job option from the General page of the Options dialog.

If you click Yes to create a new database, the Select Database dialog appears prompting you to
select an existing database to be used as the basis for the new database. After you select a
database and click OK, the Copy Database dialog appears. 

From this dialog, you must enter a description (up to 31 characters long) for the new database in
the Description field, and an identifier for the database. If you wish to place the new database in a
directory other than the default directory, then click the Drive and Directory list and select a different
directory. To create the new database, click the Copy button. After the new database is created,
the New Job dialog appears.

If you click No, (choosing to use an existing database), the New Job dialog appears.

From the New Job dialog, you must specify the job name, job number, material database, and job
path. After you enter this information and click OK, the Job Information screen for the new job
appears.

You can also copy an existing job or job template to create a new job.
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Job Templates

If you find yourself entering the same information each time you create a job for a particular kind of
project (e.g. new breakdown options), you can create a job template for that project type. Job
templates are job outlines that form the basis for new jobs. They save you time and they ensure
consistency among multiple estimators working on a single project. Instead of entering the same
information for each generic job every time you create a new job, you simply enter the information
once, save it and each time you create a job using the job template, the information automatically
appears in the new job. You then save the job template as a job under a different name and begin
adding takeoffs and other information to complete the job.

Although similar to the default job in that they form the basis for each new job created, you can create
many different job templates customizing each one for a particular type of project or client, whereas
you can only have one default job.

To create a job template:

1. Open an existing job or create a new one.

2. Customize the job with information specific to your company or to a particular project type.

3. Click the Job menu and select the Save As option. Save the job without takeoffs under a different
name, with the word “template” in it. For example, you might save a template under the name
"IndustrialTemplate.es9”.

To create a new job from a job template: 

1. Open the job template.

2. Click the Job menu and select the Save As option to save the job template as a job under a
different name. For example, if you opened the “IndustrialTemplate.es9” file, you might choose to
save it as a new job under the name “ConcordMetalWorks.es9”.

3. Begin adding takeoffs and other information to complete the job.
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Create Sub Job

Topic Under Construction 
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Copy Existing Job

This is another method you can use to create a new job. After copying an existing job, you can then
modify it without affecting the original job.

To copy an existing job:

1. Open the job you wish to copy.

2. Click the Job menu and select the Save As option. The Save As dialog appears.

3. Indicate the name and location of the new job file. The file name should include an .es9 extension.

4. Click OK to save the new job and to exit the dialog.
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Open Jobs

To open an existing job, use one of the following methods:

click the Job menu and select the Open option, or

double click on the row number to the left of the job name on the Schedule screen’s job list, or

click on the job on the Schedule screen’s job list, then press [Enter].

When you select the Open menu option, the Open Job dialog appears. From this dialog, select the
existing job you wish to open and click the Open button.

If you open a job that includes an item that was deleted or renamed, a re-sync error occurs. The
program does suggest an existing item to use in its place, and prompts you for confirmation. If you
choose to replace the missing item, any takeoffs based on that item are linked to the new item. The
takeoff descriptions are not however, modified.

If you experience a power failure or a system crash before you can properly close a job, you will be
prompted to recover the job file the next time you open the job. The job file, along with any backup
copies, are renamed and added to the Job Schedule screen. From there, you can review the different
versions of the job and decide which one to recover and which to delete. To control the automatic
recovery feature, select Options from the Settings menu, then click on the File Location tab. From
the File Locations page, you can disable the automatic recovery feature, control how often the
recovery file is created, and change the location where the recovery file is saved.

You can have multiple jobs open at the same time, allowing you to copy and paste information
between them.

After you open a job the Takeoff screen for the selected job appears. When you open a job, the job file
becomes locked so that other users on a network cannot open the same job and overwrite your
modifications.
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Close Jobs

To close a job without exiting the program, use one of the following methods:

click the Job menu and select the Close option, or

double click the job control button in the upper left corner of the job window

single click the job control button in the upper left corner of the job window, then click the Close
option, or

click the X button in the upper right corner of the job window

If you made changes to the job but did not save them, you are prompted whether you wish to save
your changes before closing the job.
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Save Jobs

You should save your job regularly to avoid any loss of work. You can also save your job under a
different file name or in a different directory to create a copy you can then modify. To create a job
template, you can save an existing job without the takeoffs under a different file name. If you attempt
to close a job or exit the program without first saving your changes, you are prompted to save your
changes before closing the job.

 Tip - By default, Trimble estimating programs save a recovery copy of your job every 10 minutes. If
you experience a power failure or a system crash before you’ve saved your latest changes, you are
prompted to recover the job file the next time you open the job. The job file, along with any backup
copies, are renamed and added to the Job Schedule screen. From there, you can review the different
versions of the job and decide which one to recover and which to delete. To control the automatic
recovery feature, select Options from the Settings menu, then click on the File Location tab. From
the File Locations page, you can disable the automatic recovery feature, control how often the
recovery file is created, and change the location where the recovery file is saved.

Trimble estimating programs can also automatically create a backup copy of a job each time it is
saved. The backup copy is stored in the same folder as the job file but with an extension of .backup. If
you want to revert to the previously saved version of a job, you can rename the .backup file extension
to .es9 and the job displays on the Schedule screen. To turn the autobackup option on, go to the File
Locations page on the Options dialog.

To save a current job: 

click the Job menu and select the Save option, or

click the Save Job button from the toolbar.

 Tip - The Save option and the Save Job button are not available if there are no changes to save.

To save a job to a different job number /different directory:

 Tip - This procedure does not update  the current job file:

1. Click the Job menu and select the Save As option (not the Save option). The Save As dialog
appears.

2. Indicate the name and location of the job file where you wish to save the current job. The file name
should include a .es9 extension.

3. Click OK to save the job and to exit the dialog. If you specified an existing file name, you are asked
whether to overwrite the existing file.

To create a job template from an existing job:

 Tip - The existing job does not have any takeoffs.

1. Click the Job menu and select the Save As option. The Save As dialog appears.

2. Select the appropriate check box(es) to indicate which portions of the job you wish to retain when
you save.



210 - Classic Estimating Help Guide

 Tip - If you are saving as a template, you should make sure that the Include Takeoffs checkbox is
not selected.

3. Indicate the name and location of the job file where you wish to save the current job. The file name
should include an .es9 extension.

4. Click OK to save the job and to exit the dialog. If you specified an existing file name, you are asked
whether to overwrite the existing file.
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Export Job Information

Trimble estimating products allow you to quickly export detailed information about a particular job as a
.CSV file or .MPX file for use in other applications, such as Lotus, MS Project or Primavera, or directly
to an Excel spreadsheet.

You can also copy cells from individual Trimble product screens to the Windows clipboard, then
paste them into Excel or other spreadsheet applications.

To export job summary information, select the Export option from the Schedule screen. From the
Export File dialog, you can specify the name and location of the .CSV file that will contain the
exported information.

1. Open the job you wish to export.

2. Click Job / Export.

3. In the Use Style list, click  and select the appropriate style from the list. This allows you to
control which columns are included in the export file. Select a screen or report style (depending on
whether screen styles or report styles are currently active). 

Tip - You control whether screen styles or report styles are currently active (currently being
used to control the display the information on screen) by selecting the View Using Screen Styles
or View Using Report Styles option from the View menu (or clicking on the corresponding button
on the Styles toolbar).

4. In the Export File dialog, select the checkboxes  next to the job items you want to export. 

Tip - If you want to export the job information as a Microsoft Project (.MPX) file, you can only
select any combination of Extension, Direct Labor, Subcontractors, and Quoted Materials.

5. If desired, select the checkboxes   next to the following:

Export headings

Export totals

Filter blank lines

6. Depending on the format you want to export to, click one of the following buttons:

Export to .csv Comma-separated variable format. Compatible
with a variety of programs.

Export to Excel Export the extension to Microsoft® Excel® as
an Excel workbook

Export to .mpx Microsoft ® Project native file format.

6. If you select either the Export to .csv or Export to .mpx, the Export File dialog appears. Specify the
name and location of the file to be created then click Save. 
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If you select the Export to Excel option, Microsoft Excel opens and the exported information
appears as a workbook.
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Rename Job

Trimble estimating products allows you to change job names and job numbers after you have created
the job.

1. Close the current job, if this is the job you wish to rename. You are returned to the Schedule
screen.

2. Click the job name or job number of the job you wish to rename.

3. Change the job description or job number, then press the [Enter] key to accept the new description
or number.
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Delete Jobs

The Delete option and [Delete] button are only available when you select a job. Also, you can only
select and delete jobs from the Job Schedule screen. If a job is currently opened, you cannot delete
the job until you close it.

 Caution - If your job is on a network, you may want to back it up onto a diskette first. This allows
you the option of restoring the job at a later date. Once deleted, you cannot recover the job because
the job does not get moved into the Windows Recycle Bin.

To delete a single job:

1. You must close the job if it is currently open. To do this, select the Close option from the Job menu
to close it. You are returned to the Schedule screen. 
OR
Display the Schedule screen. To do this, select the Schedule option from the View or Window
menu.

2. Click the row corresponding to the number of the job you wish to delete. The row number appears
as a button to the left of the job name. When you click the row number, the entire row becomes
highlighted.

3. Click the Job menu and select the Delete option.
OR
Click the Delete button from the toolbar.
OR
Press the [Delete] key on your keyboard.

4. Click Yes to delete the job when asked to confirm your desire to delete the job.

 Caution - When you delete a job that is stored on your local machine, the job gets moved to the
Windows Recycle Bin. Once there you can restore the deleted job, if you wish. When you empty the
Recycle Bin however, the job gets permanently deleted and can no longer get restored. Before you
delete a job, you might wish to first back it up onto a diskette. This allows you to restore the job at a
later date.

To delete multiple jobs:

1. Go to the Schedule screen. To do this, select the Schedule option from the View or Window menu.

2. Hold down your left mouse button and drag the mouse pointer over the row numbers for the jobs
you wish to delete. Row numbers appear as buttons to the left of the job names. When you select
a row number, the entire row becomes highlighted.

3. Click the Job menu and select the Delete option
OR
Click the Delete button within the toolbar.
OR
Press the [Delete]  key on your keyboard.

4. Click Yes to delete the jobs when asked to confirm your request to delete the jobs.



Classic Estimating Help Guide  - 215

Back Up Jobs

By default, Trimble estimating programs save a recovery copy of your job every 10 minutes. If you
experience a power failure or a system crash before you’ve saved your latest changes, the program
will ask you the next time you open the job whether you wish to restore the job from the recovery file.
If you click on Yes, the recovery copy will be used in place of the job file. If you click on No, the last
saved version of the job file will be used, and the recovery copy will be discarded.

To control the automatic recovery feature, select Options from the Settings menu, then click on the
File Location tab. From the File Locations page, you can disable the automatic recovery feature,
control how often the recovery file is created, and change the location where the recovery file is saved.

Trimble estimating programs can also automatically create a backup copy of a job each time it is
saved. The backup copy is stored in the same folder as the job file but with an extension of .backup. If
you want to revert to the previously saved version of a job, you can rename the .backup file extension
to .es9 and the job displays on the Schedule screen. To turn the autobackup option on, go to the File
Locations page on the Options dialog.

While the automatic recovery and automatic backup features provide crash protection and ability to
revert to a previously saved version of a job, you should also regularly back up your job data onto a
diskette, CD, or a network directory to protect your jobs from inadvertent modification or accidental
deletion.

To back up a single job:

Use the Save As option and save onto separate medial (CD-RW, flash drive, and so on) or network
location.

To back up multiple jobs: 

1. From the Job Schedule Screen, click the Job menu and select the BackUp option. The Back Up
Jobs dialog now appears.

2. Click the Job Path list box at the top of the dialog and switch between the different job folders. You
can back up multiple jobs, but only one directory at a time.

3. Click the check box beside each of the jobs you wish to back up, after you select the appropriate
job folder.

4. Type the path to the media (CD-RW, flash drive, and so on) or network location you wish to back
up your jobs to.  To select a location, click on the Browse button and navigate to the desired drive
or network path.

5. In the Description field, you may type a brief text description of the job(s) you are archiving. This
description will be available to view during a later Restore function, and may prove useful to
differentiate one archive from another.

6. Click the Back Up button to back up the specified jobs.

7. When instructed, insert the backup diskette (if you haven’t already done so), then click OK.

While the backup takes place, a message box appears indicating the progress of the operation.
You can cancel the backup before it is completed if you click the Cancel button in this message
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box.

8. Remove the backup media (if applicable) and store it in a secure location once the backup is
complete.
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C H A P T E R 5
Takeoff Overview

The takeoff process consists of choosing your takeoff breakdown, selecting materials from the
database, and entering the takeoff measurements. The access the Takeoff screen  from another
product screen, click on the Takeoff tab at the bottom of the screen.

For more information on performing a takeoff, click on the button beside one of the following topics:

Takeoff Basics

  Takeoff Screen

  Takeoff Breakdown

  Takeoff Breakdown Options

  Labor Factoring

  Materials for a Takeoff

  Counting/Measuring Material

  Assemblies

  Temporary Items

  Temporary Assemblies

  Navigate Audit Trail

  Filter Audit Trail

Advanced Takeoffs

  Switch Databases

  Copy/Paste Takeoffs

  Designations

  Hot Lists

  Create Typical Takeoff

  Modify Existing Takeoff

  Delete Takeoffs

  Merge Takeoffs/Multiple Jobs
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Advanced Takeoffs
For more information on performing a takeoff, click on the button beside one of the following topics:

  Designations

  Hot Lists

  Typical Takeoff

  Merge Takeoffs
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Designations

Pro, BidWinner Plus ONLY

Using the FIXTURES, ELECTRIC HEATING, or DISTRIBUTION options (for electrical users) or the
PLUMBING FIXTURES, HEATING, or EQUIPMENT options (for mechanical users), you can create
specialized designations which you can then take off.

 Tip - Designations are not available for VDV (voice/data/video) users.

Creating a designation involves selecting any number of different items and assemblies, and then
assigning them a designation name. Once you have created the designation, you can take off all the
items in the designation in a single step. Any changes you make to the designation will be
automatically reflected in all takeoffs performed using that designation.

If you wish, you can use these same takeoff options to assemble specialized takeoffs without creating
designations.

For more information on designations, click on one of the following topics:

  Creating a Designation

  Taking Off a Designation

  Modifying a Designation

  Renaming a Designation

  Deleting a Designation
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Create Designations

Pro, BidWinner Plus ONLY

Using the FIXTURE, ELECTRIC HEATING, or DISTRIBUTION options (for electrical users) or the
PLUMBING FIXTURES, HEATING, or EQUIPMENT options (for mechanical users), you can create
specialized designations which you can then take off.

 Tip - Designations are not available for VDV (voice/data/video) users.

Creating a designation involves a step-by-step process of selecting the materials that comprise the
designation. The steps in the process vary according to the takeoff option you select. Once you have
created the designation, you can take off all the items in the designation in a single step. Any
changes you make to the designation will be automatically reflected in all takeoffs performed using
that designation.

If you wish, you can use these same takeoff options to assemble specialized takeoffs without creating
designations.

 Tip - You can also create a new designation by copying then pasting or inserting the copied
designation.

Procedure

1. Choose the appropriate takeoff option from the list box to the right of the Takeoff heading
(FIXTURES or DISTRIBUTION for electrical users, PLUMBING FIXTURES, HEATING, or
EQUIPMENT for mechanical users).

2. Double click the first blank line below the Designation heading. The Modify Designation Description
dialog displays.

3. Type a description for the designation (maximum 80 characters) in the dialog that appears,then
click OK. A list of categories now appears below the Takeoff heading.

4. Double click the appropriate category. Depending on which takeoff option you selected, either a list
of items (indicated by the letter I in the Type column) or another set of categories (indicated by the
letter C in the Type column) appears.

5. If another set of categories appeared, then double click the appropriate category to display the item
level.

6. Double click the appropriate item from the item level. The Measure Takeoff dialog appears.

If you were taking off an item or assembly, rather than creating a designation, you would use this
dialog to specify the appropriate count or length. However, when creating a designation, you cannot
specify the quantity for the initial item. Instead, just click on OK to accept the item or assembly
and continue. Later, when you take off the designation, you can specify the quantity for the entire
designation. The item or assembly now appears in the audit trail list on the right side of the screen.

7. From the list of related components (e.g. fixture lamps) that appears, double click on the
appropriate item or assembly in the list. Alternatively, you could select the COMMON
ASSEMBLIES, ITEM DATABASE, TEMPORARY ITEMS, or TEMPORARY ASSEMBLIES  takeoff
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option and select an item or assembly not found in the components list. From the Measure Takeoff
dialog that appears, specify a count, length, or other applicable measurement, then click on OK.
The item now appears in the list on the right side of the screen.

If you do not wish to add a component to the designation, then click the Next button to skip to the
next components list,

Next
OR

Click the Finish button to complete the designation Finish

8. From the next components list, double click the appropriate item or assembly, or select a different
item or assembly from the ITEM DATABASE, COMMON ASSEMBLIES, or TEMPORARY ITEMS
lists. From the Measure Takeoff dialog that appears, specify a count, length, or other applicable
measurement, then click OK. If you do not wish to add an accessory to the designation, then click
on the Finish button to skip this step and complete the designation.

9. Click the Finish button to complete the designation if you haven’t already done so. To abort the

designation, click the Abort .

The designation now appears in the designation list. You can now take off the designation as many
different times as you wish, within any takeoff breakdown.
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Take Off a Designation

Pro, BidWinner Plus only

To take off a designation:

1. Make sure the takeoff breakdown is set to the appropriate drawing, area, phase, system, location,
and labor factor. (For more information, see Selecting the Takeoff Breakdown.)

2. Double click the designation.

3. From the Designation Count dialog that appears, specify the quantity directly, or click the Send
button to read the count from a probe.

4. Click OK to complete the takeoff. The designation now appears in the current audit trail list with the
takeoff quantity you specified. The total quantity for all takeoffs based on this designation appears
as part of the designation entry.

The designation takeoff will remain in the audit trail list even if you modify or delete the designation
itself. Any changes you made to the designation will be automatically reflected in any and all takeoffs
based on the designation.

To assemble a specialized takeoff without creating a designation:

1. Choose the appropriate takeoff option from the list box to the right of the Takeoff heading
(FIXTURES or DISTRIBUTION for electrical users, PLUMBING FIXTURES, HEATING, or
EQUIPMENT for mechanical users).

2. Double click the first blank line Designation heading.

3. Instead of specifying a description for the designation, press [Enter].

4. Assemble the takeoff as you would if you had created a designation. When you finish the takeoff,
click the Finish button, the takeoff is added to the audit trail under the name of the first item in the
takeoff.
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Modify a Designation

Pro, BidWinner Plus only

Any changes you make to a designation will be automatically reflected in all takeoffs performed using
that designation.

1. Click the designation within the designation list on the left side of the screen.

2. Click Modify  within the toolbar, or click with your right mouse button and select Modify from
the pop-up menu that appears.

The items and assemblies that currently comprise the designation are listed on the right side of
the screen.

3. To modify one of the current items or assemblies, double click it. To add another item or assembly
to the designation, double click the appropriate item or assembly from the material list on the left
side of the screen. To switch to a different material list, click on the list box beside the Takeoff
heading and select the appropriate list.

To remove one of the items or assemblies, click it, then select the Delete option from the Edit
menu. Alternatively, you could click the Delete button from the toolbar, or press the [Delete] key on
your keyboard. The item now appears grayed and crossed out. You can restore the deleted takeoff
item by clicking on the Delete option or button again. You can restore the deleted item in this way
at any point in the future, even after you have closed the program and shut down your computer.

 Tip - You cannot modify or delete the first item in the designation. You can, however, delete all
the items in a designation by highlighting the designation and pressing the [Delete] key.

4. To save the modified designation, select the Finish option from the Takeoff menu, or click the
Finish button from the toolbar.

You are prompted to specify a new description for the modified designation. To retain the existing
description, just click OK.
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Rename a Designation

Pro, BidWinner Plus only

1. Click the designation within the designation list on the left side of the screen.

2. Select the Rename option from the Takeoff menu, or click with your right mouse button and select
Rename from the pop-up menu that appears.

3. Enter the new name from the Modify Designation Description dialog that appears.

4. Click OK to accept the new name.
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Delete a Designation

Pro, BidWinner Plus only

1. Click the designation within the designation list on the left side of the screen.

2. Select the Delete option from the Edit menu. Alternatively, you could click the Delete button from
the toolbar, or press the [Delete] key on your keyboard.

The designation remains in the designation list, but its status has been changed to empty.
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Hot Lists

Pro, BidWinner Plus only

Using the following takeoff options, you can step through a series of hot lists to assemble a
specialized takeoff.

Database Type Takeoff Options

Electrical SYSTEMS, CONTROLS, DUCTS & TRAYS,
BRANCH CONDUIT, FEEDER CONDUIT,
BRANCH CABLE, FEEDER CABLE

Mechanical INDUSTRIAL SYSTEMS, COMMERCIAL
SYSTEMS, PIPE STAINLESS STEEL, PIPE
INDUSTRIAL, PIPE COMMERCIAL

VDV (voice/data/video) CAMPUS BACKBONE, EQUIPMENT ROOM,
RISER BACKBONE, HORIZONTAL CABLING,
WORKSTATION, MOVES ADDS CHANGES

1. Choose the appropriate option from the list box to the right of the Takeoff heading. A list of
categories appears below the Takeoff heading.

2. Double click the appropriate category. A list of assemblies appears.

3. Double click the appropriate entry from the list The Measure Takeoff dialog appears.

4. Specify the appropriate count, length, or other applicable measurement for the selected item or
assembly, then press [Enter] to accept the change and click OK. The item or assembly now
appears in a list on the right side of the screen.

For information on using the Measure Takeoff dialog to count or measure materials, see one of the
following sections:

Counting/Measuring Using the Keyboard

Counting/Measuring Using a Probe

Counting/Measuring Using a Digitizer

A list of related components now appears in place of the categories list. If you wish to add a
component to the takeoff, double click the appropriate item or assembly in the list. Alternatively,
you could select the COMMON ASSEMBLIES, ITEM DATABASE, TEMPORARY ITEMS, or
TEMPORARY ASSEMBLIES takeoff option and select an item or assembly not found in the
components list. From the Measure Takeoff dialog that appears, specify the appropriate
measurement, then click OK. The item appears in the list on the right side of the screen.

If you do not wish to add a component to the takeoff, then click the Next button to skip to the next

components list (if applicable), or click the Finish button  to complete the takeoff.
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5. Double click another item or assembly within the components list, or click the Next button  to
proceed to the next components list.

Double click the appropriate item or assemblies, or select a different item or assembly from the
COMMON ASSEMBLIES, ITEM DATABASE, TEMPORARY ITEMS, or TEMPORARY
ASSEMBLIES lists. From the Measure Takeoff dialog that appears, specify a quantity, then click
OK. If you do not wish to add a component to the takeoff, then click the Finish button to skip this
step and complete the takeoff.

6. You can now double click another component to be added to the takeoff, or you can click the
Finish button to complete the takeoff.
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Typical Takeoff

Not available in PowerBid

During a job estimate, you may need to repeat the same takeoff several times in different areas of the
job. In a nine-story office building, for example, you may take off the same quantity for the same
component for each floor. Instead of requiring you to repeat the process multiple times, the program
allows you to create a ‘typical’ takeoff which can be automatically repeated a specific number of times
for each drawing, area, phase, system, or location.

When you create a typical takeoff, you specify the number of times you want the material taken off for
each takeoff breakdown. Once you have created the typical takeoff, it displays at the bottom of the
breakdown listing following your other breakdown descriptions.

If you select a typical takeoff as your takeoff breakdown, any material you take off is taken off the
number of times you have specified for each of the takeoff breakdowns defined as part of the typical.
For example, if you create a typical and specify a Count of 2 for each floor in a 4-story building, then
take off a light fixture assembly using the typical as your phase breakdown, the fixture assembly is
automatically taken off twice for each floor.

By default, typical takeoffs are displayed within the audit trail using green text rather than black text.
You can control whether typical takeoffs appear highlighted within the audit trail from the Takeoff page
of the Options dialog, and control the color used to highlight them from the Appearance page.

Create a typical takeoff

1. Click the appropriate Type button to the right of the Drawing, Area, Phase, System, or Bid Item
from the Takeoff screen. A Typical Modify dialog appears.

2. Type an appropriate description (e.g. ‘Floors 2 thru 10’ ), under the Typical Description heading on
the left side of the dialog then press [Enter] or click the checkmark button to accept the description.

3. Click the Count column beside the appropriate drawing, area, phase, system, or bid item
descriptions, and enter the number of times the typical takeoff is to occur in the drawing, area,
phase, system, or location. Press the [Enter] key to accept each count.

For example, if you wanted the material to be taken off once for each floor in a building, you would
enter a value of 1 beside each floor in the Typical Phase Modify dialog.

4. Repeat steps 2-3 for each typical you wish to add. You can reorder the typicals within this dialog
by clicking the Move Up and Move Down buttons or by right clicking over a typical and selecting
Move Up or Move Down from the pop-up menu that appears. To duplicate a typical, select the
typical then click the Duplicate button. To delete a typical not used in any takeoffs, click the Delete
button or right click and select Delete.

Tip -You cannot delete a typical if it is currently being used in a takeoff.

5. Click Close to exit the Typical Modify dialog and return to the Takeoff screen.

Now the typical takeoffs you have created appear as an option at the bottom of the breakdown listing.
The program automatically adds ‘Typical -’ in front of the description you specified, so that ‘Floors 2
thru 10’ displays as ‘Typical - Floors 2 thru 10’ in the list. If you select the typical, then measure and
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complete the takeoff, the material is automatically taken off the number of times you specified for
each takeoff breakdown.
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Merging Takeoffs

Pro ONLY

For more information on merging takeoffs, click on the button beside one of the following topics:

  Merge Takeoff from Multiple Jobs

  Merge Takeoff from Sub Jobs
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Merge Takeoffs: Multiple Jobs

Pro only

To allow multiple estimators to contribute takeoffs to the same job from different workstations, Pro
provides a job merge feature. Job merge combines takeoffs from separate jobs into a single job,
merging temporary items, breakdowns, typicals, and designations, and appending audit trail entries.

Pro also provides an enhanced job merge feature, which allows you to create multiple jobs that are
subordinate to a master job. You can split up a project and allow different users to work on different
portions of the project, with each portion being a separate sub job. At any point, takeoffs from the sub
jobs can be merged into the master job. For more information, see Creating Sub Jobs and  Merging
Takeoffs from Sub Jobs.

Procedure

1. Open the job where you wish to merge the takeoffs, or create a new job.

2. Go to the Takeoff screen and select the Job Merge option from the Takeoff menu. The Job Merge
dialog appears.

3. From the Job Merge dialog, select the existing jobs to be merged into the current job by clicking on
the check box beside the appropriate job name(s). Takeoffs, breakdowns, typicals, and
designations from the selected jobs will be merged into the current job in the order in which they
are listed on this dialog.

4. From this dialog, you can also control whether your program performs a comprehensive merge or
not. A comprehensive merge involves making sure that the description and all other details match
before combining two breakdowns, typicals, or designations into one.

A non-comprehensive merge involves merging the breakdowns, typicals, or designations that share
the same description even if the remaining details do not match. Where details do not match, the
details of the breakdowns, typicals, or designations already stored in the current job will be used.
You can control whether the merge is comprehensive for breakdowns, typicals, or designations, by
checking or clearing the check box beside the appropriate option.

By default, comprehensive merges are performed when combining breakdowns, typicals, and
designations. To perform a non-comprehensive merge, click on the appropriate job merge option, so
that a checkmark no longer appears.

5. Click on the Merge button to merge the takeoffs from the selected jobs.

6. When you are prompted to confirm your request to merge the jobs, click on OK.

7. After the job merge is complete, a confirmation message displays. Click on OK to acknowledge
this message.

8. Unless you want to merge another job into the current job, click on Exit to return to the Takeoff
screen.

If any of the takeoffs being merged involve materials not found in the database assigned to the current
job, Pro will create temporary items for these materials. Temporary items are stored as part of the job
(rather than the database) and can be viewed or accessed by selecting TEMPORARY ITEMS from the
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Takeoff options list box on the Takeoff screen.

Tip - If you wish to merge jobs in a different order than they appear on the Job Merge dialog
(perhaps because you are performing a non-comprehensive merge and wish the details of a particular
job to override those of other jobs), then merge the jobs one at a time in the order you prefer.
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Merge Takeoffs: Sub Jobs

Pro ONLY

You can create one or more sub jobs that are subordinate to a master job. This allows you to split up
a project and allow different users to work on different portions of the project, with each portion being a
separate sub job. At any point, takeoffs from the sub jobs can be merged into the master job. Master
jobs and sub jobs form part of Pro's Enhanced Job Merge feature that allows you to track merge dates
and eliminate the possibility of a "double-merge". For more information, see Merging Takeoffs from
sub jobs.

The Enhanced Job Merge feature provides several advantages over the regular job merge feature. The
Enhanced Job Merge:

eliminates the possibility that a user will accidentally perform a double job merge.  

facilitates the merge process by designating jobs as sub jobs subordinate to a master job and
therefore eliminating the possibility of merging the wrong jobs.

provides the ability to update a master job with revisions made in the merged sub job(s).

allows the user to more effectively the ability within the Master job to filter the audit trail and sort
the extension by the original (sub job) numbers.

Enhanced Job merge combines takeoffs from separate jobs into a single job, merging temporary
items, breakdowns, typicals, and designations, and appending audit trail entries.

Procedure

1. Open the master job  you wish to merge sub jobs into.

2. Go to the Takeoff screen and select the Enhanced Job Merge option from the Job menu. The
Enhanced Job Merge dialog appears.

3. From the Enhanced Job Merge dialog, you can select the existing sub jobs to be merged into the
currently open Master job by clicking on the check box beside the appropriate job
name(s).Takeoffs, breakdowns, typicals, and designations from the selected sub jobs will be
merged into the master job in the order in which they are listed on this dialog.

If a sub job has been renamed or moved, the sub job displays grayed out in the merge list, with a
question mark button beside the job number:

To relink the sub job, click on it then click the Relink button. A dialog displays allowing you to
specify the location of the sub job.

4. Select the appropriate checkbox(es) to control the comprehensive merge options.

A comprehensive merge involves making sure that the description and all other details match before
combining two breakdowns, typicals, or designations into one. A non-comprehensive merge
involves merging the breakdowns, typicals, or designations that share the same description even if
the remaining details do not match. Where details do not match, the details of the breakdowns,
typicals, or designations already stored in the current job will be used. You can control whether the
merge is comprehensive for breakdowns, typicals, or designations, by checking or clearing the
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check box beside the appropriate option. By default, comprehensive merges are performed when
combining breakdowns, typicals, and designations. To perform a non-comprehensive merge, click
on the appropriate job merge option, so that a checkmark no longer appears.

5. Click on the Merge button to merge the takeoffs from the selected jobs.

6. When you are prompted to confirm your request to merge the jobs, click on OK.

7. After the job merge is complete, a confirmation message displays. Click on OK to acknowledge
this message.

8. Unless you want to merge another sub job into the master job, click on Exit to return to the Takeoff
screen.

If any of the takeoffs being merged involve materials not found in the database assigned to the current
job, Pro will create temporary items for these materials. Temporary items are stored as part of the job
(rather than the database) and can be viewed or accessed by selecting TEMPORARY ITEMS from the
Takeoff options list box on the Takeoff screen.

If a master job has sub jobs that are open or have been modified since the last merge, then the Final
Price cell at the bottom of the Calculated ($) column on the Final Pricing screen displays with a
yellow background.

Tip - If you wish to merge jobs in a different order than they appear on the Enhanced Job Merge
dialog (perhaps because you are performing a non-comprehensive merge and wish the details of a
particular job to override those of other jobs), then merge the jobs one at a time in the order you
prefer.
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Takeoff Breakdown
Before you take off material for the estimate, you should set the takeoff breakdown. Setting the takeoff
breakdown involves assigning the takeoff to a specific job (Pro, BidWinner Plus only), drawing (Pro,
BidWinner Plus only), area (Pro, BidWinner Plus only), phase (Pro, BidWinner Plus, BidWinner),
system, bid item (Pro, BidWinner Plus only), and labor factor (Pro, BidWinner Plus, BidWinner). After
the job is taken off and extended, you can view the material list, total cost, and labor hours for each of
these breakdowns.

1. Click the description of the current breakdown setting. (The current breakdown settings are
displayed in list boxes in the upper right corner of the Takeoff screen.) A drop-down list displays
with a selection of valid choices.

2. Click your choice, or use the arrow keys to move the highlight over your choice and press the [Enter]
key.

You can modify the list of valid choices.
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Takeoff Breakdown Options
From the Takeoff screen, you can assign the takeoff to a specific job (Pro, BidWinner Plus only),
drawing (Pro, BidWinner Plus only), area (Pro, BidWinner Plus only), phase (Pro, BidWinner Plus,
BidWinner), system, bid item (Pro, BidWinner Plus only), and labor factor (Pro, BidWinner Plus,
BidWinner). After the job is taken off and extended, you can view the material list, total cost, and total
labor hours broken down by drawing, area, phase, system, bid item, or labor factor.

When you set the takeoff breakdown, you select the appropriate drawing, area, phase, system,
location, and labor factor from a list of available choices. If you wish, you can modify or add to any of
these lists.

Add Takeoff Breakdown:

1. Click the appropriate breakdown option button (Job, Drawing, Area, Phase, System, Bid Item, or Lb
Factor), just above the Audit Trail Description heading. Alternatively, you could select the Modify
Breakdown Description option from the Takeoff menu, then choose the appropriate sub-menu
option. In either case, a Modify dialog appears.

2. From the Modify dialog, you can click on a blank line at the bottom of the list, begin typing, then
press the [Enter] key to save your change.
OR
You could click on an existing breakdown option then click the Insert button to insert a new
breakdown option above the selected option. When you do this, a dialog appears prompting you to
specify the option name.

You can also copy a range of cells from other applications such as Excel or Word and paste the
information into a blank line at the bottom of the list. You can paste the cells by right clicking over
the blank line and selecting the Paste option, or by pressing [Ctrl] + [V] on your keyboard. If the
pasted cells consist of multiple columns, then the information will be distributed across the
multiple columns that define the breakdown. If the pasted cells consist of multiple rows, then
multiple breakdowns will be added. If the values to be pasted are not valid for each of the
destination columns, then an error message displays and the paste operation will be aborted.

3. After you have completed adding new breakdown options or modifying existing ones, click on Close
to exit the Modify dialog and return to the Takeoff screen.

Modify Takekoff Breakdown

1. Click the appropriate breakdown option button (Job, Drawing, Area, Phase, System, Bid Item, or Lb
Factor), just above the Audit Trail Description heading. Alternatively, you could select the Modify
Breakdown Description option from the Takeoff menu, then choose the appropriate sub-menu
option. In either case, a Modify dialog appears.

2. From the Modify dialog, click on the appropriate breakdown option then type over the existing
Description or Code value.

3. Press the [Enter] key to save your change.

4. After you have completed adding new breakdown options or modifying existing ones, click on Close
to exit the Modify dialog and return to the Takeoff screen.
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To move or delete an existing breakdown option, follow these steps:

1. Click the appropriate breakdown option button (Job, Drawing, Area, Phase, System, Bid Item, or Lb
Factor), just above the Audit Trail Description heading. Alternatively, you could select the Modify
Breakdown Description option from the Takeoff menu, then choose the appropriate sub-menu
option. In either case, a Modify dialog appears.

2. From the Modify dialog, click on the appropriate breakdown option

3. Click on the Move Up or Move Down button to move the option up or down within the list, or click
the [Delete] button to remove the option from the list.

Tip - You cannot delete a breakdown option if a cost has been assigned to it from the Cost
Allocation dialog.

4. After you have added or modified the breakdown description, press the [Enter] key to save your
change.

5. After you have completed adding new breakdown options or modifying existing ones, click on Close
to exit the Modify dialog and return to the Takeoff screen.
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Labor Factoring
Labor factoring is used to adjust the labor units required for a takeoff, based on the installation
conditions. When you select the labor factor condition for a takeoff, the labor units are adjusted based
on the percentage assigned to each item’s factor group. To select a labor factor condition, click on
the list box to the right of the Lb Factor button. Labor factor options may include such installation
conditions as Standard, Suspended Ceiling, Slab, Exposed @ 30’, etc.

In the database, each item is assigned to a factor group, ranging from 1 to 5. As well, the default job
maintains a table that assigns adjustment percentages to each factor group for each labor installation
condition. When you perform a takeoff, the program checks the factor group for each item, then
applies the appropriate percentage adjustment for the selected labor installation condition.

For example, consider a takeoff on an item that has been assigned to Group 2 and using Masonry as
the labor factor condition. The program will check the Labor Factor table and determine that the
percentage for Masonry on a Group 2 item is 200.  Consequently, the labor hours in this case will be
doubled.

To select a labor factor condition, click on the list box to the right of the Lb Factor button. To modify
the labor factoring options, click on the Lb Factor button. From the Labor Modify dialog that appears,
you can modify the Labor Factor Descriptions and the adjustment percentages for Groups 1 through
5.

The labor factor groups assigned to different type of materials in the database are listed below:

Labor Factors (Electrical)

Material Labor Factor Group

Conduit & Fittings Group 2

Ducts & Fittings Group 2

Cable Tray & Fittings Group 2

Wireway & Fittings Group 2

Wiremold & Fittings Group 2

Flex Group 2

Cable Group 2

Fixture Group 2

Fasteners & Hangers Group 3

Boxes & Cabinets Group 4

Wire Group 5
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Material Labor Factor Group

Everything else Group 1 (always set to 100%)

Labor Factors (Mechanical)

Material Labor Factor Group

Pipe & Fittings Group 2

Fasteners & Hangers Group 3

Equipment

(Boilers, Pumps, etc.)

Group 4

Everything else Group 1 (always set to 100%)

Labor Factors (Structured Cabling/VDV)

Material Labor Factor Group

Cable Tray & Fittings Group 2

Wireway & Fittings Group 2

Wiremold & Fittings Group 2

Fasteners & Hangers Group 3

Device & Junction Boxes Group 4

Copper & Fiber Optic Cable Group 5

Copper & Fiber Optic Cord > 25' Group 5

Wire Group 5

Everything else (e.g. Devices, Faceplates,
Blocks, Panels, Adapters, Racks, Cords < 25',
etc.)

Group 1 (always set to 100%)
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Switch Databases
From the Takeoff screen, you can switch to a different material database.

To switch to a different material database:

1. Click the Database menu, then select the Select option. The Select Database dialog appears.

2. Select the database to which you want to switch.

3. Click OK.

If any of the items you have already taken off cannot be found in the new database, the
Resynchronize Takeoff Items dialog displays. This dialog displays:

a list of extension items that could be matched to similar database items, and

a list of extension items that could not be matched to database items.

Within the first list, you select the matches that you consider valid. You can click the items one at a
time, or you can click the Select All button to select all the items in the list. If you wish to convert the
unmatched items in the second list to temporary items, click the check box in the bottom left corner
of the dialog.
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Select Materials for Takeoff
After you have selected the appropriate drawing, area, phase, system, location, and labor factor
breakdowns, you select the material for the takeoff.

The first step in selecting the material for the takeoff is to select the appropriate takeoff library from
the list box that appears along the left side of the screen beside the Takeoff heading. The takeoff
library you select determines which items and assemblies are displayed in the materials list that
appears below the Takeoff list box.

Takeoff libraries

For simple takeoffs, you typically select one of the following libraries:

COMMON ASSEMBLIES
Displays a list of assemblies from the material database. Assemblies are collections of related
items identified by a single description. You can navigate through the list to select the material to
be taken off. For more information, see Taking Off Assemblies.

ITEM DATABASE
Displays a list of items from the material database. You can navigate through the list to select the
material to be taken off. For more information, see below.

TEMPORARY ASSEMBLIES
Displays temporary assemblies— assemblies assigned to the job rather than the database. For
more information, see Working with Temporary Assemblies. 

TEMPORARY ITEMS
Displays temporary items— items assigned to the job rather than the database. For more
information, see Working with Temporary Items. 

For more advanced takeoffs (Pro and BidWinner Plus only), such as those involving designations or
hot lists, you would select one of the following libraries:

FIXTURES / ELECTRIC HEATING / DISTRIBUTION (Electrical only)
Allows you to create specialized designations which you can then take off. If you wish, you can use
these options to assemble specialized takeoffs without creating designations. For more information,
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see Working with Designations (Pro, BidWinner Plus only).

PLUMBING FIXTURES / HEATING / EQUIPMENT (Mechanical only)
Allows you to create specialized designations which you can then take off. If you wish, you can use
these options to assemble specialized takeoffs without creating designations. For more information,
see Working with Designations (Pro, BidWinner Plus only).

SYSTEMS / CONTROLS / DUCTS & TRAYS / BRANCH CONDUIT & WIRE / FEEDER CONDUIT &
WIRE / BRANCH CABLE / FEEDER CABLE (Electrical only)
Displays the first in a series of specialized hot lists that you can step through to assemble your
takeoff. For more information, see Using Hot Lists (Pro, BidWinner Plus only).

INDUSTRIAL SYSTEMS / COMMERCIAL SYSTEMS / PIPE STAINLESS STEEL / PIPE
INDUSTRIAL / PIPE COMMERCIAL (Mechanical only)
Displays the first in a series of specialized hot lists that you can step through to assemble your
takeoff. For more information, see Using Hot Lists (Pro, BidWinner Plus only).

CAMPUS BACKBONE / EQUIPMENT ROOM / RISER BACKBONE / HORIZONTAL CABLING /
WORKSTATION / MOVES ADDS CHANGES (VDV only)
Displays the first in a series of specialized hot lists that you can step through to assemble your
takeoff. For more information, see Using Hot Lists (Pro, BidWinner Plus only).

Navigating the Database

Within the different lists, material has been categorized into as many as four levels. The current level
will be identified by a level indicator. Each level consists of either categories, items or assemblies.
The Type column will display the letter C to identify a category, the letter A to identify an assembly
and the letter I to identify items.

Double clicking on a category moves you down one level within the database, displaying the items or
categories that comprise the category you clicked on. To return to a previous level, click with your
right mouse button or press the [Esc] button on your keyboard. Alternatively, you can use the right
arrow key on your keyboard to move down a level, and the left arrow key to return to the previous level.

Selecting Items and Assemblies

Using the COMMON ASSEMBLIES, ITEM DATABASE, TEMPORARY ITEMS, or TEMPORARY
ASSEMBLIES takeoff libraries, you can select individual items or assemblies to be taken off.
Temporary items and assemblies behave just like database items and common assemblies, but are
stored as part of the job, rather than the database. For information on creating temporary items, see 
Working with Temporary Items.  For information on creating temporary assemblies, see Working with
Temporary Assemblies.

Takeoff items or assemblies:

1. Choose the COMMON ASSEMBLIES, ITEM DATABASE, TEMPORARY ITEMS, or TEMPORARY
ASSEMBLIES library from the list box to the right of the Takeoff heading.

2. Double click the desired category to display the next level within the database. The next level
consists of either categories, assemblies or items.

3. Repeat step 2 until you reach the level where items or assemblies are displayed. Items are
indicated by the letter I in the Type column, while assemblies are indicated by the letter A.
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4. Double click the item or assembly you want to take off. The Measure Takeoff dialog appears.

5. For information on using the Measure Takeoff dialog to count or measure materials, see one of the
following sections:

Counting/Measuring Using the Keyboard

Counting/Measuring Using a Probe

Counting/Measuring Using a Digitizer

Modify Category, Item, or Assembly During the Takeoff

To modify a database category, item, or assembly during a takeoff:

1. Click the category, item, or assembly you wish to modify from the database section on the left side
of the Takeoff screen.

2. Click the Edit menu and select the Modify option, or click the Modify button from the toolbar.

3. Modify the item or assembly as required.
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Perform Quick Takeoff
Instead of navigating through the material database to select the takeoff material, you can simply
enter a quick takeoff code for the database item you want to take off. You assign the quick takeoff
codes in the Quick Takeoff Code column of the Database Manager screen. The code you assign
cannot contain spaces and each code must be unique; no duplicate codes are allowed.

To print a report listing the quick takeoff codes assigned to items in the current database, click the 
Database menu and select Print Quick Takeoff Codes from the Takeoff screen. You are prompted to
indicate whether you want to sort the items first by Description then by Quick Takeoff Code.

To specify a database item to be taken off using the quick takeoff code, make sure you’re on the
Takeoff screen with the Takeoff option set to Item Database, then select the Quick Takeoff option from
the Takeoff menu. From the dialog that appears, enter the takeoff code. If the code you have entered
corresponds to a quick takeoff code in the currently loaded database, the Measure Takeoff dialog
displays so you can specify the quantity for the material.
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Count/Measure Materials
Takeoff quantities for items in the Trimble material database are based on length, count, or other
measurement variables. When you take off a designation, you specify the count. When you take off
individual items, you specify a length or a count. When taking off assemblies, you specify a length, a
count, or both, depending on the items included in the assembly. When you perform a takeoff using
hot lists, you may be able to specify length or count, along with other measurements.

You can count or measure materials using the keyboard, a measuring device such as a probe or
digitizer, or LiveCount™, Trimble's on-screen takeoff tool. For information on using a probe, see 
Counting/Measuring Materials Using a Probe. For information on using a digitizer, see Counting/
Measuring Materials Using a Digitizer. For information on using LiveCount, see Counting/Measuring
Material Using LiveCount. For more information on measuring material using the keyboard, see below.

Count/Measure Materials: Keyboard:

1. Double click the item or assembly you wish to take off from the list on the left side of your screen,
or use the arrows on your keyboard to move the highlight bar to the item or assembly and press 
[Enter]. The Measure Takeoff dialog appears. In the Measurement Information area of the Measure
Takeoff dialog, the Value column for the first measurement variable displays highlighted.

Length and Count measurement variables

2. Type in the count, length, or other applicable measurement, or use the calculator to calculate the
value. The value you enter appears both in the Value column.

3. After you have finished entering the measurement, press the [Enter] key to accept the change. The
extended measurement will be displayed in the Quantity column within the Item Information area of
the screen.

If you are taking off an assembly, the program calculates the required quantity for each component
in the assembly. To arrive at the extended measurement, the program multiplies the count or
length you specify by Factor 1, then divides the resulting value by Factor 2.

Calculating the extended measurement



246 - Classic Estimating Help Guide

4. To modify the measurement, click the Value box in the Measurement Information area of the
screen and repeat steps 2 and 3.

5. Click the OK button or press [Enter] to finish the takeoff. To cancel this takeoff, click the Cancel
button. In either case, you are returned to the Takeoff screen. After you have finished the takeoff, it
appears as a line in the audit trail list.
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Take Off Assemblies
The term assembly refers to a group of related items identified by one description. Within an electrical
database, for example, a conduit assembly consists of conduit, connectors, couplings, straps, and
possibly wire. Within a mechanical database, a copper pipe assembly consists of pipe, couplings,
and hangers.

In each material database, assemblies are simply sets of pointers to individual database items, along
with the required quantities for each item. When you delete an item from the database, the item is
automatically removed from all applicable assemblies.

When you take off an assembly, you are actually taking off several items at the same time. This can
greatly increase the speed and accuracy of your takeoffs. The program gives you the ability to create
and modify assemblies as desired.

When an assembly is taken off, the actual length or count measurement for each individual item is
determined by two pre-set factors (Fct 1 and Fct 2). The value of these factors is established when
the assembly is created and can be modified as necessary. Depending on the item, the takeoff value
is based on length, count or an absolute value. Absolute values are used if an item needs to be
included in the assembly, but the quantity of the item is not related to the takeoff length or the takeoff
count. For items based on absolute value, the quantity taken off will be the value entered for Fct 1.

Example

Assume a conduit assembly consisting of:

 Base Fct 1 Fct 2  

2” GRC Len 1.0 1.0 for every 1 foot
measured (Fct 2)
, 1 foot will be
taken off (Fct 1)

2” Steel Locknut Cnt 4.0 1.0 for every 1 count
(Fct 2), 4
locknuts will be
taken off (Fct 1)

2” Strap Len 1.0 8.0 for every 8 feet
measured (Fct
2), 1 strap will be
taken off (Fct 1)

2” GRC 90 Elbow Abs 2  two elbows will
be taken off with
each assembly ,
regardless of
length or count
entered for the
assembly (You
may have to
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 Base Fct 1 Fct 2  

modify absolute
values for specific
takeoffs)

Assume that 96’ is measured off with a count of 4. The resulting takeoff would consist of ...

96’ 2” GRC

16 2” Steel Locknuts

12 2” Straps

2 GRC 90 Elbows
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Temporary Items
Temporary items are items saved as part of the job, rather than the database. You can take off
temporary items just as you would items from the material database. You can also copy and paste
temporary items just like database items.

 Tip - If you have multiple estimators working on a common job from separate workstations, and
they need to create new items, they should create them as temporary items, rather than new
database items. When the separate jobs are merged, the temporary items will be merged, allowing
your chief estimator to review the new items within a single list.

Create Temporary Items

1. Select the TEMPORARY ITEMS option from the list box to the right of the Takeoff heading.

2. Double click on the first blank line below the Temporary Item heading. The Create/Modify
Temporary Item dialog appears, displaying the various fields that define the item.

3. Enter or modify values for the appropriate fields. To modify the value for one of these fields, click the
field then modify the value. If the field allows only certain values (like Material Condition), you can
click the field and select the appropriate value from the drop-down list that appears. Otherwise, you
can simply type the new value.

 Tip - You cannot modify the Date field. The system date is automatically inserted when the
item is created, and each time the price is modified.

4. Click OK to accept your changes and exit the Create/Modify Item dialog after you have completed
modifying the fields that define the item.

You can also create a temporary item by copying and pasting an item from the Item Database.

You can add a note to a temporary item by right clicking over the item and selecting the Notes
option. If you have attached a note to a temporary item, a note button displays beside the item
within the temporary items list.

You can insert or reorder items within the temporary item list by right clicking over an existing
entry and selecting the appropriate menu option. If a temporary item has not been taken off, you
can delete it by right clicking over the item and selecting Delete.
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Temporary Assemblies
Not available in PowerBid

Temporary Assemblies are groups of related items identified by a single description. For example, a
copper pipe assembly consists of pipe, couplings, and hangers. A conduit assembly consists of
conduit, connectors, couplings, straps, and possibly wire. When you take off an assembly, you are
actually taking off several items at the same time. This can greatly increase the speed and accuracy
of your takeoffs. Unlike common assemblies, temporary assemblies are not saved in the materials
database, they are only saved with the current job.

You can create a temporary assembly or modify existing ones. You can only modify a single
temporary assembly by adding to or deleting items from the temporary assembly. You can, however,
delete the entire temporary assembly if it has not been taken off.

You can insert or reorder items within the temporary assembly list by right clicking over an existing
entry and selecting the appropriate menu option. If a temporary assembly has not been taken off, you
can delete it by right clicking over the assembly and selecting Delete.

Create Temporary Assembly

1. Select the TEMPORARY ASSEMBLIES option from the list box to the right of the Takeoff heading.

2. Double click on the first blank line below the Temporary Assembly heading. The Create/Modify
Temporary Assembly dialog appears.

3. Add an item to the assembly by navigating through the item database on the left side of the dialog
then double clicking on the appropriate item. The first item you add to the assembly will be used as
the default name for the assembly. (You can also add an assembly to another assembly by
switching to the Common Assemblies view, then double clicking on an assembly.)

4. Change the Base, Fct 1, or Fct 2 value for the item as required. When an assembly is taken off,
the actual length or count measurement for each individual item is determined by the pre-set
factors Fct 1 and Fct 2, in combination with the takeoff length or count. For items whose Base
value is Len (length) or Cnt (count), the program calculates the required quantity for each item by
multiplying the length or count specified in the takeoff by Fct 1, then dividing the resulting value by
Fct 2. For items whose Base value is Abs (absolute), the required quantity equals the value of Fct
1. Absolute values are used if an item needs to be included in the assembly, but the quantity of the
item is not related to the takeoff length or the takeoff count. 

You can enter values ranging from -999.9 to 999.9 in the Fct 1 cell, and values ranging from 0.1 to
999.9 in the Fct 2 cell.

5. Repeat Steps 2-4 for each item you wish to add to the assembly.

 Tip - The maximum number of items within a single temporary assembly is 32.

6. If you wish to change the default assembly name, click the Name field at the top right of the dialog
and type a new name.

7. After you have completed adding items to the assembly, click the OK to accept your changes and
exit the Create/Modify Temporary Assembly dialog.
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You can also create a temporary assembly by copying and pasting an assembly from the Common
Assemblies library.

You can add a note to a temporary assembly by right clicking over the assembly and selecting the
Notes option. If you have attached a note to a temporary assembly, a note button displays beside
the assembly within the temporary assembly list.

Modify a single temporary assembly

 Tip - Entries in the Audit Trail for previously taken off Temporary Assemblies will not be altered if
the Temporary Assembly is modified.

1. Select the TEMPORARY ASSEMBLIES option from the list box to the right of the Takeoff heading.

2. Select an existing Temporary Assembly. Right-click and select Modify from the pop-up menu. The 
Create/Modify Temporary Assembly dialog appears.

3. To add an item to the temporary assembly, navigate through the item database on the left side of
the dialog then double click the appropriate item. (You can also add an assembly to another
assembly by switching to the Common Assemblies view, then double clicking on an assembly.)

 Tip - The maximum number of items within a single assembly is 32.

You can add the same item more than once to a single assembly. For example, you may wish to
add screws based on length as well as count.

4. Change the Base, Fct 1, or Fct 2 value for the item as required. When an assembly is taken off,
the actual length or count measurement for each individual item is determined by the pre-set
factors Fct 1 and Fct 2, in combination with the takeoff length or count. For items whose Base
value is Len (length) or Cnt (count), the program calculates the required quantity for each item by
multiplying the length or count specified in the takeoff by Fct 1, then dividing the resulting value by
Fct 2. For items whose Base value is Abs (absolute), the required quantity equals the value of Fct
1. Absolute values are used if an item needs to be included in the assembly, but the quantity of the
item is not related to the takeoff length or the takeoff count.

You can enter values ranging from -999.9 to 999.9 in the Fct 1 cell, and values ranging from 0.1 to
999.9 in the Fct 2 cell.

5. To change the assembly name, click the Name field at the top right of the dialog and type a new
name.

6. To remove an item within an assembly, click on the item description within the right side of the
dialog, then click on the Delete button at the bottom of the dialog. The item no longer forms part of
this assembly, but still exists within the item database.

7. To move an item within an assembly, within the right side of the dialog click on the line number
next the item description , then click on the Move Up/Move Down button to position the item.

8. After you have completed modifying the assembly, click the OK button to accept your changes and
exit the Create/Modify Assembly dialog.
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Search for Items/Assemblies
From the Takeoff screen and the Database Manager, you can locate an item or assembly within the
current database by selecting the Database Find option. This option is available from the Edit menu
on the Takeoff Screen. (The takeoff option must be set to either Item Database or Common
Assemblies.)

From the Find Database Item/Assembly dialog that appears, you can specify the search criteria and
initiate the search. You can search for partial or exact matches, and control whether spaces and
upper or lower case is taken into consideration.

Once the search is complete, you can double click on any of the search result entries and
immediately jump to that item or assembly within the database hierarchy on the left side of the
screen.
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Navigate Audit Trail
The audit trail is a permanent record of all your takeoffs, including any takeoffs you have deleted. After
a takeoff is deleted, the contents of the takeoff will still be available for viewing and can be
immediately restored if desired.

Each line in the audit trail represents a separate takeoff. You can filter the audit trail to display all
takeoffs, or only those takeoffs that match the currently selected job, drawing, area, phase, system,
bid item, and/or labor factor.  Initially, the audit trail displays only those takeoffs that match the
currently selected system breakdown (as indicated by a check mark in the box to the left of the
System button). To filter by additional breakdowns, click the check box beside the appropriate
breakdown name so that a checkmark appears.

By default, typical takeoffs are displayed within the audit trail using green text rather than black text.
You can control whether typical takeoffs appear highlighted within the audit trail from the Takeoff page
of the Options dialog, and control the color used to highlight them from the Appearance page. You
can also control whether deleted takeoffs appear within the audit trial by selecting or deselecting the
Show Deleted Takeoffs check box.

Double clicking a takeoff line displays the components of the takeoff. Double click one of the takeoff
components to display the Edit Takeoff dialog, allowing you to modify the takeoff. With a takeoff
displayed on the audit trail, you can add components to a takeoff.

To return to displaying the takeoff lines, press [Esc] on your keyboard. Alternately, you could click with
your right mouse button and select the Abort option.

From the audit trail, you can reverse a takeoff so that a negative takeoff becomes positive/negative. To
reverse a takeoff, right click over the takeoff and select Reverse Takeoff from the pop-up menu that
appears.

You can add a note to a takeoff within the audit trail by right clicking over the takeoff and selecting the
Notes option. If you have attached a note to a takeoff (either from the Measure/Edit Takeoff screen or
from the audit trail), a note button displays beside the takeoff in the audit trail.

To view the note, right click over the takeoff and select the Notes option.
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You can also use this option to attach a note to an existing takeoff in the audit trail.
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Filter Audit Trail
The audit trail is a permanent record of all your takeoffs including any deletions that are made. When
a takeoff is deleted, the contents of the takeoff are still available for viewing and can quickly be
restored if desired.

You can filter the audit trail to display all takeoffs, or only those takeoffs that match the currently
selected job, drawing, area, phase, system, bid item, and/or labor factor.

Initially, the audit trail displays only those takeoffs that match the currently selected system
breakdown (as indicated by a check mark in the box to the left of the System button). To filter by
additional breakdowns, click the check box beside the appropriate breakdown name so that a
checkmark appears.

 

The Audit Trail will show only those takeoffs which match the current breakdowns you have checked.
For example, if you check the boxes beside Area, Phase, and System buttons, then only those
takeoffs that are assigned to the currently selected Area, Phase, and System breakdowns will be
displayed.  
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Takeoff Tools
For more information on merging takeoffs, click on the button beside one of the following topics:

  Probe

  Digitizer

  LiveCount™
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Probe

You can count or measure materials using the keyboard, or a measuring device such as a probe or
digitizer. Currently, Trimble estimating programs support the QuickScaler2, Quickscaler 3, and
Scalex 1000 probes. For information on using a probe, click on the button beside one of the following
options.

  Configure Probe

  QuickScaler2

  QuickScaler 3

  Scalex 1000
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Configure Probe

If you wish to measure materials using a probe, you must configure the device so that it can work
properly with your Trimble estimating program. There are several measuring devices that will interface
with the program. Each device will plug into a serial port on your computer and use a different
interface. You must tell the computer which device you are using and which serial port it is plugged
into.

1. Click the Takeoff menu from the Takeoff screen, then click the Configure Probe option. The Probe
Options dialog appears.

2. On the General tab, click the Probe list box and select the type of measuring device you are using.

3. Click the Port list box and select the serial port being used by the probe.

4. Advanced features specific to different models of probes (read/write timeouts) can be set on the
Advanced tab by entering information in the appropriate fields.

5. Click OK to accept the probe configuration and exit the dialog.
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QuickScaler2

Takeoff quantities for items in the Trimble material database are based on length or count. When you
take off individual items, you specify a length or a count. When taking off assemblies, you specify a
length, a count, or both, depending on the items included in the assembly. See also:

  Setting the QuickScaler2 Scale

  Troubleshooting with the QuickScaler2

Count/Measure with QuickScaler2

1. Make sure the probe is connected to the serial port, properly configured, and online.

2. Double click the item or assembly you wish to take off from the list on the left side of your screen
or, use the arrows on your keyboard to move the highlight bar to the item or assembly and press 
[Enter]. The Measure Takeoff dialog appears.

3. The Scale field within the Probe Information area of the screen displays the scale as programmed
on the QuickScaler2. If the scale is acceptable, proceed to step 4. If you wish to change the scale,
click the scale field box and a list of valid scales will be displayed. Click the desired scale and all
QuickScaler2 measurements will be based on the chosen scale.

4. If you wish to calculate length, roll the QuickScaler2’s wand along the drawing. If you wish to
calculate the count, press the wand’s count button. The length or count you measure will be
automatically displayed on the Probe Information area of the screen.

5. If you want to change these measurements, press twice on the wand’s clear button and the
measurements in the length and count boxes on the Probe Information area of the screen will be
erased. To cancel this takeoff before accepting the input data, click on the Cancel button on your
screen, you will be returned to the Takeoff screen. Repeat from step 2.

6. Press the Clear button on the wand, or click on the Send button in the Probe Information area of
the screen when the Probe Information is correct. The measurement entered (length and/or count),
will be displayed in the value box on the Measurement Information area of the screen and the
extended measurements displays in the Quantity column within the Item Information area of the
screen.

If you are taking off an assembly, the program calculates the required quantity for each component
in the assembly. To arrive at the extended measurement, the program multiplies the count or length
you specify by Factor 1, then divides the resulting value by Factor 2.



260 - Classic Estimating Help Guide

7. Click OK or press [Enter] to finish the takeoff when the Item Information is correct. To cancel this
takeoff, click the Cancel button. In either case, you will be returned to the Takeoff screen. If you
chose to finish the takeoff, the takeoff appears in the audit trail list.

Tip - Alternatively, you could click the Scale box from the Measure Takeoff dialog.

QuickScaler2 Scale

1. Turn ON the QuickScaler2 and verify it is off-line.

2. If the words ON-LINE do not appear in the upper left corner of the QuickScaler2 display then the
scaler is off-line. If the words ON-LINE are displayed in the upper left corner of the QuickScaler2
display, press the ON/ONLINE button in the bottom left corner of the QuickScaler2 keypad. The
ON-LINE symbol will disappear.

3. Press the SCALE button in the upper right corner of the QuickScaler2 keypad. The current scale
will be displayed.

4. If this setting is correct, press the LENGTH button in the upper left corner of the QuickScaler2
keypad, and turn the probe back on-line.

5. If you want to change the setting, press the AC button in the right most column of the
QuickScaler2 keypad. Key in the correct scale. For example, if the desired scale is 1” = 8’, press 1
then INCHES then = then 8 then FEET.

6. The scale will be displayed on the QuickScaler2 screen.

7. The scale must be in whole numbers. If your desired scale is 1/8 “ = 5’ (the same as 1’’ = 40’),
press 1 then INCHES then = then 40 then FEET.

8. Press the LENGTH key in the upper right corner of the QuickScaler2 keypad and you will be ready
to perform a takeoff using the QuickScaler2. Put the QuickScaler2 back ON-LINE. The scale
setting will not be lost if the QuickScaler2 is turned off.

For more detailed information about using the QuickScaler2, please refer to your QuickScaler2
Operator’s Guide.
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Troubleshoot QuickScaler2

If you are encountering problems with the QuickScaler2, follow the step-by-step troubleshooting guide
below to determine the nature of the problem.

1. Is the QuickScaler2 on-line?

YES: Confirm that the word "ON-LINE" appears in the upper left hand corner of the
QuickScaler2’s LCD and proceed to Step 2.

NO: Press the ON/ON-LINE button on the QuickScaler2 base unit to place the unit on-line. Try
using the QuickScaler2 again. If you are still encountering problems, proceed to Step 2.

 Is the QuickScaler2 properly connected to the computer?

YES: Proceed to Step 3.

NO: Connect the QuickScaler2 to a serial port, make sure the cables are properly connected
and then set up the program to look at that port for the QuickScaler2. Try using the
QuickScaler2 again. If you are still encountering problems, proceed to Step 3.

 Are there more than 2 serial ports (or serial devices, example: internal modem) on the computer?

To check on Windows 98, right click on My Computer, select Properties, click on Device Manager
and double click on Computer. On Windows 2000, right click on My Computer, select Properties,
then click on the Hardware tab, then click on the Device Manager button. On Windows NT, click
on Start, then Programs, then Administrative Tools, then Windows NT Diagnostics. From the
dialog that appears, click on Resources.

YES: If the serial port the QuickScaler2 is on and is conflicting with another serial port (or serial
device), remove the conflicting device. Try using the QuickScaler2 again. If you are still
encountering problems, run the Device Manager to confirm, then proceed to Step 4.

NO: Proceed to Step 4. 

2. Is there a serial mouse or free serial port on the computer?

YES: Attach the QuickScaler2 onto a free serial port, or disable your mouse driver then place
the QuickScaler2 onto the serial port the mouse was using. Then set up your Trimble estimating
program to look at that serial port for the QuickScaler2. Try using the QuickScaler2 again. If you
are still encountering problems, proceed to Step 5.

NO: Proceed to Step 5. 

3. Contact Trimble and determine if your QuickScaler2 product is under warranty. If so, you can
exchange the unit. If not, Trimble can test the product or suggest a replacement.
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QuickScaler3

Takeoff quantities for items in the Trimble material database are based on length or count. When you
take off individual items, you specify a length or a count. When taking off assemblies, you specify a
length, a count, or both, depending on the items included in the assembly.

1. Make sure the probe is properly plugged into a serial port and is properly configured. For more
information, see Configuring the Probe.

2. Click the Takeoff tab at the bottom of the estimating, billing or change order product screen.

3. Double click the appropriate assembly or item you wish to take off from the list on the left hand
side of your screen, or use the arrows on your keyboard to move the highlight bar to the item or
assembly and press [Enter]. The Measure Takeoff dialog appears.

If the Scale field in the Probe Information area displays an acceptable scale, proceed to the next
step. Otherwise, to change the scale, either select the desired scale from the Scale drop-down list
box, or select Custom to set the custom scale to suit your needs.

The Settings button is used to customize the various probe settings. For more information and
instructions on customizing the settings, see Customizing the QuickScaler 3 Settings.

4. Roll the QuickScaler 3’s wand along the drawing, if you wish to calculate the length. If you wish to
calculate the count, press the wand’s count button (button closest to the wheel). The length or
count you measure, automatically appear in the appropriate field in the Probe Information area of
the screen.

5. If you wish to change the length and count measurements, press twice on the wand’s clear/send
button (furthest from the wheel) to erase them first. If you wish to cancel this takeoff before
accepting the input data, click the Cancel button to return to the Takeoff screen. Repeat the
process from step 2.

6. Either press the clear/send button on the wand or click the Send button in the Probe Information
area when all the information is correct. The measurement entered (length and/or count) appears in
the Value box in the Measurement Information area, and the extended measurements in the
Quantity column in the Item Information area. 

If you are taking off an assembly, the program calculates the required quantity for each component
in the assembly. To arrive at the extended measurement, the program multiplies the count or length
you specify by Factor 1 then divides the resulting value by Factor 2.

7. Click OK or press [Enter] to finish the takeoff, when the Item Information is correct, or click Cancel
to cancel this takeoff. You are returned to the Takeoff screen. If you chose to finish the takeoff, the
takeoff appears in the audit trail list.
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Scalex 1000

Takeoff quantities for items in the Trimble materials database are based on length or count. When you
take off individual items, you specify a length or a count. When taking off assemblies, you specify a
length, a count, or both, depending on the items included in the assembly.

1. Make sure the probe is connected to the serial port, properly configured, and online. For more
information, see Configuring the Probe.

2. Double click the item or assembly you wish to take off from the list on the left side of your screen
or, use the arrows on your keyboard to move the highlight bar to the item or assembly and press 
[Enter]. The Measure Takeoff dialog appears.

3. The Scale field within the Probe Information area of the screen will display the scale as
programmed on the Scalex 1000. The display area on the Scalex may display an abbreviated
version of the scale. For example, if the scale is set to 1”=83 1/3”, the Scalex may display the
scale as 1”=83”.

If the scale is acceptable, proceed to step 4. If you wish to change the scale, click on the scale
field box and a list of valid scales will be displayed. Click on the desired scale and all QuickScaler2
measurements will be based on the chosen scale. For information on setting custom scales on the
Scalex 1000, see your Scalex 1000 User Guide.

4. If you wish to calculate length, roll the Scalex wand along the drawing. If you wish to calculate the
count, press the wand’s Count button. The length or count you measure will be automatically
displayed on the Probe Information area of the screen.

5. If you want to change these measurements, press the wand’s clear button once and the
measurements in the length and count boxes on the Probe Information area of the screen will be
reset to zero. To cancel this takeoff before accepting the input data, click on the Cancel button on
your screen, you will be returned to the Takeoff screen. Repeat from step 2.

6. When the Probe Information is correct, click on the Send button in the Probe Information area of
the screen. The measurement entered (length and/or count), will be displayed in the value box on
the Measurement Information area of the screen and the extended measurements will be displayed
in the Quantity column within the Item Information area of the screen.

If you are taking off an assembly, the program calculates the required quantity for each component
in the assembly. To arrive at the extended measurement, the program multiplies the count or length
you specify by Factor 1, then divides the resulting value by Factor 2.

7. When the Item Information is correct, click on the OK button or press [Enter] to finish the takeoff. To
cancel this takeoff, click on the Cancel button. In either case, you will be returned to the Takeoff
screen. If you chose to finish the takeoff, the takeoff appears in the audit trail list.
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Digitizer

You can count or measure materials using the keyboard, or a measuring device such as a probe or
digitizer. Trimble estimating products provides support for the Numonics BidMat XNT and GTCO Roll-
Up II digitizers. For information on using these digitizers, click on the button beside one of the
following options.

  Configuring the Numonics BidMat XNT

  Counting/Measuring Materials Using the Numonics BidMat XNT

  Configuring the GTCO Roll-Up II

  Counting/Measuring Materials Using the GTCO Roll-Up II
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Numonics BidMat XNT

Takeoff quantities for items in the Trimble material database are based on length or count. When you
take off individual items, you specify a length or a count. When taking off assemblies, you specify a
length, a count, or both, depending on the items included in the assembly.

1. Make sure the digitizer is properly configured. The digitizer default position has the controller
housing on the right side. For more information, see Configuring the Numonics BidMat XNT.

2. From the Takeoff menu, select the Configure Probe option and choose the Numonics BidMat XNT
along with the correct serial port.

3. Double click on the item or assembly you wish to take off from the list on the left side of your
screen, or use the arrows on your keyboard to move the highlight bar to the item or assembly and
press [Enter]. The Measure Takeoff dialog appears.

4. The scale field in the Probe Information area of the dialog will initially display the default scale (1:1).
Subsequently, the field will display the last scale used. Change the scale by clicking on the scale
field box and selecting from the list of valid scales. Once you click on the desired scale, all takeoff
measurements will be based on this scale.

5. When calculating length you will define two positions on the digitizer mat by depressing and
releasing the stylus on both positions. Move to the beginning of the length measurement and
depress the stylus by pressing it against the tablet. Then move to the end point and depress the
stylus a second time by pressing it against the tablet. The measurement information entered will be
automatically displayed on the Probe Information area of the Measure Takeoff dialog.

6. To detach the digitizer so that you can move the stylus to a new position and continue the length
measurement from there, position the stylus close to or just touching the tablet (do not depress the
stylus), then depress and release the detach button (the button farthest from the stylus). The
detach button will also perform a send. Now, move the stylus to the new location and continue
measuring. The measurement information will be automatically displayed on the Probe Information
area of the Measure Takeoff dialog.

7. When counting you will use the count button on the pen which is the button closest to the stylus.
Position the stylus close to or just touching the tablet (do not depress the stylus) and push the
button once for each count. The measurement information entered will be automatically displayed
on the Probe Information area of the Measure Takeoff dialog.

8. If you want to change these measurements, position the stylus close to or just touching the tablet
(do not depress the stylus) and press the detach button twice to clear the measurements in the
Probe Information area of the screen. To cancel this takeoff before accepting the input data, click
on the Cancel button in the Measure Takeoff dialog; you will be returned to the Takeoff screen.

9. When the Probe Information is correct, press the Detach button or click on the Send button in the
Probe Information area of the Measure Takeoff dialog. The measurement entered (length or count),
will be displayed in the value box on the Measurement Information area of the dialog and the
extended measurements will be displayed in the quantity box on the Item Information area of the
dialog.

10.When the Item Information is correct, click on the OK button or press [Enter] to finish the takeoff;
you will be returned to the Takeoff screen. The accepted takeoff will be displayed in the audit trail.
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Tip - The extended measurement for an assembly may not be the same as the measurement you
entered, it will depend on the Fct 1 and Fct 2 settings established in your database.

Numonics BidMat XNT Configuration

Place the tablet on a large, flat surface. The digitizer default position has the controller housing on the
right side. Next, connect the serial cable to the socket at the end of the housing and connect the free
end to your computer. Connect one end of the power cable to the serial connector and the other to a
power outlet or a power bar.

Before you can use the Numonics BidMat XNT digitizer with your Trimble estimating program, you
must set the following parameters correctly:

Bank A Configuration:

Operating Mode: Line (B1=0, B2 = 0)

Increment: None (B3 = 0, B4 = 0)

Polled Mode: Off (B5 = 0)

Data Rate: 125pps (B6 = 1, B7 = 1, B8 = 1)

Resolution: 1000lpi (B9 = 1, B10 = 1, B11 = 0)

Format: Numonics ASCII (B12 = 1, B13 = 0, B14 = 0, B15 = 1, B16 = 0)

Line Feed: Add (B17 = 1)

Data Bits: 7 (B18 = 0)

Bank B Configuration:

Baud Rate: 9600 (B1 = 0, B2 = 0, B3 = 1)

Parity: None (B4 = 1, B5 = 0, B6 = 0)

Pen Drive Frequency: Low (B7 = 0)

Use ESC on 9x00 Commands: Do no use ESC (B9 = 0)

Pen Click: Yes click on first pen down (B10 = 1)

Pen Tilt Correction: Enable (B14 = 1)

High/Low Proximity: High (B17 = 0)

CTS Line Enable: Off (B18 = 0)

Bank C Configuration:
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Tablet Rotation: Tablet in default position (B1 = 0, B6 = 0)

Remove CR on ASCII formats: Disable (B2 = 0)

See Chapter 4 and Appendix B in the BidMat XNT User Manual for more information on configuring the
digitizer.
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 GTCO Roll-Up II

Takeoff quantities for items in the Trimble material database are based on length or count. When you
take off individual items, you specify a length or a count. When taking off assemblies, you specify a
length, a count, or both, depending on the items included in the assembly.

1. Make sure the digitizer is properly configured. For more information, see Configuring the GTCO Roll
Up II. Trimble estimating programs have designated the three squares in the bottom left corner of
the tablet to perform the following functions: Clear, Detach, Send. The single button on the Roll-Up
II performs a Count function.

Bottom left corner of tablet

2. From the Takeoff menu, select the Configure Probe option and choose the GTCO Roll-Up II along
with the correct serial port.

3. Double click on the item or assembly you wish to take off from the list on the left side of your
screen, or use the arrows on your keyboard to move the highlight bar to the item or assembly and
press [Enter]. The Measure Takeoff dialog appears.

4. The scale field in the Probe Information area of the dialog will initially display the default scale (1:1).
Subsequently, the field will display the last scale used. Change the scale by clicking on the scale
field box and selecting from the list of valid scales. Once you click on the desired scale, all takeoff
measurements will be based on this scale.

5. When calculating length you will define two positions on the digitizer mat by depressing and
releasing the stylus on both positions. Move to the beginning of the length measurement and
depress the stylus by pressing it against the tablet. Then move to the end point and depress the
stylus a second time by pressing it against the tablet. The measurement information entered will be
automatically displayed on the Probe Information area of the Measure Takeoff dialog.

6. To detach the digitizer so that you can move the stylus to a new position and continue the length
measurement from here, click on the Detach square (the second from the left in the bottom left
corner of the tablet). Move to the starting point of the next stroke or line segment and continue as
usual.

7. Position the stylus close to or just touching the tablet (do not depress the stylus) and push the
count button on the stylus once for each count. The measurement information will be automatically
displayed on the Probe Information area of the dialog.

8. If you want to change these measurements, click on the Clear square (the square in the bottom left
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corner of the tablet).

9. When the Probe Information is correct, click on the Send square (the third from the left in the
bottom left corner of the tablet) or click on the Send button in the Probe Information area of the
Measure Takeoff dialog. The measurement entered (length or count), will be displayed in the value
box on the Measurement Information area of the dialog and the extended measurements will be
displayed in the quantity box on the Item Information area of the dialog.

10.When the Item Information is correct, click on the OK button or press [Enter] to finish the takeoff;
you will be returned to the Takeoff screen. The accepted takeoff will be displayed in the audit trail.

Tip - The extended measurement for an assembly may not be the same as the measurement you
entered, it will depend on the Fct 1 and Fct 2 settings established in your database.

GTCO Roll-Up II Configuration

Trimble estimating programs have designated the three squares in the bottom left corner of the tablet
to perform the following functions: Clear, Detach, Send. The single button on the Roll-Up II performs a
Count function.

1. Position the Custom Configuration Quick Reference Card (supplied with your GTCO Roll-Up II)
within the active area of the tablet.

2. Select 'P' in the SuperSet Configuration Menu.

3. Set the menu location by clicking the cursor or stylus on Point 1 and then again on Point 2.

The system will sound an alert ' beep' when the cursor or stylus is over the current setting in each
option group.

4. Depending on Options selected, some groups may be inactive. Click on the desired setting to
change (to cancel all changes, click in the active area outside the menu).

5. If you wish to recall the new configuration at a later date, a SuperSet code can be assigned by
selecting 'S' and a 2-digit number between 90 and 99. If a later recall will not be required, then
select 'P'.

Before you can use the GTCO Roll-Up II digitizer with your Trimble estimating program, you must be
set the following parameters correctly:

Communication options: 9600, 7, 1, even

Output Format Options: GTCO ASCII, Include Button, space, LF and CR.

Mode Options: Continuous Mode, Max rate, 1000 lpi resolution 
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LiveCount

Using LiveCount™, a takeoff tool sold separately by Trimble, you can quantify material directly from
engineering or architectural drawings saved in raster formats such as PDF or TIFF.

1. Set up LiveCount as your measuring device by selecting the Configure Probe option from the
Takeoff menu. From the Probe Options dialog that appears, click the Probe drop-down and select
LiveCount. Click OK.

2. Navigate the material database until you locate the item or assembly you wish to take off.

3. Double click the item or assembly you wish to take, or use the arrows on your keyboard to move
the highlight bar to the item or assembly and press [Enter].

4. The Measure Takeoff dialog displays, and the LiveCount program will be automatically opened
(unless you have disabled this feature from the Takeoff page of the Options dialog, in which case
you can click the ellipsis button in the Value field).

5. Within LiveCount, you must open an existing project or create a new one.

To create a new project, click the File menu and select Create New Project. You will be prompted
to select a folder for the project. This is the folder where the project’s drawing files are typically
stored. (You should store each project in a separate folder.) Next, you will be prompted to specify a
project description, and select the default scale, among other project properties. (For a complete
description of project properties, consult the LiveCount online help.)

To open an existing project, click the Project List button that appears to the right of the Current
Project field.

Current Project field and Project List

6. If you opened an existing project, any drawings associated with the project will be automatically
loaded, with the mostly recently used drawing in focus.

If you created a new project and allowed the Scan for Drawings checkbox to remain checked on the
Project Properties dialog, LiveCount will scan the project folder (and any subfolders) for drawings
and prompt you to add them to the project.

To switch between different drawings already associated with the project, click the Document List
button that appears to the right of the Current Document field and select from the list.

Current Document field and
Document List

7. If the New Measurement pointer  is not already active, click the New Measurement button

 on the measurement toolbar.

8. If prompted, select the scale for the drawing.
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9. If a standard trace corresponding to the system breakdown currently active in your Trimble
Estimating or ChangeOrder program is not found in LiveCount, you will be prompted to create it and
specify its properties. Traces are used to track different systems within LiveCount and determine
the color applied to takeoffs within the drawing. Separate traces are maintained for each
combination of system breakdown and measurement variable, using the following naming
convention:

<System>-<Variable>   (e.g. Switches-Count)

For more information on traces, consult the LiveCount online help.

10.Within the drawing, click on each of the objects to be counted, or click the boundaries of the
object to be measured, depending on the measurement variable of the material selected in your
Trimble Estimating or ChangeOrder program. (For example, if the measurement variable is Count,
you would click each of the objects to be counted; if the measurement is length, you would click
the boundaries of the object to be measured.)

11.Click the Return Quantity to Estimating button on the measurement toolbar to complete the
quantification.

The quantified object now appears highlighted using the color assigned to the selected trace. The
measurement or count appears in the Value column on the Measure Takeoff dialog in your Trimble
Estimating or ChangeOrder program.

12.If the material you are taking off uses multiple measurement variables, you can click the ellipsis
button beside the additional variables on the Measure Takeoff dialog to return to LiveCount and
quantify each variable.

13.When you are finished quantifying the measurement variables, click OK on the Measure Takeoff
dialog to complete the takeoff. The takeoff now appears in the audit trail with a value of LiveCount in
the Source column to indicate the takeoff's origin.

See also:

Modifying Takeoff Quantities Using LiveCount

Drilling Up to the Audit Trail From LiveCount
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Takeoff Quantities with LiveCount

With LiveCount™, you can modify existing takeoff quantities using engineering or architectural
drawings saved in raster formats such as PDF or TIFF. You can modify takeoff quantity even if the
takeoff was not originally performed using LiveCount.

1. With LiveCount still set up as your measuring device, double click the takeoff line from the Takeoff
screen’s audit trail. The components of the takeoff appears.

2. Double click any of the takeoff components.

3. From the Edit Takeoff dialog that appears, click the ellipsis button beside the variable you wish to
modify. Focus will now shift to LiveCount.

If the takeoff was originally performed using LiveCount, the corresponding measurement in
LiveCount will be automatically selected.

If the takeoff was not originally performed using LiveCount, you can use LiveCount to create a new
takeoff that will replace the existing takeoff quantity in your Trimble Estimating or ChangeOrder
program. For complete instructions, see Counting/Measuring Using LiveCount.

4. If you are modifying an existing LiveCount takeoff, you can click the following toolbar buttons on the
measurement toolbar to modify the length, count, or area:

 = Add points/objects

 = Add disconnected points

 = Edit points

 = Move/copy measurement

 = Add 2 point lines

(For more information on these buttons and the functions they represent, consult the LiveCount
online help.)

5. When you finished modifying the takeoff, click the Return Quantity to Estimating button . The
updated measurement or count appears in the Value column on the Measure Takeoff dialog in your
Trimble Estimating or ChangeOrder program.

6. Click OK to exit the Measure Takeoff dialog.

7. Select the Finish option from the Takeoff menu, or click on the Finish button  within the toolbar
to save the modified takeoff.

8. You will be prompted to specify a new takeoff description. To keep the existing description, click
OK or press the [Enter] key.
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See also:

Counting /Measuring Using LiveCount

Drilling Up to the Audit Trail From LiveCount
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Drill to the Audit Trail

You can "drill-up" from a measurement in LiveCount to the corresponding takeoff in your Trimble
Estimating or ChangeOrder program. The takeoff displays highlighted within the Takeoff screen's audit
trail.

To drill up from a LiveCount measurement to the corresponding takeoff in your Trimble Estimating or
ChangeOrder program:

1. Make sure that your Trimble Estimating or ChangeOrder program is running, and the job containing
the takeoff is open and in focus.

2. Within LiveCount, click the appropriate measurement to select it. If the Select Measurement

pointer  is not already active, click the Select Measurement button  on the measurement
toolbar.

3. Click the Drill-Up to Estimating button  on the measurement toolbar.

4. Focus will now shift to the Trimble Estimating or ChangeOrder program, and the corresponding
takeoff displays highlighted within the Takeoff screen's audit trail.

See also:

Counting /Measuring Using LiveCount

Modifying Takeoff Quantities Using LiveCount
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Modify Existing Takeoffs
After a takeoff is performed, it appears as a line within the audit trail on the right side of the Takeoff
screen. You can modify an existing takeoff at any time by adding components, changing quantities,
modifying the takeoff description, and reassigning takeoff breakdowns.

If a takeoff is based on a designation, you can modify only the takeoff quantity from the audit trail. To
add components to a designation, you must modify the designation itself. For more information on
modifying designations, see Modifying a Designation.

When you are finished modifying a takeoff, you must select the Finish Takeoff option from the Takeoff

menu, or click on the Finish button  within the toolbar, to save the modified takeoff and post it to
the audit trail.

When you finish the takeoff, you will be prompted to specify a new takeoff description. To keep the
existing description, click on OK or press the [Enter] key.

To discard the modifications you have made to a takeoff, select the Abort Takeoff option from the

Takeoff menu, or click on the Abort button  within the toolbar.

For more information on modifying existing takeoffs, click on the button beside one of the following
topics:

  Add Takeoff Components

  Takeoff Quantities

  Substitute Takeoff Items

  Substitute Assemblies

  Substitute Designations 

  Modify Takeoff Description

  Reassign Takeoff Breakdowns

  Remove Items

  Delete Takeoff

  Copy/Paste Takeoffs



276 - Classic Estimating Help Guide

Add TakeOff Components

There are two different ways you can add a component to an existing takeoff. The first method uses
the existing takeoff quantity, while the second requires you to specify a separate takeoff quantity for
the new component.

Add a Component (same quantity)

1. Double click the takeoff line from the Takeoff screen’s audit trail. The components of the takeoff
displays.

2. Double click any of the takeoff components from the list of takeoff components. The Edit Takeoff
dialog appears.

3. Click the Add button from the Edit Takeoff dialog. The Add Items dialog appears.

4. Navigate through the material database until you find the item you wish to add, or click the
Selection list box and switch to Common Assemblies to find an assembly to be added. After you
locate the item or assembly to be added, double click it.

5. Repeat step 4 for each component you wish to add. When you are finished, click the Close button
to return to the Edit Takeoff dialog.

By default, each item added is assigned a quantity equal to the takeoff length or count. If you wish to
increase the quantity, adjust the Fct 1 and Fct 2 columns accordingly. (The length or count is
multiplied by Fct 1, then the result is divided by Fct 2, to arrive at the quantity.)

6. Click OK to accept the changes and exit the Edit Takeoff dialog.

7. Select the Finish option from the Takeoff menu, or click the Finish button  from the toolbar to
save the modified takeoff.

8. When you finish the takeoff, you will be prompted to specify a new takeoff description. To keep the
existing description, click on OK or press the [Enter] key.

Add a Component (different quantity)

1. Double click the takeoff line from the Takeoff screen’s audit trail. The components of the takeoff
displays.

2. Navigate through the database on the left side of the Takeoff screen, until you find the item or
assembly you wish to add.

3. Double click the item or assembly you wish to add. The Measure Takeoff dialog appears. You can
measure the item or assembly using the keyboard or a probe.

4. After you measure the item or assembly, click the OK button to exit the Measure Takeoff dialog.
The new items or assemblies get added to the component list for this takeoff.

5. Select the Finish Takeoff option from the Takeoff menu, or click the Finish button  from the
toolbar to save the modified takeoff.
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When you finish the takeoff, you are prompted to specify a new takeoff description. To keep the
existing description, click OK or press the [Enter] key.
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Takeoff Quantities

1. Double click the takeoff line from the Takeoff screen’s audit trail. The components of the takeoff
displays.

2. Double click any of the takeoff components. The Edit Takeoff dialog appears.

3. If LiveCount is set up as your measuring device from the Probe Options dialog, ellipsis buttons
displays beside each measurement variable. Click the ellipsis button to shift focus to LiveCount,
which you can use to determine the takeoff quantity.

If LiveCount is not set up as your measuring device, click the Count or Length measurement
variable within the Measurement Information section of the Edit Takeoff dialog to change the
quantity of all components in the takeoff. Type in the new value and click the checkmark button or
press the [Enter] key on your keyboard. All components of the takeoff related to this measurement
are adjusted to reflect the new value.

To change the quantity of a single component in the takeoff, click the appropriate Quantity cell
within the Item Information area of the dialog. Type in the new value and click the checkmark button
or press the [Enter] key.

4. Click OK to accept the change and exit the Edit Takeoff dialog.

5. Select the Finish option from the Takeoff menu, or click on the Finish button  within the toolbar
to save the modified takeoff.

When you finish the takeoff, you are prompted to specify a new takeoff description. To keep the
existing description, click OK or press the [Enter] key.
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Substitute Takeoff Items

Not available in PowerBid

After performing a takeoff, you can substitute a specific item in a group of existing takeoffs with a
different item. The existing takeoffs can consist of items, assemblies, or a combination of both. You
can substitute an item with a temporary item.

This feature is especially useful if you need to change a material component after the job has been
taken off, since it allows you to substitute material in your existing takeoffs without having to delete or
add takeoffs.

1. Proceed to the Takeoff screen.

2. Select the takeoff(s) you wish to modify. To select a range of takeoffs, click the first takeoff
description, hold down the button and drag the pointer over the other takeoff descriptions in the
range. To select non-consecutive takeoffs, hold down the [Ctrl] key and click on each of the takeoffs
to be selected. To select all takeoffs in the current audit trail, click the Audit Trail column heading.

3. Click the Takeoff menu and select the Substitute Items option. Alternatively, you could right click
over one of the selected takeoffs and select Substitute Items from the pop-menu that appears.

4. The Item Substitution dialog appears, showing two copies of the Item Database. The left side
(From) is where the existing items to be replaced will be displayed, and the right side (To) is where
the new items that are intended to replace the existing items will be displayed. If you want to
replace only temporary items rather than database items, you can click the Item Type list box on
the From list and switch from Item Database to Temporary Items. Similarly, if you want to replace
existing items with temporary items, click the Item Type list on the To side and switch to
Temporary Items. 

In the top left corner of this dialog, the Range defaults to Selected Takeoffs (Excluding
Designations). You can change the range of takeoffs to be substituted from this to All Takeoffs
(Excluding Designations), All Designations, or All Takeoffs & Designations.

On the left side of the Item Substitution dialog, double click the categories until you locate the
items to be replaced.

5. Select one or more items you want to replace within the selected takeoffs. To select a single item,
click the item. To select multiple items, hold down your left mouse button and drag your pointer
over the appropriate items, then release your mouse button. A range of items should now appear
highlighted.

6. On the right side of the screen, double click on categories until you locate the items to be used in
place of the existing items.

7. Select the item(s) you want to use in place of the existing items. If you select more than 1 item on
the left side of the screen, you must select the same number on the right.

Tip - You cannot select the same item on both sides of the screen. If you do so, an error
message displays.

8. Click Substitute and the items will be replaced within the appropriate takeoffs.
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9. Click Close to exit the Item Substitution dialog.

Tip - You cannot substitute items within takeoffs that are based on designations. Instead, you can
substitute items within the designation itself, thereby modifying all takeoffs based on the designation.
To substitute items within a designation, click the designation from the designation list on the left side
of the Takeoff screen, then select the Substitute Items option from the Takeoff menu.
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Substitute Assemblies

Not available in PowerBid

After performing a takeoff, you can substitute a common assembly for a different assembly within a
group of existing takeoffs. This feature is especially useful if you need to change a material
component after the job has been taken off, since it allows you to substitute material in your existing
takeoffs without having to delete or add takeoffs.

1. Proceed to the Takeoff screen.

2. Select the takeoff(s) you wish to modify. To select a range of takeoffs, click the first takeoff
description, hold down the button and drag the pointer over the other takeoff descriptions in the
range. To select non-consecutive takeoffs, hold down the [Ctrl] key and click on each of the takeoffs
to be selected. To select all takeoffs in the current audit trail, click the Audit Trail column heading.

3. Click the Takeoff menu and select the Substitute Assemblies option. Alternatively, you could right
click over one of the selected takeoffs and select Substitute Assemblies from the pop-menu that
appears.

4. The Common Assembly Substitution dialog appears, showing two copies of the Common
Assemblies database. The left side (From) is where the existing assemblies to be replaced will be
displayed, and the right side (To) is where the new assemblies that are intended to replace the
existing assemblies will be displayed.

Select the assemblies you want to replace within the selected takeoffs. To select a single
assembly, click the assembly. To select multiple assemblies, hold down your left mouse button
and drag your pointer over the appropriate assemblies, then release your mouse button. A range of
assemblies should now appear highlighted.

5. On the right side of the screen, double click on categories until you locate the assemblies to be
used in place of the existing assemblies.

6. Select the assemblies you want to use in place of the existing items. If you select more than 1
assembly on the left side of the screen, you must select the same number on the right.

Tip - You cannot select the same assembly on both sides of the screen. If you do so, an error
message displays.

7. Click the Substitute button and the selected assemblies will be replaced in all the selected
takeoffs.

8. Click Close to exit the Common Assembly Substitution dialog.

Tip - You can only substitute assemblies taken off from Common Assemblies. You cannot
substitute assemblies within a designation.
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Substitute Designations

Not available in PowerBid

After performing a takeoff, you can substitute designation for a different designation within a group of
existing takeoffs. This feature is especially useful if you need to change a material component after
the job has been taken off, since it allows you to substitute material in your existing takeoffs without
having to delete or add takeoffs.

1. Proceed to the Takeoff screen.

2. Select the takeoff(s) you wish to modify. To select a range of takeoffs, click the first takeoff
description, hold down the button and drag the pointer over the other takeoff descriptions in the
range. To select non-consecutive takeoffs, hold down the [Ctrl] key and click on each of the takeoffs
to be selected. To select all takeoffs in the current audit trail, click the Audit Trail column heading.

3. Click the Takeoff menu and select the Substitute Designation option. Alternatively, you could right
click over one of the selected takeoffs and select Substitute Designation from the pop-menu that
appears.

4. The Designation Substitution dialog appears, showing two copies of the Designation database. The
left side (From) is where the existing designations to be replaced will be displayed, and the right
side (To) is where the new designations that are intended to replace the existing designations will
be displayed.

Select the designations you want to replace within the selected takeoffs. To select a single
assembly, click the assembly. To select multiple designations, hold down your left mouse button
and drag your pointer over the appropriate designations, then release your mouse button. A range
of designations should now appear highlighted.

5. On the right side of the screen, double click on categories until you locate the designations to be
used in place of the existing designations .

6. Select the designations you want to use in place of the existing designations. If you select more
than 1 designation on the left side of the screen, you must select the same number on the right.

Tip - You cannot select the same designation on both sides of the screen. If you do so, an
error message displays.

7. Click the Substitute button and the selected designations will be replaced in all the selected
takeoffs.

8. Click Close to exit the Designation Substitution dialog.
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Power Substitutions

Pro only

Power Substitution is an advanced takeoff item replacement feature that allows users to not only
substitute one item for another but to also replace any related components at the same time. For
example, if you wished to swap 1/2" EMT to #12/2C MC cable, power substitution can automatically
change the straps and hangers to match the new cable and conduit  they support. In this case, the
power substitution would also automatically resize the conduit and change the quantities, counts and
lengths of all the items associated with the takeoff.

You begin the Power Substitution process by selecting a Category, a From and To Material type and
one or more Sizes. Power Substitution then submits each group to examination at three degrees of
detail to determine if the items within the group match against the items in the selected takeoffs. For
more information, see the Power Substitution Process.

To determine if the items in the selected takeoffs match the items in the tables of the substitution
sets, Power Substitution uses five sets of rules. For more information, see Power Substitution Rules.

1. Proceed to the Takeoff screen.

2. Within the audit trail, highlight the range of takeoffs you wish to modify. To do this, click within your
left mouse on the first takeoff description, then hold down your button and drag the mouse pointer
over the other takeoff descriptions in the range. If the takeoffs you wish to select do not appear one
after another, you could filter the audit trail to narrow down the takeoffs being displayed. If you want
to change all takeoffs in the current audit trail, click the Audit Trail column heading.

3. Click the Takeoff menu and select the Power Substitution option. Alternatively, you could right click
over one of the selected takeoffs and select Power Substitution  from the pop-menu that appears.

4. The Power Substitution dialog appears.

5. If you have not previously created a Power Substitution set, or if you wish to create a new Power
Substitution set, click the Setup button to proceed to the Power Substitution Setup dialog.

6. From the Power Substitution dialog, you may select a Category, a From material type, and a To
material type and one or more Sizes.

7. Select a category, a From group of items that will be replaced, a To set of items that will do the
replacing, and at least one size (using the associated checkbox, or by clicking the Select All
button).

8. One you have made your selections, click Substitute to submit each group for examination at three
degrees of detail to determine if the items within the group match against the items in the selected
takeoffs.

If you wish to view notes that you have previously entered (on the Notes page) describing the
selected Power Substitution set, click the View Notes button.

9. Click Close to exit the Power Substitution dialog.

To speed up the Power Substitution process, you create Power Substitution sets in which the items



284 - Classic Estimating Help Guide

to be swapped are already defined. To organize the different Power Substitution sets, you can create
one or more categories, and then within each category, you can create one or more groups (from the
Groups page of the Power Substitution Setup dialog). For more information, see Creating Power
Substitution Sets.
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Power Substitution Sets

Power Substitution is an advanced takeoff item replacement feature that allows users to not only
substitute one item for another but to also replace any related components at the same time. For
more information, see Performing a Power Substitution.

To speed up the Power Substitution process, you create Power Substitution sets in which the items
to be swapped are already defined. To organize the different Power Substitution sets, you can create
one or more categories, and then within each category, you can create one or more groups (from the 
Groups page of the Power Substitution Setup dialog).

You can then organize Power Substitution sets within each group by material and size. You can
create one or more material labels from the Materials page, and one or more size labels from the
Sizes page.

From the Items page of the Power Substitution Setup dialog, you specify the actual database items to
be swapped. For each combination of size, From material, and To material labels you select, you can
specify the database items to be replaced and the database items to be used in their place.

When the Power Substitution takes place, each database item in the From list will be replaced by the
item in the corresponding row in the To list.

You can change the order in which substitution items are displayed in the From and To areas. To do
this, select a row in the From or To area, then click the Move Up or Move Down button. You can
delete an item in the From or To areas. To do this, select a row in the From or To area, then click the
Delete button.

You can leave space for a new, unmatched substitution item to be added during your Power
Substitution. To do this, select an unused row in the From area, then click the "add item" button. This
creates a blank item in the Substitution Set that will be replaced by the item in the corresponding row
of the To area.

You can remove a substitution item from your Substitution set without replacing it. To do this, select
an unused row in the To area, then click the "remove item" button. This instructs the substitution set
to remove the item in the corresponding row of the From area, and not replace it with a new item.

You can save all of the information in your substitution set. To do this, click the Save Substitution Set
button. 
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Power Substitution Process

Power Substitution is an advanced takeoff item replacement feature that allows users to not only
substitute one item for another but to also replace any related components at the same time. For
more information, see Performing a Power Substitution.

You begin the Power Substitution process by selecting a Category, a From and To Material type and
one or more Sizes. Power Substitution then submits each group to examination at three degrees of
detail to determine if the items within the group match against the items in the selected takeoffs.

The three degrees of detail are:

The individual items within each substitution set as measured by the Item Criteria and Item
Occurrence rules.

The items within each substitution set as a group as measured by the Item Matching and Group
Action rules.

The groups on any given level as measured by the Children Matching rules for the levels below it.

The process starts at the groups level and progressively works its way down towards the groups at
the lowest level systematically determining the status of the items in each group individually and then
the status for each group individually. The results for each group are passed back to their respective
parent group and tested against the parent’s rules. This process returns to the groups level to
determine the overall outcome. The overall result must be TRUE for the substitution to occur.

The relationship between groups and child objects works on the same principle as that of categories
and sub-categories within the materials database. Where Level 1 categories contain general
information, Level 2 categories contain specific information, leading to Level 3 categories containing
very specific information, lastly leading to Level 4 the item level.

In Power Substitution terms:

If there are 2 groups,

Parent Objects = Categories (Level 1)

Child Objects = Sub-Categories (Level 2)

If there are 3 groups,

Parent Objects = Categories (Level 1 and Level 2)

Child Objects = Sub-Categories (Level 2 and Level 3)

To understand the above examples, think of the hierarchy structure in the materials database. Conduit
& Fittings (Level 1) is a parent to all the (Level 2) sub-categories that are contained inside it, such as
EMT, PVC, IMC; these are child objects to Conduit & Fittings. They in turn are parents to other more
specific sub-categories such as EMT CONDUIT, CONDUIT BODIES which are child objects to EMT.

To determine if the items in the selected takeoffs match the items in the tables of the substitution
sets, Power Substitution uses five sets of rules. For more information, see Power Substitution Rules.
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Power Substitution Rules

To determine if the items in the selected takeoffs match the items in the tables of the substitution
sets, Power Substitution uses five sets of rules. Four of these rules work together to look at the
individual group and the items within the group. These are Item Criteria, Item Occurrence, Item
Matching, and Group Action. Together these produce a TRUE or FALSE result.

Only if the first four rules produce a TRUE result will the fifth rule be examined. This rule is Children
Matching and it looks at the groups on the level below the current group to establish a second TRUE
result or a FALSE result.

Each group must achieve two TRUE results. At the end of the entire process, only the items that are
marked as matched with a TRUE path from top to bottom will actually be substituted.

Item Criteria: Group Rule #1

Each line of the From tables in the Substitution Sets has 4 cells defining the variables that may be
found in the takeoffs.

The variables are:

The item itself – is it in the takeoff?

The Based On setting used in the takeoff

The Fct1 and Fct2 values used in the takeoff

The Item Criteria rules determine how many of the variables must be tested to determine if any given
item in the takeoff matches an item in the From table of the substitution set. How many of the items
in the From table are tested is predetermined by the Item Matching rules for the entire group.

 Match Item Only

The item must be found in the takeoff but it does not matter if the Based On setting (Len, Cnt, or
Abs) or the Fct1 or Fct2 values in the takeoff do not match the setting and values in the From table
of the substitution set.

This is the simplest and probably the most common test that will be used.

When items are substituted, the Based On setting and Fct1 and Fct2 values as found in the takeoff
will be retained – the values shown in the To table of the substitution set will be ignored.

Match Item & Based On

The item must be found in the takeoff and must have the same Based On setting (Len, Cnt, or Abs)
as the From table of the substitution set but the Fct1 and Fct2 values are irrelevant.

This may be used when searching for items that may be present in the takeoff more than once with
different settings (such as Wire by Len and Cnt or Couplings by Len and Abs) and you want to
change only one instance of the item.

Typically, the item may be substituted but the Based On setting would remain the same since the
Fct1 and Fct2 values as found in the takeoff are retained. Changing the Based On setting without
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also changing the Fct1 and Fct2 values would make little sense unless the Based On setting was
simply wrong in the takeoff.

Match Item, Based On, & Factors

The item must be found in the takeoff and must have the same Based On setting and the same
Fct1 and Fct2 values as the From table of the substitution set.

This is a very specific search and will not be used as frequently.

Two examples would be:

Searching for couplings and elbows based on Abs and with a Fct1 of 3.0 so that you can change
them to a Fct 1 of 2.0.

Searching for cables based on Cnt with a Fct1 of 150.0 and Fct2 of 1.0 so that you can change the
Fct1 to 165.0.

 Item Occurrence: Group Rule #2

The Item Occurrence rules work in tandem with the Item Criteria rules. They might be better described
as application rules since they do not test the items from the takeoff. They determine how many
instances of the item found in the takeoff should be marked as matched subject to the Item Matching
Group Action rules.

Once

If the item is found in the takeoff multiple times only the first matching occurrence of the item will be
marked as matched.

For example, a certain wire is found in a takeoff based on Len and then again based on Cnt and the
applicable Item Criteria rule is Match Item Only. In this instance, only the first match (based on
Len) will be marked as matched.

Multiple times

If the item is found in the takeoff multiple times, then all of the matching occurrences of the item will
be marked as matched.

Using the example above, both occurrences would be marked as matched since they meet the
rules.

This would be used most commonly when Item Criteria is set to Match Item Only.

 Item Matching: Group Rule #3

Item matching determines how many items in the From table of a substitution set must match with
items in the takeoff as determined by the Item Criteria and Occurrences rules. The Group Action rules
will influence whether items are marked as matched.

Any One Item Must Match

One item in the From table of the substitution set that has met the Item Criteria rules must match.
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Once a matching item is found in the takeoff, the search stops.

Only the item that matches first will be marked as matched.

If the item occurs multiple times in the takeoff and the Item Occurrence rule is set to Multiple
Times, then all occurrences of the item will be marked as matched.

Any other items in the From table of the substitution set that might match with takeoff items will be
ignored, except for “add items” immediately below the first matched item.

Typically used where items in the table, by their nature, are mutually exclusive.

Examples:

½” 1-Hole Strap, ½” 2-Hole Strap, ½” Strut Clamp

½” 1-Hole Strap, ¾” 1-Hole Strap, 1” 1-Hole Strap

In these examples, the takeoff should have one of the items but it would be unseemly to have more
than one of them.

Any One or More Items Must Match

One item in the From table of the substitution set must match.

Search will look at all items in the table and all items that match will be marked as matched.

Typically the items in the table will be variations of a type of item such as single gang plastic device
plates where we might list toggle switch, single receptacle, duplex receptacle, and blank plates.

This is the most generic matching rule and will be widely used.

All Items Must Match

All of the items in the From table of the substitution set must match.

If it finds one that doesn’t match, none of the items are marked as matched.

Typically used with only one or two items in the table. Otherwise, the chances of achieving
matches are substantially reduced.

First Item Must and Any Other Items May Match

This is a more specific variation on the Any One or More Items Must Match rule.

The first item in the From table of the Substitution Set must match.

If the first item is matched then the search will look at all other items in the table and additional
items that match will be marked as matched as well.

Typically this would be used when the first item serves as a unique identifier for the type of takeoffs
and the subsequent items are variables that may be present with that unique item.

For example, you need to change from #12 THHN Solid to #12 THHN Stranded but only if there is a
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#14 THHN Green wire present. You test for the presence of the #14 THHN Green first and then look
for the #12 THHN Solid.

Group Action: Group Rule #4

The Group Action rules are application rules. They provide the direction as to what should be done
with the items that have been identified as matches by the Item Criteria, Occurrence, and Matching
rules.

At this point, we establish whether the group has a TRUE or FALSE result as it relates to the items
within the group.

Replace if Matched (Match & Replace)

If the items in the group have met the requirements as dictated by the Item Matching and Item Criteria
rules for the group, this is considered to be a TRUE result. Thus, the items in the takeoff that have
been matched will be marked as matched and will be substituted if the overall result for this group
proves TRUE.

Continue if Matched (Match Only)

If the items in the group have met the requirements as dictated by the Item Matching and Item
Criteria rules for the group, this is considered to be a TRUE result. However, the items that have
been matched will not be marked as matched since they are not to be substituted even if the overall
result proves TRUE.

In this application, the group is being used to test for the existence of items in the takeoff that meet
the criteria. If so, then the sub-group(s) will provide the tests for the items that should be substituted
if the overall result proves TRUE.

Typically this rule would be used to short-cut the testing process by eliminating takeoffs that do not
contain certain items. For example, if there is #12 THHN in a takeoff, it will be necessary to do
additional testing if the intent is to change the conduit and wire to MC or Bx cable. If there is no #12
THHN, there is no need to test any further.

Continue if Not Matched (Match & Abort)

Essentially this works in the opposite way as the Continue if Matched rule.

If the items in the group do not meet the tests for the group, this is considered to be a TRUE result.
By extension, no substitutions would take place since no items in the takeoff matched.

This also would be used to short-cut the testing process. For example, you want to change the
fittings for any empty conduits. You might test for any THHN wire in a takeoff. If it is not there, it
may be reasonable to assume that it is an empty conduit. If it is, there is no need to continue the
process.

Disabled

At the Groups level, the Group Action automatically displays as Disabled. As well, the Item
Matching, Item Criteria, and Item Occurrence boxes are grayed out.

It is theoretically possible to use this setting for a group at any other level but no testing of the
items will be done. In effect, the group becomes a placeholder and the only testing is for Children
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Matching.

Children Matching: Group Rule # 5

Children Matching for any group is done only if the substitution set for that group has met all the given
tests and has produced a TRUE result in accordance with the Group Action rules. Children Matching
looks at results for the sub-groups below the current group to determine the final TRUE or FALSE
result for the current group. This process is repeated all the way back to the Groups level. Groups
must be TRUE for the substitution to take place.

Match One Child

If the group has no children, the result will be FALSE.

One child must match for result to be TRUE.

Once a matching child is found search stops.

Only the items in the group and sub-groups controlled by child that matches first will be substituted
subject to all other rules.

Any other children that might match will be ignored.

Typically used where children, by their nature, are mutually exclusive.

Match One or More Children

If the group has no children, the result will be FALSE.

One child must match for result to be TRUE.

Search will look at all children and the items in the groups and sub-groups controlled by the
additional children that match will be substituted as well, subject to all other rules.

Match All Children

If the group has no children, the result will be FALSE.

All of the children must match for result to be TRUE.

Match Zero or One Child

The group will always return a result of TRUE.

Search will look at the children and will substitute the first sub-group that has a TRUE result and
then stop.

Match Zero or More Children

The group will always return a result of TRUE.

Search will look at children and substitute all sub-groups that have a TRUE result.

Match No Children
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The group will always return a result of TRUE.

All groups at Level 4 are automatically set to this rule and the drop-down list box is disabled.

At any other level, the result is TRUE but none of the children below the current group will be
substituted.
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Modify Takeoff Description

If you need to change a Takeoff description in the audit trail (perhaps to create a Feeder schedule),
you can edit the takeoff description directly. Simply highlight the current description and choose the 
Rename option from the Takeoff menu, or click with your right mouse button over the description and
select Rename. From the Modify Takeoff Description dialog that appears, you can make any changes
that are necessary. To keep the existing description, click OK or press the [Enter] key.
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Reassign Takeoff Breakdowns

If you assign a takeoff to the wrong takeoff breakdown, you can, at any time, easily change the
breakdown settings. You can reassign one takeoff at a time, or multiple takeoffs at the same time.

Reassign single takeoff

1. Double click the takeoff you wish to reassign from the Takeoff screen’s audit trail. A list of takeoff
components appears.

2. Click the description of the current assigned job, drawing, area, phase, system, bid item, or labor
factor. (Click on the appropriate description, not on the Job, Drawing, Area, Phase, System, Bid
Item, or Lb Factor buttons.)

3. Select the one you wish to use from the list of available breakdown descriptions.

4. Select the Finish Takeoff option from the Takeoff menu, or click the Finish button from the
toolbar to save the modified takeoff.

When you finish the takeoff, you are prompted to specify a new takeoff description. To keep the
existing description, click OK or press the [Enter] key.

Tip - To see the result of the reassignment, set the audit trail filter to the breakdown being
reassigned. For example, if a takeoff is being reassigned to a different Phase option then set the audit
trail filter to Phase. The takeoff will disappear after you click the Finish Takeoff option, and the takeoff
can be viewed by selecting the breakdown option to which the takeoff was reassigned. For more
information, see Filtering the Audit Trail.

Reassign several takeoffs

1. Highlight the takeoffs you wish to reassign from the Takeoff screen’s audit trail. To select a range of
takeoffs, click the first takeoff description, hold down the button and drag the pointer over the other
takeoff descriptions in the range. To select non-consecutive takeoffs, hold down the [Ctrl] key and
click on each of the takeoffs to be selected. To select all takeoffs in the current audit trail, click the
Audit Trail column heading.

2. Click the Takeoff menu and select the Change Breakdown option, or click with your right mouse
button and select Change Breakdown. The Change Breakdown dialog appears.

3. Click the description of the breakdown you want to change and a drop down menu with the valid
choices will be displayed. Click the desired choice.

4. Click OK to save your changes and exit the Change Breakdown dialog. The modified takeoffs are
automatically saved; you do not need to click the Finish button or select the Finish option.
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Remove Items

You can remove individual items from a takeoff after the takeoff is finished. If you are taking off an
assembly, removing an item from the takeoff does not affect the assembly as it is stored within the
material database. You cannot delete all the items in a takeoff. You can, however, delete the entire
takeoff. For more information, see Deleting a Takeoff .

There are two ways to remove an item from a takeoff, one which allows the deleted item to be easily
restored to the takeoff, and one which permanently removes the item from the takeoff.

Permanent Removal

1. Double click the takeoff line within the Takeoff screen’s audit trail. The components of the takeoff
will be displayed.

2. From the list of takeoff components, double click on any of the items. The Edit Takeoff dialog
appears.

3. Click in the Item Information area on the item to be removed.

4. Click the Delete button.

5. Click OK to accept the change and exit the Edit Takeoff dialog.

6. To save the modified takeoff, select the Finish option from the Takeoff menu, or click on the Finish
button from the toolbar. You will be prompted to specify a new takeoff description. To keep the
existing description, click OK or press the [Enter] key.

Temporary Removal (available to re-add later)

1. Double click on the takeoff line within the Takeoff screen’s audit trail. The components of the takeoff
will be displayed.

2. Within the list of takeoff components, click on the item you wish to remove. The item should now
appear highlighted.

3. Select the Delete option from the Edit menu. Alternatively, you could click on the Delete button
within the toolbar, or press the [Delete] key on your keyboard. The item now appears grayed and
crossed out. You can restore the deleted takeoff item by clicking on the Delete option or button
again. You can restore the deleted item in this way at any point in the future, even after you have
closed the program and shut down your computer.

4. To save the modified takeoff, select the Finish option from the Takeoff menu, or click on the Finish
button within the toolbar. You will be prompted to specify a new takeoff description. To keep the
existing description, click on OK or press the [Enter] key.
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Copy/Paste Takeoffs

You can copy and paste takeoffs between jobs, or within a job. Using the Copy and Paste options
available from the Edit menu, you can create a duplicate category, item or assembly in a different
location in the same job, or in a different job. After you have copied a takeoff, you can modify either
the copy or the original takeoff without affecting the other.

To copy and paste one or more takeoffs:

1. Select one or more takeoffs you wish to copy from the audit trail in the lower right portion of the
Takeoff screen. To select a single takeoff, click the takeoff. To select multiple takeoffs, hold down
your left mouse button and drag your pointer over the appropriate takeoffs, then release your mouse
button. A range of takeoffs should now appear highlighted.

2. Click the Copy button within the toolbar, or select the Copy option from the Edit menu, or click
with your right mouse button and select Copy from the pop-up menu that appears.

The selected takeoff(s) are copied to the Windows clipboard, but still remain in their current
location. You can now switch to a different breakdown or to a different job where you wish to paste
the copied takeoffs.

3. Click the audit trail and select the Paste option from the Edit menu or click on the Paste button

,or click with your right mouse button and select Paste from the pop-up menu after you have
switched to the appropriate breakdown. The Paste Takeoffs dialog appears.

If you are pasting into an audit trail that uses a different breakdown, you can use this dialog to control
whether the takeoff retains its original breakdown setting. If a check mark does not appear beside a
particular breakdown category, then the current audit trail breakdown for that category will be used. If
you are copying between two jobs and choose to retain the takeoff’s current breakdown settings, the
program creates any breakdown settings not found in the second job.

The selected takeoff(s) are added to the bottom of the appropriate audit trails.
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Delete Takeoff

1. Click the appropriate takeoff within the audit trail list. To select multiple takeoffs, hold down the [Ctrl]
key and click on each of the takeoffs to be selected.

2. Select the Delete option from the Edit menu. Alternatively, you could click the Delete button from
the toolbar, or press the [Delete] key on your keyboard.

When you delete a takeoff entry from the audit trail list, the takeoff remains in the list but appears
grayed and crossed out.

Deleted takeoff

You can restore the deleted takeoff by clicking on the Delete option or button again. You can restore
the deleted takeoff in this way at any point in the future, even after you have closed the program and
shut down your computer.

You can control whether deleted takeoffs are displayed within the audit trail by selecting or
deselecting the Show Deleted Takeoffs check box.
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C H A P T E R 6
Extension

When you display the Extension screen, the program reads the takeoffs, sorts the items by the
takeoff breakdowns, consolidates item totals and applies the item prices and labor units from the
currently assigned database. This information appears in a spreadsheet format.

Initially, the Extension screen appears in consolidated view with combined totals for each item. To
switch to the expanded view, so you can view the takeoff quantities for a particular item, double click
the row displaying the item. You can also double click on an assembly entry to display quantities and
prices for each item in that assembly. For return to the consolidated view, select Collapse from the
Extension menu.

By default, the extension is grouped by item. You can also group the extension by system, drawing,
phase, labor factor, sort codes, or unit price. When the extension is grouped by item, you can edit the
item description, price, material unit of measure, discount, net cost, labor, labor unit of measure,
material condition, and labor condition. To change item quantities from the Extension screen, double
click the row heading (the number on the far left) of the consolidated item to display the expanded
view. From the expanded view, you can modify the item quantity for each takeoff (except those
performed using a typical or a designation).

You can also filter the extension so that it displays only those items that match the conditions you
specify.

You can save the filter and grouping settings that you apply to the extension as a "view", which you
can select from a list of saved views. This allows you to create multiple views that you can quickly
switch between. For more information, see Working with Views.

(Pro and BidWinner Plus only) If you have switched from the default bid summary to another bid
summary, then only those items that have been assigned to breakdowns included within the current
bid summary are displayed. For more information on multiple bid summaries, see Using Alternate Bid
Summaries.

If you make changes to the currently assigned database, you must re-extend the job in order for the
changes to be reflected on the Extension screen. Re-extending the job normally reverses any
changes you have manually made to the portion of the extension you are re-extending, except
changes made to description or quantity. For example, if you modify labor, you can re-extend and
update prices without losing the modifications you have made to labor. You can, however, select cells
within the Net Cost column and lock them so that your changes are not lost when the job is re-
extended.

For more information on using the Extension screen, click the button beside one of the following
topics:
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  Editing the Extension

  Grouping the Job Extension

  Calculating a Unit Price

  Filtering the Extension

  Controlling Rounding of Takeoff Quantities

  Re-extending the Extension

  Exporting the Extension

  Extension Screen
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Edit Extension
After extending a job, the items for the job are listed on the Extension screen in a spreadsheet format.
Initially, the Extension screen appears in consolidated view with combined totals for each item. To
switch to the expanded view, so you can view the takeoff quantities for a particular item, double click
the row displaying the item. You can also double click on an assembly entry to display quantities and
prices for each item in that assembly. For return to the consolidated view, select Collapse from the
Extension menu.

When the extension is grouped by item, you can edit the Description, Price, Unit, Discount, Net Cost,
Material Adjustment, Labor, Labor Unit, Material Condition, Labor Condition, Manufacturer Name,
Catalog Number, Price Code, Reference, Supplier Name, and Supplier Code. Manual changes to
extension cell values are now automatically flagged by a change in text color. If you wish to change
the Quantity, you must first double click the row heading (the number on the far left) of the
consolidated item to display the expanded view. From the expanded view, you can modify only the
item quantity.

Tip - Within the extension, you cannot modify the item quantity for takeoffs that are based on
typicals.

Pro and BidWinner Plus ONLY:  If you have switched from the default bid summary to a different bid
summary option, you can edit the item quantity from the expanded view, but you cannot modify any
information from the consolidated item view. For more information, see Creating Multiple Bid
Summaries.

When the extension is grouped by system, area, drawing, phase, location, or labor factor, you can
double click the row heading of an entry (the number on the far left) to display the extended items
within the system, area, drawing, phase, location, or labor factor. If you have grouped the extension
by unit price, you can double click on the row heading of any takeoff to display quantities and prices
for each item that makes up the unit price.

All changes, except changes to quantity and description, can be easily reversed by re-extending the
job using the Re-Extend option (available from the Extension menu). When you re-extend, you
indicate whether you wish to update the price, discounts, labor, or sort codes with the original
database information.

You can also add a takeoff item from the extension. The item is automatically added to the temporary
items list.

Edit Takeoff Item

To change the Description, Price, Unit, Discount, Net Price, Material Adjustment, Labor, Labor Unit,
Material Condition, Labor Condition, Manufacturer Name, Catalog Number, Price Code, Reference,
Supplier Name, or Supplier Code:

1. Make sure the extension is grouped by item. For more information, see Grouping the Extension.

2. Click the cell you want to change. The selected cell is highlighted.

3. Depending on the cell, either type in the new value or the select the new value from the drop-down
list.
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4. Press the [Enter] key to complete the change.

When you modify the Price field, the Date field is automatically set to the current date.

Change Item Quantity

From the expanded view, you can change the quantity for an item. If the item forms part of an
assembly, the assembly quantity and the quantity of the other items in the assembly will not be
affected.

To change the Quantity:

1. Double click the row heading (the number on the far left) of the item whose quantity you wish to
change. The individual takeoff information appears.

2. Click the takeoff quantity you want to change. The selected cell is highlighted.

3. Type in the new value.

4. Press the [Enter] key to complete the change.

Modify Multiple Items

To quickly change values in an entire row or column:

1. Click the row heading (the number on the far left), or the heading at the top of the column. The row
or column becomes highlighted.

2. Type the value you wish to appear in the first cell in that row or column, then press [Enter]. The first
cell gets updated, and the next cell in the row or column becomes active.

3. Repeat step 2 until you have completed making your desired changes.

Apply Same Value to a Range of Cells:

1. Click the value if the value you want to use already appears at the beginning of the range of cells.
Otherwise, click the first cell you want to change.

2. Drag the mouse up or down over the other cells you want set to the same value. You can select
any number of cells within the same column.

3. Type the value you want to use if the value you want to use doesn’t already appear in the first cell
of the range.

4. Press the [Enter] key. The first cell has been updated.

5. Click the Edit menu and select the Fill option. All cells within the highlighted column will be
replaced by the value you assigned to the first cell.

Add Takeoff Items

From the Extension screen, you can add a new takeoff item. The item you are taking off is
automatically added to the temporary item list and to the audit trail on the Takeoff screen.
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1. Make sure the extension is grouped by item. For more information, see Grouping the Job
Extension . You must also be displaying the consolidated item view, rather than the expanded
view, and must have the default bid summary selected (Pro and BidWinner Plus only).

2. Select the Add Item option from the Extension menu. The Add Extension Item dialog appears.

3. Provide a description for the new item, specify the quantity, and select the breakdowns to use for
the takeoff. Click OK to add the takeoff. The takeoff now appears at the bottom of the extension.
You can now modify the description, price, unit, discount, net cost, labor, labor unit, material
condition, and labor condition for the new item.

4. Click the appropriate cell, then type in the new value and press [Enter] to complete the change.

5. Double click on the row heading of the new takeoff to display the expanded view for this item. From
the expanded view, you can modify the quantity for this item. To do so, click the Qty cell, then type
in the new value and press [Enter] to complete the change.
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Group Extension
Initially, the Extension screen displays a consolidated material list showing the quantity and price for
each individual item. You can, however, also group the extension by system, area, drawing, phase,
location, labor factor, sort codes, or unit price (depending on which Trimble estimating program you
are using).

Grouping by system, area, drawing, phase, location, or labor factor allows you to view total material
costs and labor hours for each system, area, drawing, phase, location, or labor factor. You can double
click the row heading (the number on the far left) of an entry to display the extended items within that
breakdown. Grouping by unit price allows you to view total costs and labor hours for each takeoff in
your audit trail. You can double click the row heading of an assembly takeoff entry to display
quantities and prices for each item in the assembly.

When the Extension screen is grouped by unit price, it includes columns for entering material tax,
labor rate, job expense percentage, markup percentage, and number of units. Using the Unit Price
screen, you can calculate a unit price for any of your takeoffs. For more information, see Calculating a
Unit Price.

You can save a particular extension grouping, along with a particular extension filter, as a "view",
which can be selected from a list of saved views. The view will be in effect until you select a different
view, clear the view, or override the view by applying a quick view. For information on creating and
selecting views, see Working with Views.

The last selected view is automatically applied the next time you open the job. If you override a saved
view with a quick view, the extension will be displayed using the unfiltered and ungrouped
consolidated view the next time you open the job.

To group the extension without creating a view:

1. Click the Extension menu heading and select the Group option. Alternatively, you can click the

Group button  within the toolbar.

2. The Quick View dialog appears, displaying the Group page. From here, double click the appropriate
group option from the left side of the Group page. Alternatively, you could single click the option,
then click on the Add button. You can group the extension by item, system, drawing, area, phase,
location, labor factor, sort codes, or unit price, or any combination of these criteria in any order.

The order in which the options appear on the right side of the dialog determine the order in which
the extension items are grouped. You can reorder items on the right side by selecting an item then
clicking the up or down arrows.

You can also click on the Filter tab to narrow the scope of the extension so that it displays only
those items that match the conditions you specify.

3. Click OK to exit the Quick View dialog. The Extension screen now groups the extension using the
criteria you selected.

To clear the extension grouping, click on the Remove All button from the Filter page of the Quick View
dialog, then click on OK.
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Filter Extension
Not available in PowerBid.

You can narrow the scope of the extension so that it displays only those items that match the
conditions you specify. You can filter the extension by material condition, price, discount, labor
condition, labor hours, date, or price code. For example, you may want to see only those takeoff
items with a Budget material condition.

Filtering the extension does not alter the extension itself or your bid totals. If you wish to experiment
with alternate bids, and you're using Pro or BidWinner Plus, you create alternate bid summaries and
switch between them. For more information on alternate bid summaries, see Using Alternate Bid
Summaries.

You can save a particular extension filter, along with a particular extension grouping, as a "view",
which can be selected from a list of saved views. The view will be in effect until you select a different
view, clear the view, or override the view by applying a quick view. For information on creating and
selecting views, see Working with Views.

The last selected view is automatically applied the next time you open the job. If you override a saved
view with a quick view, the extension will be displayed using the unfiltered and ungrouped
consolidated view the next time you open the job.

To filter the extension without creating a view, follow these steps:

1. Click on the Extension menu and select the Filter option. Alternatively, you can click on the Filter

button within the toolbar.

2. The Quick View dialog appears, displaying the Filter page. From here, enter the appropriate
information to filter the extension by material condition, price, discount, labor condition, labor hours,
date, and/or price code.

You can also click on the Group tab to group the extension by system, area, drawing, phase,
location, or labor factor.

3. Click on OK to accept the settings and exit the Quick View dialog. The extension will now display
only those items that match the selected filter and grouping options.

While a filter is applied to the Extension screen, a filter indicator displays beside the word Totals at
the bottom of the screen.

Filter indicator

To clear the extension filter, so that all items are displayed, click on the Clear All button from the
Filter page of the Quick View dialog, then click on OK.
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Views
You can save the filter and grouping settings that you apply to the extension as a "view", which you
can select from a list of saved views. This allows you to create multiple views that you can quickly
switch between. Views can also be shared between multiple users on a network.

The view will be in effect until you select a different view, clear the view, or override the view by
applying a quick view (a view that is not saved). To clear the view, click the Extension menu and
select Clear View. To apply a quick view, you select either the Group or Filter option from the
Extension menu, or click on the corresponding toolbar button. From the Quick View dialog, you can
choose temporary grouping and/or filter settings.

The last selected view is automatically applied the next time you open the job. If you override a saved
view with a quick view, the extension will be displayed using the unfiltered and ungrouped
consolidated view the next time you open the job.

Create View

1. Click on the Extension menu and select the Views option. Alternatively, you can click on the Views
button within the Extension Views toolbar.

2. From the Views dialog that appears, click the Add button to create a view. You will be prompted to
specify the view name then click on OK.

3. Click the Group tab to select grouping options, and/or click the Filter tab to select filter options.

4. When you are finishing selecting your grouping and filter options, click to OK to save and apply the
view.

To modify an existing view, follow these steps:

1. Click on the Extension menu and select the Views option. Alternatively, you can click on the Views
button on the Views toolbar.

2. From the Views dialog that appears, select the view you wish to modify from the list.

3. Click the Group tab to select grouping options, and/or click the Filter tab to select filter options.

4. When you are finishing modifying your grouping and filter options, click to OK to save and apply the
view.

Apply View

If the Views toolbar is displayed, click on the drop down list and select the appropriate view name. To
display the Views toolbar, click View then Toolbars then Extension Views.

If the Views toolbar is not displayed, click on the Extension menu and select the Views option. From
the Views toolbar that appears, click on the drop down list and select the appropriate view name, then
click on OK.

If you want to share extension views between multiple users, you can choose to load the views.dat file
from a central location.
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Share View

1. Display the Options dialog by clicking the Settings menu and selecting Options.

2. Click on the File Locations tab.

3. From the File Location page, click the Acquire Extension Views at Startup option so that a check
mark appears.

4. Click the Browse and select the location of the directory or folder containing the file to be shared.

5. Click to OK to accept the changes and exit the Options dialog

The next time you run the program, the views.dat file will be loaded from the location you have
specified.
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Unit Price Calculation
When the Extension screen is grouped by unit price, it includes columns for entering material tax,
labor rate, job expense percentage, and markup percentage. Using the Unit Price screen, you can
calculate a unit price for each audit trail entry.

To specify the default values for selected columns on the Unit Price screen, select the Defaults option
from the Extension menu. From the Unit Price Default Values dialog that appears, you can set default
values to be applied to new takeoffs in the current job and all other jobs. Changes to the default unit
price values will not affect any existing takeoffs.

To calculate a unit price, follow these steps:

1. Click on the Extension menu heading and select the Group option. Alternatively, you can click on

the Group button .

2. The Quick View dialog appears, with the Group page displayed. Within the left side of the Group
page, double click on the Unit Price option. Instead of double clicking on the option, you can single
click on the option, then click on the Add button.

3. Click on OK to exit the Quick View dialog. The Extension screen now displays total costs and
labor hours for each takeoff in your audit trail.

4. Move to the description of the takeoff that you want to price. Enter values for Tax (%), Labor Rate,
Tools ($ or % of labor), Exp (%), Equip ($), Mkp (%), or Other (%). The Qty value (used to reduce
the total price to a price per each unit) defaults to the takeoff length or count.  The Exp (%) and
Mkp (%) cells can accept positive or negative values.

5. Enter the # Units to see the total charge for the number of units involved in the work.

Tip - 

The values entered in this screen are not carried forward to the Price Summary. The unit price
calculations exist separately from your selling price.

If an item is not priced in the database (for example fixtures), you will have to group the extension
by item, enter a cost for the item in the Extension screen, and then group the extension again by
unit price. After calculating the unit price charge, remember to remove the item’s cost from your
extension or it will be included in your final selling price.
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Unit Price Default Values
The Unit Price Default option in the Extension menu allows you to set the default values for selected
columns that appear on the Extension screen when the extension is sorted by unit price.

1. Click the Extension menu and select Unit Price Defaults. The Unit Price Default Values dialog
appears.

2. Enter the values in the appropriate areas. For Small Tools you have a choice of either applying the
percentage of the labor amount, or the dollar value of the labor hours.

3. Click OK. Any changes you make to the default values affect all new takeoffs, but does not affect
existing ones. To apply these values to takeoffs in all subsequent jobs, open the default job and
specify the appropriate values. For more information, see Setting Job Defaults.
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Material Adjustment Default Values
The Material Adjustment Default option in the Extension menu allows you to set the default values for
the Material Adjustment column on the Extension screen.

1. Click the Extension menu and select Material Adjustment Defaults. The Material Adjustment
Column Default Dialog appears.

2. Select Value and enter the appropriate Material Adjustment, or select Database Adjustment
Column and choose the affected Column (1 or 2).

3. Click OK. Any changes you make to the default values affect all new takeoffs, but does not affect
existing ones. To apply these values to takeoffs in all subsequent jobs, open the default job and
specify the appropriate values. For more information, see Setting Job Defaults.
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Takeoff Quantity Rounding Controls
By default, the extension rounds takeoff quantities to the nearest whole number. For example, when
you take off an item with a Factor 1 value of 1 and a Factor 2 value of 10, then specify a length or
count of 6, the program will calculate the quantity by multiplying the count or length by Factor 1, then
dividing by Factor 2, to arrive at a value of .6. That value is then rounded to 1, the nearest whole
number. However, if the length or count had been 4, then the quantity would have been .4, and the
program would have rounded the quantity to zero, the nearest whole number.

To avoid having small takeoff quantities rounded to zero in the extension, you can turn the
rounding on or off:

Tip - When you turn the rounding of extension items on or off, all takeoff quantities will be re-
extended. To avoid reversing any manual changes you have made to quantities, you should set the
rounding option before you begin your takeoffs.

1. Click on the Settings menu and select Options.

2. On the General tab of the Options dialog that appears, click on the Round Takeoff/Extension Items
check box to add or remove the check mark. If the box is checked, then takeoff quantities in the
extension will be rounded to the nearest whole number.

3. Click on OK to accept the change and exit the Options dialog.
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Re-extend the Job
If you have made changes to the currently assigned database (updated the prices, for example), you
must re-extend the job in order for the changes to be reflected on the Extension screen. Re-extending
the job involves reapplying the item prices, discounts, labor units, and group codes from the currently
assigned database to a selected portion of the extension.

Re-extending the job will normally reverse changes you have manually made to the selected portion of
the extension, except changes made to quantities or descriptions, which are directly linked to the
takeoffs. You can, however, select cells within the Net Cost column or Labor column and lock them
so that your changes are not lost when the job is re-extended.

1. Click on the Extension menu heading and select the Re-extend option. When you select this
option, the Re-Extend dialog appears.

2. From this dialog, you can choose whether you wish to update descriptions, pricing, discounts,
adjustments, labor, sort codes, manufacturers, and suppliers. For pricing, labor, sort codes,
manufacturers, and suppliers, you can click the plus sign to expand the tree and control exactly
which elements will be updated as part of a re-extend. 

Checking or clearing an option will automatically check or clear each of its sub-options.
Components that are not selected will remain unchanged from the current extension. To select all
the re-extend options, click the All button.

If you choose to update labor, you should click the Labor Column button and select the labor
column to be used. The default setting is taken from the default job.

Default Labor Column Descriptions

Column Description

Column 1 Electrical: Labor hours for competitive bidding
(base rate).

Mechanical: Trimble competitive labor units.

Column 2 Electrical: Labor hours for industrial
applications (base rate + 25%).

Mechanical: Trimble change order labor units.

Column 3 Electrical: Labor hours for unique or special
conditions (base rate + 50%).

Mechanical: Trimble industrial labor units.

Column 4 Electrical: NECA’s published labor column 1.
If you are not using a NECA database, this
field will have a value of 0.00.

Mechanical: MCAA labor units.
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Column Description

Column 5 Electrical: NECA’s published labor column 2.
If you are not using a NECA database, this
field will have a value of 0.00.

Mechanical: PHCC labor units.

Column 6 Electrical: NECA’s published labor column 3.
If you are not using a NECA database, this
field will have a value of 0.00.

Mechanical: intentionally left blank.

Tip - The default column order described above may not correspond to your database if you have
moved any of these columns within your database.

 Caution: Defaults values have been set for Column 4, Column 5, or Column 6 in NECA
databases (electrical users) and MCA databases (mechanical users) only. If you are using any
other database, you should specify labor values for these columns, since they are currently set to
zeros.

3. Click on the OK button. A confirmation message appears.

4. Click on OK to proceed with the re-extension.

If you choose to update prices as part of the re-extension, the Date field for each update price will be
set to the date stored for that item in the material database.

Lock Net Cost or Labor Cells

Tip - This prevents the cells from updating during a re-extend.

1. Select the cell or cells you want to lock. To select a single cell, click on it. To select a range of
cells, click on the first cell in the range then hold down your left mouse button and drag your pointer
over the remaining cells in the range and release your mouse button.

2. Click the Extension menu then select the Re-extension Lock option (or else right click and select
Re-extension Lock) . The selected cells should now appear with a green background to indicate
that they are locked. Also, a check mark will subsequently appear beside the Re-extension Lock
menu option.
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Export Extension
You can export your job extension for use in other applications, such as Lotus, Excel, MS Project, or
Primavera. Before exporting, you should group and filter the extension as required, since only those
items currently appearing on the Extension screen are exported. Grouping ensures the items
exported are in the order in which they appear on the Extension screen.

1. Open the job whose extension you wish to export.

2. Group and filter the extension as required.

3. Click the Job menu and select the Export option.

4. From the Export dialog that appears, click the Extension check box to include the extension.

5. Click one of the following buttons to export the extension:

Export to .CSV Comma-separated variable format. Compatible
with a variety of programs.

Export to .MPX Microsoft Project's native file format.

Export to Excel Export the extension to Excel as an Excel
workbook.

6. If you select either the Export to .CSV or Export to .MPX option, an Export File dialog appears.
Specify the name and location of the file to be created then click on Save. If you select the Export
to Excel option, Microsoft Excel opens and the exported information appears as an Excel
workbook.
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C H A P T E R 7
Complete the Bid

After performing the takeoffs, and viewing the job extension, you can specify additional expenses,
review your bid, arrive at your final price, and prepare a formal quotation. After you close the bid, you
can use the Schedule screen to track your job status.

For more information on completing the bid, click on the button beside one of the following topics:

  Incorporating Labor Costs

  Incorporating General Expenses

  Adding/Modifying Quotes

  Closing the Bid

  Preparing a Formal Quotation



Classic Estimating Help Guide  - 315

Labor Costs
Trimble estimating programs allow you to incorporate and customize direct labor, indirect labor,
incidental labor, labor factoring, and labor escalation.

Direct Labor

From the Direct Labor screen, you can customize your labor and adjust your crew allocation after the
job has been extended. Labor hours and labor cost information will be obtained from the database.

Labor hours are derived from the extension and divided among the different labor types according to
the specified number of crew members. When you add takeoffs or modify the extension, the Crew
value is used to calculate the new labor hours for each labor type. You should therefore review your
direct labor costs after adding takeoffs or modifying the extension.

If you override the number of hours assigned to a labor type, the Crew value will be removed, and the
program will no longer automatically adjust the labor hours for that labor type. As you add more
takeoffs, the additional labor hours will be divided among the remaining labor types that are based on
Crew.

Labor descriptions, rates and crew allocations are defined on the Direct Labor screen; initial values
are drawn from the default job. You should set your crew and rates in the default job so they appear
automatically in each new job. For more information, see Setting Job Defaults.

To access the Direct Labor screen from another product screen, click on the DirLb tab at the bottom
of the screen, or click on the View menu and select Direct Labor.

Incidental Labor

From the Incidental Labor screen, you can add labor hours that have not yet been included (hours
required over and above the installation time). Examples would include job setup, travel time and
sleeving.

You should set up incidental labor descriptions in the default job so they appear automatically in each
new job. For more information, see Setting Job Defaults. The default values for Rate $, Brdn %, and
Frng $ are derived from the average values appearing at the bottom of the Direct Labor screen.

To access the Incidental Labor screen from another product screen, click on the IncLb tab at the
bottom of the screen, or click on the View menu and select Incidental Labor.

Labor Factoring (Pro only)

From the Labor Factoring screen, you can adjust project labor for various factors related to the job
conditions. The default values for Rate $, Brdn %, and Frng $ are derived from the average values
appearing at the bottom of the Direct Labor screen.

To access the Labor Factoring screen from another product screen, click on the LbFac tab at the
bottom of the screen, or click on the View menu and select Labor Factoring.

Labor Escalation (Pro only)

From the Labor Escalation screen, you can provide for changes in labor rates over the course of the



316 - Classic Estimating Help Guide

job (e.g. scheduled increases for unionized labor). To access the Labor Escalation screen from
another product screen, click on the LbEsc tab at the bottom of the screen, or click on the View
menu and select Labor Escalation.

Indirect Labor (Pro, BidWinner Plus, and BidWinner only)

From the Indirect Labor screen, you can incorporate non-field labor (e.g. supervisory or clerical). To
access the Indirect Labor screen from another product screen, click on the IndLb tab at the bottom of
the screen, or click on the View menu and select Indirect Labor.
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General Expenses
From the General Expenses screen, you can add general expenses, such as permits, room and
board, telephone, and so on. General expenses descriptions should be set in your default job. For
more information, see Setting Job Defaults.

Add/Modify General Expenses

1. To modify a current value, click on the value. To add a new value, click on an empty cell. In either
case, the cell you click on displays highlighted.

2. Type in the new value.

3. Press the [Enter] key to complete the change.

If you do not have a firm quote, you can enter a budget price and set a red flag to remind you of the
need to adjust the price. To set a red flag, you change the value of the appropriate Alarm cell to
Budget or Alarm. To change the Alarm setting, click on the Alarm cell, then press B (Budget) or A
(Alarm) on your keyboard, then press [Enter]. The cell will then have a red background. Setting the
Alarm cell to Budget indicates that a budget price is being used, while setting the cell to Alarm
represents any other reason to remind you of the need to adjust the quoted price. The red flag will
also appear on the Final Pricing and Price Summary screens. When you enter a new quoted value in
the Cost/Unit column, the Alarm cell will revert to Off, and the red flag will be removed.

Pro only

So that the Bid Breakdown screen can properly distribute costs across different breakdowns, you can
portions of an expense to different to different breakdowns. To allocate expenses to breakdowns,
select one of the expenses to be allocated then right click and select the Cost Allocation option.
From the Cost Allocation dialog that appears, you can assign either a dollar value or a percentage to
indicate the portion of the expense to be assigned to each breakdown. Within each breakdown
category, the allocated percentage(s) must add up to 100. Without closing the Cost Allocation dialog,
you can select another expense to be allocated, then click OK when you are finished allocating
expenses. To make the same allocations for multiple expenses, select multiple rows using the [Shift]
key to select a range of rows or hold down the [Ctrl] key and click on each of the rows to be included
before selecting the Cost Allocation option. After you have allocated an expense, a dollar sign
displays beside the description of the expense in the General Expenses column. The cost allocations
you assign will be saved as part of the current bid summary, and will no longer be assigned when you
switch to a different bid summary.
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Add/Modify Quotes
Using your Trimble estimating program, you can record subcontractor quotes, and quotes for
materials.

Subcontractor Quotes

From the Subcontractors screen, you can enter your subcontractor quotes. If you haven’t received a
firm quote, you can enter a budget price and set a red flag to remind you of the outstanding quote.

The amount of the selected quote appears in the Cost column. You can add % overhead and %
markup as necessary. The total column shows the quoted amount plus overhead and markup. The
total charge will be carried forward to the Final Pricing and Price Summary screens.

To set a red flag, you change the value of the appropriate Alarm cell to Budget or Alarm. To change
the Alarm setting, click on the Alarm cell, then select Alarm from the drop-down menu that appears.
The cell will now display the word Alarm with a red background. Setting the Alarm cell to Budget
indicates that a budget price is being used, while setting the cell to Alarm represents any other
reason to remind you of the need to adjust the quoted price. The red flag will also appear on the Final
Pricing and Price Summary screens. When a new quoted value is entered in the Cost column, the
Alarm cell will revert to Off, and the red flag will be removed.

Pro only

 So that the Bid Breakdown screen can properly distribute costs across different breakdowns, you
can allocate one or more quotes to breakdowns by selecting the row(s) then right clicking and
selecting the Cost Allocation option. (You can select a range of quotes or hold down the [Ctrl] key and
click on each of the quotes to be included.) From the Cost Allocation dialog that appears, you can
assign either a dollar value or a percentage to indicate the portion of the cost to be assigned to each
breakdown. After you have allocated a quote, a dollar sign displays beside the description of the item
in the Subcontractors column. The cost allocations you assign will be saved as part of the current bid
summary, and will no longer be assigned when you switch to a different bid summary.

Add/Modify Subcontracts

1. To modify a current value, click on the value. To add a new value, click on an empty cell. In either
case, the cell you click on displays highlighted.

2. Type in the new value.

3. Press the [Enter] key to complete the change.

Track Quotes

1. Double click on the appropriate Cost cell, or click the dialog button  that appears in the Cost cell
when its row is selected.

2. From the Vendor Quotes dialog that appears, you can select an existing quote or add a new one.
To select a quote, click the appropriate check box in the Selected column. Clicking the Low Price
button will automatically selected the lowest priced quote.

To add a new vendor, click on an empty cell within the Vendor column and type the name of the
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new vendor. If you add a new vendor and check the Update All Vendor Lists check box, then the
vendor will be added to each vendor quote list. Otherwise, the vendor will be added to the current
vendor quote list only.

3. When you are finished creating or selecting quotes, click the OK button. You will be returned to the
Subcontractors screen, and the quoted value will be automatically inserted in the amount field. If a
red flag had been set for this entry, it will be automatically removed.

Quoted Materials

From the Quoted Materials screen, you can keep track of vendors and quoted prices. To access the
Quoted Materials screen from another product screen, click on the QtMat tab at the bottom of the
screen.

If you haven’t received a firm quote, you can enter a budget price and set a red flag to remind you of
the outstanding quote. To change the Alarm setting, click on the Alarm cell, then select Alarm from
the drop-down menu that appears. The cell will now display the word Alarm with a red background.

Setting the Alarm cell to Budget indicates that a budget price is being used, while setting the cell to
Alarm represents any other reason to remind you of the need to adjust the quoted price. The red flag
will also appear on the Final Pricing and Price Summary screens. When a new quoted value is
entered in the Cost column, the Alarm cell will revert to Off, and the red flag will be removed.

You can apply a % Adjustment to your quoted materials. The adjusted totals will be carried forward to
your Final Pricing and Price Summary screens.

Pro only

So that the Bid Breakdown screen can properly distribute costs across different breakdowns, you can
portions of a quote to different to different breakdowns. To allocate quotes to breakdowns, select one
of the quotes to be allocated then right click and select the Cost Allocation option. From the Cost
Allocation dialog that appears, you can assign either a dollar value or a percentage to indicate the
portion of the cost to be assigned to each breakdown. Within each breakdown category, the allocated
percentage(s) must add up to 100. Without closing the Cost Allocation dialog, you can select another
quote to be allocated, then click OK when you are finished allocating quotes. To make the same
allocations for multiple quotes, select multiple rows using the [Shift] key to select a range of rows or
hold down the [Ctrl] key and click on each of the rows to be included before selecting the Cost
Allocation option. After you have allocated a quote, a dollar sign displays beside the description of the
item in the Quoted Materials column. The cost allocations you assign will be saved as part of the
current bid summary, and will no longer be assigned when you switch to a different bid summary.

Add/Modify Quoted Materials

1. To modify a current value, click on the value. To add a new value, click on an empty cell. In either
case, the cell you click on displays highlighted.

2. Type in the new value.

3. Press the [Enter] key to complete the change.

Track Quotes

1. Double click on the appropriate Cost cell, or click the dialog button  that appears in the Cost cell
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when its row is selected.

2. From the Vendor Quotes dialog that appears, you can select an existing quote or add a new one.
To select a quote, click the appropriate check box in the Selected column. Clicking the Low Price
button will automatically selected the lowest priced quote.

To add a new vendor, click on an empty cell within the Vendor column and type the name of the
new vendor. If you add a new vendor and check the Update All Vendor Lists check box, then the
vendor will be added to each vendor quote list. Otherwise, the vendor will be added to the current
vendor quote list only.

3. When you are finished creating or selecting quotes, click the OK button. You will be returned to the
Subcontractors screen, and the quoted value will be automatically inserted in the amount field. If a
red flag had been set for this entry, it will be automatically removed.
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Close the Bid
From the Final Pricing screen, you can review the total cost of materials and labor, and arrive at your
selling price. You can also enter overhead, markup, labor burden, and taxes. To access the Final
Pricing screen from another product screen, click on the FnPrc tab at the bottom of the screen, or
click on the View menu and select Final Pricing.

By default, cells that have a light yellow background cannot be directly modified, but are carried
forward from other screens.

To jump to the screen where a particular value has been specified, just double click on the appropriate
entry. Where you can specify a value as either a fixed amount or a percentage, the specified (or
“pinned”) value appears as blue text on a white background. To modify the default screen colors,
select Options from the Job menu.

If you are using Pro, you can try out different “what if” scenarios by entering different values in the
Modified ($) or Modified (%) columns, and comparing the totals against those in the Calculated (%)
and Calculated ($) columns. To reset the values in the Modified columns to match those in the

Calculated columns, click on the Reload button within the toolbar.

If an Alarm flag was set on the Subcontractor screen, the General Expenses screen, the Equipment
screen, or the Quoted Materials screen , a red bar displays in the Alarm column for the corresponding
row. If you double click on the red bar, the appropriate screen will be displayed.

Just below the Total Markup entry, there are three user-defined adjustments. By default, these
adjustments are labeled Other Expenses, Financing, and Bonding. These amounts will be included in
the General Expenses total that appears on the Bid Breakdown screen. To change the adjustment
description, double click on it, or single click on it and select the Descriptions option from the Edit
menu. From the Adjustment Descriptions dialog that appears, you can also change the description of
the global tax (VAT, GST, etc.) that is applied to your Selling Price to arrive at the Final Price.

If you using Pro or BidWinner Plus and you want to isolate portions of your bid, you can set up
alternate bid summaries, each of which can include a different combination of drawing, area, phase,
system, and location breakdowns. When you switch between different bid summaries, the extension
changes to include only those breakdowns you chose to be part of the current bid summary. Totals
appearing on all screens other than the Takeoff screen will be similarly adjusted. For more
information, see Creating Multiple Bid Summaries.

Depending on which estimating program you are using, different columns displays on the Final Pricing
screen. The different columns are described in the sections that follow.

Using PowerBid, BidWinner, BidWinner Plus

The same columns appear on the Final Pricing screen when you are using PowerBid, BidWinner, or
BidWinner Plus.

Column Description

Final Pricing The description of the value that has been
specified, or can be specified from this screen.
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Column Description

Value ($) The value used to determine the overall final
price. In some cases, you can enter a fixed
amount under this column, or enter a
percentage in the Pct (%) column and allow
your estimating program to calculate the Value
($).

Pct (%) The percentage that has been derived from, or
used to determine the value appearing in the
Value ($) column. In most cases, you can enter
a fixed amount under the Value ($) column, or
enter a percentage in the Pct (%) column and
allow your estimating program to calculate the
Value ($).

Alarm  If a red flag has been set for a value carried
forward from the Subcontractors, General
Expenses, or Quoted Materials, then the Alarm
cell will be set to On. Red flags are set to
remind you that the quoted price needs to be
adjusted, possibly because the price is a
budget price. To adjust the quoted price, double
click on the flagged entry and you will be
automatically returned to the appropriate
screen, where you can make the necessary
changes.

Code Cost code. Can be used as a reference point
when exporting to an accounting package.

Tip - The Final Price appearing at the bottom of the Value ($) column will be the final price that
appears on your formal quotation, and on subsequent product screens.

Using Pro

If you are using Pro, you can try out different “what if” scenarios by entering different values in the
Modified ($) or Modified (%) columns, then comparing the totals against those in the Calculated (%)
and Calculated ($) columns.

To reset the values in the Modified columns to match those in the Calculated columns, click on the
Reload button within the toolbar.

Column Description

Final Pricing The description of the value that has been
specified, or can be specified from this screen.

Calculated (%) A percentage used to determine the value
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Column Description

appearing in the Calculated ($) column. In some
cases, you can specify the percentage from the
Final Pricing screen. In other cases, the
percentage is carried forward from previous
screens.

Calculated ($) The value calculated using values entered on
this and previous product screens.

Variance (%) The difference between the Calculated ($) and
the Modified ($) represented as a percentage.

Modified ($) The value used to determine the overall final
price. This value overrides the value appearing in
the Calculated ($) column. In most cases, you
can enter a fixed amount under this column, or
enter a percentage in the Modified (%) column
and allow your estimating program to calculate
the Modified ($) value.

Modified (%) The percentage that has been derived from, or
used to determine the value appearing in the
Modified ($) column. In most cases, you can
enter a fixed amount under the Modified ($)
column, or enter a percentage in the Modified
(%) column and allow your estimating program
to calculate the Modified ($) value.

Alarm If a red flag has been set for a value carried
forward from the Subcontractors, General
Expenses, or Quoted Materials, then the Alarm
cell will be set to On. Red flags are set to
remind you that the quoted price needs to be
adjusted, possibly because the price is a
budget price. To adjust the quoted price, double
click on the flagged entry and you will be
automatically returned to the appropriate
screen, where you can make the necessary
changes.

Code Cost code. Can be used as a reference point
when exporting to an accounting package.

Tip - The Final Price appearing at the bottom of the Modified ($) column will be the final price that
appears on your formal quotation, and on subsequent product screens.
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Prepare Formal Quotation
After you have completed and reviewed the bid, you can produce a formal quotation using the Quote
Pad screen. To access the Quote Pad screen from another product screen, click on the QPad tab at
the bottom of the screen.

The Quote Pad screen acts as a simple text editor in which you can type, delete, cut, copy, and
paste text, as well as change text color, font and size in order to  produce a formal quotation. You
can paste text copied to the Windows clipboard from other applications such as Word or Excel. To
alter the appearance of the text you may use the options available from the Format menu, or enable to
the Formatting toolbar.  

A standard description is automatically loaded from your default job. If you want a company heading
or standard clauses to appear in all your formal quotations, you can add them to your default job.

To change the font used when printing your quotation, create a new report style or modify an existing
one. For more information on using report styles, see Using Report Styles.

To include information from your job, such as selling price or database name, you can insert special
field codes. When you print your formal quotation, the field code will be replaced with the appropriate
value. For example, if you insert the <SELLING_PRICE> field code, then your program will print the
selling price in place of the code. If you want the same kind of information to be printed for each
quotation, you should insert the appropriate field codes into your default job.

To insert a field code into your formal quotation, click where you want the code to appear, then type
the appropriate field code within angle brackets.

For example, if you include the following in your formal quotation...

for the amount of $<FINAL_PRICE>.

it might print as follows:

for the amount of $9,000.00.

If you want a field code to appear in a particular location, you can type a colon ( : ) following the field
name, then type the distance in inches from the left margin. You must include one decimal place
when specifying the distance. For example, to display the job name two inches from the left margin,
you would use the following field code:

<JOB_NAME:2.0>

To move a line of text a specified distance from the left margin, use the TAB keyword. For example, to
move a General Conditions heading 3 inches in from the left margin, you would type the following:

<TAB:3.0>General Conditions

You can also use field codes to have job information printed in the header or footer areas of your
reports. For a list of field codes, see Using Field Codes in Reports.
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C H A P T E R 8
Analyze the Bid

Estimating programs provide several screens and features that help you analyze your bids, and track
them against those of your competitors. These screens and features are described in the following
sections.

For more information on analyzing the bid, click on the button beside one of the following topics:

  Breaking Down the Bid

  Creating Multiple Bid Summaries

  Tracking Your Jobs
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Break Down the Bid
Pro only

From the Bid Breakdown screen, you can view the total cost of your bid broken down by drawing,
area, phase, system, location, sort codes, unit price, and item. The Bid Breakdown screen is ideal for
determining total cost per system, price per area, and labor per area, among other information. You
can manipulate this information, export it to other applications, and use it as the basis for progress
billings.

To switch between the Drawing, Area, Phase, System, Location, Sort Code, Unit Price, and Item
breakdowns, click the Breakdown View list box and select the appropriate option. If you’ve made
changes to any of the preceding screens, you must click the Reload button from the toolbar to update
the breakdown.

The cost per system is displayed on the Bid Breakdown screen under the Total column. At the
bottom of the screen, the Revised Totals represent the currently displayed values, while the Final
Totals indicate the values carried forward from the previous screens. To try out different “what if”
scenarios, you can enter new values in any of the cells and compare the new Revised Totals against
the actual Final Prices. Any changes you make here does not affect any previously specified values
or your final price. To reset the displayed values to match the Final Price values, click the Reload
button from the toolbar.

Allocating Costs

To distribute the costs for quoted materials or subcontractors quotes among different breakdowns,
you can enter a number in the appropriate cell representing the share of the quote to be assigned to
that breakdown. For example, if you enter a value of 1 in the Quoted Material column for both the
Lighting System and Wiring Devices system breakdowns, then click the Reload button, the program
will divide the quote equally between the two. If instead, you enter 2 for the Lighting System and 1 for
the Wiring Devices, then 2/3 of the costs would have been assigned to the Lighting System and 1/3
would have been assigned to Wiring Devices.

You can also allocate costs to breakdowns for individual rows on the General Expenses, Quoted
Materials, Subcontractors, and Equipment screens. To do so, select one or more rows then right click
and select the Cost Allocation option. From the Cost Allocation dialog, you can allocate the costs to
different breakdowns in whatever percentages you choose. The Bid Breakdown screen will then
distribute costs to breakdowns accordingly.

General expenses, quoted materials, subcontractor costs, and equipment costs that have not been
allocated will not be distributed or broken down.

Multi-Level Bid Breakdowns

By default, the Breakdown View list consists of single breakdowns that allow you to break down the
bid by that breakdown alone. If you want to see some of the breakdowns further broken down, you can
create multi-level breakdowns. Multi-level bid breakdowns allow you to group the bid by a combination
of multiple breakdown options. For example, instead of just breaking down the bid by system, you
can break it down by system and phase so that system breakdowns are themselves broken down by
phase.

To create a multi-level breakdown, click the Add button on the Bid Breakdown screen. From the Bid



Classic Estimating Help Guide  - 327

Breakdown View dialog that appears, you select the breakdowns you wish to use. To select the
breakdowns, double click the appropriate option from the left side of the dialog. Alternatively, you
could single click the option, then click on the Add button. You can select as many different
breakdowns as you require. The order in which the options appear on the right side of the dialog
determine the order in which the bid is broken. You can reorder items on the right side by selecting an
item then clicking the Up or Down buttons. Based on your selection, the Name of the breakdown view
will be automatically assigned.

Tip -  If you have any unallocated costs for the selected breakdowns on the General Expenses or 
Equipment screens, you can prorate the unallocated costs evenly across the breakdowns by clicking
the appropriate checkbox(es).

After you click on OK from the Bid Breakdown View dialog and return to the Bid Breakdown screen,
the bid will be broken down by the selected breakdowns in the selected order. Additional breakdowns
displays nested under the previous breakdown, with plus and minus buttons to expand and collapse
the branches of the tree. Subtotals displays for the final breakdown in the in the tree.

Creating Alternate Bid Summaries

If you want to isolate portions of your bid, you can set up multiple bid summaries, each of which can
include a different combination of drawing, area, phase, system, and location breakdowns. When you
switch between different bid summaries, the extension changes to include only those breakdowns you
chose to be part of the current bid summary. Totals appearing on all screens other than the Takeoff
screen will be similarly adjusted. For more information, see Creating Multiple Bid Summaries.
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Alternate Bid Summaries
Pro, BidWinner Plus only

With Pro and BidWinner Plus, you can set up different bid summaries, each of which can include a
different combination of drawing, area, phase, system, and location breakdowns. When you switch
between different bid summaries, the extension changes to include only those breakdowns you chose
to be part of the current bid summary. Totals appearing on all screens other than the Takeoff screen
will be similarly affected. The total value of the currently selected bid summary appears on the Job
Schedule Screen in the Last Bid field.

Tip - If you want to view only a portion of the extension without affecting the extension itself, or any
bid totals, you can group the extension rather than switch to a different bid summary. For more
information, see Grouping the Extension.

Multiple bid summaries can be combined into a single summary that you can view or print. To
combine multiple bid summaries, select the Combine option from the Bid Summary menu. When you
select this option, you are prompted to select the bid summaries you want to combine. After you
select the bid summaries to be combined, a price summary appears with columns for each selected
bid summary as well as a column displaying totals for all selected bid summaries.

Create Alternative Bid Summaries

1. Select the Modify option from the Bid Summary menu, or click the Modify Bid Summary

Components button  on the Bid Summary toolbar. The Bid Summaries dialog appears.

2. Click on the New button at the top of the Bid Summaries dialog.

3. From the Add Bid Summary dialog that appears, specify a name for your bid summary, and select
an existing bid summary to be used as the basis for the new bid summary. Click on OK to return to
the Bid Summary Components dialog.

4. Select or deselect the appropriate breakdowns from the Bid Summaries dialog. If a checkbox at the
top of a branch within the breakdowns list on the side of the dialog is checked, then all breakdowns
in that branch will be included. If you click on the checkbox so that a check mark no longer
appears, then all the breakdowns in that branch will be automatically deselected. You can then
click on the checkbox beside the individual breakdown options you wish to include.

Tip - You cannot deselect a breakdown if a cost has been assigned to it from the Cost Allocation
dialog.

5. Click OK when you have selected all the breakdowns you wish to include in your bid summary. The
bid summary you have just created is automatically loaded, and appears in the list box within the
Bid Summary toolbar.

Tip - You cannot modify the default bid summary setup.

Review Different Bid Summaries

1. Make sure the Bid Summary toolbar is being displayed.
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2. Click the list box within the Bid Summary toolbar, and select the appropriate bid summary.

OR

Select Modify option from the Bid Summary menu, then click the Bid Summary list box and select
the appropriate bid summary. When you click the OK, the bid summary you selected will be
loaded.

Modify Bid Summary:

1. Click the bid summary name on the left side of Bid Summaries dialog.

2. Select or deselect the breakdowns included in the bid summary.

Remove Bid Summary:

1. Select the Modify option from the Bid Summary menu, or click the Modify Bid Summary

Components button  on the Bid Summary toolbar. The Bid Summaries dialog appears.

2. Click the click the Rename button at the top of the dialog.

3. The Rename Bid Summary dialog appears. From here, specify a new name for your bid summary,
and click OK to return to the Bid Summary Components dialog.

Delete Bid Summary

1. Select the Modify option from the Bid Summary menu, or click the Modify Bid Summary

Components button  on the Bid Summary toolbar. The Bid Summaries dialog appears.

2. Click the bid summary name on the left side of the Bid Summaries dialog.

3. Click on the Delete button  at the top of the dialog.

4. You will be prompted to confirm your intention to delete the bid summary.

Change Bid Summary Display Order

1. Select the Modify option from the Bid Summary menu, or click the Modify Bid Summary
Components button  on the Bid Summary toolbar. The Bid Summaries dialog appears.

2. Select a bid summary name on the left side of the Bid Summaries dialog.

3. Click the Move Up or Move Down buttons.
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Track Jobs
You can use the Schedule screen to view summaries of all your jobs, and to track your success
against competing contractors. You can record information about your pending jobs as well as any
closed jobs.

The Schedule screen lists your jobs in ascending order by job number. If you number your jobs
sequentially, then the most recent job displays at the bottom of the list. When sorting the jobs by job
number, your estimating program ignores all non-numeric characters. When the Schedule screen
appears, it automatically shifts focus to the last line in the list.

The Schedule screen automatically appears when you run any estimating product. To access the Job
Schedule screen from another product screen, choose the Schedule option from the View or Window
menu, or click on the Schedule button.

Changing the Job Status

After a contract has been awarded, you can change the status of your job, and indicate how your bid
price compared to competing bids. You can also record the value of the lowest bid after your bid. At
the bottom of the Job Schedule screen, your bid prices are summarized according to status.

1. Click the Status cell for the job whose status you wish to change. By default, the status is set to
Pending.

2. Press one of the following letters on your keyboard to indicate the appropriate status:

Key Status

P Pending

F First

S Second

T Third

O Other

3. Press [Enter] to complete the change.

To indicate the value of the lowest bid other than yours, enter a value in the Next Price cell and let
your estimating product calculate the Spread %.
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C H A P T E R 9
Multi-User Support

Estimating programs offer support for multiple estimators working on the same project, including the
ability to share jobs across a network, merge takeoffs from multiple jobs, and manage Master jobs
and Sub jobs using the Enhanced Job Merge functionality.

For more information on the program’s multi-user support features, click on the button beside one of
the following topics:

  Using the Network Security Server

  Using the License Administrator

  Sharing Files Across a Network

  Organizing a Project

  Merging Takeoffs from Multiple Jobs

  Merging Takeoffs from Sub Jobs

  Security Protection
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Organizing a Project
 Pro only

On larger bids, you may require the efforts of several estimators, each working on a portion of the bid.
Using Pro, you can divide the project among multiple estimators, then merge takeoffs from each
estimator’s job into the master job.

To organize a larger project, we recommend you follow these steps:

1. The senior estimator or project leader creates a job template. The job template is just a job with
modifications and additions specific to that project. The senior estimator may create typicals, add
breakdown options, or adjust default values to reflect the specific conditions of the project. For
instructions on creating and using job templates, see Using Job Templates .

2. The project is then divided between the estimators according to system, area, or another
appropriate breakdown. Each estimator should be responsible for a distinct portion of the project, to
avoid overlap and redundancy.

3. Each estimator then opens the project template job and saves it as a separate job with a file name
that identifies him or his portion of the project.

4. The estimators then perform the takeoffs for their different portions of the project.

5. After all the estimators have completed their portion of the project, the senior estimator or project
leader merges the takeoffs from each job into a master job. For instructions on merging takeoffs
from multiple jobs, see Merging Takeoff from Multiple Jobs or Merging Takeoffs from Sub Jobs.

Tip - If you have multiple estimators working on different portions of the same project and they
need to create new items, they should create them as temporary items, rather than new database
items. When the separate jobs are merged, temporary items taken off will be merged, allowing your
chief estimator to review the new items within a single list.
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Merging Takeoffs from Multiple Jobs
Pro only

To allow multiple estimators to contribute takeoffs to the same job from different workstations, Pro
provides a job merge feature. Job merge combines takeoffs from separate jobs into a single job,
merging temporary items, breakdowns, typicals, and designations, and appending audit trail entries.

Pro also provides an enhanced job merge feature, which allows you to create multiple jobs that are
subordinate to a master job. You can split up a project and allow different users to work on different
portions of the project, with each portion being a separate sub job. At any point, takeoffs from the sub
jobs can be merged into the master job. For more information, see Creating Sub Jobs and  Merging
Takeoffs from Sub Jobs.

Procedure

1. Open the job where you wish to merge the takeoffs, or create a new job.

2. Go to the Takeoff screen and select the Job Merge option from the Takeoff menu. The Job Merge
dialog appears.

3. From the Job Merge dialog, select the existing jobs to be merged into the current job by clicking on
the check box beside the appropriate job name(s). Takeoffs, breakdowns, typicals, and
designations from the selected jobs will be merged into the current job in the order in which they
are listed on this dialog.

4. From this dialog, you can also control whether your program performs a comprehensive merge or
not. A comprehensive merge involves making sure that the description and all other details match
before combining two breakdowns, typicals, or designations into one.

A non-comprehensive merge involves merging the breakdowns, typicals, or designations that share
the same description even if the remaining details do not match. Where details do not match, the
details of the breakdowns, typicals, or designations already stored in the current job will be used.
You can control whether the merge is comprehensive for breakdowns, typicals, or designations, by
checking or clearing the check box beside the appropriate option.

By default, comprehensive merges are performed when combining breakdowns, typicals, and
designations. To perform a non-comprehensive merge, click on the appropriate job merge option, so
that a checkmark no longer appears.

5. Click on the Merge button to merge the takeoffs from the selected jobs.

6. When you are prompted to confirm your request to merge the jobs, click on OK.

7. After the job merge is complete, a confirmation message displays. Click on OK to acknowledge
this message.

8. Unless you want to merge another job into the current job, click on Exit to return to the Takeoff
screen.

If any of the takeoffs being merged involve materials not found in the database assigned to the current
job, Pro will create temporary items for these materials. Temporary items are stored as part of the job
(rather than the database) and can be viewed or accessed by selecting TEMPORARY ITEMS from the
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Takeoff options list box on the Takeoff screen.

Tip - If you wish to merge jobs in a different order than they appear on the Job Merge dialog
(perhaps because you are performing a non-comprehensive merge and wish the details of a particular
job to override those of other jobs), then merge the jobs one at a time in the order you prefer.
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Merging Takeoffs from Sub Jobs
Pro ONLY

You can create one or more sub jobs that are subordinate to a master job. This allows you to split up
a project and allow different users to work on different portions of the project, with each portion being a
separate sub job. At any point, takeoffs from the sub jobs can be merged into the master job. Master
jobs and sub jobs form part of Pro's Enhanced Job Merge feature that allows you to track merge dates
and eliminate the possibility of a "double-merge". For more information, see Merging Takeoffs from
sub jobs.

The Enhanced Job Merge feature provides several advantages over the regular job merge feature. The
Enhanced Job Merge:

eliminates the possibility that a user will accidentally perform a double job merge.  

facilitates the merge process by designating jobs as sub jobs subordinate to a master job and
therefore eliminating the possibility of merging the wrong jobs.

provides the ability to update a master job with revisions made in the merged sub job(s).

allows the user to more effectively the ability within the Master job to filter the audit trail and sort
the extension by the original (sub job) numbers.

Enhanced Job merge combines takeoffs from separate jobs into a single job, merging temporary
items, breakdowns, typicals, and designations, and appending audit trail entries.

Procedure

1. Open the master job  you wish to merge sub jobs into.

2. Go to the Takeoff screen and select the Enhanced Job Merge option from the Job menu. The
Enhanced Job Merge dialog appears.

3. From the Enhanced Job Merge dialog, you can select the existing sub jobs to be merged into the
currently open Master job by clicking on the check box beside the appropriate job
name(s).Takeoffs, breakdowns, typicals, and designations from the selected sub jobs will be
merged into the master job in the order in which they are listed on this dialog.

If a sub job has been renamed or moved, the sub job displays grayed out in the merge list, with a
question mark button beside the job number:

To relink the sub job, click on it then click the Relink button. A dialog displays allowing you to
specify the location of the sub job.

4. Select the appropriate checkbox(es) to control the comprehensive merge options.

A comprehensive merge involves making sure that the description and all other details match before
combining two breakdowns, typicals, or designations into one. A non-comprehensive merge
involves merging the breakdowns, typicals, or designations that share the same description even if
the remaining details do not match. Where details do not match, the details of the breakdowns,
typicals, or designations already stored in the current job will be used. You can control whether the
merge is comprehensive for breakdowns, typicals, or designations, by checking or clearing the
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check box beside the appropriate option. By default, comprehensive merges are performed when
combining breakdowns, typicals, and designations. To perform a non-comprehensive merge, click
on the appropriate job merge option, so that a checkmark no longer appears.

5. Click on the Merge button to merge the takeoffs from the selected jobs.

6. When you are prompted to confirm your request to merge the jobs, click on OK.

7. After the job merge is complete, a confirmation message displays. Click on OK to acknowledge
this message.

8. Unless you want to merge another sub job into the master job, click on Exit to return to the Takeoff
screen.

If any of the takeoffs being merged involve materials not found in the database assigned to the current
job, Pro will create temporary items for these materials. Temporary items are stored as part of the job
(rather than the database) and can be viewed or accessed by selecting TEMPORARY ITEMS from the
Takeoff options list box on the Takeoff screen.

If a master job has sub jobs that are open or have been modified since the last merge, then the Final
Price cell at the bottom of the Calculated ($) column on the Final Pricing screen displays with a
yellow background.

Tip - If you wish to merge jobs in a different order than they appear on the Enhanced Job Merge
dialog (perhaps because you are performing a non-comprehensive merge and wish the details of a
particular job to override those of other jobs), then merge the jobs one at a time in the order you
prefer.
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C H A P T E R10
Reports

Using the estimating products, you can print comprehensive reports showing information from your
database, from your price update, or for any of your jobs. The reports available from the print function
will vary depending on your location in the program.

For more information on printing reports within your estimating product, click on the button beside one
of the following topics:

  Printing Job Reports

  Printing to PDF

  Printing Job Summaries

  Print Preview

  Using Field Codes

  Using Report Styles
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Printing Job Reports
Estimating programs allow you to print job summaries or comprehensive job reports. Each time you
print a job report, you must select the report style you wish to use. A report style determines which
job components are included in the report, and controls the layout of the report, including headers,
footers, margins, and page orientation. You can create as many different report styles as you wish,
each with its own combination of job components and report parameters.

Report styles are distinct from screen styles, which control the columns that are displayed on each
job screen. However, you can view the currently report style on screen, so that only those job
components included in the report style will displayed on screen. As well, you can apply your current
screen style in place of a report style, so that only those columns displayed on screen will be
included in the job report. For information on creating, defining, and using report styles, see Using
Report Styles.

You can only select a report style when you choose the Print option from a job-specific screen. If you
select the Print option from the Schedule screen, then a job summary, complete with job description,
job number, date, status, etc., will be printed. Instructions on printing comprehensive job reports
appear below. For information on printing job summaries, see Printing Job Summaries.

To print detailed reports on a particular job, follow these steps:

1. Open the appropriate job. For instructions on opening a job, see Opening a Job.

2. Select the Print option from the Job menu, or click on the Print button  on the toolbar.

3. In either case, the Print Report dialog appears.

From here, you can choose which report style you wish to use by clicking on the Report Style list
box. The selected report style determines which job screens and columns are included in the
report and in what order, and controls the font used in your report. (The default style includes all
printable job components.) For instructions on creating report styles, see Creating a Report Style.

The Print Report dialog lists all job screens (or screen sections in the case of the Takeoff and
Extension screens) with a check box beside each. When the Audit Trail, Designations, or
Extension options are checked, you can click the plus sign to select the full or partial view to be
printed.

Those job screens that were selected as part of the current report style displays checked, while
those excluded from the report style displays unchecked. If you switch to a different report style,
the job screen selections will change to reflect the selected report style. You can override any or
all of the report style’s selections without modifying the report style itself by checking or clearing
the appropriate screen names in the list.

If you wish to use the current screen layout in place of a report style, so that only those
components currently enabled as part of the current screen style will be included in the report,
click on the Use Screen Layout check box at the bottom of the screen. (Screen styles function
like report styles, controlling what job components are displayed on each job screen. For more
information on screen styles, see Using Screen Styles).

If you click on the Setup button, the Print Setup dialog appears. From the Print Setup dialog, you
can select a different printer and choose the number of copies you wish to print.
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4. Click the Print button to print the report. If you have selected screens on the Print Report dialog for
which no columns were selected in the current report style, then a list of screens unavailable for
printing will be displayed.
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Printing Job Reports to PDF
To print detailed job reports to a PDF file, follow these steps:

1. Open the appropriate job. For instructions on opening a job, see Opening a Job.

2. Select the Print option from the Job menu, or click on the Print button  on the toolbar. 

3. In either case, the Print Report dialog appears.

From here, select the report style you wish to use by clicking on the Report Style list box. The
selected report style determines which job screens and columns are included in the report and in
what order, and controls the font used in your report. (The default style includes all printable job
components.) For instructions on creating report styles, see Creating a Report Style.

The Print Report dialog lists all job screens (or screen sections in the case of the Takeoff and
Extension screens) with a check box beside each. When the Audit Trail, Designations, or
Extension options are checked, you can click the plus sign to select the full or partial view to be
printed.

Job screens that are part of the current report style displays checked, while those excluded from
the report style displays unchecked. You can override any or all of the report style’s selections
without modifying the report style itself by checking or clearing the appropriate screen names in
the list.

If you wish to use the current screen layout in place of a report style, so that only those
components currently enabled as part of the current screen style will be included in the report,
click on the Use Screen Layout check box at the bottom of the screen. (Screen styles function
like report styles, controlling what job components are displayed on each job screen. For more
information on screen styles, see Using Screen Styles).

4. If you click on the Setup button, the Print Setup dialog appears. From the Print Setup dialog, you
can select a different printer and choose the number of copies you wish to print.

5. After you have selected the components to be included in your report, click the PDF button to save
the report in PDF format.

The Export to PDF dialog displays.

6. In the File name field type the desired filename for your PDF report and click the Save button to
complete the export.
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Printing Job Summaries
In addition to job reports, you can print job summaries from the Job Schedule screen. Job summary
reports do not make use of report styles, but instead use screen styles. The appearance of the job
summary report is determined by the currently selected screen style. For information on creating
screen styles, see Using Screen Styles.

To print a summary of all your jobs, follow these steps:

1. If the Schedule screen is not already being displayed, go to the Job Schedule screen by selecting
the Schedule option from the View or Window menu.

2. Select the Print option from the Job menu, or click on the Print button within the toolbar.

3. From the Print dialog that appears, you can change your printer setup and choose the number of
copies you wish to print. Click on OK when you are ready to print your job summary.

The job summary will print the same information that appears on the Job Schedule screen.
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Using Print Preview
Using the Print Preview function, you can see what your print jobs will look like before they are sent to
the printer.

To preview a print job, follow these steps:

1. Open the appropriate job. For instructions on opening a job, see Opening a Job.

2. Select the Print Preview option from the Job menu.

3. From the Preview Report dialog, you select the report style you wish to use, and the job screens to
be included in the report. Job screens that are part of the current report style displays checked,
while those excluded from the report style displays unchecked. You can override any or all of the
report style’s selections without modifying the report style itself by checking or clearing the
appropriate screen names in the list.

4. Click OK to proceed. The Print Preview screen appears, displaying a preview of your print job.

If there is more than one report available for printing, then they will all be combined into a single
printed document with a page break between each report. To switch between the different reports,
simply click Next Page or Prev Page buttons until the window is displaying the appropriate report.

The following options are available from the Print Preview screen:

Option Description

Print Click on this button to print the currently
displayed report(s).

Next Page If the current displayed report consists of
multiple pages, you can click on this button to
display the next page in the report.

Prev Page If the current displayed report consists of
multiple pages, you can click on this button to
display the previous page in the report.

Two Page If the current displayed report consists of
multiple pages, you can click on this button to
display two pages at a time side by side.

Zoom In Click on this button to magnify the report being
previewed.

Zoom Out Click on this button to reduce the magnification
of the report being previewed.

Close Click on this button to close the Print Preview
function and return to your previous screen.
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Using Field Codes
If you want job information, such as database name or the date, to appear on your report, your notes
or formal quotation, you can insert special field codes. When you print your reports, notes, or
quotation, the field codes will be automatically replaced by the appropriate value. For example, if you
insert the <SELLING_PRICE> field code, then your estimating program will print the selling price in
place of the code.

Field codes can be inserted in the header or footer area of any report, and in the body of your notes or
your formal quotation. You can also used field codes to automatically insert a value in the Qty cell on
either the General Expense screen or Equipment screen. If you want the same kind of information to
be printed for each quotation, you should insert the appropriate field codes into your default job.

To insert a field code from the Notes screen or Quote Pad screen, left click where you want the
information to appear, then right click and select the Insert Field option. From the Field Codes dialog
that appears, you can select the appropriate code. Alternatively, you could type the field code within
angle brackets ( < > ). For example, if you include the following in your formal quotation:

for the amount of $<SELLING_PRICE>.

it might print as follows:

for the amount of $9,000.00.

To use a field code to insert a value in the Qty cell on the General Expense or Equipment screen,
select a field code from the Field cell to the right of the Qty cell.

If you want a field code to appear in a particular location, you can type a colon ( : ) following the field
name, then type the distance in inches from the left margin. You must include one decimal place
when specifying the distance. For example, to display the job name two inches from the left margin,
you would use the following field code:

<JOB_NAME:2.0>

To move a line of text a specified distance from the left margin, use the TAB keyword. For example, to
move a General Conditions heading 3 inches in from the left margin, you would type the following:

<TAB:3.0>General Conditions

To insert a field code into the header or footer area of a report, you invoke the Report Style Setup
dialog by selecting Report Styles from the Settings menu. From the Report Style Setup dialog, click
on the Page Setup tab to display the Page Setup page. In the Header or Footer field, type the
appropriate field code within angle brackets ( < > ). The following field codes are available:

Header and Footer Field Codes

Code Description

BID_SUMMARY_NAME Pro and BidWinner Plus only

Where alternate bid summaries have been set
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Code Description

up. For more information on alternate bid
summaries, see Creating Multiple Bid
Summaries.

DATABASE_NAME The name of the database used for this job.

DATABASE_NUMBER The number of the database used for this job.

JOB_NAME The job description.

JOB_NUMBER The job number.

JOB_PATH The folder in which the job is stored.

Notes Screen Field Codes

Code Description

<TAB:1.0> Distance in inches that text following will be
indented from left

<DATE> The present date

<TIME> The current time

<JOB_NAME> Job description

<JOB_NUMBER> Job number

<JOB_PATH> Folder in which the job is stored

<JOB_TYPE> Job category as it appears on the Job
Information screen

<STARTING_DATE> Starting date of the job as defined on the Job
Information screen

<COMPLETION_DATE> Completion date of the job as defined on the
Job Information screen

<DURATION> Duration of the job as calculated on the Job
Information screen

<DURATION_BASEDON> Whether the duration is expressed in days,
weeks, or months

<DURATION_DAYS> The duration of the job in days, calculated using
the information entered on the Job Information
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Code Description

screen

<DURATION_WEEKS> The duration of the job in weeks, calculated
using the information entered on the Job
Information screen

<DURATION_MONTHS> The duration of the job in months, calculated
using the information entered on the Job
Information screen

<DURATION_4WEEKS> The duration of the job in 4-week intervals,
calculated using the information entered on the
Job Information screen

<DATABASE_NAME> The name of the database used for this job

<DATABASE_NUMBER> The number of the database used for this job

<DATABASE_PATH> The folder in which the database is stored

<BID_SUMMARY_NAME> Currently selected bid summary

<BID_DUE_DATE> Bid due date as it appears on the Job Info
screen

<BID_DUE_TIME> Bid due time as it appears on the Job Info
screen

<ESTIMATOR> Estimator's name as it appears on the Job Info
screen

<ESTIMATOR_TELEPHONE> Estimator's telephone number as it appears on
the Job Info screen

<ESTIMATOR_CELLPHONE> Estimator's telephone number as it appears on
the Job Info screen

<ESTIMATOR_FAX> Estimator's fax number as it appears on the Job
Info screen

<ESTIMATOR_EMAIL> Estimator's e-mail

<JOB_ADDRESS_NUMBER> Job address number as it appears on the Job
Info screen

<JOB_ADDRESS_SITE_NAME> Job address site name as it appears on the Job
Info screen

<JOB_ADDRESS_ADDRESS_1> Job address 1 as it appears on the Job Info
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Code Description

screen

<JOB_ADDRESS_ADDRESS_2> Job address 2 as it appears on the Job Info
screen

<JOB_ADDRESS_CITY> Job address city as it appears on the Job Info
screen

<JOB_ADDRESS_STATE> Job address state as it appears on the Job Info
screen

<JOB_ADDRESS_COUNTRY> Job address country as it appears on the Job
Info screen

<JOB_ADDRESS_ZIP> Job address zip or postal code as it appears on
the Job Info screen

<JOB_ADDRESS_TELEPHONE> Job phone as it appears on the Job Info screen

<JOB_ADDRESS_CELLPHONE> Job cell phone as it appears on the Job Info
screen

<JOB_ADDRESS_FAX> Job fax as it appears on the Job Info screen

<JOB_ADDRESS_CONTACT> Job address contact as it appears on the Job
Info screen

<JOB_ADDRESS_EMAIL> Job address e-mail

<CLIENT_ADDRESS_NUMBER> Client address number as it appears on the Job
Info screen

<CLIENT_ADDRESS_SITE_NAME> Client address site name as it appears on the
Job Info screen

<CLIENT_ADDRESS_ADDRESS_1> Client address 1 as it appears on the Job Info
screen

<CLIENT_ADDRESS_ADDRESS_2> Client address 2 as it appears on the Job Info
screen

<CLIENT_ADDRESS_CITY> Client address city as it appears on the Job Info
screen

<CLIENT_ADDRESS_STATE> Client address state as it appears on the Job
Info screen

<CLIENT_ADDRESS_COUNTRY> Client address country as it appears on the Job
Info screen
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Code Description

<CLIENT_ADDRESS_ZIP> Client address zip as it appears on the Job Info
screen

<CLIENT_ADDRESS_TELEPHONE> Client phone as it appears on the Job Info
screen

<CLIENT_ADDRESS_CELLPHONE> Client cell phone as it appears on the Job Info
screen

<CLIENT_ADDRESS_FAX> Client fax as it appears on the Job Info screen

<CLIENT_ADDRESS_CONTACT> Client address contact as it appears on the Job
Info screen

<CLIENT_ADDRESS_EMAIL> Client address e-mail

<LABOR_COLUMN> Labor column used in the Extension screen

<EXTENSION_TOTAL_HOURS> Total hours from the Extension screen

<DIRECT_LABOR_HOURS> Total hours from the Direct Labor screen

<DIRECT_LABOR_FULL_RATE> Full rate from the Direct Labor screen

<INCIDENTAL_LABOR_HOURS> Total hours from the Incidental Labor screen

<INCIDENTAL_LABOR_FULL_RATE> Full rate from the Incidental Labor screen

<LABOR_FACTORING_HOURS> Total hours from the Labor Factoring screen

<LABOR_FACTORING_FULL_RATE> Full rate from the Labor Factoring screen

<INDIRECT_LABOR_HOURS> Total hours from the Indirect Labor screen

<INDIRECT_LABOR_FULL_RATE> Full rate from the Indirect Labor screen

<GENERAL_EXPENSES_COST> Total cost from the General Expenses screen

<GENERAL_EXPENSES_TAX> Total tax from the General Expenses screen

<EQUIPMENT_COST> Total cost from the Equipment screen

<EQUIPMENT_TAX> Total tax from the Equipment screen

<QUOTED_MATERIALS_ADJUSTED_COST> Total adjusted cost of all material from the
Quoted Material screen

<SUBCONTRACTORS_ADJUSTED_COST> Total cost from the Subcontractors screen
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Code Description

<SUBCONTRACTORS_TAX> Total tax from the Subcontractors screen

<SELLING_PRICE> Selling price as it appears on the Final Pricing
screen

<FINAL_PRICE> Final price as it appears on the Final Pricing
screen

<AREA> Area value from the Price Summary screen

<TOTAL_HOURS> Total labor hours as it appears on the Price
Summary screen

<LABOR_RISK_RATIO> The Labor Risk Ratio % value from the Price
Summary screen

Quote Pad Screen Field Codes

The following codes are available from the Quote Pad screen:

Code Description

<TAB:1.0> Distance in inches that text following will be
indented from left

<DATE> The present date

<TIME> The current time

<JOB_NAME> Job description

<JOB_NUMBER> Job number

<JOB_PATH> The folder in which the job is stored

<JOB_TYPE> Job category as it appears on the Job
Information screen

<STARTING_DATE> Starting date of the job as defined on the Job
Information screen

<COMPLETION_DATE> Completion date of the job as defined on the
Job Information screen

<DURATION> Duration of the job as calculated on the Job
Information screen

<DURATION_BASEDON> Whether the duration is expressed in days,
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Code Description

weeks, or months

<DURATION_DAYS> The duration of the job in days, calculated using
the information entered on the Job Information
screen

<DURATION_WEEKS> The duration of the job in weeks, calculated
using the information entered on the Job
Information screen

<DURATION_MONTHS> The duration of the job in months, calculated
using the information entered on the Job
Information screen

<DURATION_4WEEKS> The duration of the job in 4-week intervals,
calculated using the information entered on the
Job Information screen

<DATABASE_NAME> The name of the database used for this job

<DATABASE_NUMBER> The number of the database used for this job

<DATABASE_PATH> The folder in which the database is stored

<BID_SUMMARY_NAME> Currently selected bid summary

<BID_DUE_DATE> Bid due date as it appears on the Job Info
screen

<BID_DUE_TIME> Bid due time as it appears on the Job Info
screen

<ESTIMATOR> Estimator's name as it appears on the Job Info
screen

<ESTIMATOR_TELEPHONE> Estimator's telephone number as it appears on
the Job Info screen

<ESTIMATOR_CELLPHONE> Estimator's telephone number as it appears on
the Job Info screen

<ESTIMATOR_FAX> Estimator's fax number as it appears on the Job
Info screen

<ESTIMATOR_EMAIL> Estimator's e-mail

<JOB_ADDRESS_NUMBER> Job address number as it appears on the Job
Info screen



350 - Classic Estimating Help Guide

Code Description

<JOB_ADDRESS_SITE_NAME> Job address site name as it appears on the Job
Info screen

<JOB_ADDRESS_ADDRESS_1> Job address 1 as it appears on the Job Info
screen

<JOB_ADDRESS_ADDRESS_2> Job address 2 as it appears on the Job Info
screen

<JOB_ADDRESS_CITY> Job address city as it appears on the Job Info
screen

<JOB_ADDRESS_STATE> Job address state as it appears on the Job Info
screen

<JOB_ADDRESS_COUNTRY> Job address country as it appears on the Job
Info screen

<JOB_ADDRESS_ZIP> Job address zip or postal code as it appears on
the Job Info screen

<JOB_ADDRESS_TELEPHONE> Job phone as it appears on the Job Info screen

<JOB_ADDRESS_CELLPHONE> Job cell phone as it appears on the Job Info
screen

<JOB_ADDRESS_FAX> Job fax as it appears on the Job Info screen

<JOB_ADDRESS_CONTACT> Job address contact as it appears on the Job
Info screen

<JOB_ADDRESS_EMAIL> Job address e-mail

<CLIENT_ADDRESS_NUMBER> Client address number as it appears on the Job
Info screen

<CLIENT_ADDRESS_SITE_NAME> Client address site name as it appears on the
Job Info screen

<CLIENT_ADDRESS_ADDRESS_1> Client address 1 as it appears on the Job Info
screen

<CLIENT_ADDRESS_ADDRESS_2> Client address 2 as it appears on the Job Info
screen

<CLIENT_ADDRESS_CITY> Client address city as it appears on the Job Info
screen

<CLIENT_ADDRESS_STATE> Client address state as it appears on the Job
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Code Description

Info screen

<CLIENT_ADDRESS_COUNTRY> Client address country as it appears on the Job
Info screen

<CLIENT_ADDRESS_ZIP> Client address zip as it appears on the Job Info
screen

<CLIENT_ADDRESS_TELEPHONE> Client phone as it appears on the Job Info
screen

<CLIENT_ADDRESS_CELLPHONE> Client cell phone as it appears on the Job Info
screen

<CLIENT_ADDRESS_FAX> Client fax as it appears on the Job Info screen

<CLIENT_ADDRESS_CONTACT> Client address contact as it appears on the Job
Info screen

<CLIENT_ADDRESS_EMAIL> Client address e-mail

<LABOR_COLUMN> Labor column used in the Extension screen

<EXTENSION_TOTAL_HOURS> Total hours from the Extension screen

<DIRECT_LABOR_HOURS> Total hours from the Direct Labor screen

<DIRECT_LABOR_FULL_RATE> Full rate from the Direct Labor screen

<INCIDENTAL_LABOR_HOURS> Total hours from the Incidental Labor screen

<INCIDENTAL_LABOR_FULL_RATE> Full rate from the Incidental Labor screen

<LABOR_FACTORING_HOURS> Total hours from the Labor Factoring screen

<LABOR_FACTORING_FULL_RATE> Full rate from the Labor Factoring screen

<INDIRECT_LABOR_HOURS> Total hours from the Indirect Labor screen

<INDIRECT_LABOR_FULL_RATE> Full rate from the Indirect Labor screen

<GENERAL_EXPENSES_COST> Total cost from the General Expenses screen

<GENERAL_EXPENSES_TAX> Total tax from the General Expenses screen

<EQUIPMENT_COST> Total cost from the Equipment screen

<EQUIPMENT_TAX> Total tax from the Equipment screen



352 - Classic Estimating Help Guide

Code Description

<QUOTED_MATERIALS_ADJUSTED_COST> Total adjusted cost of all material from the
Quoted Material screen

<SUBCONTRACTORS_ADJUSTED_COST> Total cost from the Subcontractors screen

<SUBCONTRACTORS_TAX> Total tax from the Subcontractors screen

<TOTAL_PROFIT> Total Profit value from the Price Summary
screen

<PRIME_COST> Prime Cost value from the Price Summary
screen

<NET_COST> Net Cost value from the Price Summary screen

<AREA> Area value from the Price Summary screen

<TOTAL_HOURS> Total labor hours as it appears on the Price
Summary screen

<LABOR_RISK_RATIO> The Labor Risk Ratio % value from the Price
Summary screen

Tip - For Pro, the following codes are available for cells under the Modified $ column on the
Final Pricing screen:

<DATABASE_MATERIAL> Database material as it appears on the Final
Pricing screen

<DATABASE_MATERIAL_ESCALATION> Database material escalation as it appears on
the Final Pricing screen

<QUOTED_MATERIAL> Quoted material as it appears on the Final
Pricing screen

<QUOTED_MATERIAL_EXTENSION> Quoted material extension as it appears on the
Final Pricing screen

<MATERIAL_TAX> Material tax as it appears on the Final Pricing
screen

<MATERIAL_TOTAL> Material total as it appears on the Final Pricing
screen

<DIRECT_LABOR> Direct labor as it appears on the Final Pricing
screen

<INCIDENTAL_LABOR> Incidental labor as it appears on the Final
Pricing screen
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Code Description

<LABOR_FACTORING> Labor factoring as it appears on the Final
Pricing screen

<LABOR_ESCALATION> Labor escalation as it appears on the Final
Pricing screen

<INDIRECT_LABOR> Indirect labor as it appears on the Final Pricing
screen

<LABOR_TAX> Labor tax as it appears on the Final Pricing
screen

<LABOR_TOTAL> Labor total as it appears on the Final Pricing
screen

<GENERAL_EXPENSES> General expenses as it appears on the Final
Pricing screen

<EQUIPMENT> Equipment as it appears on the Final Pricing
screen

<SUBCONTRACTORS> Subcontractors as it appears on the Final
Pricing screen

<TOTAL_COST> Total cost as it appears on the Final Pricing
screen

<DATABASE_MATERIAL_OVERHEAD> Database material overhead as it appears on
the Final Pricing screen

<QUOTED_MATERIAL_OVERHEAD> Quoted material overhead as it appears on the
Final Pricing screen

<LABOR_OVERHEAD> Labor overhead as it appears on the Final
Pricing screen

<GENERAL_EXPENSES_OVERHEAD> General expenses overhead as it appears on
the Final Pricing screen

<EQUIPMENT_OVERHEAD> Equipment overhead as it appears on the Final
Pricing screen

<SUBCONTRACTORS_OVERHEAD> Subcontractors overhead as it appears on the
Final Pricing screen

<ADJUSTMENT_OVERHEAD> Adjustment overhead as it appears on the Final
Pricing screen

<TOTAL_OVERHEAD> Total overhead as it appears on the Final
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Code Description

Pricing screen

<DATABASE_MATERIAL_MARKUP> Database material markup as it appears on the
Final Pricing screen

<QUOTED_MATERIAL_MARKUP> Quoted material markup as it appears on the
Final Pricing screen

<LABOR_MARKUP> Labor markup as it appears on the Final Pricing
screen

<GENERAL_EXPENSES_MARKUP> General expenses markup as it appears on the
Final Pricing screen

<EQUIPMENT_MARKUP> Equipment markup as it appears on the Final
Pricing screen

<SUBCONTRACTORS_MARKUP> Subcontractors markup as it appears on the
Final Pricing screen

<ADJUSTMENT_MARKUP> Adjustment markup as it appears on the Final
Pricing screen

<TOTAL_MARKUP> Total markup as it appears on the Final Pricing
screen

<USER_DEFINED1> First user-defined adjustment as it appears on
the Final Pricing screen

<USER_DEFINED2> Second user-defined adjustment as it appears
on the Final Pricing screen

<USER_DEFINED3> Third user-defined adjustment as it appears on
the Final Pricing screen

<FINAL_ADJUSTMENT> Final adjustment as it appears on the Final
Pricing screen

<SELLING_PRICE> Selling price as it appears on the Final Pricing
screen

<GLOBAL_TAX> Global tax it appears on the Final Pricing
screen

<FINAL_PRICE> Final price as it appears on the Final Pricing
screen
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Report Styles
Report styles are used to control which columns are included in a particular job report. You can
include or exclude entire job screens, or just include selected columns from different job screens. You
can also control the order in which the columns are printed. As part of a report style, you can also
control the font used in your report, as well as headers and footers, page margins, and page
orientation.

Report styles can only be used when printing job reports. They do not apply when printing job
summaries from the Job Schedule screen, database reports from the Database Manager module, or
price update reports from the Price Update screen.

You can create as many different report styles as you wish, each with a different combination of job
components and printer parameters. A number of predefined report styles are installed as part of your
estimating product, including a default report style that includes all columns from all job screens.

Each time you print a report, you can select the required report style, allowing you to switch quickly
and easily between different report types. Before printing a job report, be sure to group and filter the
extension to suit your requirements. For instructions on printing job reports, see Printing Job Reports.

Report styles work together with the audit trail and extension filters to determine the contents of a job
report. Report styles control which columns are printed for each takeoff or extension item, and filters
determine which takeoff or extension items are available for printing.

Similarly, report styles work together with the grouping options to determine the order in which
information appears in a job report. Report styles control the order in which different columns are
printed for each takeoff or extension item, and grouping options determine the order in which the
takeoff or extension items appear.

If you're on a network, you can share report styles between multiple users. To do so, specify a shared
location for the report style files on the File Locations page of the Options dialog.

For more information on using report styles, click on the button beside one of the following topics:

  Creating a Report Style

  Defining a Report Style

  Displaying a Report Style on Screen

  Renaming a Report Style

  Deleting a Report Style



356 - Classic Estimating Help Guide

Creating a Report Style

Until you create your own report style, the default style is used. The default report style includes all
columns from all job screens.

1. Open a job.

2. Click on the Settings menu heading, move your mouse down to the Report Styles option. The 
Report Style Setup dialog appears, with the default report style selected.

3. To create your own report style, click on the Add button.

4. From the Add Style dialog that appears, enter the name you wish to use to identify the new report
style. Then, select an existing report style you wish to use as the basis for the new style. In
addition to the default report style, you can use the blank style, which does not include any
columns from any job screen. Click on OK.

5. Your new report style now appears within the Style Name list box. Now, you can modify the report
components and parameters that define your report style.
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Defining a Report Style

Defining a report style involves selecting the job components that you wish to include in your report,
and determining the order in which they should appear. You can also select the font to be used in
your report, control the headers and footers to be printed, and the page margins and page orientation
to be used.

Choose Screens to Include

Choosing the job components to be included in your report style is a two-step process: first, you
choose the job screens you wish to include in your report using the Report Style Setup dialog‘s
Report Elements page; then, you choose which (if any) columns you wish to exclude from job
screens using the Column Setup page.

On the Report Elements page, all job screens are listed with a check box beside each. For the
Takeoff and Extension screens, there are multiple entries, allowing you to select entire sections within
each screen. If you want to include a particular screen (or screen section) in your report style, make
sure a check mark appears in the check box beside the appropriate screen or section. If a check
mark does not appear beside a screen or screen section, it will not be included in the report style.

Choose Columns to Include

Once you have chosen the job screens to be included in your report style, you can click on the
Column Setup tab and narrow the scope even further. From the Column Setup page, you can exclude
individual columns from your report style, and rearrange the order in which columns will be printed.

The Column Setup page is divided into two sections: the columns included in the report style appear
on the right side of the page, while the columns excluded from the style appear on the left side.
Initially, all columns are included and appear on the right side of the dialog. Columns from all job
screens will be listed on the Column Setup page, even columns from job screens you have deselected
on the Report Elements page. However, only columns from job screens you have selected on the
Report Elements page will be included in your printed report.

Columns are grouped under the corresponding job screen name. To display the columns for a
particular screen, click on the plus sign beside the screen name. The tree will expand, displaying the
columns grouped under that screen or section. To collapse the list again, click on the minus sign that
appears in place of the plus sign.

To exclude a particular column, click on the column name within the right side of the screen, then
click on the Remove button. Alternatively, you could just double click on the column to be removed.
The column moves from the right side of the screen to the left side of the dialog, and is now excluded
from the report style. To exclude all the columns from a particular screen or section, click on the
screen or section name, then click on the Remove button.

To include a column within the report style, click on the column name within the left side of the
screen, then click on the Add button. Alternatively, you could just double click on the column to be
added. To include all columns from all screens, click on the Add All button.

Within the column list for each screen, other elements such as headings, totals, blank lines, and
page breaks are also listed. You can control whether these elements are printed by checking or
clearing the check boxes that appear beside each element.

Control Printing Order
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Controlling the order in which job components are printed is a two-step process: first, you control the
order in which job screens are printed from the Report Style Setup dialog’s Report Elements page;
then, you control the order of individual columns within each screen from the Column Setup page.

To change the order of jobs screen from the Report Elements page, click on the name of the job
screen to be repositioned, then click on the Move Up or Move Down. Alternatively, you could just drag
and drop the screen name to the new location.

To reposition a column from the Column Setup, simply click on the column name, then click on the
Move Up or Move Down button, or drag and drop the column to a new location under the same job
screen name. You cannot move a column from one job screen name to another.

Freeze/Unfreeze Columns

As part of the report style, you can control which columns get repeated if the report is unable to fit all
the columns on a single row. The frozen columns will be printed at the beginning of each row.

To freeze columns so that they appear at the beginning of each row, follow these steps:

1. On the Column Setup page within the Report Style Setup dialog, display the columns grouped
under the appropriate screen, then click on the last of the columns that you wish to remain
stationary. For example, if you want the first 3 columns to remain stationary, then click on the 3rd
column.

2. Click on the Freeze Cols button. The currently selected column, along with any columns preceding
that column within the same screen, are now frozen, and will be printed at the beginning of each
row.

To unfreeze columns so that they are no longer printed at the beginning of each row, follow these
steps:

1. On the Column Setup page within the Report Style Setup dialog, click on the first of the columns
that you wish to unfreeze. For example, if the first 5 columns are frozen and you want to unfreeze
columns 3 to 5, then click on column 3.

2. Click on the Unfreeze button. The currently selected column, along with any columns following that
column on the same screen, will be unfrozen.

Choose Fonts

As part of your report style, you can choose the fonts to be used in the report. Since report styles can
only be used when printing job reports, the fonts you choose from the Report Style Setup dialog will
not affect the fonts used when printing job summaries from the Job Schedule screen.

To control the fonts used by a particular report style, follow these steps:

1. Display the Report Style Setup dialog by clicking on the Settings menu, and selecting the Report
Styles option.

2. From the Report Style Setup dialog, select the appropriate report style from the Style Name list
box

3. Click on the Fonts tab to display the Fonts page.
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4. From the Fonts page, select the appropriate typeface, point size, and type style. Depending on the
typeface you select, type style options may include Normal, Bold, Italic, and Bold Italic.

Print Parameters

Within your report style, you can set various printing parameters, including headers and footers, page
margins, and page orientation. Since report styles can only be used when printing job reports, the
print parameters you specify from the Report Style Setup dialog will not affect reports printing from the
Job Schedule screen.

To specify print parameters for a particular report style, follow these steps:

1. Display the Report Style Setup dialog by clicking on the Job menu, moving your pointer over the
Styles option, then selecting Report.

2. From the Report Style Setup dialog, select the appropriate report style from the Style Name list
box

3. Click on the Page Setup tab to display the Page Setup page.

4. From the Page Setup page, set the print parameters are required. The following options are
available:

Option Description

Page Margins You can control the size of the page margins in
inches by entering values in the Top, Bottom,
Left, and Right fields. You can specify margins
between .25" and 3.0".

Header /Footer Determines the information printed at the top
and bottom of each page. You can choose to
have the date, time, page #, and/or a solid
dividing line printed in the header or footer area.
To enable any of these print options, click the
appropriate check box so that a checkmark or
an X appears if one is not already there. You
can also specify text to print in the header and
footer areas. If you want job information (such
as the database name) to print, you can include
one or more field codes, each enclosed within
angle brackets. The valid field codes depend on
the type of report you are printing. Orientation
Controls how to print the page; portrait or
landscape.

Orientation You can choose what orientation (portrait or
landscape) your report will be printed with.

Header Logo Graphic Allows you to select a logo bitmap to be printed
on the report in the Header of the report. Any
Windows .BMP file can be chosen as a logo
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Option Description

graphic. You can specify the name and location
of the bitmap file by typing it in the File Name
field, or you can click on the Browse button and
locate the file within your directory structure.

Using the appropriate radio buttons you can
choose between the having the logo printed on
only the first page of the report, or on all pages
of the report.

You can control the position of the logo using
the Top and Left fields, and its size using the
Width and Height fields. If you allow the
Maintain Proportion check box to be remained
checked, you can modify either the Width or
Height and the other value will be automatically
calculated. If you deselect the check box, you
can enter Width and Height values that could
stretch or otherwise distort the logo graphic.
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Displaying a Report Style on Screen

Once you have created a report style, you can view it on screen so that only those columns that
would get printed in the job report are displayed on screen. Displaying a report style on screen also
allows you to set the column widths for the report style. The column widths that appear on screen will
be used when using the report style to print reports.

To display a report style on screen:

click on the View menu and select the View Using Report Styles option, or

click on the View Using Report Styles button in the Styles toolbar.

Styles toolbar

The currently selected report style will be used in place of the screen style to determine which
columns appear on job screens. Only those columns enabled from the Column Setup page on the
Report Style Setup dialog displays on screen, and in the order specified as part of the report style.
(The currently selected report style is style that was last selected from the Report Style Setup
dialog.) A floating Report Style toolbar appears to remind you that the report style is in effect.

From the Styles toolbar, you can select a different report style to be viewed on screen by clicking on
the list box displaying the current report style.

To exit report style mode, so that the report style is no longer used in place of the screen style to
determine which columns appear on job screens, you can either:

select the View Using Screen Styles option from the View menu, or

click on the View Using Screen Styles button in the Styles toolbar.

The Report Style toolbar will disappear, and the currently selected screen style will be used to
determine which columns appear on job screens.
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Renaming a Report Style

After you have created a report style, you can rename it at any time. You cannot, however, rename
the default report style.

1. Display the Report Style Setup dialog, by clicking on the Settings menu heading then selecting the
Report Styles option from the sub-menu that appears.

2. From the Report Style dialog, select the report style you wish to rename from the Style Name list
box.

3. Click on the Rename button.

4. From the Edit Style Name dialog that appears, enter the new name, then click on OK. Your report
style has now been renamed.
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Deleting a Report Style

You can, at any time, delete a report style you have created. You cannot, however, delete the default
report style.

1. Display the Report Style Setup dialog, by clicking on the Settings menu heading then selecting the
Report Styles option.

2. From the Report Style dialog, select the report style you wish to delete from the Style Name list
box.

3. Click on the Delete button.

4. You will be prompted to confirm your desire to delete the selected report style. If you are sure you
wish to delete it, click on OK. The report style has now been deleted.
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C H A P T E R11
Product Screens

Estimating programs provide a number of screens to help you prepare, review, and manage your bids.
For information on screen components common to most estimating program screens, see Screen
Components. For information on specific screens, click on the button beside one of the following:

  Schedule Screen

  Job Information Screen

  Notes Screen

  Takeoff Screen

  Extension Screen

  Direct Labor Screen

  Incidental Labor Screen

  Labor Factoring Screen

  Labor Escalation Screen

  Indirect Labor Screen

  Subcontractors Screen

  General Expenses Screen

  Quoted Materials Screen

  Final Pricing Screen

  Price Summary Screen

  Bid Breakdown Screen

  Graph Screen

  Quote Pad Screen
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Screen Components
All estimating program screens share a common look, feel, and behavior. The major screen
components found on most estimating program screens are described below.

Program Control Box

The program control box appears in the upper left corner of the program screen and provides menu
options that can be used to close or minimize the program. To display the program control menu,
click once on the program control box. From the menu, select an option by clicking on it.

Job Control Box

The job control box appears in the upper left corner of the job window and provides menu options that
can be used to close or minimize a job window. To display the job control menu, click once on the job
control box. From the menu, select an option by clicking on it.

Title Bar

The title bar displays the name of the program and the title of the active window. If you change to a
different company, job file, or switch between a schedule and job window, the title bar will change to
reflect the new information.

Menu Bar

The menu bar displays program menus, each of which consists of a number of related menu options.
Single click on any of the menu names to view its pull-down menu. To select one of the menu options
from the pull-down menu, click the option name.

Toolbar

Toolbars provide a quick way to access frequently used program functions without using pull-down or
pop-up menus. If you position your mouse pointer over a toolbar button and wait a second or two, the
function represented by the button will be displayed in a tool tip. If a toolbar button appears “grayed”
out, that option is not currently appropriate or available.
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The estimating programs use a standard toolbar, as well as several optional toolbars. The standard
toolbar appears below.

You can disable any toolbar by selecting the appropriate option from the View menu.

Windows Buttons

You can use the buttons that appear in the upper right corner of the program window to control the
size of the window. The following buttons appear in the upper right corner of the program window.

Scroll Bars

You can use horizontal and vertical scroll bars to move hidden portions of a screen or window into
view. If the entire contents of a window are displayed on the screen, the scroll bars may be absent or
dimmed to indicate they are not required.

Splitter

The splitter is used to divide the screen into separate window panes. You can adjust the portion of the
screen occupied by each pane by dragging the splitter up or down, or to the left or right (depending on
whether the screen is divided horizontally or vertically). When you position your pointer over the
splitter, the pointer changes to a double-sided arrow. With the pointer appearing as a double-sided
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arrow, you can move the splitter by holding down your left mouse button and dragging.

Screen tabs

The screen tabs that appear at the bottom of each screen allow you to move quickly between program
screens. To move to another screen, click the appropriate tab. For example, to move to the Extension
screen, click the Extension tab.

Status Bar

The status bar appears along the bottom of the program window and displays information messages,
status messages, and the name of the currently loaded database.
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Screen Appearance
You can control the appearance and content of your program screens in a number of different ways.

From the Appearance page on the Options dialog allows you to control the colors used in cells to
represent different kinds of information.

From the Appearance page, you can also choose themes that determine the overall color and
appearance of the program screens.

From any program screen with a grid, you can use the mouse to resize column widths.

On most screens that consist of grids, you can control the order in which rows are displayed.

Using screen styles, you can control the content and fonts of job screens, and the Job Schedule
screen.

For more information, follow one of the above links.
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Choosing Screen Themes

Screen themes control the overall color and appearance ("look and feel") of program screens. You can
select a different screen theme from the Appearance page of the Options dialog. (To display the
Options dialog, select Options from the Settings menu.)

The available themes correspond to the themes available in different versions of Windows and
Microsoft Office.

Screen themes do not affect the foreground or background colors of individual grid cells. You can also
control the foreground and background colors of cells from the Appearance page of the Options dialog.
For more information, see Controlling Cell Colors.
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Controlling Cell Colors

The estimating programs use certain combinations of foreground and background colors to represent
different kinds of information in cells. The foreground color is applied to the text itself, while the
background color is applied to the area behind the text. For example, by default, missing or
incomplete data displays as white text on a red background.

To override the default colors, select Options from the Settings menu, then click the Appearance tab.
The Appearance page allows you to control the colors used to represent different kinds of information,
and choose themes that determine the overall color and appearance of the program screens.

To specify a different color, click the Foreground or Background list box and select the desired color.
The Sample area displays the foreground and background colors you choose. To return all color
settings to their original default values, click the Reset All button.

The following color categories are available:

Category Default Color Scheme Applied to ...

Cell Editable Normal Black on white Regular editable cells.

Cell Non-Editable Normal Black on light yellow Cell data that cannot be
modified.

Cell Editable Grayed Gray on white Default cell values that can be
overridden.

Cell Non-Editable Grayed Gray on light yellow Cell values that cannot be
overridden. These include non-
modifiable default values.

Cell Editable Highlight Blue on white Pinned values that can be
modified. For example, where
a value can be specified as
either a percentage or a fixed
amount, the specified (or
“pinned”) value displays
highlighted.

Cell Non-Editable Highlight  Blue on light yellow Pinned values that cannot be
directly modified. For example,
values appear on the Totals
screen that have been carried
forward from previous screens
appear highlighted but can only
be modified from the original
screen.

Cell Editable Alarm White on red Cells with missing or
incomplete data that can you
can modify directly. To control
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Category Default Color Scheme Applied to ...

cell alarms see the Extension
page of the Options dialog.

Cell Non-Editable Alarm White on red Cells with missing or
incomplete data that cannot be
directly modified, but can be
completed by entering the
appropriate values in other
related fields. To control cell
alarms for certain fields on the
Extension screen, see the 
Extension page of the Options
dialog.

Cell Totals Alarm Red on white Column totals that include
cells with missing or
incomplete data.

Typical Highlight Green on white Typical takeoffs within the
audit trail
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Resizing Columns

From any program screen with a grid, you can use the mouse to resize the column widths, to bring
hidden information into view. Any changes you make to column widths will be saved when you exit the
program.

1. Move your pointer to the column headings at the top of the column you wish to resize.

2. Position your pointer over the grid boundary-line separating this column heading from the one to the
right. Your pointer will change shape to become a double sided arrow.

3. Hold the left mouse button down and drag the grid boundary to resize the row or column.

Alternatively, you can allow the program determine the ‘best fit’ for the column width. To do so, move
your pointer over the grid boundary of the column you wish to resize so that the pointer becomes a
double-sided arrow. Then, double click the left mouse button to have the program automatically resize
the column.

Tip - A string containing ##### occurs when a cell contains a value that is wider than the cell. To
view the actual value in the cell, increase the width of the column.
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Sorting Grids

On most screens that consist of grids, you can control the order in which rows are displayed. You
can sort the rows using any of the available column headings. For example, you can sort the Direct
Labor screen by Hours, in ascending or descending order.

You can sort rows on any screen except the Job Info, Takeoff, Final Pricing,  Price Summary, and Bid
Breakdown screens. To control the order in which jobs appear on the Job Schedule screen, you
select the Sort Schedule option from the Filter & Sort submenu under View.

To control the order in which rows are displayed on a grid:

1. Click a cell in the column you want to sort by.

2. Click the Sort Ascending button on the toolbar to sort rows in ascending order (numerically
beginning with 1 then alphabetically beginning with A)

An up or down triangle displays in the heading of a column being used to sort rows in ascending or
descending order.

Sorting indicator

The sorting will be ignored when printing or export screen information. While the sorting is in effect,
the Insert, Cut, and Paste options will not be available from the pop-up menus for individual rows.

To remove the sorting so that rows appear in their default order, click the Clear Sort button on the
toolbar. The sorting is automatically cleared when you switch to another program screen.



374 - Classic Estimating Help Guide

Screen Styles
Using screen styles, you can control the content and fonts of job screens, and the Job Schedule
screen. You can control the columns that appear, the width of the columns, and the fonts to use to
display the information. (Job screens include any screens except the Schedule screen) You can
create multiple screen styles, each with a different combination of columns, column widths, and fonts,
and easily switch back and forth between different screen styles.

Though screen styles are primarily used to control the on-screen appearance of your estimating
program, they can, in some cases, be used to determine the appearance and content of reports such
as database reports and job summaries. To control the appearance of other printed reports, you use 
report styles.

Trimble estimating programs maintain separate sets of screen styles for the following:

Job screens

Job Schedule screen

The screen styles you create while displaying a job screen will be available on any other job screen,
but will not be available on the Job Schedule screen. Once created, a screen style can be accessed
and updated from any job. Any changes made to a screen style from one job will apply to any jobs
that use that style.

When you save a job, any changes you have made to the current screen style are saved as well.
Each time you run your estimating program, the program will automatically open the screen style in
use the last time you displayed the Job Schedule screen. Each time you open a job, the job
automatically loads the last screen style used with this job. When you create a new job, the current
screen style serves as the default screen style for the new job.

 Tip - If a screen style is shared by multiple jobs, any changes made to the style sheet from one
job does affect the style sheet of the other jobs that use it.

If you're on a network, you can share screen styles between multiple users. To do so, specify a
shared location for the screen style files on the File Locations page of the Options dialog.

For more information on using screen styles, see one of the following topics:

Manage Screen Styles
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Creating a Screen Style

Using screen styles, you can control the appearance and content of job screens, the Job Schedule
screen, and the Database Manager module. If you do not create a screen style, the default screen
style is used. The default screen style includes all possible columns

Create Screen Style

To create and define screen styles, you use the Screen Style Setup dialog. The Screen Style
Setup dialog is accessed in different ways depending on whether you are creating screen styles for
job screens, the Job Schedule screen, or the Database Manager module.

1. Switch to the screen whose appearance you wish to control. For example, switch to a job screen
such as the Takeoff screen or the Extension screen if you wish to create a screen style that
determines the appearance of job screens.

2. Display the Screen Style Setup dialog. 

3. Do one of the following: 

To access the Screen Style Setup dialog, you can click on the Edit Screen Styles button
within the Screen Styles toolbar,

From a job screen, click the Settings menu, and select Screen Styles. 
From the Job Schedule screen,  click the Settings menu, and select Screen Styles.
From the Database Manager screen,  click the Settings menu, and select Screen Styles.

4. Click the Add button and the Add Style dialog displays.

5. Enter the name of the new style in the first field.

6. Click the second field, and select the style to use as the basis for the new style. You can model
the new style after an existing style or the default style (which includes all columns).

7. Click OK. The new style you created now appears as the currently selected style in the Screen
Style Setup dialog.

From the Screen Style Setup dialog, you can change the column setup or screen fonts. To change
column widths on any job screen, click OK to exit the Screen Style dialog, then jump to the
appropriate screen and adjust the appropriate column(s).

Tip - To reset column widths to their default state, click the Reset Widths button. You are then
asked whether you wish to reset column widths for all screens, or just for the screen currently
selected on the Column Setup page within the Screen Style Setup dialog.

Switch to a Different Style
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The default screen includes all columns on all screens. If you have already created one or more of
your own screen styles, you can easily switch to a different screen style.

1. Click on the View menu and select the View Using Screen Styles option, or click on the View
Using Screen Styles button in the Styles toolbar.

2. Click  to select a different screen style from the list.

Include/Exclude Columns

From the Screen Style Setup dialog, you can control which columns appear on job screens, the
Job Schedule screen, or the Database Manager module.

1. Display the Screen Style Setup dialog for job screens, the Job Schedule screen, or the
Database Manager module.

2. Click the Column Setup tab if it is not already selected.

3. Select the appropriate screen style from the Style Name list box. The left side of the Column
Setup tab displays the columns currently excluded from the screen style, while the right side
displays the columns currently included in the style. At first, the lists appear collapsed so that
only screen names are displayed. To view the columns included or excluded for each screen,
click the plus sign to the left of the screen name. A column list should appear as a branch
beneath the screen name.

4. To exclude a column/screen, click the column from the right side of the dialog, then click the
Remove button. Click a column/screen from the left side of the dialog to include it, then click the
Add button. To exclude all columns/screens, click the Remove All button. To include all
columns/screens, click the Add All button.

To include or exclude a column/screen, double click it from the appropriate side of the dialog.
For example, if a column/screen appears on the right side of the dialog (and is therefore
included in the current screen style), double clicking the column would move it to the left side
of the dialog (thereby excluding it from the screen style).

To change the order in which columns appear on each screen, you can drag and drop the
column to a new location under the same screen name on the right side of the Screen Style
Setup dialog. Alternatively, you can click a column name, then click the Move Up or Move
Down button to reposition the column.

To prevent future changes to column location, select the column and click the Freeze Cols
button. To alter a previously frozen column, select the column and click the Unfreeze button.
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5. Click OK.

Freeze/Unfreeze Columns

As part of a screen style, you can control the number of columns along the left side of the screen
that remain stationary when you scroll within the screen to view hidden columns.

Freeze Columns

1. Display the Screen Style Setup dialog for job screens, the Job Schedule screen, or the
Database Manager module.

2. Click the Column Setup tab if it is not already selected.

3. Click the last of the columns that you wish to remain stationary. For example, if you want the
first 3 columns to remain stationary, then click the 3rd column.

4. Click the Freeze Cols button. The currently selected column, along with any columns preceding
that column on the same screen, are now frozen, and will not move when you scroll within the
screen.

Unfreeze Columns

1. Display the Screen Style Setup dialog for job screens, the Job Schedule screen, or the
Database Manager module.

2. Click the Column Setup tab if it is not already selected.

3. Click the first of the columns that you wish to unfreeze. For example, if the first 5 columns are
frozen and you want to unfreeze columns 3 to 5, then click column 3.

4. Click the Unfreeze button. The currently selected column, along with any columns following that
column on the same screen, becomes unfrozen.

Screen Fonts

From the Fonts tab on the Screen Style Setup dialog, you can choose the font to be used on
screen for the currently selected screen style.

1. Click the Fonts tab.

2. Select the appropriate screen style from the Style Name list box.

3. Select the appropriate font, point size, and style. Depending on the typeface, style options may
include Normal, Bold, Italic, and Bold Italic.
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Controlling the Page Setup

If you invoke the Screen Style Setup dialog from the Job Schedule screen, you can use the Page
Setup options to control the page setup for job summary reports and database update reports.

From the Page Setup page, you can control page layout, and specify headers and footers.

You can specify the following page setup information for job schedules:

Option Description

Page Margins You can control the size of the page margins in
inches by entering values in the Top, Bottom,
Left, and Right fields. You can specify margins
between .25" and 3.0".

Header /Footer Determines the information printed at the top
and bottom of each page. You can choose to
have the date, time, page #, and/or a solid
dividing line printed in the header or footer area.
To enable any of these print options, click the
appropriate check box so that a checkmark or
an X appears if one is not already there. You
can also specify text to print in the header and
footer areas. If you want job information (such
as the database name) to print, you can include
one or more field codes, each enclosed within
angle brackets. The valid field codes depend on
the type of report you are printing. Orientation
Controls how to print the page; portrait or
landscape.

Orientation You can choose what orientation (portrait or
landscape) your report will be printed with.
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Enter Information
Depending on the cell, you can enter values directly, select from a list of possible values, or invoke a
dialog where the value can be determined. When entering values directly, you can enter them one at a
time or fill multiple cells with the same value.

You can also copy and paste information from other applications, such as Microsoft Word or
Microsoft Excel, into any editable grid.

Where you can enter information directly into a cell (or overwrite the existing contents of the cell), you
just click the cell and begin typing. If you want to modify the existing contents of an editable cell,
double click the cell.

For more information, see one of the following topics:

Displaying Lists and Invoking Dialogs

Filling a Range of Cells

Copying Information from Other Applications
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Displaying Lists and Invoking Dialogs

Depending on the cell, you can enter information directly, select from a list of possible values, or
invoke a dialog where the value can be determined.

If a cell can only accept a limited number of value, a drop-down list button  displays in the cell
when its row is selected. To display the list of possible values, click on the drop-down list button.

If the value of a cell depends on the information you select or enter on a dialog, then a dialog button 

 displays in the cell when its row is selected. To invoke the dialog, click on the dialog button.
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Filling a Range of Cells

The Fill menu option (available from the Edit menu) allows you to update a range of cells with the
same value. You can use an existing value or enter a value in a cell to fill a range of selected cells.

To fill a range of cells with the same value:

1. Click the cell that contains the value you want to use.

2. Drag the mouse up or down over the whole range of cells that you want to set to the same value.
You can select any number of cells within the same column.

3. Click the Edit menu and select the Fill option. Alternatively, with the pointer positioned in the
selected area, click the right mouse button and select the Fill option from the pop-up menu that
appears.

All the selected cells now contain the same value you assigned to the first cell in the range.

To fill a range of cells with a new value:

1. Click the first cell of the range that you want to change then drag the mouse up or down over the
whole range of cells that you want to set to the same value. You can select any number of cells
within the same column.

2. Enter the new value in the selected cell.

3. Press the [Enter] key to update the first cell.

4. Click the Edit menu and select the Fill option, or right click and select the Fill option.

All the selected cells now contain the same value.
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Copying Information from Other Applications

You can copy information from other applications, such as Microsoft Word or Microsoft Excel, and
paste it into any editable grid. You can copy and paste multiple rows and columns of information, or a
single cell. For example, you can copy and paste multiple system breakdowns, complete with
adjustment percentage and cost code, from an accounting spreadsheet into the System Modify
dialog.

If you paste multiple rows or columns of information, your estimating program will attempt to paste all
rows and columns. If any of the information is incompatible with any of the destination cells, the
program will paste only the compatible information and display a message indicating that some of the
information could not be pasted. For example, if you are copying and pasting alphanumeric
information into the first two columns of the Direct Labor screen, the program will paste into the Labor
Type column, but not the Crew column, since this column accepts only numeric input.
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Job Schedule Screen
The Job Schedule screen is used to help you keep track of your bids. You can record information
about your pending jobs as well as any closed jobs.

The Job Schedule screen lists your jobs in ascending order by job number. If you number your jobs
sequentially, then the most recent job displays at the bottom of the list. When sorting the jobs by job
number, the program ignores all non-numeric characters. When the Job Schedule screen appears, it
automatically shifts focus to the last job in the list.

You can also filter the Job Schedule screen so that only those jobs that match the criteria you specify
displays.

After a contract has been awarded, you can change the status of your job, and indicate how your bid
price compared to competing bids. To indicate the value of the lowest bid other than yours, enter a
value in the Next Price cell and let the program calculate the Spread %. At the bottom of the Job
Schedule screen, your bid prices are summarized according to status.

The Job Schedule screen automatically appears when you run the program. To access the Job
Schedule screen from another program screen, choose the Schedule option from the View menu or
the Window menu.

The columns that appear on the Job Schedule screen are described below.

Column Description

Type The type of job. Estimating jobs will be
designated either normal (blank),  Master Job
(M), or Sub Job (S).

Job Name The job description. Can be up to 80 characters
long. The job name displays alarmed (with a red
background) if any row on the Final Pricing
screen is set to alarm. The job name will be
appear alarmed with the words *** Job in use ***
if the job is currently open.

Job # The number you have assigned to the job. The
job number is combined with an .es9 extension
to form the name of the job file.

Date Saved The date the job was last saved.

Bid Price The total dollar amount for this job, including
material, labor, overhead, markup etc.
Automatically inserted based on the Final Price
from the Price Summary screen.

Status The status indicates if a job has closed and the
overall ranking of the submitted bid. By default,
the job status is Pending. You can change the
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Column Description

job status from Pending to First, Second, Third,
or Other. To change the status of your job, click
the Status cell for the appropriate job, then
press one of the following letters on your
keyboard: [F] for First, [S] for Second, [T] for
Third, or [O] for Other. After pressing the
appropriate key, press [Enter] or click the
checkmark button to complete the change.

Spread % The % difference between the low bid and your
price, or your price (if you are low bid) and the
next price.

Next Price If you were low bid, the next closest price. If
you were not low bid, this will be the price of the
winning tender.

Notes Comments about the job.

Last Bid Displays the name of the bid summary in effect
when you last saved the job. For more
information on bid summaries, see Creating
Multiple Bid Summaries.

Price / Area This is the price per unit area. This value is first
calculated in the PrSum screen.

Lb Hrs The total labor hours from the Direct Labor,
Incidental Labor, Indirect Labor, and Labor
Factoring screens.

Job Path The name and location of the job file.

Bid Due Date The date that client will require delivery of a
completed bid.

Estimator The name of the estimator responsible for the
job.

Job Category Description of the category of  job.
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Job Information Screen
Not available for PowerBid.

 The Job Information screen is used to help you keep track of the contact, bid, and file information that
is necessary to successfully complete the job.

The Job Information screen automatically appears when you access a job from the Job Schedule
screen. To access the Job Information screen from another program screen, click the Job Info tab at
the bottom of the screen.

The fields appearing on the Job Information screen are described below:

Field Description

Job Name The job description. Can be up to 80 characters
long.

Job Number The number you have assigned to the job. The
job number is combined with an .es11
extension to form the name of the job file.

Bid Due Date The date that client will require delivery of a
completed bid.

Due Time The time of day that the client has set as the
bid submission deadline.

Job Address The address and contact information for the site
of the job on which you are bidding.

Client Address The address and contact information for the
client or company that is requesting the bid.

Job Path The directory or folder where your jobs are
stored.

Job Category Description of the category of  job.

Estimator The name and contact information of the
estimator responsible for the job.

Starting Date The starting date of the job. If you click the
radio button beside this field, it will be
automatically calculated using the values you
enter for Completion Date and Duration.

Completion Date The projected completion date of the job. If you
click the radio button beside this field, it will be
automatically calculated using the values you
enter for Starting Date and Duration.
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Field Description

Duration The duration of the job in days, weeks, months,
or 4-week intervals. If you click the radio button
beside this field, it will be automatically
calculated using the values you enter for
Starting Date and Completion Date. You can
click on the drop down to change whether the
duration is expressed in days, weeks, months,
or 4-week intervals.

Link area Add, remove, and open links to files, folders, or
internet addresses (URLs) associated with the
job.
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Notes Screen
The Notes screen provides a notepad in which you can record comments or reminders. To access the
Notes screen from another program screen, click the Notes tab at the bottom of the screen, or click
on the View menu and select Notepad.

This screen acts as a simple text editor in which you can type, delete, cut, copy, and paste text, as
well as change text color, font size, and use field codes to include information from your job (such as
database name) in order to  produce a formal quotation. When you print your notes, the program will
replace the field code with the appropriate value. To insert a field code, right click and select the Insert
Field option. From the Field Codes dialog that appears, you can select the appropriate code.

To alter the appearance of the text on the notes screen, simply select the text you wish to edit, and
select an option from the Format menu (Font, Alignment, or Bullet) or enable the Formatting toolbar.

The following field codes are available from the Notes screen:

Code Description

<TAB:1.0> Distance in inches that text following will be
indented from left

<DATE> The present date

<TIME> The current time

<JOB_NAME> Job description

<JOB_NUMBER> Job number

<JOB_PATH> Directory and filename of the job

<JOB_TYPE> Job category as it appears on the Job
Information screen

<STARTING_DATE> Starting date of the job as defined on the Job
Information screen

<COMPLETION_DATE> Completion date of the job as defined on the
Job Information screen

<DURATION> Duration of the job as calculated on the Job
Information screen

<DURATION_BASEDON> Whether the duration is expressed in days,
weeks, or months

<DATABASE_NAME> The name of the database used for this job

<DATABASE_NUMBER> The number of the database used for this job
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Code Description

<DATABASE_PATH> The name and location of the database file

<BID_SUMMARY_NAME> Currently selected bid summary

<BID_DUE_DATE> Bid due date as it appears on the Job Info
screen

<BID_DUE_TIME> Bid due time as it appears on the Job Info
screen

<ESTIMATOR> Estimator's name as it appears on the Job Info
screen

<ESTIMATOR_TELEPHONE> Estimator's telephone number as it appears on
the Job Info screen

<ESTIMATOR_CELLPHONE> Estimator's telephone number as it appears on
the Job Info screen

<ESTIMATOR_FAX> Estimator's fax number as it appears on the Job
Info screen

<ESTIMATOR_EMAIL> Estimator's e-mail

<JOB_TYPE> Job type as it appears on the Job Info screen

<JOB_ADDRESS_NUMBER> Job address number as it appears on the Job
Info screen

<JOB_ADDRESS_SITE_NAME> Job address site name as it appears on the Job
Info screen

<JOB_ADDRESS_ADDRESS_1> Job address 1 as it appears on the Job Info
screen

<JOB_ADDRESS_ADDRESS_2> Job address 2 as it appears on the Job Info
screen

<JOB_ADDRESS_CITY> Job address city as it appears on the Job Info
screen

<JOB_ADDRESS_STATE> Job address state as it appears on the Job Info
screen

<JOB_ADDRESS_COUNTRY> Job address country as it appears on the Job
Info screen

<JOB_ADDRESS_ZIP> Job address zip or postal code as it appears on
the Job Info screen
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Code Description

<JOB_ADDRESS_TELEPHONE> Job phone as it appears on the Job Info screen

<JOB_ADDRESS_CELLPHONE> Job cell phone as it appears on the Job Info
screen

<JOB_ADDRESS_FAX> Job fax as it appears on the Job Info screen

<JOB_ADDRESS_CONTACT> Job address contact as it appears on the Job
Info screen

<JOB_ADDRESS_EMAIL> Job address e-mail

<CLIENT_ADDRESS_NUMBER> Client address number as it appears on the Job
Info screen

<CLIENT_ADDRESS_SITE_NAME> Client address site name as it appears on the
Job Info screen

<CLIENT_ADDRESS_ADDRESS_1> Client address 1 as it appears on the Job Info
screen

<CLIENT_ADDRESS_ADDRESS_2> Client address 2 as it appears on the Job Info
screen

<CLIENT_ADDRESS_CITY> Client address city as it appears on the Job Info
screen

<CLIENT_ADDRESS_STATE> Client address state as it appears on the Job
Info screen

<CLIENT_ADDRESS_COUNTRY> Client address country as it appears on the Job
Info screen

<CLIENT_ADDRESS_ZIP> Client address zip as it appears on the Job Info
screen

<CLIENT_ADDRESS_TELEPHONE> Client phone as it appears on the Job Info
screen

<CLIENT_ADDRESS_CELLPHONE> Client cell phone as it appears on the Job Info
screen

<CLIENT_ADDRESS_FAX> Client fax as it appears on the Job Info screen

<CLIENT_ADDRESS_CONTACT> Client address contact as it appears on the Job
Info screen

<CLIENT_ADDRESS_EMAIL> Client address e-mail



390 - Classic Estimating Help Guide

Code Description

<LABOR_COLUMN> Labor column used in the Extension screen

<EXTENSION_TOTAL_HOURS> Total hours from the Extension screen

<DIRECT_LABOR_HOURS> Total hours from the Direct Labor screen

<DIRECT_LABOR_FULL_RATE> Full rate from the Direct Labor screen

<INCIDENTAL_LABOR_HOURS> Total hours from the Incidental Labor screen

<INCIDENTAL_LABOR_FULL_RATE> Full rate from the Incidental Labor screen

<LABOR_FACTORING_HOURS> Total hours from the Labor Factoring screen

<LABOR_FACTORING_FULL_RATE> Full rate from the Labor Factoring screen

<INDIRECT_LABOR_HOURS> Total hours from the Indirect Labor screen

<INDIRECT_LABOR_FULL_RATE> Full rate from the Indirect Labor screen

<GENERAL_EXPENSES_COST> Total cost from the General Expenses screen

<GENERAL_EXPENSES_TAX> Total tax from the General Expenses screen

<EQUIPMENT_COST> Total cost from the Equipment screen

<EQUIPMENT_TAX> Total tax from the Equipment screen

<QUOTED_MATERIALS_ADJUSTED_COST> Total adjusted cost of all material from the
Quoted Material screen

<SUBCONTRACTORS_ADJUSTED_COST> Total cost from the Subcontractors screen

<SUBCONTRACTORS_TAX> Total tax from the Subcontractors screen

<SELLING_PRICE> Selling price as it appears on the Final Pricing
screen

<FINAL_PRICE> Final price as it appears on the Final Pricing
screen

<AREA> Area value from the Price Summary screen

<TOTAL_HOURS> Total labor hours as it appears on the Price
Summary screen

<LABOR_RISK_RATIO> The Labor Risk Ratio % value from the Price
Summary screen
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Takeoff Screen
From the Takeoff screen, you can choose your takeoff breakdown, select materials for the takeoff, and
enter the takeoff measurements. To access the Takeoff screen from another program screen, click the
Takeoff tab at the bottom of the screen.

The fields appearing on the Takeoff screen are described below:

  Field   Description

Takeoff Click here to select the Takeoff option. The
takeoff option you select determines which
items and assemblies are displayed in the
materials list that appears below the Takeoff list
box. For more information on takeoff options,
see Selecting Materials for a Takeoff. In the
area below the Takeoff list box, different
material lists are displayed depending on the
current takeoff option. Within both the Item
Database and Common Assemblies options,
materials have been categorized into as many
as four levels. The current level will be identified
by a level indicator. Each level consists of either
categories, items or assemblies. The Type
column will display the letter C to identify a
category, the letter A to identify an assembly,
and the letter I to identify items.

Double clicking on a category moves you down
one level within the database, displaying the
items or categories that comprise the category
you clicked on. To return to a previous level,
click with your right mouse button while your
pointer is positioned over the database section.
Alternatively, you could achieve the same result
by pressing the [Esc] key.

Database In the Database area, the categories, items,
and assemblies that comprise the database are
displayed. Within both the Item Database and
Common Assemblies views, materials have
been categorized into as many as four levels.
The current level will be identified by a level
indicator.

Each level consists of either categories, items
or assemblies. The Type column will display the
letter C to identify a category, the letter A to
identify an assembly, and the letter I to identify
items.
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  Field   Description

Double clicking on a category moves you down
one level within the database, displaying the
items or categories that comprise the category
you clicked on. To return to a previous level,
click with your right mouse button while your
pointer is positioned over the database section.
Alternatively, you could achieve the same result
by pressing the [Esc] key.

Job (not available for BidWinner or PowerBid) Click
the Job button to modify the list of job
breakdowns (for master jobs only), and click the
Job list box to select the job breakdown whose
takeoffs will be shown. For more information,
see Modifying Takeoff Breakdown Options and
Creating a Sub Job.

Drawing (not available for PowerBid) Click the Drawing
button to modify the list of drawing breakdowns,
and click the Drawing list box to select the
drawing breakdown to which the takeoff will
apply. For more information, see Modifying
Takeoff Breakdown Options.

Area (not available for BidWinner or PowerBid) Click
the Area button to modify the list of area
breakdowns, and click the Area list box to
select the area breakdown to which the takeoff
will apply. For more information, see Modifying
Takeoff Breakdown Options.

Phase Click the Phase button to modify the list of
phase breakdowns, and click the Phase list box
to select the phase breakdown to which the
takeoff will apply. For more information, see 
Modifying Takeoff Breakdown Options.

System Click the System button to modify the list of
system breakdowns, and click the System list
box to select the system breakdown to which
the takeoff will apply. For more information, see 
Modifying Takeoff Breakdown Options.

Bid Item (not available for BidWinner or PowerBid) Click
the Location button to modify the list of location
breakdowns, and click the Location list box to
select the location breakdown to which the
takeoff will apply. For more information, see 
Modifying Takeoff Breakdown Options.
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  Field   Description

Lb Factor (not available for PowerBid) Click the Lb Factor
button to modify the list of labor factor
breakdowns, and click the Lb Factor list box to
select the labor factor breakdown to which the
takeoff will apply. For more information, see 
Modifying Takeoff Breakdown Options and
Labor Factoring.

Show Deleted Takeoffs Controls whether deleted takeoffs are displayed
(grayed and crossed out) within the audit trail.

Audit Trail The audit trail is a permanent record of all your
takeoffs including any deletions that are made.
To modify a takeoff, you double click the
appropriate entry within the audit trail. You
change a negative takeoff to a positive one by
right clicking over the takeoff and selecting
Reverse Takeoff from the pop-up menu that
appears.

When you delete a takeoff entry from the audit
trail list, the takeoff remains in the list but
appears crossed out. You can restore the
deleted takeoff by clicking on the Delete option
or button again. You can control whether
deleted takeoffs are displayed within the audit
trail by selecting or deselecting the Show
Deleted Takeoffs check box.

You can filter the audit trail to display only
those takeoffs that match the currently selected
breakdown criteria. By default, the audit trail
displays only those takeoffs that match the
currently selected system breakdown (as
indicated by a check mark in the box to the left
of the System button). To filter by additional
breakdowns, click the check box beside the
appropriate breakdown name so that a
checkmark appears. For more information, see 
Filtering the Audit Trail.

To display the items that comprise a takeoff
line, double click the appropriate line within the
audit trail. To return to displaying the takeoff
lines, press [Esc] on your keyboard. Alternately,
you could click with your right mouse button
and select the Abort option.

If you have attached a note to a takeoff from the
Measure/Edit Takeoff screen, a note button
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  Field   Description

displays beside the takeoff in the audit trial. To
view or modify the note, right click over the
takeoff and select the Notes option.

If you have used an external takeoff tool such
as cadLive or LiveCount to determine the takeoff
quantity, a value displays in the Source column
to identify the source application.
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Extension Screen
When you display the Extension screen, the program reads the takeoffs, groups the items by the
Takeoff Breakdown, consolidates item totals and applies the item prices and labor units from the
currently assigned database. This information displays in a spreadsheet format. To access the
Extension screen from another program screen, click the Extension tab at the bottom of the screen.

Initially, the Extension screen appears in consolidated view with combined totals for each item. To
switch to the expanded view, so you can view the takeoff quantities for a particular item, double click
the row displaying the item. You can also double click on an assembly entry to display quantities and
prices for each item in that assembly. For return to the consolidated view, select Collapse from the
Extension menu.

When the extension is first displayed, it will be grouped by item. You can also group the extension by
system, drawing, area, phase, location, labor factor, sort codes, or unit price.

When the extension is grouped by item, you can edit the Description, Price, Unit, Discount, Net Cost,
Labor, Labor Unit, Material Condition, and Labor Condition. If you wish to change the Quantity, you
must first double click the row heading (the number on the far left) of the consolidated item to display
the expanded view. From the expanded view, you can modify only the item quantity.

When the extension is grouped by system, area, drawing, phase, location, or labor factor, you can
double click the row heading of an entry to display the extended items within the system, drawing,
phase, or labor factor. If you have grouped the extension by unit price, you can double click the row
heading of any takeoff to display quantities and prices for each item.

You can filter the extension so that it displays only those items that match specific conditions as
defined in the database. You can filter the extension by material condition, price, discount, labor
condition, labor hours, date, or price code. For example, you may want to see only those takeoff
items with a Budget material condition. The filter will remain in effect until it is cleared or until the job
is closed.

Filtering the extension does not alter the extension itself or your bid totals. However, switching
between different bid summaries (Pro and BidWinner Plus only) will result in different extensions and
bid totals. For more information on alternate bid summaries, see Creating Alternate Bid Summaries.

While a filter is applied to the Extension screen, a filter indicator displays beside the word Totals at
the bottom of the screen.

You can save the filter and grouping settings that you apply to the extension as a "view", which you
can select from a list of saved views. This allows you to create multiple views that you can quickly
switch between. For more information, see Working with Views.

From the Extension screen, you can also add a takeoff item, which will be automatically added to the
temporary items list.

By default, a Net Cost cell or a Labor cell with a value of 0.00 displays alarmed (with a red
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background), regardless of material condition. You can control which material conditions will result in
a Net Cost or Labor cell with a value of 0.00 appearing alarmed from the Extension page of the
Options dialog.  

If you make changes to the currently assigned database, you must re-extend the job in order for the
changes to be reflected on the Extension screen. Re-extending the job will reverse any changes you
have manually made to the portion of the extension you are re-extending.

For more information on using the Extension screen, click the button beside one of the following
topics:

  Editing the Extension

  Grouping the Job Extension

  Working With Views

  Calculating a Unit Price

  Filtering the Extension

  Re-extending the Extension

  Controlling Rounding within the
Extension

  Extension Menu

The following columns appear on the Extension screen in the consolidated view:

Colum
n

Description

Descripti
on

The description of the item.

Quantity The quantity of the item.

Date The date that the item's list price was last updated.

Trade
Price

The list or trade price of the item.

Price
Unit

The price unit for the item. Options are: E ( per each), C (per hundred), or M (per
thousand).

Disc % The supplier's discount applied to the list price as a percentage.

Link
Price

Net price obtained from supplier using Trimble's Supplier Link utility.

Cost Adj
%

Cost adjustment percentage to be applied to the discounted material price.

Net Cost The net material cost after the discount and cost adjustment is applied. If you override
the net cost, the cost adjustment percentage will be back-calculated to reflect the
change.
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Colum
n

Description

Labor The number of labor hours associated with the item. Field hours can be changed.

Labor
Unit

The labor unit for the item. Options are: E (per each), C (per hundred), or M (per
thousand).

Lab Adj
%

Percentage adjustment to be applied to the labor hours.

Total
Material

The total material cost of the item.

Total
Labor

The total number of labor hours including all labor adjustments times the quantity.

Material
Conditio
n

The material condition of the item. Options are: Normal, Halted, Quoted, Sub Contractor,
Owner Supplied, No Cost, Equipment, or Budget. Initially, this value is the same value
as that found in the database. However, the material condition can be changed.

Labor
Conditio
n

The labor condition of the item. Options are: Normal, Budget, No Labor, Sub Contractor,
Owner Supplied, or Shop Labor. Initially, this value is the same value as that found in the
database. You can change the labor condition.

Manufact
urer
Name

The manufacturer of the item.

Catalog
Number

The catalog number of the item. The catalog number is used in conjunction with the
manufacturer to identify which items are required for the job.

Price
Code

The price code associated with the item.

Referenc
e
Number

Number used to identify the item (e.g. part number).

Supplier The supplier of the item.

Supplier
Code

The supplier's order code for the item.

Sort
Codes 1-
6

The sort code values for sort codes 1-6.

Quick The quick takeoff code associated with the item. For more information, see Performing a
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Colum
n

Description

Takeoff
Code

Quick Takeoff.

The following columns appear on the Extension screen in the expanded view:

Column Description

Descripti
on

The description of the item.

Quantity The quantity of the item.

Job The job breakdown for this takeoff.

Drawing The drawing breakdown for this takeoff.

Area The area breakdown for this takeoff.

Phase The phase or floor breakdown for this takeoff.

System The system breakdown for this takeoff.

Bid Item The bid item breakdown for this takeoff.

Labor
Factoring

The labor factor applied to this takeoff.

Takeoff The takeoff description as it appears on the Takeoff screen.

Trade
Price

The list or trade price of the item.

Price
Unit

The price unit for the item. Options are: E (per each), C (per hundred), or M (per
thousand).

Disc % The supplier's discount applied to the list price as a percentage.

Link
Price

Net price obtained from supplier using Trimble's Supplier Link utility.

Cost Adj
%

Cost adjustment percentage to be applied to the discounted material price.

Net Cost The net cost after the discount and cost adjustment is applied. If you override the net
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Column Description

cost, the cost adjustment percentage will be back-calculated to reflect the change.

Labor
Type

The type of labor to use to produce the item.

Labor The number of field hours associated with the item.

Labor
Unit

The labor unit for the item. Options are: E (per each), C (per hundred), or M (per
thousand).

Total
Material

The total material cost of the item.

Total
Labor

The total number of labor hours including all labor adjustments times the quantity.

Material
Condition

The material condition of the item. Options are: Normal, Halted, Quoted, Sub
Contractor, Owner Supplied, No Cost, Equipment, or Budget. Initially, this value is the
same value as that found in the database. However, the material condition can be
changed.

Labor
Condition

The labor condition of the item. Options are: Normal, Budget, No Labor, Sub Contractor,
Owner Supplied, or Shop Labor. Initially, this value is the same value as that found in
the database. You can change the labor condition.

Lab Fct
%

The labor factoring percentage applied to this takeoff.

Brkdn
Fct %

The breakdown adjustment percentage applied to this takeoff.
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Direct Labor Screen
From the Direct Labor screen, you can customize your labor and adjust your crew allocation after the
job has been extended.

Labor hours are derived from the extension and divided among the different labor types according to
the specified number of crew members. When you add takeoffs or modify the extension, the Crew
value is used to calculate the new labor hours for each labor type. You should therefore review your
direct labor costs after adding takeoffs or modifying the extension.

If you override the number of hours assigned to a labor type, the Crew value will be removed, and the
program will no longer automatically adjust the labor hours for that labor type. As you add more
takeoffs, the additional labor hours will be divided among the remaining labor types that are based on
Crew.

Labor descriptions, rates and crew allocations are defined on the Direct Labor screen; initial values
are drawn from the default job. You should set your crew and rates in the default job so they appear
automatically in each new job. For more information, see Setting Job Defaults.

For more information on specifying labor costs, see Incorporating Labor Costs.

You can insert, cut, copy, and paste rows within this screen by right clicking on a row number and
selecting the appropriate menu option.

To access the Direct Labor screen from another program screen, click the DirLab tab at the bottom of
the screen.

The following columns appear on the Direct Labor screen:

Column Description

Labor Type The description of the type of labor.

Crew Number of people in the crew. After specifying
the number of crew for each labor type, you can
allow the program to divide the labor hours
among the different types, or you can directly
assign the labor hours to any or all of the labor
types.

Hours Direct labor hours. This value is calculated by
dividing the total labor hours among the different
labor types according to the specified number of
crew members. To override the calculated
hours, simply enter a different value in this
column.

Rate $ Hourly rate for the direct labor.

Subtotal Calculated by multiplying Hours x Rate $.
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Column Description

Brdn % The labor burden percentage to be added to the
hourly labor rate. Labor burden can include
holiday pay, government insurance plans,
unemployment insurance, public liability,
property damage, etc.

Frng $ Labor fringe rate.

Brdn Tot. Total labor burden (Subtotal * Brdn %).

Frng Tot. Total labor fringe (Hours * Frng $).

Total Calculated by adding Brdn Tot (total labor
burden) and Frng Tot (total fringe labor) to
Subtotal.

Full Rate Total labor rate including labor burden and labor
fringe.

Code Cost code. Used when exporting to accounting
packages.

Type Pro only

Cost type. Used when exporting to accounting
packages.



402 - Classic Estimating Help Guide

Incidental Labor Screen
From the Incidental Labor screen, you can incorporate labor not directly related to material quantities.
Examples would include job setup, travel time, and sleeving.

You should set up incidental labor descriptions in the default job so they appear automatically in each
new job. For more information, see Setting Job Defaults. The default values for Rate $, Brdn %, and
Frng $ are derived from the average values appearing at the bottom of the Direct Labor screen.

You can insert, cut, copy, and paste rows within this screen by right clicking on a row number and
selecting the appropriate menu option.

To access the Incidental Labor screen from another product screen, click the IncLb tab at the bottom
of the screen.

The following columns appear on the Incidental Labor screen:

Column Description

Incidental Labor Description of the incidental labor activity.

Hours The labor hours for each incidental labor
activity.

Rate $ Hourly rate for the incidental labor.

Subtotal Calculated by multiplying Hours x Rate $.

Brdn % The labor burden percentage to be added to the
hourly labor rate. Labor burden can include
holiday pay, government insurance plans,
unemployment insurance, public liability,
property damage, etc.

Frng $ Labor fringe rate.

Brdn Tot. Total labor burden (Subtotal * Brdn %).

Frng Tot. Total labor fringe (Hours * Frng $).

Total Calculated by adding Brdn Tot (total labor
burden) and Frng Tot (total fringe labor) to
Subtotal.

Full Rate Total labor rate including labor burden and labor
fringe.

Code Cost code. Used when exporting to accounting
packages.

Type Pro only
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Column Description

Cost type. Used when exporting to accounting
packages.
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Labor Factoring Screen
Pro only

From the Labor Factoring screen, you can adjust project labor for various factors related to the job
conditions. For more information, see Labor Factoring.

The default values for Rate $, Brdn %, and Frng $ are derived from the average values appearing at the
bottom of the Direct Labor screen. You should set up the labor factoring descriptions as part of your
default job, so they will automatically appear in each new job. For information on editing the default
job, see Setting Job Defaults.

You can insert, cut, copy, and paste rows within this screen by right clicking on a row number and
selecting the appropriate menu option.

To access the Labor Factoring screen from another program screen, click the LbFac tab at the
bottom of the screen.

The following columns appear on the Labor Factoring screen:

Column Description

Labor Factoring Description of the labor condition.

Factor Percentage increase in labor.

Hours The direct labor hours for this labor activity.

Rate $ Hourly rate for the labor.

Subtotal Calculated by multiplying Hours x Rate $.

Brdn % The labor burden percentage to be added to the
hourly labor rate. Labor burden can include
holiday pay, government insurance plans,
unemployment insurance, public liability,
property damage, etc.

Frng $ Labor fringe rate.

Brdn Tot. Total labor burden (Subtotal * Brdn %).

Frng Tot. Total labor fringe (Hours * Frng $).

Total Calculated by adding Brdn Tot (total labor
burden) and Frng Tot (total fringe labor) to
Subtotal.

Full Rate Total labor rate including labor burden and labor
fringe.
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Column Description

Code Cost code. Used when exporting to accounting
packages.

Type Pro only

Cost type. Used when exporting to accounting
packages.

% of Direct Hours Allows you to apply the factoring to a
percentage of the direct labor hours for this
activity.
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Labor Escalation Screen
 Pro only

From the Labor Escalation screen, you can provide for changes in labor rates over the course of the
job (e.g. scheduled increases for unionized labor).

You can insert, cut, copy, and paste rows within this screen by right clicking on a row number and
selecting the appropriate menu option.

To access the Labor Escalation screen from another product screen, click the LbEsc tab at the
bottom of the screen.

The following columns appear on the Labor Escalation screen:

Column Description

Escalation Period The label used to identify the escalation period.
For example, if the job runs 3 years and labor
costs are expected to increase in the last two
years of the job, you would set up three
escalation periods, using the different years as
the label for each period.

Description Description of the escalation period.

% of Contract The portion of the contract represented by the
escalation period. For example, if the job runs 2
years, and labor costs are expected to increase
in the last year of the job, you would enter 50 (as
in 50% of the 2 year period) as the first
escalation period, and 50 as the second
escalation period.

Labor Hours Number of labor hours to be escalated.
Calculated by multiplying the total labor hours
from the Direct Labor, Incidental Labor, and
Labor Factoring screens by the % of Contract
value.

Escalation % The percentage by which labor costs are
expected to increase over the escalation period.
You can specify either the escalation percentage
or a fixed escalation value (Escalation $), and
allow the program to specify the other value.

Tip - The Escalation % is not compounded
over the escalation periods. Each escalation
percentage is applied to the initial value, not to
the previous period’s value.



Classic Estimating Help Guide  - 407

Column Description

Escalation $ The increase in labor costs over the specified
portion of the contract. You can specify either
the Escalation $ or the Escalation %, and allow
the program to calculate the other value.

Financing % If you are planning to recover the financing of the
escalated labor, enter the financing rate.

Total The total escalation in labor costs. This value is
calculated by multiplying the Labor Hours by the
Escalation $, then applying any Financing %.

Code Cost code. Used when exporting to accounting
packages.

Type Pro only

Cost type. Used when exporting to accounting
packages.
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Indirect Labor Screen
Pro, BidWinner Plus, and BidWinner only

From the Indirect Labor screen, you can incorporate non-field labor (e.g. supervisory or clerical).

You can insert, cut, copy, and paste rows within this screen by right clicking on a row number and
selecting the appropriate menu option.

To access the Indirect Labor screen from another program screen, click the IndLb tab at the bottom of
the screen.

The following columns appear on the Indirect Labor screen:

Column Description

Indirect Labor The description of the type of labor.

Lab % Percentage of direct labor. You can specify the
Lab % and let the program calculated the
number of hours, or you can specify the number
of hours yourself.

Hours Indirect labor hours. You can specify the Lab %
and let the program calculate the number of
hours, or you can specify the number of hours
yourself.

Rate $ Hourly rate for the indirect labor.

Subtotal Calculated by multiplying Hours x Rate $.

Brdn % The labor burden percentage to be added to the
hourly labor rate. Labor burden can include
holiday pay, government insurance plans,
unemployment insurance, public liability,
property damage, etc.

Frng $ Labor fringe rate.

Brdn Tot. Total labor burden (Subtotal * Brdn %).

Frng Tot. Total labor fringe (Hours * Frng $).

Total Calculated by adding Brdn Tot (total labor
burden) and Frng Tot (total fringe labor) to
Subtotal.

Full Rate Total labor rate including labor burden and labor
fringe.
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Column Description

Code Cost code. Used when exporting to accounting
packages.

Type Pro only

Cost type. Used when exporting to accounting
packages.
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Subcontractors Screen
From the Subcontractors screen, you can enter your subcontractor quotes. If you haven’t received a
firm quote, you can enter a budget price and set a red flag to remind you of the outstanding quote.

To set a red flag, you change the value of the appropriate Alarm cell to Budget or Alarm. To change
the Alarm setting, click on the Alarm cell, then select Alarm from the drop-down menu that appears.
The cell will now display the word Alarm with a red background. Setting the Alarm cell to Budget
indicates that a budget price is being used, while setting the cell to Alarm represents any other
reason to remind you of the need to adjust the quoted price. The red flag will also appear on the Final
Pricing and Price Summary screens. When a new quoted value is entered in the Cost column, the
Alarm cell will revert to Off, and the red flag will be removed.

To select a vendor quote, double click on the appropriate Cost cell, or click the dialog button  that
appears in the Cost cell when its row is selected. From the Vendor Quotes dialog that appears, you
can select an existing quote or add a new one. To select a quote, click the appropriate check box in
the Selected column. Clicking the Low Price button will automatically selected the lowest priced
quote. If no quote is selected, the lowest price will be automatically selected and marked as Budget.
If you add a new vendor and check the Update All Vendor Lists check box, then the vendor will be
added to each vendor quote list. Otherwise, the vendor will be added to the current vendor quote list
only.

Pro only

So that the Bid Breakdown screen can properly distribute costs across different breakdowns, you can
portions of a quote to different to different breakdowns. To allocate quotes to breakdowns, select one
of the quotes to be allocated then right click and select the Cost Allocation option. From the Cost
Allocation dialog that appears, you can assign either a dollar value or a percentage to indicate the
portion of the cost to be assigned to each breakdown. Within each breakdown category, the allocated
percentage(s) must add up to 100. Without closing the Cost Allocation dialog, you can select another
quote to be allocated, then click OK when you are finished allocating quotes. To make the same
allocations for multiple quotes, select multiple rows using the [Shift] key to select a range of rows or
hold down the [Ctrl] key and click on each of the rows to be included before selecting the Cost
Allocation option. After you have allocated a quote, a dollar sign displays beside the description of the
item in the Quoted Materials column. The cost allocations you assign will be saved as part of the
current bid summary, and will no longer be assigned when you switch to a different bid summary. To
clear all cost allocations for an expense, right click over the row and select Clear Allocations.

To access the Subcontractors screen from another program screen, click the Sbcon tab at the bottom
of the screen.

The following columns appear on the Subcontractors screen:

Column Description

Subcontractors Description of the work to be subcontracted.

Alarm You can set the Alarm cell to Budget or Alarm.
Setting the Alarm cell to Budget indicates that
a budget price is being used, while setting the
cell to Alarm represents any other reason to
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Column Description

remind you of the need to adjust the quoted
price. To change the Alarm setting, click on the
Alarm cell, then select Alarm from the drop-
down menu that appears. The cell will now
display the word Budget or Alarm with a red
background. The red flag will also appear on the
Final Pricing and Price Summary screens.
When a new quoted value is entered in the Cost
column, the Alarm cell will revert to Off, and the
red flag will be removed.

Cost The price quoted for this item.

Adjustment % (not available for PowerBid) The adjustment
offered by the subcontractor, as a percentage,
that is being applied to the quoted cost.

Adjustment $ (not available for PowerBid) A dollar value
adjustment offered by the subcontractor.

Adj Cost (not available for PowerBid) The quoted price
after any adjustment has been applied.

Tax (%) (not available for PowerBid) The taxes, as a
percentage, that are being applied to the
subcontractor item.

Overhead % Overhead, as a percentage of the Amount.

Markup % Markup, as a percentage of the Amount plus
Overhead.

Total The total cost of the subcontract, including
adjustments, taxes, overhead and markup.

Vendor The name of the subcontractor. To specify a
vendor, double click on this cell. From the
Vendor Quotes dialog that appears, you can
select an existing vendor or add a new one. If
you want to make this vendor available for all
subcontractor quotes in this job, make sure the
Global Vendor Addition check box is checked.

Notes Notes about the vendor and/or quote as entered
on the Vendor Quotes dialog.

Code Cost code. Used when exporting to accounting
packages.
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Column Description

Type Pro only

Cost type. Used when exporting to accounting
packages.
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General Expenses Screen
From the General Expenses screen, you can add general expenses, such as permits, room and
board, telephone, and so on. If you do not have a firm quote, you can enter a budget price and set a
red flag to remind you of the need to adjust the price.

To set a red flag, you change the value of the appropriate Alarm cell to Budget or Alarm. To change
the Alarm setting, click on the Alarm cell, then press [B] (Budget) or [A] (Alarm) on your keyboard,
then press the [Enter] key. The cell will then have a red background. Setting the Alarm cell to Budget
indicates that a budget price is being used, while setting the cell to Alarm represents any other
reason to remind you of the need to adjust the expense. The red flag will also appear for the General
Expenses row on the Final Pricing and Price Summary screens. When a new quoted value is entered
in the Cost/Unit column, the Alarm cell will revert to Off, and the red flag will be removed.

You can insert, cut, copy, and paste rows within this screen by right clicking on a row number and
selecting the appropriate menu option.

Pro only

So that the Bid Breakdown screen can properly distribute costs across different breakdowns, you can
portions of an expense to different to different breakdowns. To allocate expenses to breakdowns,
select one of the expenses to be allocated then right click and select the Cost Allocation option.
From the Cost Allocation dialog that appears, you can assign either a dollar value or a percentage to
indicate the portion of the expense to be assigned to each breakdown. Within each breakdown
category, the allocated percentage(s) must add up to 100. Without closing the Cost Allocation dialog,
you can select another expense to be allocated, then click OK when you are finished allocating
expenses. To make the same allocations for multiple expenses, select multiple rows using the [Shift]
key to select a range of rows or hold down the [Ctrl] key and click on each of the rows to be included
before selecting the Cost Allocation option. After you have allocated an expense, a dollar sign
displays beside the description of the expense in the General Expenses column. The cost allocations
you assign will be saved as part of the current bid summary, and will no longer be assigned when you
switch to a different bid summary. To clear all cost allocations for an expense, right click over the row
and select Clear Allocations.

To access the General Expenses screen from another program screen, click the GnExp tab at the
bottom of the screen.

The following columns appear on the General Expenses screen:

Column Description

General Expenses The description of the expense.

Alarm You can set the Alarm cell to Budget or Alarm.
Setting the Alarm cell to Budget indicates that
a budget price is being used, while setting the
cell to Alarm represents any other reason to
remind you of the need to adjust the quoted
price. To change the Alarm setting, click on the
Alarm cell, then select Alarm from the drop-
down menu that appears. The cell will now
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Column Description

display the word Budget or Alarm with a red
background. The red flag will also appear on the
Final Pricing and Price Summary screens.
When a new quoted value is entered in the Cost
column, the Alarm cell will revert to Off, and the
red flag will be removed.

Quantity The quantity of the expense. You can either
enter this value directly, or automatically derive
the value from a field on another job screen by
selecting a field code from the Field cell. For a
list of available field codes, see below.

Field The field code associated with the expense.

Duration (not available for PowerBid) The duration of the
general expense.

Cost/Unit The cost per unit of the expense. This value is
multiplied by the Qty (along with the overhead
and markup) to arrive at the total cost.

Total Cost The Total Cost, before adjustments, calculated
by multiplying the quantity, duration, and cost
per unit of the expense item.

Tax (%) (not available for PowerBid) The taxes, as a
percentage, that are being applied to the
expense item.

Overhead % Overhead, as a percentage of the Amount.

Markup % Markup, as a percentage of the Amount plus
Overhead.

Total The total cost of the expense, calculated by
multiplying Qty by Cost/Unit, then applying any
specified overhead and markup.

Notes Any notes you wish to record regarding this
expense.

Code Cost code. Used when exporting to accounting
packages.

Type Pro only

Cost type. Used when exporting to accounting
packages.
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General Expenses Screen Field Codes

Instead of entering a value in the Quantity column, you can derive its value from a field on another job
screen by selecting a field code from the Field cell.

The following field codes are available from the General Expenses screen.

  Code   Description

Ext Total Mat($) The Total Mat($) total from the Extension
screen

Ext Total Hr The Total Hours total from the Extension screen

DirLb Hours The Hours total from the Direct Labor screen

DirLb Rate $ The Rate $ total from the Direct Labor screen

DirLb Sub Total The SubTotal total from the Direct Labor screen

DirLb Total The Total total from the Direct Labor screen

DirLb Full Rate The Full Rate total from the Direct Labor screen

IncLb Hours The Hours total from the Incidental Labor screen

IncLb Rate $ The Rate $ total from the Incidental Labor
screen

IncLb Sub Total The SubTotal total from the Incidental Labor
screen

IncLb Total The Total total from the Incidental Labor screen

IncLb Full Rate The Full Rate total from the Incidental Labor
screen

LbFac Hours The Hours total from the Labor Factoring screen

LbFac Rate $ The Rate $ total from the Labor Factoring
screen

LbFac Sub Total The SubTotal total from the Labor Factoring
screen

LbFac Total The Total total from the Labor Factoring screen

LbFac Full Rate The Full Rate total from the Labor Factoring
screen

IndLb Hours The Hours total from the Indirect Labor screen
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  Code   Description

IndLb Rate $ The Rate $ total from the Indirect Labor screen

IndLb Sub Total The SubTotal total from the Indirect Labor
screen

IndLb Total The Total total from the Indirect Labor screen

IndLb Full Rate The Full Rate total from the Indirect Labor
screen

LbEsc Labor Hours The Labor Hours total from the Labor Escalation
screen

Total Hours The Labor Hours value from the Price Summary
screen

Total Labor The Labor Total value from the Price Summary
screen

Subs Adj Cost The Adj Cost total on the Subcontractors
screen

QtMat Total The Total from the Quoted Materials screen

Area The Area value from the Price Summary screen

Equipment Total Cost The Total Cost total from the Equipment screen

Dur Days The duration of the job in days, calculated using
the information entered on the Job Information
screen.

Dur Weeks The duration of the job in weeks, calculated
using the information entered on the Job
Information screen.

Dur Months The duration of the job in months, calculated
using the information entered on the Job
Information screen.

Dur 4weeks The duration of the job in 4-week intervals,
calculated using the information entered on the
Job Information screen.
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Equipment Screen
Pro, BidWinner Plus only

From the Equipment screen, you can record equipment costs. If you only have an estimate of a
particular equipment cost, you can enter a budget price and set a red flag to remind you of the need
to adjust the cost.

To set a red flag, you change the value of the appropriate Alarm cell to Budget or Alarm. To change
the Alarm setting, click on the Alarm cell, then press [B] (Budget) or [A] (Alarm) on your keyboard,
then press the [Enter] key. The cell will then have a red background. Setting the Alarm cell to Budget
indicates that a budget cost is being used, while setting the cell to Alarm represents any other reason
to remind you of the need to adjust the details. The red flag will also appear for the Equipment row on
the Final Pricing and Price Summary screens. When a new value is entered in the Cost/Unit column,
the Alarm cell will revert to Off, and the red flag will be removed.

You can insert, cut, copy, and paste rows within this screen by right clicking on a row number and
selecting the appropriate menu option.

Pro only

So that the Bid Breakdown screen can properly distribute costs across different breakdowns, you can
portions of an equipment cost to different to different breakdowns. To allocate equipment costs to
breakdowns, select one of the costs to be allocated then right click and select the Cost Allocation
option. From the Cost Allocation dialog that appears, you can assign either a dollar value or a
percentage to indicate the portion of the cost to be assigned to each breakdown. Within each
breakdown category, the allocated percentage(s) must add up to 100. Without closing the Cost
Allocation dialog, you can select another cost to be allocated, then click OK when you are finished
allocating equipment costs. To make the same allocations for multiple costs, select multiple rows
using the [Shift] key to select a range of rows or hold down the [Ctrl] key and click on each of the rows
to be included before selecting the Cost Allocation option. After you have allocated a cost, a dollar
sign displays beside the description of the cost in the Equipment column. The cost allocations you
assign will be saved as part of the current bid summary, and will no longer be assigned when you
switch to a different bid summary. To clear all cost allocations for an expense, right click over the row
and select Clear Allocations.

To access the Equipment screen from another program screen, click the Eqpmt tab at the bottom of
the screen.

The following columns appear on the Equipment screen:

Column Description

Equipment The description of the equipment.

Alarm You can set the Alarm cell to Budget or Alarm.
Setting the Alarm cell to Budget indicates that
a budget price is being used, while setting the
cell to Alarm represents any other reason to
remind you of the need to adjust the quoted
price. To change the Alarm setting, click on the
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Column Description

Alarm cell, then select Alarm from the drop-
down menu that appears. The cell will now
display the word Budget or Alarm with a red
background. The red flag will also appear on the
Final Pricing and Price Summary screens.
When a new quoted value is entered in the Cost
column, the Alarm cell will revert to Off, and the
red flag will be removed.

Qty The quantity of the equipment. You can either
enter this value directly, or automatically derive
the value from a field on another job screen by
selecting a field code from the Field cell. For a
list of available field codes, see below.

Field The field code associated with the equipment.

Duration (not available for PowerBid) The duration of the
equipment costs.

Cost/Unit The cost per unit of the equipment. This value is
multiplied by the Qty (along with the overhead
and markup) to arrive at the total cost.

Total Cost The Total Cost, before adjustments, calculated
by multiplying the quantity, duration, and cost
per unit of the equipment.

Tax (%) (not available for PowerBid) The taxes, as a
percentage, that are being applied to the
equipment.

Overhead (%) Overhead, as a percentage of the Amount.

Markup (%) Markup, as a percentage of the Amount plus
Overhead.

Total The total cost of the equipment, calculated by
multiplying Qty by Cost/Unit, then applying any
specified overhead and markup.

Notes Any notes you wish to record regarding the
equipment.

Code Cost code. Used when exporting to accounting
packages.

Type Pro only

Cost type. Used when exporting to accounting
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Column Description

packages.

Equipment Screen Field Codes

Instead of entering a value in the Quantity column, you can derive its value from a field on another job
screen by selecting a field code from the Field cell.

The following field codes are available from the General Expenses screen.

   Code    Description

Ext Total Mat($) The Total Mat($) total from the Extension screen

Ext Total Hr The Total Hours total from the Extension screen

DirLb Hours The Hours total from the Direct Labor screen

DirLb Rate $ The Rate $ total from the Direct Labor screen

DirLb Sub Total The SubTotal total from the Direct Labor screen

DirLb Total The Total total from the Direct Labor screen

DirLb Full Rate The Full Rate total from the Direct Labor screen

IncLb Hours The Hours total from the Incidental Labor screen

IncLb Rate $ The Rate $ total from the Incidental Labor screen

IncLb Sub Total The SubTotal total from the Incidental Labor
screen

IncLb Total The Total total from the Incidental Labor screen

IncLb Full Rate The Full Rate total from the Incidental Labor
screen

LbFac Hours The Hours total from the Labor Factoring screen

LbFac Rate $ The Rate $ total from the Labor Factoring screen

LbFac Sub Total The SubTotal total from the Labor Factoring
screen

LbFac Total The Total total from the Labor Factoring screen

LbFac Full Rate The Full Rate total from the Labor Factoring
screen
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   Code    Description

IndLb Hours The Hours total from the Indirect Labor screen

IndLb Rate $ The Rate $ total from the Indirect Labor screen

IndLb Sub Total The SubTotal total from the Indirect Labor screen

IndLb Total The Total total from the Indirect Labor screen

IndLb Full Rate The Full Rate total from the Indirect Labor screen

LbEsc Labor Hours The Labor Hours total from the Labor Escalation
screen

Total Hours The Labor Hours value from the Price Summary
screen

Total Labor The Labor Total value from the Price Summary
screen

Subs Adj Cost The Adj Cost total on the Subcontractors screen

QtMat Total The Total from the Quoted Materials screen

Area The Area value from the Price Summary screen

Equipment Total Cost The Total Cost total from the Equipment screen

Dur Days The duration of the job in days, calculated using
the information entered on the Job Information
screen.

Dur Weeks The duration of the job in weeks, calculated
using the information entered on the Job
Information screen.

Dur Months The duration of the job in months, calculated
using the information entered on the Job
Information screen.

Dur 4weeks The duration of the job in 4-week intervals,
calculated using the information entered on the
Job Information screen.
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Quoted Materials Screen
From the Quoted Materials screen, you can keep track of vendors and quoted prices. If you haven’t
received a firm quote, you can enter a budget price and set a red flag to remind you of the outstanding
quote.

To set a red flag, you change the value of the appropriate Alarm cell to Budget or Alarm. To change
the Alarm setting, click on the Alarm cell, then select Alarm from the drop-down menu that appears.
The cell will now display the word Alarm with a red background. Setting the Alarm cell to Budget
indicates that a budget price is being used, while setting the cell to Alarm represents any other
reason to remind you of the need to adjust the quoted price. The red flag will also appear on the Final
Pricing and Price Summary screens. When a new quoted value is entered in the Cost column, the
Alarm cell will revert to Off, and the red flag will be removed.

To select a vendor quote, double click on the appropriate Cost cell, or click the dialog button  that
appears in the Cost cell when its row is selected. From the Vendor Quotes dialog that appears, you
can select an existing quote or add a new one. To select a quote, click the appropriate check box in
the Selected column. Clicking the Low Price button will automatically selected the lowest priced
quote. If no quote is selected, the lowest price will be automatically selected and marked as Budget.
If you add a new vendor and check the Update All Vendor Lists check box, then the vendor will be
added to each vendor quote list. Otherwise, the vendor will be added to the current vendor quote list
only.

Pro only

So that the Bid Breakdown screen can properly distribute costs across different breakdowns, you can
portions of a quote to different to different breakdowns. To allocate quotes to breakdowns, select one
of the quotes to be allocated then right click and select the Cost Allocation option. From the Cost
Allocation dialog that appears, you can assign either a dollar value or a percentage to indicate the
portion of the cost to be assigned to each breakdown. Within each breakdown category, the allocated
percentage(s) must add up to 100. Without closing the Cost Allocation dialog, you can select another
quote to be allocated, then click OK when you are finished allocating quotes. To make the same
allocations for multiple quotes, select multiple rows using the [Shift] key to select a range of rows or
hold down the [Ctrl] key and click on each of the rows to be included before selecting the Cost
Allocation option. After you have allocated a quote, a dollar sign displays beside the description of the
item in the Quoted Materials column. The cost allocations you assign will be saved as part of the
current bid summary, and will no longer be assigned when you switch to a different bid summary. To
clear all cost allocations for an expense, right click over the row and select Clear Allocations.

To access the Quoted Materials screen from another program screen, click the QtMat tab at the
bottom of the screen.

The following columns appear on the Quoted Materials screen:

   Column    Description

Quoted Materials Description of the quoted materials.

Alarm You can set the Alarm cell to Budget or Alarm.
Setting the Alarm cell to Budget indicates that
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   Column    Description

a budget price is being used, while setting the
cell to Alarm represents any other reason to
remind you of the need to adjust the quoted
price. To change the Alarm setting, click on the
Alarm cell, then select Alarm from the drop-
down menu that appears. The cell will now
display the word Alarm with a red background.
The red flag will also appear on the Final Pricing
and Price Summary screens. When a new
quoted value is entered in the Cost column, the
Alarm cell will revert to Off, and the red flag will
be removed.

Cost The quoted amount. If the Alarm cell is set to
Budget or Alarm, this value may only be a
budget price.

Adjustment % An adjustment percentage to be applied to your
quoted materials. This is an adjustment to your
quoted amount in anticipation of a better
buyout; it is not overhead or markup. To reduce
the price, enter a negative value.

Adjustment $ (not available for PowerBid) A dollar value
adjustment to be applied to your quoted
materials.

Adj Cost The quoted material cost after any adjustment
has been applied.

Vendor The name of the vendor supplying the materials.
To specify a vendor, double click this cell. From
the Vendor Quotes dialog that appears, you can
select an existing vendor or add a new one. If
you want to make this vendor available for all
quoted material in this job, make sure the
Global Vendor Addition check box is checked.

Notes Notes about the vendor and/or quote as entered
on the Vendor Quotes dialog.

Code Cost code. Used when exporting to accounting
packages.

Type Pro only

Cost type. Used when exporting to accounting
packages.
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Final Pricing Screen
From the Final Pricing screen, you can review the total cost of materials and labor, and arrive at your
selling price. You can also enter overhead, markup, labor burden, and taxes. By default, cells that
have a light yellow background cannot be directly modified, but are carried forward from other screens.

To jump to the screen where a particular value has been specified, just double click the appropriate
entry. Where you can specify a value as either a fixed amount or a percentage, the specified (or
“pinned”) value appears as blue text on a white background. To modify the default screen colors,
select Options from the Job menu.

If you are using Pro, you can try out different “what if” scenarios by entering different values in the
Modified ($) or Modified (%) columns, and comparing the totals against those in the Calculated (%)
and Calculated ($) columns. To reset the values in the Modified columns to match those in the
Calculated columns, click the Reload button from the toolbar.

Tip - The Final Price appearing at the bottom of the Modified ($) / Value ($) column is the final price
that appears on your formal quotation, and on subsequent program screens.

If an Alarm flag was set on the Subcontractor screen, the General Expenses screen, or the Quoted
Materials screen, a red bar displays in the Alarm column on the corresponding on the Final Pricing
screen. If you double click the red bar, the corresponding program screen will be displayed.

Alarms will also appear under the following circumstances

On the Database Material (Extension) row if there are items on the Extension screen that are
alarmed for zero cost (excluding items with Quoted condition).

On the Quoted Material (Extension) row if there are items on the Extension screen that are alarmed
for zero cost with a Quoted condition.

On the Direct Labor row if there are items on the Extension screen that alarmed for zero hours, or if
there is no crew assigned on the Direct Labor screen.

The Final Price cell at the bottom of the Calculated ($) column displays with a yellow background for a
master job that has one or more sub jobs that are open or have been modified since the last merge.

Just below the Total Markup entry, there are three user-defined adjustments. By default, these
adjustments are labeled Other Expenses, Financing, and Bonding. These amounts are included in the
General Expenses total that appears on the Price Summary and Bid Breakdown screens. To change
the adjustment description, either double click it, or single click it and select the Descriptions option
from the Edit menu. From the Adjustment Descriptions dialog that appears, you can also change the
description of the global tax (VAT, GST, etc.) that is applied to your Selling Price to arrive at the Final
Price.

To specify the adjustment percentages for each user-defined adjustment, click on the appropriate
Ranges button within the Adjustment Descriptions dialog, or click on the Edit menu and select
Ranges. From the User Defined Adjustment Ranges dialog, you can specify different adjustment
percentages to be applied as the value of the job increases.

To access the Final Pricing screen from another program screen, click the FnPrc tab at the bottom of
the screen.
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Final Pricing Columns

The following columns appear on the Final Pricing screen:

Using PowerBid, BidWinner, BidWinner Plus

Column Description

Final Pricing The description of the value that has been
specified, or can be specified from this screen.

Value ($) The value used to determine the overall final
price. In some cases, you can enter a fixed
amount under this column, or enter a
percentage in the Pct (%) column and allow
your estimating program to calculate the Value
($).

Pct (%) The percentage that has been derived from, or
used to determine the value appearing in the
Value ($) column. In most cases, you can enter
a fixed amount under the Value ($) column, or
enter a percentage in the Pct (%) column and
allow your estimating program to calculate the
Value ($).

Alarm If the Selling Price has been manually entered
in the Modified column, then the Alarm cell will
be set to Pinned.

If a red flag has been set for a value carried
forward from the Subcontractors, General
Expenses, or Quoted Materials, then the Alarm
cell will be set to On. Red flags are set to
remind you that the quoted price needs to be
adjusted, possibly because the price is a
budget price. To adjust the quoted price, double
click the flagged entry and you will be
automatically returned to the appropriate
screen, where you can make the necessary
changes.

Code Cost code. Can be used as a reference point
when exporting to an accounting package.

Tip - The Final Price appearing at the bottom of the Value ($) column will be the final price that
appears on your formal quotation, and on subsequent product screens.

Using Pro

If you are using Pro, you can try out different “what if” scenarios by entering different values in the
Modified ($) or Modified (%) columns, then comparing the totals against those in the Calculated (%)
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and Calculated ($) columns.

To reset the values in the Modified columns to match those in the Calculated columns, click the
Reload button from the toolbar.

Column Description

Final Pricing The description of the value that has been
specified, or can be specified from this screen.

Calculated (%) A percentage used to determine the value
appearing in the Calculated ($) column. In some
cases, you can specify the percentage from the
Final Pricing screen. In other cases, the
percentage is carried forward from previous
screens. The Final Price cell at the bottom of
this column displays with a yellow background
for a master job that has one or more sub jobs
that are open or have been modified since the
last merge.

Calculated ($) The value calculated using values entered on
this and previous product screens.

Variance (%) The difference between the Calculated ($) and
the Modified ($) represented as a percentage.

Modified ($) The value used to determine the overall final
price. This value overrides the value appearing in
the Calculated ($) column. In most cases, you
can enter a fixed amount under this column, or
enter a percentage in the Modified (%) column
and allow your estimating program to calculate
the Modified ($) value.

Modified (%) The percentage that has been derived from, or
used to determine the value appearing in the
Modified ($) column. In most cases, you can
enter a fixed amount under the Modified ($)
column, or enter a percentage in the Modified
(%) column and allow your estimating program
to calculate the Modified ($) value.

Alarm If the Selling Price has been manually entered
in the Modified column, then the Alarm cell will
be set to Pinned.

If a red flag has been set for a value carried
forward from the Subcontractors, General
Expenses, or Quoted Materials, then the Alarm
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Column Description

cell will be set to On. Red flags are set to
remind you that the quoted price needs to be
adjusted, possibly because the price is a
budget price. To adjust the quoted price, double
click the flagged entry and you will be
automatically returned to the appropriate
screen, where you can make the necessary
changes.

Code Cost code. Can be used as a reference point
when exporting to an accounting package.

Tip - The Final Price appearing at the bottom of the Modified ($) column will be the final price that
appears on your formal quotation, and on subsequent product screens.

Final Pricing Rows

The following rows appear on the Final Pricing screen:

Row Description

Database Material (Extension) The database material at Extension. This value
is carried to the Price Summary screen. Does
not include quoted material. A red bar (alarm)
displays in the Value column if there are items
on the Extension screen that are alarmed for
zero cost (excluding items with Quoted
condition).

Material Escalation Calculation based on the Database Material
(Extension).

Quoted Material (Extension) Based on the material with a condition of
Quoted in the Extension screen. A red bar
(alarm) displays in the Value column if there are
items on the Extension screen that are alarmed
for zero cost with a Quoted condition.

Quoted Material Based on values entered manually in the
Quoted Material screen.

Material Tax Any tax to apply to the material.

Material Total The sum of all the material rows previous to the
Material Total row.

Direct Labor Based on the values from the Direct Labor
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Row Description

screen. A red bar (alarm) displays in the Value
column if there are items on the Extension
screen that alarmed for zero hours, or if there is
no crew assigned on the Direct Labor screen.

Incidental Labor Based on the values from the Incidental Labor
screen.

Labor Factoring Based on values from the Labor Factor screen.

Labor Escalation Based on values from the Labor Escalation
screen.

Indirect Labor Based on values from the Indirect Labor screen.

Labor Tax Any tax to apply to labor.

Labor Total The sum of all labor rows previous to the Labor
Total.

Subcontractors The total cost from the Subcontractors screen.

General Expenses The total cost from the General Expenses
screen.

Equipment The total cost from the Equipment screen.

Total Cost The total of all the previous rows previous to
Total Cost.

Database Material Overhead Applied to the cost of database materials
(includes escalation and material tax).

Quoted Material Overhead Applied to the cost of the quoted material.
Includes Quoted Material (Extension), Quoted
Material, Quoted Material (QA), plus tax.

Labor Overhead Applied to the Labor Total.

Subcontractors Overhead Applied to the subcontractors cost.

General Expenses Overhead Applied to the general expenses cost.

Equipment Overhead Applied to the equipment cost.

Adjustment Overhead The difference between Total Overhead and the
sum of the Database Materials through
Equipment Overhead rows.
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Row Description

Total Overhead The sum of all the overhead rows previous to the
Total Overhead row.

Database Material Markup Applied to Database Material plus Material
Escalation plus tax plus Database Material
Overhead.

Quoted Material Markup Applied to the cost of the quoted material plus
tax plus the Quoted Material Overhead dollars.

Labor Markup Applied to Labor Total plus labor overhead.

Subcontractors Markup Applied to subcontractors charges plus
subcontractors overhead.

General Expenses Markup Applied to general expenses charges plus
general expenses overhead.

Equipment Markup Applied to equipment charges plus equipment
overhead.

Adjustment Markup The difference between Total Markup and the
sum of the Database Materials through
Equipment Markup rows.

Total Markup The total of all the preceding markup rows. If
you override the value in this field, the program
will back-calculate the adjustment markup. If
you want to end up with a particular labor risk
ratio, click the ellipsis button in this cell. From
the dialog that appears, click the Calculate
Total Markup Based on a Pre-determined Labor
Risk Ratio radio button then enter the desired
ratio in the field and click OK. The adjustment
markup will be adjusted to achieve the specified
labor risk ratio.

Adjustment #1-3 User defined adjustments.

Final Adjustment The difference between the Selling Price and
the sum of the Total Cost, Total Overhead, Total
Markup, and the 3 user-defined adjustment
rows.

Selling Price The sum of Total Cost, Total Overhead, Total
Markup, the 3 user-defined adjustment rows,
and the Final Adjustment.

Global Tax Any tax applied to the Selling Price.
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Price Summary Screen
From the Price Summary screen, you can review the total cost of materials and labor. You can use
this screen as a quick check of the estimate and point to possible errors or omissions. The only value
you can change on the Price Summary screen is Area, which is used to calculate the Labor Hours
per Unit Area value and the Price per Unit Area value.

To access the Price Summary screen from another program screen, click the PrSum tab at the
bottom of the screen.

Price Summary Columns

The following columns appear on the Price Summary screen:

Column Description

Price Summary The description of the information being
summarized.

Value The value of the summary item.

% The value of the summary item, as a
percentage of the final price.

Alarm If a red flag is set for a value carried forward
from the Subcontractors, General Expenses,
Equipment, or Quoted Materials screens, then
the Alarm cell is set to On. Red flags are set to
remind you that the quoted price needs to be
adjusted, possibly because the price is a
budget price. To adjust the quoted price, double
click the flagged entry and you are
automatically returned to the appropriate
screen, where you can make the necessary
changes. When you enter a new quoted value in
the Cost column, the Alarm cell switches to Off,
and the red flag is removed.

Price Summary Rows

The following rows appear on the Price Summary screen:

Row Description

Database Material The sum of Database Material (Extension) and
Material Escalation from the Final Pricing
screen.

Quoted Material The sum of Quoted Material (Extension),
Quoted Material, and Quoted Material (QA) from
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Row Description

the Final Pricing screen.

Material Tax Any tax applied to the material.

Material Total The total of the above material rows: Database
Material, Quoted Material, and Material Tax

Direct Labor Calculated from the labor screens except
Indirect Labor.

Direct Labor Burden & Fringes The burden and fringes portion of the Direct
Labor value.

Indirect Labor The value calculated on the Indirect Labor
screen.

Indirect Labor Burden & Fringes The burden and fringes portion of the Indirect
Labor value.

Labor Tax Any tax applied to labor.

Labor Total The total of the above labor rows (Direct Labor,
Direct Labor Burden & Fringes, Indirect Labor,
Indirect Labor Burden & Fringes and Labor Tax.

Subcontractors The total cost from the Subcontractors screen.

General Expenses The total cost from the General Expenses
screen, combined with any user-defined
adjustments.

Equipment The total cost from the Equipment screen.

Prime Cost The sum of Material Total, Labor Total,
Subcontractors, General Expenses, and
Equipment.

Total Overhead The value from the Final Pricing screen. The
total of all overhead values.

Net Cost The sum of the Prime Cost and the Total
Overhead.

Total Profit The sum of the Total Markup and the Final
Adjustment in the Final Pricing screen.

Adjustment #3 The Adjustment #3 cost as defined by the user
on the Final Pricing screen.
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Row Description

Selling Price The sum of the Net Cost, the Total Profit, and
Bonding costs.

Global Tax Any tax applied to the Selling Price in the Final
Pricing screen.

Final Price The sum of the Selling Price and the Global
Tax.

Labor Risk Ratio % This percentage is calculated by dividing profit
by labor dollar value, and multiplying the result
by 100. Since labor is the most volatile portion
of the job, the labor risk ratio provides you with
a margin of error in the event that unanticipated
variables such as weather, labor relations, or
employee illness affect the labor dollars.

Area The unit of measure. For example, square
footage, number of suites).

Price Per Unit Area The value of each area.

Total Labor Hours The total number of hours.

Labor Hours Per Unit Area The number of labor hours for each area.

Average Labor Cost Per Hour The average cost per hour for labor.

General Expenses Per Hour The cost per hour for general expenses.
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Bid Breakdown Screen
From the Bid Breakdown screen, you can view the total cost of your bid broken down by drawing,
area, phase, system, location, sort codes, unit price, and item. The Bid Breakdown screen is ideal for
determining total cost per system, price per area, and labor per area, among other information. You
can manipulate this information, export it to other applications, and use it as the basis for progress
billings.

To switch between the Drawing, Area, Phase, System, Location, Sort Code, Unit Price, and Item
breakdowns, click the Breakdown View list box and select the appropriate option. If you’ve made
changes to any of the preceding screens, you must click the Reload button from the toolbar to update
the breakdown.

The cost per system is displayed on the Bid Breakdown screen under the Total column. At the
bottom of the screen, the Revised Totals represent the currently displayed values, while the Final
Totals indicate the values carried forward from the previous screens. To try out different “what if”
scenarios, you can enter new values in any of the cells and compare the new Revised Totals against
the actual Final Prices. Any changes you make here does not affect any previously specified values
or your final price. To reset the displayed values to match the Final Price values, click the Reload
button from the toolbar.

Allocating Costs

To distribute the costs for quoted materials or subcontractors quotes among different breakdowns,
you can enter a number in the appropriate cell representing the share of the quote to be assigned to
that breakdown. For example, if you enter a value of 1 in the Quoted Material column for both the
Lighting System and Wiring Devices system breakdowns, then click the Reload button, the program
will divide the quote equally between the two. If instead, you enter 2 for the Lighting System and 1 for
the Wiring Devices, then 2/3 of the costs would have been assigned to the Lighting System and 1/3
would have been assigned to Wiring Devices.

You can also allocate costs to breakdowns for individual rows on the General Expenses, Quoted
Materials, Subcontractors, and Equipment screens. To do so, select one or more rows then right click
and select the Cost Allocation option. From the Cost Allocation dialog, you can allocate the costs to
different breakdowns in whatever percentages you choose. The Bid Breakdown screen will then
distribute costs to breakdowns accordingly.

General expenses, quoted materials, subcontractor costs, and equipment costs that have not been
allocated will not be distributed or broken down.

Creating Multi-Level Bid Breakdowns

By default, the Breakdown View list consists of single breakdowns that allow you to break down the
bid by that breakdown alone. If you want to see some of the breakdowns further broken down, you can
create multi-level breakdowns. Multi-level bid breakdowns allow you to group the bid by a combination
of multiple breakdown options. For example, instead of just breaking down the bid by system, you
can break it down by system and phase so that system breakdowns are themselves broken down by
phase.

To create a multi-level breakdown, click the Add button on the Bid Breakdown screen. From the Bid
Breakdown View dialog that appears, you select the breakdowns you wish to use. To select the
breakdowns, double click the appropriate option from the left side of the dialog. Alternatively, you
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could single click the option, then click on the Add button. You can select as many different
breakdowns as you require. The order in which the options appear on the right side of the dialog
determine the order in which the bid is broken. You can reorder items on the right side by selecting an
item then clicking the Up or Down buttons. Based on your selection, the Name of the breakdown view
will be automatically assigned.

Tip -If you have any unallocated costs for the selected breakdowns on the General Expenses or 
Equipment screens, you can prorate the unallocated costs evenly across the breakdowns by clicking
the appropriate checkbox(es).

After you click on OK from the Bid Breakdown View dialog and return to the Bid Breakdown screen,
the bid will be broken down by the selected breakdowns in the selected order. Additional breakdowns
displays nested under the previous breakdown, with plus and minus buttons to expand and collapse
the branches of the tree. Subtotals displays for the final breakdown in the in the tree.

Creating Alternate Bid Summaries

If you want to isolate portions of your bid, you can set up multiple bid summaries, each of which can
include a different combination of drawing, area, phase, system, and location breakdowns. When you
switch between different bid summaries, the extension changes to include only those breakdowns you
chose to be part of the current bid summary. Totals appearing on all screens other than the Takeoff
screen will be similarly adjusted. For more information, see Creating Multiple Bid Summaries.

To access the Bid Breakdown screen from another program screen, click the Brkdn tab at the bottom
of the screen.

The following columns appear on the Bid Breakdown screen:

   Colu
mn

   Description

<breakdo
wn>
Descripti
on

The description of the takeoff breakdown or sort code depending on what was chosen
from the Selection drop-down box. Description for unit price uses audit trail
description.

DB Pricing does not include material with condition of quoted at extension.
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   Colu
mn

   Description

Material

Qtd Mat
(Ext)

Pricing of material with condition of Quoted at extension.

Qtd
Material

Based on values entered manually in the Quoted Material screen.

Total
Material

The sum of the above DB Material, Qtd Mat (Ext), Qtd Material, and Qtd Mat (QA).

Direct
Hours

The sum of the DirLb, IncLb, and LbFac values.

Indirect
Hours

This value is based on the value from the IndLb screen.

Total
Hours

The sum of the direct hours and indirect hours.

Direct
Labor $

This calculation is based on direct labor hours and an average dollar rate.

Indirect
Labor $

This calculation is based on indirect labor hours and an average dollar rate.

Total
Labor $

The sum of direct labor and indirect labor dollars.

Subs Based on values entered on the Subcontractors screen.

General
Expense
s

Based on values entered on the General Expenses screen.

Equipme
nt

Based on values entered on the Equipment screen.

Overhead Based on the distribution of cost. This value is obtained from the Final Pricing screen.

Markup Based on the distribution of cost. This value is obtained from the Final Pricing screen.

Defined
Adjustme
nts

Based on values entered in the user-defined adjustment fields on the Final Pricing
screen.
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   Colu
mn

   Description

Total The sum of all the columns previous to the Total column.

Area OR
Quantity

The unit of measure. For example, square footage, number of suites.

Tip - When the selection is by Unit Price, Area is replaced by Quantity.

DB Mtl
$ / Area

The DB Material dollars divided by the area.

Qtd Mtl $
/ Area

The sum of all Qtd Mtl columns divided by the area.

Total Mtl
$ / Area

The Total Material dollars divided by the area.

Labor $ /
Area

The labor dollars divided by the area.

Total $ /
Area

Total divided by the area.

Direct
Hrs /
Area

The Direct Hours divided by the area.

Ind Hrs /
Area

The Indirect Hours divided by the area.

Total Hrs
/ Area

The Total Hours divided by the area.
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Graph Screen
The Graph screen is used to graphically illustrate the material costs and labor hours, and the
relationships between the different areas of the bid. Within each graph, you can double click a marker
(the bar, line, dot, or pie piece) to display its actual value. To control the appearance of the graph,
including graph type, scale, and titles, select Options from the Graph menu. To select the kind of
information being illustrated, click the Graph list box and select the appropriate option.

The following options are available from the Graph list box:

Option Description

Extension - Material Illustrates the division of material costs among
the different parts of the extension, based on
the current extension group order and filter.

Extension - Labor Illustrates the division of labor value among the
different parts of the extension, based on the
current extension group order and filter. Labor
value is calculated by multiplying labor hours by
average labor rate.

Extension - Material & Labor Illustrates the relationships between material
costs and labor value in the extension, based
on the current extension group order and filter.

Final Pricing Illustrates the division of costs as displayed on
the Final Pricing screen.

Price Summary Illustrates the relationships between the
different areas of the bid using information from
the Price Summary.

Overhead & Markup Illustrates how overhead and markup from
different areas contribute to the total overhead
and markup.

Drawing Breakdown Pro only

Illustrates the breakdown of the bid by drawing.

Area Breakdown Pro only

Illustrates the breakdown of the bid by area.

Phase Breakdown Pro only

Illustrates the breakdown of the bid by phase.

System Breakdown Pro only
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Option Description

Illustrates the breakdown of the bid by system.

Location Breakdown Pro only

Illustrates the breakdown of the bid by location.
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Quote Pad Screen
The Quote Pad screen acts as a simple text editor in which you can type, delete, cut, copy, and
paste text, as well as change text color, font and size in order to  produce a formal quotation. To alter
the appearance of the text you can use the options available from the Format menu, or enable to the 
Formatting toolbar. A standard description is automatically loaded from your default job. If you want a
company heading or standard clauses to appear in all your formal quotations, then add them to your
default job.

To include information from your job, such as final price or database name, you can insert field codes.
When you print your formal quotation, the program will replace the field code with the appropriate
value. For example, if you insert the <FINAL_PRICE> field code, then the program will print the final
price in place of the code. To insert a field code, right click and select the Insert Field option. From
the Field Codes dialog that appears, you can select the appropriate code.

To access the Quote Pad screen from another program screen, click the QPad tab at the bottom of
the screen, or click on the View menu and select Quotepad.

The following codes are available from the Quote Pad screen:

   Code    Description

<TAB:1.0> Distance in inches that text following will be
indented from left

<DATE> The present date

<TIME> The current time

<JOB_NAME> Job description

<JOB_NUMBER> Job number

<JOB_PATH> Directory and filename of the job

<JOB_TYPE> Job category as it appears on the Job
Information screen

<STARTING_DATE> Starting date of the job as defined on the Job
Information screen

<COMPLETION_DATE> Completion date of the job as defined on the
Job Information screen

<DURATION> Duration of the job as calculated on the Job
Information screen

<DURATION_BASEDON> Whether the duration is expressed in days,
weeks, or months
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   Code    Description

<DATABASE_NAME> The name of the database used for this job

<DATABASE_NUMBER> The number of the database used for this job

<DATABASE_PATH> The name and location of the database file

<BID_SUMMARY_NAME> Currently selected bid summary

<BID_DUE_DATE> Bid due date as it appears on the Job Info
screen

<BID_DUE_TIME> Bid due time as it appears on the Job Info
screen

<ESTIMATOR> Estimator's name as it appears on the Job Info
screen

<ESTIMATOR_TELEPHONE> Estimator's telephone number as it appears on
the Job Info screen

<ESTIMATOR_CELLPHONE> Estimator's telephone number as it appears on
the Job Info screen

<ESTIMATOR_FAX> Estimator's fax number as it appears on the Job
Info screen

<ESTIMATOR_EMAIL> Estimator's e-mail

<JOB_TYPE> Job type as it appears on the Job Info screen

<JOB_ADDRESS_NUMBER> Job address number as it appears on the Job
Info screen

<JOB_ADDRESS_SITE_NAME> Job address site name as it appears on the Job
Info screen

<JOB_ADDRESS_ADDRESS_1> Job address 1 as it appears on the Job Info
screen

<JOB_ADDRESS_ADDRESS_2> Job address 2 as it appears on the Job Info
screen

<JOB_ADDRESS_CITY> Job address city as it appears on the Job Info
screen

<JOB_ADDRESS_STATE> Job address state as it appears on the Job Info
screen

<JOB_ADDRESS_COUNTRY> Job address country as it appears on the Job
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   Code    Description

Info screen

<JOB_ADDRESS_ZIP> Job address zip or postal code as it appears on
the Job Info screen

<JOB_ADDRESS_TELEPHONE> Job phone as it appears on the Job Info screen

<JOB_ADDRESS_CELLPHONE> Job cell phone as it appears on the Job Info
screen

<JOB_ADDRESS_FAX> Job fax as it appears on the Job Info screen

<JOB_ADDRESS_CONTACT> Job address contact as it appears on the Job
Info screen

<JOB_ADDRESS_EMAIL> Job address e-mail

<CLIENT_ADDRESS_NUMBER> Client address number as it appears on the Job
Info screen

<CLIENT_ADDRESS_SITE_NAME> Client address site name as it appears on the
Job Info screen

<CLIENT_ADDRESS_ADDRESS_1> Client address 1 as it appears on the Job Info
screen

<CLIENT_ADDRESS_ADDRESS_2> Client address 2 as it appears on the Job Info
screen

<CLIENT_ADDRESS_CITY> Client address city as it appears on the Job Info
screen

<CLIENT_ADDRESS_STATE> Client address state as it appears on the Job
Info screen

<CLIENT_ADDRESS_COUNTRY> Client address country as it appears on the Job
Info screen

<CLIENT_ADDRESS_ZIP> Client address zip as it appears on the Job Info
screen

<CLIENT_ADDRESS_TELEPHONE> Client phone as it appears on the Job Info
screen

<CLIENT_ADDRESS_CELLPHONE> Client cell phone as it appears on the Job Info
screen

<CLIENT_ADDRESS_FAX> Client fax as it appears on the Job Info screen
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   Code    Description

<CLIENT_ADDRESS_CONTACT> Client address contact as it appears on the Job
Info screen

<CLIENT_ADDRESS_EMAIL> Client address e-mail

<LABOR_COLUMN> Labor column used in the Extension screen

<EXTENSION_TOTAL_HOURS> Total hours from the Extension screen

<DIRECT_LABOR_HOURS> Total hours from the Direct Labor screen

<DIRECT_LABOR_FULL_RATE> Full rate from the Direct Labor screen

<INCIDENTAL_LABOR_HOURS> Total hours from the Incidental Labor screen

<INCIDENTAL_LABOR_FULL_RATE> Full rate from the Incidental Labor screen

<LABOR_FACTORING_HOURS> Total hours from the Labor Factoring screen

<LABOR_FACTORING_FULL_RATE> Full rate from the Labor Factoring screen

<INDIRECT_LABOR_HOURS> Total hours from the Indirect Labor screen

<INDIRECT_LABOR_FULL_RATE> Full rate from the Indirect Labor screen

<GENERAL_EXPENSES_COST> Total cost from the General Expenses screen

<GENERAL_EXPENSES_TAX> Total tax from the General Expenses screen

<EQUIPMENT_COST> Total cost from the Equipment screen

<EQUIPMENT_TAX> Total tax from the Equipment screen

<QUOTED_MATERIAL> Total cost of all quoted material as it appears
on the Quoted Material screen

<QUOTED_MATERIALS_ADJUSTED_COST> Total adjusted cost of all material from the
Quoted Material screen

<SUBCONTRACTORS_ADJUSTED_COST> Total cost from the Subcontractors screen

<SUBCONTRACTORS_TAX> Total tax from the Subcontractors screen

<TOTAL_PROFIT> Total Profit value from the Price Summary
screen

<PRIME_COST> Prime Cost value from the Price Summary
screen
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   Code    Description

<NET_COST> Net Cost value from the Price Summary screen

<AREA> Area value from the Price Summary screen

<TOTAL_HOURS> Total labor hours as it appears on the Price
Summary screen

<LABOR_RISK_RATIO> The Labor Risk Ratio % value from the Price
Summary screen

Tip - For Pro, the following codes are available for cells under the Modified $ column on the
Final Pricing screen:

<DATABASE_MATERIAL> Database material as it appears on the Final
Pricing screen

<DATABASE_MATERIAL_ESCALATION> Database material escalation as it appears on
the Final Pricing screen

<QUOTED_MATERIAL_EXTENSION> Quoted material extension as it appears on the
Final Pricing screen

<MATERIAL_TAX> Material tax as it appears on the Final Pricing
screen

<MATERIAL_TOTAL> Material total as it appears on the Final Pricing
screen

<DIRECT_LABOR> Direct labor as it appears on the Final Pricing
screen

<INCIDENTAL_LABOR> Incidental labor as it appears on the Final
Pricing screen

<LABOR_FACTORING> Labor factoring as it appears on the Final
Pricing screen

<LABOR_ESCALATION> Labor escalation as it appears on the Final
Pricing screen

<INDIRECT_LABOR> Indirect labor as it appears on the Final Pricing
screen

<LABOR_TAX> Labor tax as it appears on the Final Pricing
screen

<LABOR_TOTAL> Labor total as it appears on the Final Pricing
screen
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   Code    Description

<GENERAL_EXPENSES> General expenses as it appears on the Final
Pricing screen

<EQUIPMENT> Equipment as it appears on the Final Pricing
screen

<SUBCONTRACTORS> Subcontractors as it appears on the Final
Pricing screen

<TOTAL_COST> Total cost as it appears on the Final Pricing
screen

<DATABASE_MATERIAL_OVERHEAD> Database material overhead as it appears on
the Final Pricing screen

<QUOTED_MATERIAL_OVERHEAD> Quoted material overhead as it appears on the
Final Pricing screen

<LABOR_OVERHEAD> Labor overhead as it appears on the Final
Pricing screen

<GENERAL_EXPENSES_OVERHEAD> General expenses overhead as it appears on
the Final Pricing screen

<EQUIPMENT_OVERHEAD> Equipment overhead as it appears on the Final
Pricing screen

<SUBCONTRACTORS_OVERHEAD> Subcontractors overhead as it appears on the
Final Pricing screen

<ADJUSTMENT_OVERHEAD> Adjustment overhead as it appears on the Final
Pricing screen

<TOTAL_OVERHEAD> Total overhead as it appears on the Final
Pricing screen

<DATABASE_MATERIAL_MARKUP> Database material markup as it appears on the
Final Pricing screen

<QUOTED_MATERIAL_MARKUP> Quoted material markup as it appears on the
Final Pricing screen

<LABOR_MARKUP> Labor markup as it appears on the Final Pricing
screen

<GENERAL_EXPENSES_MARKUP> General expenses markup as it appears on the
Final Pricing screen

<EQUIPMENT_MARKUP> Equipment markup as it appears on the Final



444 - Classic Estimating Help Guide

   Code    Description

Pricing screen

<SUBCONTRACTORS_MARKUP> Subcontractors markup as it appears on the
Final Pricing screen

<ADJUSTMENT_MARKUP> Adjustment markup as it appears on the Final
Pricing screen

<TOTAL_MARKUP> Total markup as it appears on the Final Pricing
screen

<USER_DEFINED1> First user-defined adjustment as it appears on
the Final Pricing screen

<USER_DEFINED2> Second user-defined adjustment as it appears
on the Final Pricing screen

<USER_DEFINED3> Third user-defined adjustment as it appears on
the Final Pricing screen

<FINAL_ADJUSTMENT> Final adjustment as it appears on the Final
Pricing screen

<SELLING_PRICE> Selling price as it appears on the Final Pricing
screen

<GLOBAL_TAX> Global tax it appears on the Final Pricing
screen

<FINAL_PRICE> Final price as it appears on the Final Pricing
screen
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C H A P T E R12
Dialogs

Dialogs allow you to enter data into the Estimating software.
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Add Attachment Dialog
When you click on the Link File button of the Job Information screen, the Add Attachment dialog
appears. From this dialog you may navigate to the location of, and select the file which you want to be
linked to your job.

Once you have located the desired file, click OK to link it to your job.
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Add Extension Item Dialog
This dialog appears when you select the Add Item option from the Extension menu. Using the Add
Extension Item dialog, you can provide a description for a new takeoff item, and select the
breakdowns to be used for the takeoff.

After you click OK to exit the dialog, the takeoff now appears at the bottom of the extension. You can
now modify the description, price, unit, discount, net cost, labor, labor unit, material condition, and
labor condition for the new item. To do so, click the appropriate cell, then type in the new value and
press [Enter] to complete the change.

Double click the row heading (the number on the far left) of the new takeoff to display the expanded
view for this item. From the expanded view, you can modify the quantity for this item. To do so, click
on the Qty cell, then type in the new value and press [Enter] to complete the change.
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Add Category Name Dialog
When you click on the Add button of the Power Substitution Setup dialog, the Add Category Name
dialog appears. From this dialog you may enter the name of your new power substitution category by
typing in the New Category Name field.

Once you have entered the desired name,  you may choose to copy the Group, Material Size, Item
and Note information from a previously existing category by selecting a previous category from the
Copy from list box.

Click OK to add our new category to the power substitution table.
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Add Items to Assemblies Dialog
This dialog appears when you select the Add Items option from the Edit menu on the Takeoff screen
or the Database Manager module. From the Add Items to Assemblies dialog, you can select the
items you wish to add to the assemblies you have selected.

On the left side of the Add Items to Assemblies dialog, navigate through the database hierarchy until
you reach the item you wish to add to the selected assemblies. Double click on the item to be added,
so that it appears on the item list along the right side of the dialog. Repeat this step for each item you
wish to add to the selected assemblies.

Once all the items you wish to add are listed on the right side of the Add Items to Assemblies dialog,
click on OK. You will be prompted to confirm your intention to add the items to the selected
assemblies. Click on OK to confirm.
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Add Items to Takeoff dialog
This dialog allows you to add a component to an existing takeoff. It appears when you click on the
Add button within the Edit Takeoff dialog.

From this dialog, you can navigate through the material database until you find the item you wish to
add, or click the Selection list box and switch to Common Assemblies to find an assembly to be
added. After you locate the item or assembly to be added, double click it. Repeat these steps for
each component you wish to add, then click on Close.
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Add Style Name Dialog
This dialog appears when you click on the Add button from the Screen Style Setup or Report Style
Setup dialog. From the Add Style dialog, you enter the name you wish to use to identify the new
screen or report style. Then, you select an existing screen or report style you wish to use as the
basis for the new style. The default style includes all columns from all job screens. The blank style
does not include any columns from any job screen.
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Adjustment Descriptions Dialog
Using this dialog, you can modify the descriptions for the three user-defined adjustments and the
global tax adjustment appearing on the Final Pricing screen. To specify the adjustment percentages,
click on the appropriate Ranges button. From the User Defined Adjustment Ranges dialog that
appears, you can specify different adjustment percentages to be applied as the value of the job
increases.
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Bid Breakdown View dialog
From this dialog, you can select multiple breakdowns to be used to break down the bid on the Bid
Breakdown screen. Multi-level bid breakdowns allow you to group the bid by a combination of multiple
breakdown options. The Bid Breakdown View dialog appears when you click the Add or Edit buttons
beside the Breakdown View list on the Bid Breakdown screen.

To select the breakdowns you want to use to break down the bid, double click the appropriate option
from the left side of the dialog. Alternatively, you could single click the option, then click on the Add
button. You can select as many different breakdowns as you require. The order in which the options
appear on the right side of the dialog determine the order in which the bid is broken. You can reorder
items on the right side by selecting an item then clicking the Up or Down buttons. Based on your
selection, the Name of the breakdown view will be automatically assigned.

Tip - If you have any unallocated costs for the selected breakdowns on the General Expenses or
Equipment screens, you can prorate the unallocated costs evenly across the breakdowns by clicking
the appropriate checkbox(es).

After you click on OK from the Bid Breakdown View dialog and return to the Bid Breakdown screen,
the bid will be broken down by the selected breakdowns in the selected order. Additional breakdowns
displays nested under the previous breakdown, with plus and minus buttons to expand and collapse
the branches of the tree. Subtotals displays for the final breakdown in the in the tree.
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Bid Summaries Dialog
From the Bid Summaries dialog, you can create a new bid summary, and modify or delete an existing
one. You can create any number of different bid summaries, each of which can include different
combinations of drawing, area, phase, system, and location breakdowns. When you switch between
different bid summaries, the extension changes to include only those breakdowns you chose to be
part of the current bid summary. Totals appearing on all screens other than the Takeoff screen will be
similarly affected.

Creating a New Bid Summary

To create a new bid summary, click on the New button  at the top of the Bid Summaries dialog.

From the Add Bid Summary dialog that appears, specify a name for your bid summary, and select an
existing bid summary to be used as the basis for the new bid summary. Click on OK to create the
new bid summary and return to the Bid Summaries dialog. Finally, select or deselect the breakdowns
to be included in the new bid summary.

If a checkbox at the top of a branch within the breakdowns list on the side of the dialog is checked,
then all breakdowns in that branch will be included. If you click on the checkbox so that a check mark
no longer appears, then all the breakdowns in that branch will be automatically deselected. You can
then click on the checkbox beside the individual breakdown options you wish to include.

Tip -You cannot deselect a breakdown if a cost has been assigned to it from the Cost Allocation
dialog.

Modifying Bid Summaries

To modify an existing bid summary, click the bid summary name on the left side of Bid Summaries
dialog, then select or deselect the breakdowns included in the bid summary.

Renaming Bid Summaries

To rename a bid summary, click the bid summary name, then click the Rename button at the top of
the dialog.

From the Rename Bid Summary dialog that appears, specify a new name for your bid summary, and
click OK to return to the Bid Summary Components dialog.

Deleting Bid Summaries

To delete an existing bid summary, click the bid summary name, then click on the Delete button 
at the top of the dialog.

You will be prompted to confirm your intention to delete the bid summary.

Changing the Order of Bid Summaries

To change the order in which the bid summaries appear within the Bid Summary toolbar list box, you
can select the bid summary name, then click the Move Up or Move Down buttons.

Switching Between Bid Summaries
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Whichever bid summary is selected on the left side of the Bid Summaries dialog will be automatically
loaded when you click OK to exit the dialog.
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Chart Properties Dialog

General page

From the General page within the Chart Properties dialog, you can set and customize general
settings for the current graph. The following options are available from this page:

Gallery Type

Controls the type of graph to be displayed. The following options are available:

Stacked Style

For column, area, and bar charts, you can click here to control the stacking of different series values.

Point Type

Controls the marker shape for mark, line, and curve graphs.

Grid Lines

Controls the appearance of grid lines within the graph.

Point Size

This option currently has no effect.

Color Scheme

Controls the color scheme of the graph. You can display solid colors, black and white patterns, or
color patterns.

Marker Volume

Controls the width of the markers (lines, bars, columns, dots, or pie pieces). Dragging the slider to the
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right will bring markers closer together, while sliding to the left moves markers further apart.

3D Cluster

Controls whether values appear clustered in 3D graphs.

Color Lines

For polar, curve, and line charts, checking this option makes lines appear in the same color as the
series.
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Series page

From the Series page within the Chart Properties dialog, you can customize settings separately for
each series. The following options are available from this page:

Series

Allows you to select the series you want to apply changes to.

Multiple Types

Check this box if you want to display a multiple-type graph. After checking this box, use the Series
and Gallery Type lists to select different graph types for each series.

Gallery Type

If you check the Multiple Types box, you can click the Series list, then click this list to select different
graph types for each series.

Point Markers

If you check this option, points will be displayed within line, mark, curve, and scatter graphs.

Show Values

Check this box to display the numeric value above or beside each marker (bar, line, dot, or pie piece).

Borders

Controls whether borders appears around markers (bars, lines, etc.).

Area Lines

Controls whether lines appear in area graphs.

Connecting Lines

Controls whether connecting lines appear in scatter and polar graphs.

Series Color

Controls the color used for the series selected using the Series list.

Multiple Shapes

If your graph is displaying multiple series, you can check this box to display different conic or
cylindrical shapes.

No. of Vertex

Controls the number of sides for markers within this series. For example, if you specify 5, then the
marker displays as a pentagon.
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Scale page

From the Scale page within the Chart Properties dialog, you can customize any of the axis settings.
The following options are available from this page:

Main Y axis / X axis / Secondary Y Axis

Indicate the appropriate axis that you want to customize. X axis is only available for scatter charts;
Secondary Y is not available.

Minimum / Maximum

Controls the minimum and maximum values for the axis selected. If a value is greater than the
maximum, or less than the minimum, the chart will be clipped.

Scale Unit

Determines what percentage of the actual range of values is displayed within the scale. For example,
if you enter 10 as the scale factor, then the scale will display 1/10 of the actual range of values. This
option is useful when displaying very large values that may be too wide to display within the scale.

Decimals

Controls the number of decimal places used within the scale.

Increment

Controls the number of units between each tick. You can let the program automatically select an
appropriate increment, or you can click Fixed and specify the increment yourself.

Show zero axis

If there are negative values displayed in your graph, checking this box will display a zero axis, with
positive values appearing above the axis, and negative values appearing below the axis.

Axis scale

You can choose between linear and logarithmic. When using a logarithmic scale, you can specify the
base used. The default is base 10.
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3D View page

From the 3D View page within the Chart Properties dialog, you can control the angle and depth at
which the graph is displayed. The following options are available from this page:

Rotation window

Controls the angle at which the graph is displayed. When both the 3D and Full 3D View options are
checked, red and blue marbles appear. You can drag on the blue marble to rotate the graph
horizontally, and drag on the red marble to rotate the graph vertically.

3D View window

Displays the angle and depth at which the graph appears. Using the 3D Depth slider immediately
below this window, you can control the depth of the graph. Drag the slider to the right to increase the
depth, or drag the slider to the left to decrease the depth. To control the angle of the graph, use the
Rotation window to the left.

3D Depth slider

Controls the depth at which the graph appears. Drag the slider to the right to increase the depth, or
drag the slider to the left to decrease the depth.

X angle

Controls the vertical angle at which the graph is displayed. This option is only available when both the
3D and Full 3D View options are checked. You can also control the angle of the graph using the
Rotation window (above).

Y angle

Controls the horizontal angle at which the graph is displayed. This option is only available when both
the 3D and Full 3D View options are checked. You can also control the angle of the graph using the
Rotation window (above).

3D

Controls whether the graph appears three-dimensional or not.

Full 3D View

Controls whether the graph can be rotated. This option is only available when the 3D option (above) is
checked.

Shadows

Controls whether shadows appear behind the markers (bars, lines, or pie pieces).
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Titles page

From the Title page within the Chart Properties dialog, you can specify the text that appears at the
top, bottom, left, and right of the graph. The following options are available from this page:

Top

Allows you to specify the text that appears directly above the graph.

Left

Allows you to specify the text that appears directly to the left of the graph.

Right

Allows you to specify the text that appears directly to the right of the graph.

Bottom

Allows you to specify the text that appears directly below the graph.
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Cost Allocation Dialog
Pro only

From the Cost Allocation dialog, you can distribute a cost across multiple takeoff breakdowns in
whatever percentages you choose. The Bid Breakdown screen will then distribute costs to
breakdowns accordingly. This dialog appears when you select one or more rows on the General
Expenses, Quoted Materials, Subcontractors, and Equipment screens, then right click and select the
Cost Allocation option.

The cost to be allocated appears at the top of the dialog. This corresponds to the Total value for the
selected row(s) on the Quoted Materials screen, the Adj Cost value on the Subcontractors screen,
and to the Total Cost value on the General Expenses and Equipment screens.

To begin allocating a cost, you click the tab for the appropriate breakdown category: Drawing, Area,
Phase, System, or Bid Item. An asterisk displays on the tab is costs have been allocated within that
breakdown category. For each breakdown within a breakdown category, a check box is used to
indicate whether a takeoff has been assigned to that breakdown.

For each breakdown, you can assign either a dollar value or a percentage to indicate the portion of the
cost to be assigned. If you assign a dollar value, the system will calculate the percentage. Within
each category, the allocation percentages for the different breakdowns must total 100%. To enter the
same value in multiple cells within this dialog, select a range of cells beginning with the cell
containing the value, then right click and select the Fill option. To fill one or more cells within the
remaining unallocated portion of the cost, select the cell(s) then click the Fill Balance button. To clear
all allocations for the current breakdown, click Clear.

Without closing the Cost Allocation dialog, you can select another cost to be allocated, then click OK
when you are finished allocating costs. After you have allocated a cost, a dollar sign displays beside
the description of the item. The cost allocations you assign will be saved as part of the current bid
summary, and will no longer be assigned when you switch to a different bid summary.

To make the same allocations for multiple costs, select multiple rows using the [Shift] key to select a
range of rows or hold down the [Ctrl] key and click on each of the rows to be included before selecting
the Cost Allocation option.

The cost allocations you assign will be saved as part of the current bid summary, and will no longer
be assigned when you switch to a different bid summary.
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Create/Modify Assembly Dialog
This dialog displays in any of the following circumstances:

when you double click on an existing assembly within the Database Manager module

when you double click on a blank line within a level containing existing assemblies

when you select an assembly on the left screen of your estimating or billing program’s Takeoff
screen then click the Modify button (or select Modify from the Edit menu)

Assemblies are collections of related items identified by a single description, stored within the
database as a set of pointers to individual database items. For more information on creating and
modifying assemblies, see Adding/Modifying Assemblies.

The following options are available from the Create/Modify Assembly dialog:

Selection

Click here to switch between the Item Database and Common Assemblies database views.

Item database

The left side of the dialog displays the item database. Double click to move down a level within the
database. To move up a level, click with your right mouse button or press [Esc] on your keyboard. To
add an item to the assembly, double click the appropriate item description within the item database.
The item will be added to the assembly on the right side of the dialog. You can also add an existing
assembly to another assembly.

Name

Assembly name. To change the assembly name, click the Name field at the top right of the dialog
and enter a new name.

Item description

The description of each item within the assembly. You cannot modify item descriptions within an
assembly; to change the description, you must exit this dialog and edit the item within the Item
Database view.

Base / Factor 1 / Factor 2

When an assembly is taken off, the actual length or count measurement for each individual item is
determined by two pre-set factors (Fct 1 and Fct 2), in combination with the takeoff length or count.
For items whose Base value is Len (length) or Cnt (count), the program calculates the required
quantity for each item by multiplying the length or count specified in the takeoff by Fct 1, then dividing
the resulting value by Fct 2. For items whose Base value is Abs (absolute), the required quantity
equals the value of Fct 1. Absolute values are used if an item needs to be included in the assembly,
but the quantity of the item is not related to the takeoff length or the takeoff count.
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Using Base, Fct 1, and Fct 2 to calculate quantity when taking off assemblies

You can enter values ranging from -999.99 to 999.99 in the Fct 1 cell, and values ranging from 0.1 to
999.9 in the Fct 2 cell.

catalog Number

The item's catalog number.

Add

Click here to add the currently highlighted database item to the assembly.

Delete

Click here to remove the highlighted item from the assembly.

Move Up

Click here to move the highlighted row from the assembly up in the assembly list.

Move Down

Click here to move the highlighted row from the assembly down in the assembly list.

Print

Click here to print a report listing the items in the assembly, along with their Base, Fct 1, and Fct 2
values.

OK Button

Click here to accept your changes and exit the Create/Modify Assembly dialog.

Cancel Button

Click here to reject your changes and exit the Create/Modify Assembly dialog.
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Create/Modify Temporary Assembly Dialog
This dialog displays in any of the following circumstances:

when you double click on an existing assembly within the Database Manager module

when you double click on a blank line within a level containing existing assemblies

when you select an assembly on the left screen of your estimating or billing program’s Takeoff
screen then click the Modify button (or select Modify from the Edit menu)

Assemblies are collections of related items identified by a single description, stored within the
database as a set of pointers to individual database items. For more information on creating and
modifying assemblies, see Adding/Modifying Assemblies.

The following options are available from the Create/Modify Temporary Assembly dialog:

Selection

Click here to switch between the Item Database and Common Assemblies database views.

Item database

The left side of the dialog displays the item database. Double click to move down a level within the
database. To move up a level, click with your right mouse button or press [Esc] on your keyboard. To
add an item to the assembly, double click the appropriate item description within the item database.
The item will be added to the assembly on the right side of the dialog. You can also add an existing
assembly to another assembly.

Name

Assembly name. To change the assembly name, click the Name field at the top right of the dialog
and enter a new name.

Item description

The description of each item within the assembly. You cannot modify item descriptions within an
assembly; to change the description, you must exit this dialog and edit the item within the Item
Database view.

Base / Factor 1 / Factor 2

When an assembly is taken off, the actual length or count measurement for each individual item is
determined by two pre-set factors (Fct 1 and Fct 2), in combination with the takeoff length or count.
For items whose Base value is Len (length) or Cnt (count), the program calculates the required
quantity for each item by multiplying the length or count specified in the takeoff by Fct 1, then dividing
the resulting value by Fct 2. For items whose Base value is Abs (absolute), the required quantity
equals the value of Fct 1. Absolute values are used if an item needs to be included in the assembly,
but the quantity of the item is not related to the takeoff length or the takeoff count.
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Using Base, Fct 1, and Fct 2 to calculate quantity when taking off assemblies

You can enter values ranging from -999.99 to 999.99 in the Fct 1 cell, and values ranging from 0.1 to
999.9 in the Fct 2 cell.

catalog Number

The item's catalog number.
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Create/Modify Item Dialog
When you create or modify an item or temporary item in the database, the Create/Modify Item dialog
appears. This dialog displays the various fields which define the characteristics of the item. You can
change the order in which fields are displayed on this dialog. To do this,click a field description or
value then click the Move Up or Move Down button.

Modifying Field Values

To modify a value for a field on the Create/Modify Item dialog, click a field, then start typing the new
value. If the field allows only certain values (like Material Condition), you can click the field, type any
character, and then select the appropriate value from the list that appears.

 Tip - You cannot modify the Date field. The system date is automatically inserted when the item
is created, and each time the price is modified.

After entering a value, press [Enter] or simply click another field or cell to accept the new value field. To
reject the new value, press [Esc] on your keyboard.

Printing the Item Modify Report

Click the Print button at the bottom of the dialog to obtain a copy of the Item Modify Report. When
you print, the font in the current screen style gets applied. To change the font, you can change the
screen style.

Available Fields

The fields used to define each database item are listed and described below.

Field Description

Description Description of the material item (maximum 80
characters)

Date Date of the last material price change. You
cannot modify this field. The date is
automatically inserted when the item is created,
and each time the price is modified.

Material Unit Pricing units: E (each), C (hundred), M
(thousand).

Material Price The item’s trade price. Can be updated
automatically through a pricing service.

Material Discount The percentage discount off the Material Price
used to calculate Material Net Cost.

Material Net Cost The item’s cost: material price less material
discount. If this price is entered manually, the
discount will be adjusted based on the trade
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Field Description

price. You must enter a Material Price before
you enter the Net Cost. This price is used by the
extension to calculate material cost.

Net Condition Controls whether the net price remains fixed
during price updating. If this field is set to Fixed,
then the net cost will not be updated; instead the
trade price and discount will be updated.

Material Condition Used to identify how the material is priced. You
can identify items as Normal, Halted, Quoted,
Sub Contractor, Owner Supplied, No Cost,
Equipment, or Budget. Within the extension you
can filter items by material condition.

 Tip - If your pricing service stops monitoring
the material price of an item, the material
condition will be set to Halted to indicate that the
current material price may not be correct.
However, the material price of a halted item will
still be applied to the item in the extension. Filter
the extension to view all items with a Halted
material condition and modify the prices as
necessary.

Material Adj. #1 Material adjustment #1

Material Adj. #2 Material adjustment #

Price Code The code used to identify material items during
an automatic price update (maximum 14
characters).

Price Factor A conversion factor used for metric prices or for
materials priced by a non standard unit. This
factor is only used when running a price update
from a Pricing Service (such as Trade Service).

Labor Unit Labor units E (each), C (hundred), M (thousand).

Column 1 Labor Electrical: Labor hours for competitive bidding
(base rate).

Mechanical: Competitive labor units.

Column 2 Labor Electrical: Labor hours for industrial applications
(base rate + 25%).

Mechanical: Change order labor units.
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Field Description

Column 3 Labor Electrical: Labor hours for unique or special
conditions (base rate + 50%).

Mechanical: Industrial labor units.

Column 4 Labor Electrical: NECA’s published labor column 1. If
you are not using a NECA database, this field
will have a value of 0.00.

Mechanical: MCAA labor units.

Column 5 Labor Electrical: NECA’s published labor column 2. If
you are not using a NECA database, this field
will have a value of 0.00.

Mechanical: PHCC labor units.

Column 6 Labor Electrical: NECA’s published labor column 3. If
you are not using a NECA database, this field
will have a value of 0.00.

Mechanical: intentionally left blank.

Labor Condition Used to identify the labor type for this item. You
can identify items as Normal, Budget, No Labor,
Subcontractor, Owner Supplied or Shop Labor.

Labor Factoring Specifies which one of the five labor factor
percentages will be used when a labor factor is
applied to this item during a takeoff.

Based On This item’s quantity will be based on the takeoff
length (Len) or on the takeoff count (Cnt).

Labor Code The labor code for this item.

Sort Codes Sort codes are identifiers used to group different
materials within the database. Within the
database, sort codes are assigned to individual
items. Within the extension, you can sort items
by sort code, and view separate labor and price
totals for each material group.

Databases support multiple sort codes, allowing
you to group items in a variety of different ways.
Up to 8 sets of sort codes are available. Sort
Codes #1 and #3 are predefined—the remaining
sort codes are undefined and can used to group
and classify items according to whatever criteria
you require.
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Field Description

Weight Unit For future use.

Weight For future use.

Manufacturer Name Name of the item's manufacturer (maximum 35
characters).

Supplier Name Name of the item's supplier (maximum 15
characters).

Supplier Code The supplier's order code for this item (maximum
25 characters)

catalog Number The catalog number for the item (maximum 40
characters).

Reference Manufacturer order code (maximum 25
characters).

Universal Item Code Universal code used to identify item, not specific
for any manufacturer.

Quick Takeoff Code Custom code you enter to allow for quick
takeoffs. Instead of navigating through the
material database to select the takeoff material,
you can simply enter the quick takeoff code for
the database item you want to take off. You can
enter letters and/or numbers, but not spaces or
special characters.
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Database Directories Dialog
From this dialog, you specify the directories in which material databases can be stored. This dialog
appears when you select the Database Directories option from the Settings menu.

Database Folders dialog

To be designated as a database folder, the directory must not only appear on this Database Folders
dialog, but must also be selected. A database folder is selected if a checkmark appears in the check
box beside the directory name on this dialog. At least one directory must be listed and checked
within the Database Folders dialog.

To select or deselect a database folder, click the checkbox beside the directory name.

To select all the databases listed on this dialog, click the Select All button.

To add a new directory to the list, click the Add button. In the dialog that appears, you can type the
full path of the directory where you want to store databases, or you can click the Browse button and
navigate through your directory structure until you locate the appropriate directory.

To remove a directory from the list, click the check box beside the database folder you wish to delete.
To select more than one database directory, hold down the [Ctrl] key on your keyboard and click each
desired database folder. To select all, hold down the [Shift] key and click the first desired database
folder, then click the last desired database directory. Click the Delete button then click OK to exit the
dialog.
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Delete Items from Assemblies Dialog
This dialog appears when you select the Remove Items option from the Edit menu on the Takeoff
screen or the Database Manager module. From the Delete Items from Assemblies dialog, you can
select the items you wish to remove from the assemblies you have selected.

On the left side of the Delete Items from Assemblies dialog, navigate through the database hierarchy
until you reach the item you wish to remove from the selected assemblies. Double click on the item to
be removed, so that it appears on the item list along the right side of the dialog. Repeat this step for
each item you wish to delete from the selected assemblies.

Once all the items you wish to delete are listed on the right side of the Remove Items from
Assemblies dialog, click on OK. You will be prompted to confirm your intention to delete the items to
the selected assemblies. Click on OK to confirm.
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Edit Style Name Dialog
This dialog appears when you click on the Rename button from the Screen Style Setup or Report
Style Setup dialog. From the Edit Style Name dialog, enter a new name for the current screen or
report style, then click on OK.
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Enhanced Job Merge Dialog
From the Enhanced Job Merge dialog, you can select the existing sub jobs to be merged into the
currently open master job by clicking on the check box beside the appropriate job name(s). Takeoffs,
breakdowns, typicals, and designations from the selected jobs will be merged into the current job in
the order in which they are listed on this dialog.

The Enhanced Job Merge dialog appears when you select the Enhanced Job Merge option from the
Job menu from within an open master job.

The following options are available from this dialog:

   Option    Description

Job Merge Selection Select the existing jobs to be merged into the current job by
clicking on the check box beside the appropriate job
name(s). Takeoffs, breakdowns, typicals, and designations
from the selected jobs will be merged into the current job in
the order in which they are listed on this dialog.

Job Merge Progress Displays status messages as each of the selected jobs are
merged into the current job.

Job Merge Options Control whether the program compares all details or just the
description before combining the breakdowns, typical
takeoffs, or designations. By default, the program performs a
comprehensive merge, making sure that all details match
before combing breakdowns, typicals, and designations. A
non-comprehensive merge involves merging the breakdowns,
typicals, or designations that share the same description
even if the remaining details do not match. Where details do
not match, the details of the breakdowns, typicals, or
designations already stored in the current job will be used.
You can control whether the merge is comprehensive for
breakdowns, typicals, or designations, by checking or
clearing the check box beside the appropriate option.

Comprehensive breakdown merge

If checked, the program will compare all details (e.g. Labor
Adj as well as Description) before combining breakdowns.

Comprehensive typical merge

If checked, the program will compare all details (Count as
well as Description) before combining typicals.

Comprehensive designation merge

If checked, the program will compare the items and counts
that comprise the designation, as well as the designation
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   Option    Description

description, before combining designations.

Merge Click on this button to merge the takeoffs from the selected
jobs.

Unmerge Click this button to remove (or unmerge) the previously
merged takeoffs originating in the selected Sub Job(s) from
the currently open Master job.

Select All / Clear All Click on the appropriate button to select all available jobs for
merging or clear all currently selected jobs for merging.

Remove Removes the selected sub job from the merge list and delete
the job file from your hard drive.

Relink If a sub job has been renamed or moved, the sub job
displays grayed out in the merge list, with a question mark
button beside the job number:

To relink the sub job, click on it then click the Relink button.
A dialog displays allowing you to specify the location of the
sub job.

Exit Exits the dialog without making any further changes
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Enter URL Dialog
The Enter URL dialog box appears after you have clicked the Add URL button on the Job Information
screen of the Estimating program.

1. In the Enter URL field, type the URL address.

2. Click OK. The link is added to the Job Information screen.
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Filter Job Schedule Information Dialog

Values

From the Filter Job Schedule dialog, you can control view on the Job Schedule screen. The different
options are grouped together on separate pages. To move from one page to another, click the
appropriate page tab. For example, to switch to the Date Saved page, click the Date Saved tab.

From the Values page you can filter the jobs displayed on the Job Schedule screen by the values
contained (or not contained) in certain fields. For example: Job Name, Job Number, Job Category,
Estimator, Job Path, Last Bid, Bid Price, Spread Percentage, Next Price, Price/Area, Labor Hours,
and Status.
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Date Saved

From the Filter Job Schedule dialog, you can control the view on the Job Schedule screen. The
different options are grouped together on separate pages. To move from one page to another, click the
appropriate page tab. For example, to switch to the Date Saved page, click the Date Saved tab.

From the Date Saved page you can filter the jobs displayed on the Job Schedule screen by the values
contained in the Date Saved field. For example, you could choose to show only jobs that were last
saved Today, or during the month of January, or even saved during a specific date range.
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Bid Due Date

From the Filter Job Schedule dialog, you can control the view on the Job Schedule screen. The
different options are grouped together on separate pages. To move from one page to another, click the
appropriate page tab. For example, to switch to the Date Saved page, click the Date Saved tab.

From the Bid Due Date page you can filter the jobs displayed on the Job Schedule screen by the
values contained in the Bid Due Date  field. For example, you could choose to show only jobs that
were last saved Today, or during the month of January, or even saved during a specific date range.
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Find Dialog
Using the Find dialog, you can search for a particular text string within the current grid. After
performing a search, you can leave the dialog open while you continue to work on your job.

The Find dialog appears when you select the Find option from the Edit menu, or when you hold down
the [Ctrl] key and press [F] on your keyboard.

From the Find dialog, you can specify the following search criteria:

Criteria Description

Find what In this field, you enter the text string you wish
to search for. You can click on the drop down
arrow to display the last 5 search strings.

Match whole word When this option is selected (a checkmark
appears in the box), the program will treat the
search string as one or more whole words and
search for whole words that match the string,
ignoring occurrences of the search string where
it forms part of a larger word. For example, if
you select this option and search for Electric
Heat, the category Electric Heating would not
be considered a match.

Match case When this option is selected (a checkmark
appears in the box), the program will only
consider an item or assembly a match if the
case of the characters, as well as the
characters themselves, match the specified
search text. When this option is deselected,
the search will not distinguish between upper
and lower case letters.

For example, if you select this option, then a
search for THHN would not return #14 thhn, but
would return #14 THHN. If you deselect this
option, then the search for thhn would return
#14 THHN as well as #14 thhn.

Search from top Controls whether the search begins from the top
of the current screen component, or from the
currently selected location. For example, if you
select the third entry in the audit trail, then
begin a search and select this option, then the
search will begin the first entry in the audit trial.
If this option is not checked, the search will
begin with the third entry. Whether this option is
selected or not, the search will continue
searching from the top if it reaches the bottom
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Criteria Description

without finding a match.

Search range Click on the appropriate button to control
whether the search is restricted to the selected
cells, or to any cells within the current screen
or subscreen. You cannot search for text
strings across product screens.
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Find & Replace Dialog
Using the Find & Replace dialog, you can find and replace text on the followings screens: Extension,
all labor screens, Subcontractors, General Expenses, Quoted Materials, and Bid Breakdown. After
performing a search, you can leave the dialog open while you continue to work on your job.

The Find & Replace dialog appears when you select the Replace option from the Edit menu, or when
you hold down the [Ctrl] key and press [H] on your keyboard.

From the Find & Replace dialog, you can specify the following search criteria:

Criteria Description

Find what The text string you wish to search for. You can
click on the drop down arrow to display the last
5 search strings.

Replace with The replacement text. You can select one of
the last 5 replacement text strings by clicking
on the drop down arrow.

Match whole word When this option is selected (a checkmark
appears in the box), the program will treat the
search string as one or more whole words and
search for whole words that match the string,
ignoring occurrences of the search string where
it forms part of a larger word. For example, if
you select this option and search for Electric
Heat, the category Electric Heating would not
be considered a match.

For numeric fields, the search string must
match the contents of the entire cell in order for
the replacement to take place regardless of
whether the Match Whole Word option is
selected or not. For alphanumeric fields, partial
matches are permitted (unless the Match
Whole Word option is enabled).

Match case When this option is selected (a checkmark
appears in the box), the program will only
consider an item or assembly a match if the
case of the characters, as well as the
characters themselves, match the specified
search text. When this option is deselected,
the search will not distinguish between upper
and lower case letters.

For example, if you select this option, then a
search for THHN would not return #14 thhn, but
would return #14 THHN. If you deselect this
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Criteria Description

option, then the search for thhn would return
#14 THHN as well as #14 thhn.

Search from top Controls whether the search begins from the top
of the current screen component, or from the
currently selected location. For example, if you
select the third entry in the audit trail, then
begin a search and select this option, then the
search will begin the first entry in the audit trial.
If this option is not checked, the search will
begin with the third entry. Whether this option is
selected or not, the search will continue
searching from the top if it reaches the bottom
without finding a match.

Search range Click on the appropriate button to control
whether the search is restricted to the selected
cells, or to any cells within the current screen
or subscreen. You cannot search for text
strings across product screens.
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Find Database Item/Assembly Dialog
From the Find Database Item/Assembly dialog, you can locate an item or assembly within the current
database. You can specify the search criteria, search for partial or exact matches, and control
whether spaces and upper or lower case is taken into consideration.

Once the search is complete, you can double click on any of the search result entries and
immediately jump to that item or assembly within the database hierarchy on the left side of the
screen. You can leave this dialog open while you continue to work on your job.

From the Find Database Item/Assembly dialog, you can specify the following search criteria:

Criteria Description

Search text In this field, you enter the text string you wish
to search for. You can click on the drop down
arrow to display the last 5 search strings.

Type From this list, you choose whether you wish to
search the item and assembly descriptions, the
item price codes, the manufacturer name, the
supplier name, supplier code, catalog number,
or reference number.

When you are searching for assemblies and the
Type is set to Description, the search will be
conducted against the descriptions of the
assemblies themselves, not the descriptions of
the items within the assemblies.

Search for Here, you indicate whether you wish to search
for matching items, assemblies, or both items
and assemblies. If you chose Price Code as the
Type (above), then you can search only for
items.

Match entire line When this option is selected (a checkmark
appears in the box), the program will search for
items and assemblies that exactly match the
search text, character for character. If this
option is deselected, the program will search for
items and assemblies that include the search
text within their names.

For example, if you specify THHN as your
search text and select this option, then only
items and assemblies named THHN will be
returned. An item or assembly called #14 THHN

would not be returned. If you deselect this
option, so that a check mark no longer appears,
then items such as #14 THHN would be
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Criteria Description

returned.

Ignore case When this option is selected (a checkmark
appears in the box), the program will not
distinguish between upper and lower case
letters when searching for matching items and
assemblies. With this option deselected, the
program will only consider an item or assembly
a match if the case, as well as the characters,
match the specified search text.

For example, if you leave this option selected,
then the search for thhn would return #14 THHN,
among other items and assemblies. If you
deselect this option, then a search for thhn

would not return #14 THHN, but would return
#14 thhn, if such an item existed.

Ignore whitespace When this option is selected (a checkmark
appears in the box), the program ignores
spaces when deciding whether an item or
assembly matches the search text.

For example, if you search for #14THHN and
allow this option is remain selected, the
program will consider #14 THHN to be a match,
despite the extra space. If you deselected this
option, the program will not consider #14 THHN

a match, because of the extra space.
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Font Dialog
Using the Font dialog, you can alter a selected text string within the Notes or Quotepad screens. The
Font dialog appears when you select the Font option from the Format menu.

From the Font dialog, you can specify the following font characteristics:

Option Description

Font Lists the available fonts and highlights your
current selection.

Font style Lists the available styles for the selected font.

Size Lists the available point sizes for the selected
font.

Effects Specifies whether or not to strikeout, underline,
and/ or alter the color of the font.

Script Lists the available language scripts for the
selected font.
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Job Merge Dialog
From the Job Merge dialog, you can select the existing jobs to be merged into the current job by
clicking on the check box beside the appropriate job name(s). Takeoffs, breakdowns, typicals, and
designations from the selected jobs will be merged into the current job in the order in which they are
listed on this dialog.

From this dialog, you can also control whether the program performs a comprehensive merge or not.
A comprehensive merge involves making sure that the description and all other details match before
combining two breakdowns, typicals, or designations into one.

A non-comprehensive merge involves merging the breakdowns, typicals, or designations that share
the same description even if the remaining details do not match. Where details do not match, the
details of the breakdowns, typicals, or designations already stored in the current job will be used. You
can control whether the merge is comprehensive for breakdowns, typicals, or designations, by
checking or clearing the check box beside the appropriate option.

For more information on Job Merge dialog options, click on the appropriate option below:
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Labor Calculations Dialog
Pro, BidWinner Plus only

From this dialog, you can control whether labor overhead and markup costs are calculated as a
percentage marked up from the total cost, or as dollars per hour. This dialog appears when you select
the Labor Calculations option from the Edit menu while on the Final Pricing screen with either the
Labor Markup or Labor Overhead cell selected.

Labor Calculations dialog consists of two pages: Labor Markup and Labor Overhead.



Classic Estimating Help Guide  - 489

Labor Markup page

From the Labor Markup page dialog, you can control whether labor markup costs are calculated as a
percentage marked up from the total cost, or as dollars per hour. You can also control how labor
overhead is calculated from the Labor Overhead page.

If you choose the Based on $ Per Labor Hour option, you can enter the dollar value, and choose
whether to include direct labor, incidental labor, and/or indirect labor hours in the total labor hours.
You can also choose the label that displays in place of "Labor Markup" on the Final Pricing row
displaying the calculated value.
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Labor Overhead page

From the Labor Overhead page dialog, you can control whether labor overhead costs are calculated as
a percentage marked up from the total cost, or as dollars per hour. You can also control how labor
markup is calculated from the Labor Markup page.

If you choose the Based on $ Per Labor Hour option, you can enter the dollar value, and choose
whether to include direct labor, incidental labor, and/or indirect labor hours in the total labor hours.
You can also choose the label that displays in place of "Labor Overhead" on the Final Pricing row
displaying the calculated value.
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Material Adjustment Defaults Dialog
This dialog appears when you select the Material Adjustment Defaults option from the Extension
menu while the Extension Screen is displayed. This dialog allows you to set the default Value and the
affected Database Adjustment Column (Column 1 or Column 2) for your Material Adjustment.
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Measure/Edit Takeoff Dialog
Both the Measure Takeoff and Edit Takeoff dialogs share the same layout, and allow you to specify
the count, length, or other measurements for items or assemblies within the takeoff.

The Measure Takeoff dialog appears when you double click on the item or assembly you wish to take
off from the list on the left side of the Takeoff screen. The Edit Takeoff dialog appears when you double
click on a takeoff component after double clicking on a takeoff line within the Takeoff screen’s audit
trail.

The following fields appear on the Measure/Edit Takeoff dialog:

Option Description

Calculator/Probe Information The Calculator/Probe Information area allows you to
calculate the length or quantity using a probe or the
calculator.

Scale If you have configured a measuring device for use
with your estimating program, this area will display
the device’s current scale. You can change the
device’s scale by clicking on this list box and
selecting from the list of valid scales.

Length Displays the length calculated using the measuring
device.

Count Displays the count calculated using the measuring
device.

Send Click this button when the length and/or count
displayed in the probe information is correct. The
measurement will be displayed in the value box on
the Measurement Information area of the screen,
and the extended measurements will be displayed
in the Quantity column within the Item Information
area of the screen.

Settings Displays the Custom Settings dialog for the
currently selected measuring device. From the
Custom Settings dialog, you can modify defaults
settings for the device.

Send Value Sends the value currently displayed by the
calculator to the Value field in the Measurement
Information area.

Notes Displays an area where you can enter reminders or
explanations regarding this takeoff. After you have
attached a note to a takeoff, a note button displays
beside the takeoff in the audit trail. To view the note
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Option Description

from the audit trail, right click over the takeoff and
select the Notes option. You can also this option to
add a note to an existing takeoff.

Measurement Information The Measurement Information area allows you to
count or measure materials using your keyboard,
the calculator, or LiveCount, Trimble's on-screen
takeoff tool. When performing a takeoff, some items
and assemblies require you to specify a length,
count, or other measurement.

When LiveCount is set up as your measuring device
from the Probe Options dialog, a LiveCount column
will also appear. The first item in the LiveCount
column is a status button, indicating whether the
takeoff value is linked to a LiveCount measurement,
with the following states:

Button Status

Linked to a LiveCount
measurement

Both Count and
Length for this takeoff
are linked to the same
LiveCount
measurement

blank Not linked to a
LiveCount
measurement

Beside the status button are the following options
button: 

Button Function

Determine the takeoff
quantity in LiveCount.
Focus will shift to the
LiveCount application.

Break link to
LiveCount
measurement. If both
Count and Length
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Option Description

values for this takeoff
are linked to the same
LiveCount
measurement, this will
break the link for the
Count value only. The
Length value will
continue to be linked
to the LiveCount
measurement.

 Links the Count value
to the same LiveCount
measurement as the
Length value. This
option is only available
for the Count variable.

Reverse Takeoff Allows you to designate the takeoff as a takeoff with
negative values. You can also make a takeoff
negative by right clicking over it in the audit trail and
select the Reverse Takeoff option.

Takeoff Label The label to be used to identify this takeoff. Defaults
to the item or assembly name.

Item/Assembly Name The name of the item or assembly being taken off.

Item Information The material dollars, labor hours, and average length
associated with the item or assembly.

Item Description The description of the materials being measured.

Quantity The quantity of material being taken off. If you are
taking off an assembly, your estimating program
calculates the required quantity for each component
in the assembly by multiplying the count or length
you specify by Factor 1, then divides the resulting
value by Factor 2.

Base Indicates whether the quantity for the item is
calculated using the specified length (Len) or count
(Cnt), or whether an absolute quantity of material
(Abs) is required regardless of the length or count.

Factor 1 / Factor 2 For items whose Base value is Len (length) or Cnt
(count), your estimating program calculates the
required quantity for each item by multiplying the
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Option Description

length or count specified in the takeoff by Fct 1,
then dividing the resulting value by Fct 2. For items
whose Base value is Abs (absolute), the required
quantity equals the value of Fct 1.

Catalog Number The item's catalog number.
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Network Connection Protocol Dialog
If you are experiencing difficulties linking to a security server, an MEP Client Services representative
may instruct you to click on the Advanced button and specify a different network protocol. From the
Network Connection Protocol dialog, specify the protocol by clicking on the radio button beside the
appropriate protocol option. By default, the program assumes your network uses NetBIOS as its
network protocol.
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New Job Dialog
The New Job dialog allows you to specify a job name, job number, material database, and job path.

Go to Job / New. 

Click the New Job  button on the toolbar.

Double-click on the first empty row at the bottom of the Schedule screen job list.

The fields in this screen are:

Option Description

Enter the new job name The name of the new job. The job name
appears on the Job Schedule screen, and can
be up to 80 characters long.

Enter the new job number A unique job identifier. The job number is
combined with a .es9 extension to form the
name of the job file. The job number can
contain up to 255 characters, including
spaces, but cannot contain any of the following
characters: \ / : * ? " < > |

Select the database Choose a database to assign to the job. You
may wish to assign different databases for
different types of jobs. To select a different
database, click on the list box and select a
database from the drop-down list. Only
databases stored in directories designated as
database folders displays in the list. If a
database is already being used by another
user, or by an open job, then the database will
not appear in the list.

 Caution: Do not delete a database that has
been assigned to a job. If you try to open a job
and the assigned database is missing, a
message box will be displayed telling you the
name of the database that is missing. You will
also be given the option to choose a different
database. If you select a different database,
you may encounter difficulties if you try to re-
extend the job.

Select the job path The job path is the drive and directory where
your job information will be stored. If you have
installed the program on a network, or wish to
store the job information on a drive other than
the one displayed, click on the down arrow to
display other paths. Only those directories
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Option Description

identified as job folders using the Job Folders
option displays in this list.

After you have entered all required information, click OK. The Takeoff screen for the new job displays.
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Notes Dialog
From the Notes dialog, you can enter, view, or revise a note attached to a takeoff, temporary item, or
temporary assembly. The Notes dialog appears when you right click over a takeoff in the audit trail, or
a temporary item or temporary assembly within the temporary items or temporary assemblies list,
and select the Notes option.

You can also attach a note to a takeoff from the Measure/Edit Takeoff screen.

When a note is attached to a takeoff, temporary item, or temporary assembly, a note button displays
beside the takeoff, temporary item, or temporary assembly.
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Open Job dialog
This menu commands allows you to open an existing job. 

1. Click Job / Open. The Open Job dialog displays. 

2. Navigate to the location of the job you want to open.

Tip - The location defaults to the JOBDATA folder. If your jobs is located in a different folder,
navigate to that location.

3. Click on the job and then click Open OR double-click on the job. The Takeoff screen for the
selected job appears. 

Tip - You can also open a job by double-clicking on the row number to the left of the job name on
the Schedule screen’s job list.
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Options Dialog
The following tabs are available from the Options dialog:

General

File Locations

Takeoff

Appearance

Job Schedule

Extension

Database

Security Device
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General page

From the Options dialog, you can control a number of features of your job, including autobackup,
password protection, colors, database setup, file locations, and security setup. The different options
are grouped together on separate pages. To move from one page to another, click the appropriate
page tab. For example, to switch to the Database page, click the Database tab.

The following pages are available from the Options dialog:

General

File Locations

Takeoff

Appearance

Job Schedule

Extension

Database

Security Device

The following options are available from the General page:

Options Description

Program password protection Allows you to restrict access to the program.
With password protection, only users who know
your password will be able to use your program.
See Security Protection for more details.

Prompt to create database when creating
new job

Controls whether or not you are asked to create
a new database each time you create a new
job. If you wish to be asked each time you
create a new job, leave the check box selected.
If you click the checkbox so that a check mark
no longer appears, no prompt appears for each
new job you create, and the job uses an
existing database.

Round takeoff/extension items Controls whether the extension rounds takeoff
items to the nearest whole number. With this
option selected, a takeoff quantity of 6/10 would
be rounded to 1, while a takeoff quantity of 4/10
would be rounded to zero. To avoid having small
takeoff quantities rounded to zero in the
extension, you can turn the rounding on or off.

Enable item matching by database ID Select this checkbox to allow the program to
match items during a re-sync or job merge
function by comparing their database ID
numbers.
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Options Description

Spelling Click this button to set spell-checking options.
You can spell-check text on the Notes screen
by selecting the Check Spelling option from the
Edit menu.
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File Locations page

The File Locations tab allows you to control where style files and extension view files are stored. 

Tip - Storing the style files or extension view files on a network drive allows multiple users to share
the same settings.

Common style files Description

Acquire schedule screen style at startup Select the checkbox  and then click
Browse to navigate to the location of your
schedule screen styles.

Acquire job screen style at startup Select the checkbox  and then click
Browse to navigate to the location of your job
screen styles.

Acquire job report style at startup Select the checkbox  and then click
Browse to navigate to the location of your job
report styles.

Common Extension Views Description

Acquire extension views at startup Select the checkbox  and then click
Browse to navigate to the location of your
extension views.

Click OK when you are done.
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Auto Save / Backup page

From the Auto Save / Backup page, you can control:

whether your changes are automatically saved after each takeoff

whether a backup copy of a job is created each time it is saved

how often automatic recovery files are created.

By default, estimating programs save a recovery copy of your job every 10 minutes. If you experience
a power failure or a system crash before you’ve saved your latest changes, the program will ask you
the next time you open the job whether you wish to restore the job from the recovery file.

The backup copy of a job is stored in the same folder as the job file but with an extension of .backup.
If you want to revert to the previously saved version of a job, you can rename the .backup file
extension to .es11 and the job displays on the Schedule screen.
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Takeoff page

From the Takeoff tab, you can specify takeoff-specific program options.

The following options are available from the Takeoff page:

Options Description

Prompt for confirmation when aborting
takeoff

Controls whether you are prompted to confirm
when you click the Abort button to discard the
changes you have made to an existing takeoff
within the audit trail on the Takeoff screen. 

Tip - By default, the confirmation message
is enabled. To disable the message, click the
checkbox so that a check mark no longer
appears.

Show Catalog Number at Item level Controls whether the Catalog Number is
displayed at the item level when taking off
material from the item database on the Takeoff
screen. 

Tip - By default, the Catalog Number is
displayed. To disable this option, click the
check box so that a checkmark no longer
appears.

Enable LiveCount automatic launch Controls whether LiveCount is automatically
launched when you initiate a takeoff. LiveCount
must be selected as your measuring device
from the Probe Options dialog for this option to
take effect.

Highlight typical takeoffs on Audit Trail Control whether typical takeoffs appear
highlighted (green text rather than black text)
within the audit trail. You can control the color
used to highlight them from the Appearance
tab.
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Appearance page

You can use the Appearance page on the Options dialog to control the foreground and background
colors used to represent different kinds of information in cells, as well as the overall color and
appearance of program screens. For example, you can control the color used to indicate that a field is
protected and cannot be modified.

The following options are available from the Appearance page:

Theme
You can choose from a list of themes that control the overall color and appearance of the program
screens.

Toolbar Size
Controls whether the buttons that appear on toolbar are large (24x24 pixels) or small (16x16
pixels).

Category
The category of data to be displayed using the specified colors. The following color categories are
available:

Category Applies to ...

Cell Editable Normal Regular editable cells.

Cell Non-Editable Normal Cell data that cannot be modified.

Cell Editable Grayed Default cell values that can be overridden.

Cell Non-Editable Grayed Cell values that cannot be overridden. These
include non-modifiable default values.

Cell Editable Highlight Pinned values that can be modified. For
example, where a value can be specified as
either a percentage or a fixed amount, the
specified (or “pinned”) value displays
highlighted.

Cell Non-Editable Highlight Pinned values that cannot be directly
modified. For example, values appear on the
Totals screen that have been carried forward
from previous screens appear highlighted but
can only be modified from the original
screen.

Cell Editable Alarm Cells with missing or incomplete data that
can you can modify directly. To control cell
alarms see the Extension page of the
Options dialog.

Cell Non-Editable Alarm Cells with missing or incomplete data that
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Category Applies to ...

cannot be directly modified, but can be
completed by entering the appropriate values
in other related fields. To control cell alarms
for certain fields on the Extension screen,
see the Extension page of the Options
dialog.

Cell Totals Alarm Column totals that include cells with missing
or incomplete data.

Typical Highlight Typical takeoffs within the audit trail.

Foreground
Determines the color of the text itself. To specify a different color, click on the list box and select
the desired color.

Background
Determines the color of the background that appears behind the text.

Reset Colors
Returns all color settings back to their original default values.

Disable Grid Hovering
Grid hovering occurs when the background of the row over which your pointer is positioned
changes color. Check this box to disable grid hovering.
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Job Schedule page

You can use the Job Schedule page on the Options dialog to control how the Job Schedule screen
handles updates in order to optimize the speed of the display for refreshed information, and control
whether to display job alarms.  

The following options are available from the Job Schedule page:

Options Description

Rescan Options

Tip - This only applies to scanning the Job
Schedule after the initial load of the schedule
screen upon entering the application.

No Rescan
The Job Schedule will only reflect updates/
changes to jobs that the current user has
made.  Changes to existing jobs made by
other users will not be reflected on the Job
Schedule screen.  However, if a new job is
created by any user it will be reflected on the
schedule screen.

Optimized Rescan
The visible section of the Job Schedule will
update only the jobs which have been
modified or added.  The user should always
see all updates for any job made by any
user.  This is the default selection for this
function.

Full Rescan
This option will mean that the Job Schedule
will scan for all jobs regardless of whether or
not they have been opened, edited or created
new.

Show Job Alarms Controls whether jobs with cell-level alarms
will be displayed on the Job Schedule using
alarm colors (white text on a red
background).
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Extension page

The Extension tab controls when cells on the Extension screen are alarmed (appearing by default with
a red background).

The following options are available from the Extension page:

Options Description

Activate Alarm when Net Cost is 0.00 and
Material Condition is

For an item with a Net Cost of 0.00, you can
control which material conditions will result in
the Net Cost cell appearing alarmed (with a
red background)

Activate Alarm when Labor is 0.00 and
Labor Condition is

For an item with a Labor value of 0.00, you
can control which labor conditions will result in
the Labor cell appearing alarmed (with a red
background)
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Database page

From the Database page, you can control the ability of users to update the material databases from
the Takeoff screen. Restricting database access makes it possible for multiple users to open jobs
that share a single material database.

The following takeoff mode options are available from the Database page:

Options Description

Single-user database mode Allows you to open and update the database.
If you select this as the database mode, then
other users will be unable to open jobs that
use the same database at the same time as
you.

Multi-user database mode Allows you to open but not modify the
database. To allow other users to open jobs
that use the same database at the same time
as you, select the Multiple-User Database
Mode as the database mode.

Prompt user for database access mode Users will be asked when they try to access
the database whether they wish to open the
database in read & write or read-only mode.

After you click OK, you must close and restart your estimating program to have the changes take
effect.

Tip - If you accessing a database stored on another computer on your network, the directory in
which the database is stored must be shared with the appropriate access rights. Otherwise, the
database access mode you select may be ignored. For example, if you set the Takeoff Mode to
Single-User Database Mode (read and write access), and try to open a job that uses a database
stored in a directory that is shared with read-only access, then the database opens in read-only
mode.



512 - Classic Estimating Help Guide

Security Device page

The Security Server tab allows you to control whether the program accesses a local security device or
a network security server. If you try to run a Trimble program without either attaching a local security
device or linking to a network security server, you are prompted to:

exit the program

change the programs security settings

run the program in demo mode.

If your company has purchased a network license, rather than a single user license, then a local
security device is not required to run your estimating program. Instead, link your program to a security
server on your network. 

Tip - By default, the program assumes you are linking to a local security device. For information on
setting up a network security server, see the Getting Started Guide included with your software
purchase.

From the Security Device tab, you can choose from the following options to connect to a security
device:

Options Description

Connect to a local security device Connect to the local security device attached
to your workstation.

Connect to the first available network
security server

The program will search for security servers on
your network and will connect to the first one
found.

Connect to a specific network security
server

Connect to the network security server
selected in the Server Address list box.

Connect to a customized network security
server

Connect to the network security server
selected in the Server Address list box using
the parameters specified below.
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Power Substitution Dialog
Power Substitution is an advanced takeoff item replacement feature that allows users to not only
substitute one item for another but to also replace any related components at the same time. For
example, if you wished to swap 1/2" EMT to #12/2C MC cable, power substitution can automatically
change the straps and hangers to match the new cable and conduit  they support. In this case the
power substitution would also automatically resize the conduit and change the quantities, counts and
lengths of all the items associated with the takeoff.

From the Power Substitution dialog, you may select a Category, a From material type, and a To
material type and one or more Sizes.

To begin a power substitution you must select a category, a From group of items that will be
replaced, a To set of items that will do the replacing, and at least one size (using the associated
checkbox, or by clicking the Select All button).

One you have made your selections, click Substitute to submit each group for examination at three
degrees of detail to determine if the items within the group match against the items in the selected
takeoffs.

If you have not previously created a Power Substitution set, or if you wish to create a new Power
Substitution set , click the Setup button to proceed to the Power Substitution Setup dialog.

If you wish to view notes that you have previously entered (on the Notes page) describing the selected
Power Substitution Set, click the View Notes button.
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Overview

The Rules by which any Power Substitution operates are first established on the Groups page and
then refined on the subsequent pages of the Power Substitution Setup Dialog.

The Power Substitution Setup dialog has four objects relating to managing categories: an Add button,
a Delete button, a Rename button, and a Drop Down List Box to select the category. Once the
Category has been added, or selected, you may proceed to manage the groups within the highlighted
category.

You may further modify your Power Substitution by modifying entries on the Groups, Materials, Sizes,
Items, and Note pages of the Power Substitution Setup dialog. For further information about each
these areas of the Power Substitution click on the area of interest in the graphic below.
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Groups Page

The Rules by which any Power Substitution operates are first established on the Groups page and
then refined on the subsequent pages of the Power Substitution Setup Dialog.

The Power Substitution Setup dialog has four objects relating to managing categories: an Add button,
a Delete button, a Rename button, and a Drop Down List Box to select the category. Once the
Category has been added, or selected, you may proceed to manage the groups within the highlighted
category.

The Power Substitution Setup dialog Groups page has five objects relating to managing Groups: an
Add button, a Delete button, a Rename button, a Move Up button, and a Move Down button.

There are five sets of rules that Power Substitutions uses to determine if the items in the selected
takeoffs match the items in the tables of the Substitution Sets.  Four of these rules work together to
look at the individual group and the items within the group.  These are Item Criteria, Item Occurrence,
Item Matching, and Group Action.  Together these produce a TRUE or FALSE result.

Only if the preceding rules produce a TRUE result will the final rule be examined.  This rule is Children
Matching and this looks at the groups on the level below the current group to establish a second
TRUE result or a FALSE result.

Rule Selection Description

Group Action

 

Replace if matched If the items in the group have
met the requirements as
dictated by the Item Matching
and Item Criteria rules for the
group, this is considered to be
a TRUE result.  Thus, the items
in the takeoff that have been
matched will be marked as
matched and will be substituted
if the overall result for this group
proves TRUE.

Continue if matched

 

If the items in the group have
met the requirements as
dictated by the Item Matching
and Item Criteria rules for the
group, this is considered to be
a TRUE result.  However, the
items that have been matched
will not be marked as matched
since they are not to be
substituted even if the overall
result proves TRUE.

In this application, the group is
being used to test for the
existence of items in the
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Rule Selection Description

takeoff that meet the criteria.  If
so, then the sub-group(s) will
provide the tests for the items
that should be substituted if the
overall result proves TRUE.

Typically this rule would be
used to short-cut the testing
process by eliminating takeoffs
that do not contain certain
items.  For example, if there is
#12 THHN in a takeoff, it will be
necessary to do additional
testing if the intent is to change
the conduit and wire to MC or
Bx cable.  If there is no #12
THHN, there is no need to test
any further.

Continue if not matched

 

Essentially this works in the
opposite way as the Continue if
Matched rule.

If the items in the group do not
meet the tests for the group,
this is considered to be a
TRUE result.  By extension, no
substitutions would take place
since no items in the takeoff
matched.

This also would be used to
short-cut the testing process. 
For example, you want to
change the fittings for any
empty conduits.  You might
test for any THHN wire in a
takeoff.  If it is not there, it may
be reasonable to assume that it
is an empty conduit.  If it is,
there is no need to continue the
process.

Disable At the “Groups” level, the Group
Action automatically displays
as Disabled.  As well, the Item
Matching, Item Criteria, and
Item Occurrence boxes are
grayed out.
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Rule Selection Description

It is theoretically possible to
use this setting for a group at
any other level but no testing of
the items will be done.  In
effect, the group becomes a
placeholder and the only
testing is for Children Matching.

Item Occurrence

 

Once If the item is found in the
takeoff multiple times only the
first matching occurrence of the
item will be marked as
matched.

For example, a certain wire is
found in a takeoff based on Len
and then again based on Cnt
and the applicable Item Criteria
rule is Match Item Only.  In this
instance, only the first match
(based on Len) will be marked
as matched.

Multiple Times If the item is found in the
takeoff multiple times, then all
of the matching occurrences of
the item will be marked as
matched.

Using the example above, both
occurrences would be marked
as matched since they meet
the rules.

This would be used most
commonly when Item Criteria is
set to Match Item Only.

Item Matching Any One Item Must Match One item in the “From” table of
the Substitution Set that has
met the Item Criteria rules must
match .

Once a matching item is found
in the takeoff, the search stops.

Only the item that matches first
will be marked as matched.

If the item occurs multiple
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Rule Selection Description

times in the takeoff and the
Item Occurrence rule is set to
“Multiple Times”, then all
occurrences of the item will be
marked as matched.

Any other items in the “From”
table of the Substitution Set
that might match with takeoff
items will be ignored –
Exception is “add items”
immediately below the first
matched item.

Typically used where items in
the table, by their nature, are
mutually exclusive.

Any One Or More Items Must
Match

One item in the “From” table of
the Substitution Set must
match.

Search will look at all items in
the table and all items that
match will be marked as
matched.

Typically the items in the table
will be variations of a type of
item such as single gang
plastic device plates where we
might list toggle switch, single
receptacle, duplex receptacle,
and blank plates.

This is the most generic
matching rule and will be widely
used.

All Items Must Match • All of the items in the “From”
table of the Substitution Set must
match items in the takeoff.
However, it is not necessary for
all the items in the takeoff to have
a match.

• If it finds one that doesn’t
match, none of the items are
marked as matched.
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Rule Selection Description

• Typically used with only one or
two items in the table. 
Otherwise, the chances of
achieving matches are
substantially reduced.

First Item Must And Any
Other Items May Match

This is a more specific variation
on the Any One or More Items
Must Match rule.

The first item in the “From”
table of the Substitution Set
must match. However, it is not
necessary for the first item in
the takeoff to be the match.

If the first item is matched then
the search will look at all other
items in the table and
additional items that match will
be marked as matched as well.

Typically this would be used
when the first item serves as a
unique identifier for the type of
takeoffs and the subsequent
items are variables that may be
present with that unique item.

Item Criteria Match Item The Item must be found in the
takeoff but it does not matter if
the Based On setting (Len,
Cnt, or Abs) or the Fct1 or Fct2
values in the takeoff do not
match the setting and values in
the “From” table of the
Substitution Set.

This is the simplest and
probably the most common
test that will be used.

When items are substituted the
Based On setting and Fct1 and
Fct2 values as found in the
takeoff will be retained – the
values shown in the “To” table
of the Substitution Set will be
ignored.
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Rule Selection Description

Match Item and Based On The item must be found in the
takeoff and must have the
same Based On setting (Len,
Cnt, or Abs) as the “From”
table of the Substitution Set but
the Fct1 and Fct2 values are
irrelevant.

This may be used when
searching for items that may be
present in the takeoff more than
once with different settings
(such as Wire by Len and Cnt
or Couplings by Len and Abs)
and you want to change only
one instance of the item.  

Typically, the item may be
substituted but the Based On
setting would remain the same
since the Fct1 and Fct2 values
as found in the takeoff are
retained.  Changing the Based
On setting without also
changing the Fct1 and Fct2
values would make little sense
unless the Based On setting
was simply wrong in the
takeoff.

Match Item, Based On and
Factors

The item must be found in the
takeoff and must have the
same Based On setting and
the same Fct1 and Fct2 values
as the “From” table of the
Substitution Set.

This is a very specific search
and will not be used as
frequently.

Children Matching Match One Child If the group has no children, the
result will be FALSE.

One child must match for result
to be TRUE.

Once a matching child is found
search stops.
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Rule Selection Description

Only the items in the group and
sub-groups controlled by child
that matches first will be
substituted subject to all other
rules.

Any other children that might
match will be ignored.

Typically used where children,
by their nature, are mutually
exclusive.

Match One or More Children If the group has no children, the
result will be FALSE.

One child must match for result
to be TRUE.

Search will look at all children
and the items in the groups and
sub-groups controlled by the
additional children that match
will be substituted as well,
subject to all other rules.

Match All Children If the group has no children, the
result will be FALSE.

All of the children must match
for result to be TRUE.

Match Zero or One Child The group will always return a
result of TRUE.

Search will look at the children
and will substitute the first sub-
group that has a TRUE result
and then stop.

Match Zero or More Children The group will always return a
result of TRUE.

Search will look at children and
substitute all sub-groups that
have a TRUE result.

Match No Children The group will always return a
result of TRUE.
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Rule Selection Description

All groups at Level 4 are
automatically set to this rule
and the drop-down list box is
disabled.

At any other level, the result is
TRUE but none of the children
below the current group will be
substituted. As a result, this
will be used most often in
situations where the lowest
level of groups are being
searched (groups with very few,
or no children).
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Materials Page

The Materials Page of the Power Substitution Setup dialog has four objects relating to managing
categories: an Add button, a Delete button, a Rename button, and a Drop Down List Box to select the
category. Once the Category has been added, or selected, you may proceed to manage the groups
within the highlighted category.

The Materials Page of the Power Substitution Setup dialog has five objects relating to managing
materials: an Add button, a Delete button, a Rename button,  a Move Up button and a Move Down
button. Once at least one Material has been added,  you may proceed to manage the groups within
the selected category.
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Sizes Page

The Sizes Page of the Power Substitution Setup dialog has four objects relating to managing
categories: an Add button, a Delete button, a Rename button, and a Drop Down List Box to select the
category. Once the Category has been added, or selected, you may proceed to manage the groups
within the highlighted category.

The Sizes Page of the Power Substitution Setup dialog has five objects relating to managing sizes: an
Add button, a Delete button, a Rename button,  a Move Up button and a Move Down button. Once at
least one size has been added, or selected, you may proceed to manage the groups within the
selected category.
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Items Page

The Items Page of the Power Substitution Setup dialog allows you to specify the substitution items
that will be swapped during a power substitution. Using the From area of the page you will select
items from the Database area and indicate which item, in the corresponding row of the To area will
replace them once the Power Substitution has been successfully saved and executed.

Modifying Field Values

To modify a value for a field on the Items page, click a field, then start typing the new value. If the field
allows only certain values (like Fct 1), you can click the field, type any character, and then select the
appropriate value from the list that appears.

After entering a value,  press [Enter] or simply click another field or cell to accept the new value field.
To reject the new value, press [Esc] on your keyboard.

Available Fields

The fields used to define your power substitution are listed and described below.

Field Description

Selection Click here to switch between the Item Database
and Common Assemblies views of the material
database.

Database In the Database area, the categories, items,
and assemblies that comprise the database are
displayed. Within both the Item Database and
Common Assemblies views, materials have
been categorized into as many as four levels.
The current level will be identified by a level
indicator.

Each level consists of either categories, items
or assemblies. The Type column will display the
letter C to identify a category, the letter A to
identify an assembly, and the letter I to identify
items.

Double clicking on a category moves you down
one level within the database, displaying the
items or categories that comprise the category
you clicked on. To return to a previous level,
click with your right mouse button while your
pointer is positioned over the database section.
Alternatively, you could achieve the same result
by pressing the [Esc] key.

Group Contains the list of Groups in the same order as
defined on the Groups page. Groups that are on



526 - Classic Estimating Help Guide

Field Description

a lower level are preceded by 2 spaces

Size Contains the list of Sizes in the same order as
defined on the Sizes page.

From Select the option which will define the item list
that will be changed by your Power
Substitution.

The From list box lists the available materials in
the same order as they appear on the Materials
tab.

To Select the option which will define the item list
that will be substituted into your job by Power
Substitution.

The To list box lists the available materials in
the same order as they appear on the Materials
tab.

Managing Substitution Items in the From and To areas

You can change the order in which substitution items are displayed in the From and To areas. To do
this, select a row in the From or To area, then click the corresponding Move Up or Move Down button.

You can delete an item in the From or To areas. To do this, select a row in the From or To area, then
click the corresponding Delete button.

You can leave space for a new, unmatched substitution item to be added during your Power
Substitution. To do this, select an unused row in the From area, then click the "add item" button. This
creates a blank item in the Substitution Set that will be replaced by the item in the corresponding row
of the To area.

You can remove a substitution item from your Substitution set without replacing it. To do this, select
an unused row in the To area, then click the "remove item" button. This instructs the Substitution Set
to remove the item in the corresponding row of the From area, and not replace it with a new  item.

You can save all of the information in your substitution set. To do this, click the Save Substitution Set
button.
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Notes Page

The Notes Page of the Power Substitution Setup dialog has four objects relating to managing
categories: an Add button, a Delete button, a Rename button, and a Drop Down List Box to select the
category. Once the Category has been added, or selected, you may proceed to editing the notes
within the selected category.

The Notes Page of the Power Substitution Setup dialog has one object, a large text field suitable for
entering your notes about the Power Substitution, or category in which you are presently working.

Once you have typed in notes, you may view them later from the Power Substitution dialog, or you
may print them now by clicking on the Print Notes button.
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Print Reports Dialog
From the Print Reports dialog, you select the screen style that will determine the information that gets
printed for each item and the font used to print the report. You can choose from one of the predefined
database screen styles, or one of your own. For information on creating a screen style, see Using
Screen Styles. The predefined database screen styles include the following:

Condensed will print the Item Description, Date, Material Unit, Material Price, Material Discount,
Material Net Cost, Material Condition, Labor Unit, Labor Column 1, Labor Condition and the Price
Code.

Expanded will print all of the above plus labor columns 2,3,4,5, and 6.

You can also choose a database query if you want to narrow the scope of the items to be printed.
You can choose from one of the predefined database queries, or you can create your own. For
information on creating a database query, see Creating a Database Query. The predefined database
queries include the following:

Items With Price Codes will only print items that have a price code assigned.

Priced Items Without a Price Code will only print items that are priced but do not have a price code
assigned.

After you select the screen style to be used, and optionally, a database query, click on OK. A Print
dialog appears. From the Print dialog, you can select the printer to be used, and the number of copies
you wish to print.
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Quick Update Dialog
The Quick Update dialog displays all the fields that can be updated as part of a quick update. For
each field you wish to update, click on the field description, type the letter Y, press [Enter], then type
the new value in the Value column and press [Enter] again.

In some cases, you enter a percentage to be applied to the existing field value. In other cases, you
select from a set list of valid values. For example, if you enter 10 for Column 3 Labor, then Column 3
Labor will be increased by 10%. However, if you enter 10 for Material Discount, then all discounts will
be set to 10.

After you click on OK to exit this dialog, a confirmation box appears asking you to confirm the
information about to be updated. If you click on OK, all items in the currently selected category and
below will be updated with the new field values.

For information on individual update fields, see Item Definitions. For more information on performing a
quick update, see Performing a Quick Update.
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Re-Extend dialog
From this dialog, you can control which extension components will be updated as part of a re-extend.
This dialog appears when you select the Re-Extend option from the Extension menu on the Extension
screen.

If you have made changes to the currently assigned database (updated the prices, for example), you
must re-extend the job in order for the changes to be reflected on the Extension screen. Re-extending
the job involves reapplying the item prices, discounts, labor units, and/or group codes from the
currently assigned database to items in the extension. You can, however, select cells within the Net
Cost column or Labor column and lock them so that your changes are not lost when the job is re-
extended.

From the Re-Extend dialog, you can choose whether you wish to update descriptions, pricing,
discounts, adjustments, labor, sort codes, manufacturers, and suppliers. For pricing, labor, sort
codes, manufacturers, and suppliers, you can click the plus sign to expand the tree and control
exactly which elements will be updated as part of a re-extend.

You can select the following components and sub-components to be updated:

Option Sub-Options

Update Description none

Updating Pricing Date, Price, U

Material Condition

Update Material Discount none

Update Material Adjustment none

Update Labor Labor, U

Labor Condition

Update Sort Codes Sort Codes 1-8

Update Manufacturer Manufacturer Name

Catalog Number

Price Code

Reference

Update Supplier Supplier Name

Supplier Code
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Checking or clearing an option will automatically check or clear each of its sub-options.

Components that are not selected will remain unchanged from the current extension. To select all the
re-extend options, click the All button.

If you choose to update labor, you should click the Labor Column button and select the labor column
to be used from the dialog that appears.
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Report Style Setup Dialog
This dialog appears when you select the Report option from the Styles submenu that appears under
the Job menu. From the Report Style Setup dialog, you can create and define report styles. Defining
report styles involves selecting the columns to be included in the report, controlling the order in which
the columns are printed, and setting various printing parameters. For more information on using report
styles, see Using Report Styles.

Since report styles can only be used when printing job reports, the parameters you specify from the
Report Style Setup dialog will not affect reports printing from the Job Schedule screen, Database
Manager module, or Price Update screen.

The following components appear on the Report Style Setup dialog.

Style Name

Lists the available report styles, and displays the currently selected report style.

Add

Click on this button to create a new report style. From the Add Style dialog that appears, enter the
name you wish to use to identify the new report style. Then, select an existing report style you wish
to use as the basis for the new style. In addition to the default report style, you can use the blank
style, which does not include any columns from any job screen.

Delete

Click on this button to remove the current report style. You will be prompted to confirm your desire to
delete the style.

Rename

Click on this button to rename the current report style. You cannot, however, rename the default
report style. From the Edit Style Name dialog that appears, enter the new name, then click on OK.

Report Elements

On the Report Elements page, all job screens are listed with a check box beside each one. For the
Takeoff and Extension screens, there are multiple entries, allowing you to select entire sections within
each screen. If you want to include a particular screen (or screen section) in your report style, make
sure a check mark appears in the check box beside the appropriate screen or section. If a check
mark does not appear beside a screen or screen section, it will not be included in the report style.

To control the order of the job screens within your report, click on the name of the job screen to be
repositioned, then click on the Move Up or Move Down. Alternatively, you could just drag and drop the
screen name to the new location.

Once you have chosen the job screens to be included in your report style, you can click on the
Column Setup tab and narrow the scope even further.

Column Setup

Click on the Column Setup tab to display the Column Setup page. From the Column Setup page,
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From the Column Setup page, you can exclude individual columns from your report style, and
rearrange the order in which columns will be printed.

The Column Setup page is divided into two sections: the columns included in the report style appear
on the right side of the page, while the columns excluded from the style appear on the left side.
Initially, all columns are included and appear on the right side of the dialog. Columns from all job
screens will be listed on the Column Setup page, even columns from job screens you have deselected
on the Report Elements page. However, only columns from job screens you have selected on the
Report Elements page will be included in your report style.

Columns are grouped under the corresponding job screen name. To display the columns for a
particular screen, click on the plus sign beside the screen name. The tree will expand, displaying the
name grouped under that screen or section. To collapse the list again, click on the minus sign that
appears in place of the plus sign.

To exclude a particular column, click on the column name, then click on the Remove button. The
column moves from the right side of the screen to the left side of the dialog, and is now excluded from
the report style. To exclude all the columns from a particular screen or section, click on the screen or
section name, then click on the Remove button.

Within the column list for each screen, other elements such as headings, totals, blank lines, and
page breaks are also listed. You can control whether these elements are printed by checking or
clearing the check boxes that appear beside each element.

To control the order of columns within a particular screen or subscreen, simply click on the column
name, then click on the Move Up or Move Down button, or drag and drop the column to a new location
under the same job screen name. You cannot move a column from one job screen name to another.

Fonts

Click on the Fonts tab to display the Fonts page. From the Fonts page, you can choose the fonts to
be used in the report. You can select the typeface, point size, and type style. Depending on the
typeface you select, type style options may include Normal, Bold, Italic, and Bold Italic.

Page Setup

Click the Page Setup tab to display the Page Setup page. From here, you can set various printing
parameters, including headers and footers, page margins, and page orientation. The following options
are available:

Option Description

Margins Determines the left, right, top, and bottom margins of your page (measured in
inches). These values default to the smallest margins allowed by the currently
selected printer.

Header /
Footer

Determines the information printed at the top and bottom of each page. You can
choose to have the date, time, page #, and/or a solid dividing line printed in the
header or footer area. To enable any of these print options, click the appropriate
check box so that a checkmark or an X appears if one is not already there. You can
also specify text to print in the header and footer areas. If you want job information
(such as the database name) to print, you can include one or more field codes,
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Option Description

each enclosed within angle brackets. The valid field codes depend on the type of
report you are printing. Orientation Controls how to print the page; portrait or
landscape.

Select

Click the Select button so a check mark appears in the check box beside the currently selected
screen or column name.

Clear

Click the Clear to remove the check mark from the check box beside the currently selected screen or
column name.

Select All

Click this button to select all checkboxes appears beside screen or column names on the current
page.

Clear All

Click this button to clear all checkboxes beside all screen or column names on the current page.

Move Up

Click this button to move the currently selected screen or column name up one position in the
hierarchy.

Move Down

Click this button to move the currently selected screen or column name down one position in the
hierarchy.
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Rename Category Dialog
When you click on the Rename button of the Power Substitution Setup dialog, the Rename Category
dialog appears. From this dialog you may enter the new name of your power substitution category by
typing in the New Category Name field.

Once you have entered the desired name, click OK to change the name of your category.
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Save As Dialog
From the Save As dialog, you can indicate the file name, job name, save options, and file location of
the job file where you wish to save the current job. If you specify an existing file name, you will be
asked whether you wish to overwrite the existing file. The Save As dialog appears when you select the
Save As option from the Job menu.

By selecting the appropriate checkbox(es) the Save As dialog allows you the option of including or
removing certain data from the estimating job during the save process. The available data options
include: takeoffs, typicals, designations, temporary assemblies, and temporary items.
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Scaler 3 Custom Settings Dialog

Custom Scale page

From the Custom Scale page of the Scaler 3 Custom Settings dialog, you customize the scale. This
would be useful in the event you have a drawing without a scale, but you do know a specific length on
the drawing. In order to use the customized scale, you must first select the Custom item from the
Scale drop-down list box in the Measure Takeoff dialog.

With the Custom Scale page displayed, click the Start Wheel Measure button to ready the probe for
measuring, then roll the QuickScaler 3 along the drawing until the desired value is reached. As you
roll the QuickScaler 3 forward or backward, the value increments and appears in the first field.
Alternatively, you can enter a value in the first field instead of using the probe, and select the unit of
measurement from the drop-down list box.

Click the Stop Wheel Measure button to complete the customization of your scale, then enter a value
in the field following the equal sign (=), and select the unit of measurement (inches, feet, or meter)
from the drop-down list. Either click OK to exit the dialog or click Apply to accept your input but not
exit the dialog.

For information on other Scaler 3 Custom Settings dialog pages, click on the button beside the
appropriate option below:

 Adder page

 Button Settings page

 Calibration page

 Measure Direction page
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Adder page

From the Adder page of the Scaler 3 Custom Settings dialog, you can specify the value to be used to
increment the Length each time you press the Adder button on the probe.

From the Adder page, enter a value in the field available and select the unit of measurement you wish
to use. Each time you press the Adder button on the probe, the Length will increase by the value you
set here. Click either OK to exit the dialog or click Apply to accept your input and keep the dialog
available.
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Button Settings page

From the Button Settings page of the Scaler 3 Custom Settings dialog , you can change the
maximum interval allowed between double clicks when you double click any of the buttons (count,
adder or clear/send) on the probe.

From the Button Settings page, enter a number between 0.1 and 5. Click either OK to exit the dialog
or click Apply to accept your input but not exit the dialog.
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Calibration page

From the Calibration page of the Scaler 3 Custom Settings dialog, you can change the preset
calibration of the probe. This allows you to refine the accuracy at which the probe measures
regardless of the scale being used.

From the Calibration page, click the Start Reading Probe Pulse button to ready the probe for
measuring, then roll the QuickScaler 3 along a known length until the desired value is reached. As
you roll the QuickScaler 3 forward or backward, the value increments and appears in the first field.
Alternatively, you can enter a value in the first field instead of using the probe, and select the unit of
measurement from the drop-down list box.

Click the Stop Reading Probe Pulse button to complete the customization. Enter a value in the field
following the equal sign (=), and select the unit of measurement (inches, feet, or meter) from the drop-
down list. Either click OK to exit the dialog or click Apply to accept your input but not exit the dialog.
To use the default setting any time after changing it, click the Reset to Default button.
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Measure Direction page

From the Measure Direction page of the Scaler 3 Custom Settings dialog, you can select the direction
to increment or decrement the measurement depending on the forward or backward movement of the
probe.

From the Measure Directions page, click the radio button corresponding to the direction you wish to
use. Click either OK to exit the dialog or click Apply to accept your input but not exit the dialog.
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Sound page

Normally, as you roll the probe to take your measurements, it makes a beeping sound. When the
Measure Takeoff dialog is displayed and you are taking measurements, this sound lets you know your
measurement is being recorded.  The tone of the sound changes in response to the forward or
backward movement of the wheel. While using the probe, each time you press one of the buttons
(count, adder, or clear/send) you will hear a beep.

The Sound page in the Scaler 3 Custom Settings dialog allows you to enable/disable the probe sound
and select the volume level.

To enable/disable the probe sound:

1. Make sure the probe is properly plugged into a serial port and is properly configured. For more
information on configuring the probe, see Configuring the Probe.

2. Click the Settings button to display the Scaler 3 Custom Settings dialog.

3. Click the Sound tab and click the Enable Probe Sound check box to enable/disable the sound
feature. If necessary, select a different volume level from the drop down list box. The volume feature
only becomes available when the probe sound is enabled.

4. Either click OK to exit the dialog or click Apply to accept your input but not exit the dialog.
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Screen Style Setup Dialog
The Screen Style Setup dialog allows you to define screen styles for job, schedule, and Database
Manager screens. You can control the columns displaying on each job screen, the width of each
column, and the fonts used to display information on each job screen. (Job screens include any
screens except the Schedule, Database Manager, and Price Update screens.) For more information
on screen styles, see Using Screen Styles.

Though screen styles are primarily used to control the on-screen appearance of your estimating
program, they can, in some cases, to be used to determine the appearance and content of reports
such as database reports and job summaries. From the Page Setup tab, you can set various printing
parameters, including headers and footers, page margins, and page orientation.

The following components appear on the Screen Style Setup dialog:

Style Name
Lists the available screen styles, and displays the currently selected screen style.

Add
Click on this button to create a new screen style. From the Add Style dialog that appears, enter
the name you wish to use to identify the new screen style, then select the style to be used as the
basis for the new style. You can model the new style after an existing style or the default style
(which includes all columns).

Delete
Click this button to remove the current screen style. You will be prompted to confirm your desire
to delete the style.

Rename
Click this button to rename the current screen style. You cannot, however, rename the default
screen style. From the Edit Style Name dialog that appears, enter the new name, then click on
OK.

Column Setup
From the Column Setup tab, you can control which columns appear on each screen for the
current screen style. The left side of the Column Setup tab displays the columns currently
excluded from the screen style, while the right side displays the columns currently included in the
style. At first, the lists appear collapsed so that only screen names are displayed. To view the
columns included or excluded for each screen, click on the plus sign to the left of the screen
name. A column list should appear as a branch beneath the screen name.

To exclude a column, click the column from the right side of the dialog, then click the Remove
button. To include a column, click it from the left side of the dialog, then click the Add button.
To exclude all columns, click the Remove All button. To include all columns, click the Add All
button.

You can also double click to include or exclude a column. For example, if a column appears on
the right side of the dialog (and is therefore included in the current screen style), double click
the column to move it to the left side of the dialog (thereby excluding it from the screen style).

Fonts
From the Fonts tab on the Screen Style Setup dialog, you can choose the font to be used on job
screens, the Job Schedule screen, or the Database Manager module. You can select the
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typeface, point size, and type style. Depending on the typeface you select, type style options
may include Normal, Bold, Italic, and Bold Italic.

Page Setup (Schedule Style and Database Manager Style Setup only)
If you do not wish to use the default settings for printed reports, the Page Setup tab allows you to
customize the appearance of your printed reports. From this tab you can set various printing
parameters, including headers and footers, page margins, and page orientation. Once you have
set up your page, your printed report should reflect the customized settings you made on this
page. The following options are available:

Option Description

Margins Determines the left, right, top, and bottom
margins of your page (measured in inches).
These values default to the smallest margins
allowed by the currently selected printer.

Header / Footer Determines the information printed at the top
and bottom of each page. You can choose to
have the date, time, page #, and/or a solid
dividing line printed in the header or footer
area. To enable any of these print options,
click the appropriate check box so that a
checkmark or an X appears, if one is not
already there. You can also specify text to
print in the header and footer areas. If you
want job information (such as the database
name) to print, you can include one or more 
field codes, each enclosed within angle
brackets. The valid field codes depend on the
type of report you are printing. Orientation
Controls how to print the page; portrait or
landscape.

Add
Click this button to add the currently selected screen or column to the screen style.

Add All
Click this button to add all screens to the screen style.

Remove
Click this button to remove the currently selected screen or column from the screen style.

Remove All
Click this button to remove all screens from the screen style.

Move Up
Click this button to move the currently selected screen or column name up one position in the
hierarchy.

Move Down
Click this button to move the currently selected screen or column name down one position in the
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hierarchy.

Freeze Cols
You can use this button to stop columns from moving when you use the scroll bar to scroll within
a screen. If you click this button, the currently selected column, along with any columns
preceding that column (on the same screen), remain stationary when you scroll.

Unfreeze
You can use this button to unfreeze columns so that they move when you use the scroll bar to
scroll within a screen. If you click this button, then the currently selected column, along with any
columns following that column on the same screen, remain unfrozen.

Reset Widths
Reset column widths to their default state. When you click this button, you are asked whether
you wish to reset column widths for all screens, or just for the screen currently selected on the
Column Setup tab within the Screen Style Setup dialog.

Reset Order
Resets the order of columns within each screen to their default state.
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Select Database Dialog
The Select Database screen displays when you click Yes when creating a new job.

Select Database

The Select Database dialog displays the name and location of the databases that are available. Note:
Only databases stored in directories designated as database folders display in this list. For more
information, refer to the Database Folders topic. 

Tip - If a database has been opened in single-user mode (read and write access) by another user
or job, the database will not display in the list.

1. In the Select Database dialog, click on the name of the appropriate database.

2. Click OK.

Copy Database

When you select Yes to create a new database and then select the database (in the above Select
Database procedure), the Copy Database dialog opens.

From this dialog, you must enter a description (up to 31 characters long) for the new database
in the Description field and a Folder location if you want it placed in a location other than the
default directory. 

Click Copy. After the new database is created, the New Job dialog opens.
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Sort Schedule Information dialog
From the Sort Job Schedule Information dialog, you can control view on the Job Schedule screen. The
different options on the dialog allow you to select the fields that will be used as sorting criteria, chose
the priority/order in which the sorting will be performed, and choose whether individual fields will be
sorted in ascending or descending order.

Job Schedule screen fields available for sorting include:

Column Description

Job Name The job description. Can be up to 80 characters
long.

Job Number The number you have assigned to the job. The
job number is combined with an .es9 extension
to form the name of the job file.

Date Created The date the job was last saved.

Bid Price The total dollar amount for this job, including
material, labor, overhead, markup etc.
Automatically inserted based on the Final Price
from the Price Summary screen.

Status The status indicates if a job has closed and the
overall ranking of the submitted bid. By default,
the job status is Pending. You can change the
job status from Pending to First, Second, Third,
or Other. To change the status of your job, click
the Status cell for the appropriate job, then
press one of the following letters on your
keyboard: [F] for First, [S] for Second, [T] for
Third, or [O] for Other. After pressing the
appropriate key, press [Enter] or click the
checkmark button to complete the change.

Spread % The percentage difference between the low bid
and your price, or your price (if you are low bid)
and the next price.

Next Price If you were low bid, the next closest price. If
you were not low bid, this will be the price of the
winning tender.

Last Bid Displays the name of the bid summary in effect
when you last saved the job. For more
information on bid summaries, see Creating
Multiple Bid Summaries.

Price / Area This is the price per unit area. This value is first
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Column Description

calculated in the PrSum screen.

Labor Hours The total labor hours from the Direct Labor,
Incidental Labor, Indirect Labor, and Labor
Factoring screens.

Job Path The name and location of the job file.

Job Directory The job path minus the job file name.

Job Category Description of the category of  job.

Estimator The name of the estimator responsible for the
job.

Bid Due Date The date that client will require delivery of a
completed bid.

To add a single field for sorting:

1. Select a field name from the Available fields list.

2. Double-click the field name, or click on the > button.

The field name will be moved to the Sort by fields list, and marked with an (A), for ascending, or a (D)
for descending to indicate the sort method.

To add all fields for sorting:

Click on the >> button.

All fields in the Available fields list will be added to the Sort by fields list, and marked with an (A), for
ascending, or a (D) for descending to indicate the sort method.

To remove a single field from sorting:

1. Select a field name from the Sort by fields list.

2. Double-click the field name, or click on the < button.

The field name will be moved back to the Available fields list.

To remove all fields from sorting:

Click on the << button.

All fields in the Available fields list will be removed from the Sort by fields list.

To change the sort order:
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Tip - Jobs will be sorted on the Job Schedule screen based on the order in which the field names
appear in the Sort by fields list; where fields at the top of the list will be applied as sorting criteria
before fields at the bottom of the list.

1. Select a field name from the Sort by fields list.

2. Click on the /\ button to move the field up in the order, or click the  \/  button to move the field down
in the sort order.

The field name will move up or down in the list to reflect your change.

To change the sort type:

1. Select a field name from the Sort by fields list.

2. Click on the Ascending radio button to change the sort type to Ascending, or click on the
descending radio button to change the sort type to descending.

The marker next to the field name will change to reflect your selection.
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Unit Price Default Values Dialog
Using this dialog, you can set the default values for selected columns that appear on the Extension
screen when it is grouped by unit price.

Any changes you made to the default values will affect new takeoffs in the current job and all other
jobs, but will not affect any existing takeoffs.

You can set the default values for the following unit price columns:

Tax %

Labor Rate

Small Tools (% of labor $) or ($ per labor hr)

Expense %

Markup %

Other %

Tip -  It is recommended that you set your default values in your default job prior to performing any
takeoffs. Default values added after performing takeoffs are only applied to the new takeoffs.
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User Defined Adjustment Ranges Dialog
This dialog appears when you select the Ranges option from the Edit menu while the Final Pricing

screen is displayed, or when you click the dialog button   within one of the adjustment cells. This
dialog allows you to calculate your own custom adjustment ranges.

In the To ($) column, enter the maximum dollar value for each range. In the Adjustment (%) column,
enter the percentage to be applied for each range.

You can choose to apply the adjustment using progressive range or breakpoint ranges. With
progressive ranges, the value to be adjusted to split up according to the specified ranges, and
adjusted separately for each range. With breakpoint ranges, the adjustment is applied to the entire
value according to which range the value falls into.

Using the example displayed above, consider how a value of $4000 would be adjusted using these two
methods. With a progressive range, an adjustment of 5% would be applied to the first $1,000, and
10% would be applied to the remaining $3,000. With a breakpoint range, an adjustment of 10% would
be applied to the entire amount.

Once you have finished entering all your ranges, click OK. The calculated amount appears in the Final
Pricing screen. To remove any value from the To ($) column or the Adjustment (%) column, select the
value then click Delete.
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View Notes Dialog
The View Notes dialog  has one, uneditable, object; a large text field in which you can examine notes
about the current Power Substitution set.

To exit the View Notes dialog, click the Close button.
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Views Dialog
You can save the filter and grouping settings that you apply to the extension as a "view", which you
can select from a list of saved views. This allows you to create multiple views that you can quickly
switch between.

The view will be in effect until you select a different view, or override the view by applying a quick view
(a view that is not saved). To apply a quick view, you select either the Group or Filter option from the
Extension menu, or click on the corresponding toolbar button. For more information, see Working
With Views.

From the Views dialog, you can create one or more views. To create a view, click the Add button then
specify a view name. After you have created a view, you can click the Group tab to select grouping
options, and/or click the Filter tab to select filter options. When you are finishing modifying your
grouping and filter options, click to OK to save and apply the view.

To modify an existing view, select the view name from the drop down list and change the appropriate
Group and Filter options then click OK to save the changes and apply the view. To rename a view,
select the view name from the drop down list and click Rename. To delete a view, select the view
name and click Delete.
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Group Page

From the Group page of the Views dialog, you can group the extension by system, area, drawing,
phase, location, labor factor, sort codes, or unit price (depending on which estimating program you
are using). Grouping by system, area, drawing, phase, location, or labor factor allows you to view total
material costs and labor hours for each system, area, drawing, phase, location, or labor factor. You
can double click an entry to display the extended items within that breakdown. For more information,
see Grouping the Extension.

Tip - In previous versions, the less accurate term "sorting" was used instead of "grouping".

From the Group page, you select the breakdowns to be used to group extension items. To do so,
double click the appropriate option from the left side of the Group page. Alternatively, you could single
click the option, then click on the Add button. You can group the extension by item, system, drawing,
area, phase, location, labor factor, sort codes, or unit price, or any combination of these criteria in any
order.

The order in which the options appear on the right side of the dialog determine the order in which the
extension items are grouped. You can reorder items on the right side by selecting an item then
clicking the up or down arrows.

You can also click on the Filter tab to narrow the scope of the extension so that it displays only those
items that match the conditions you specify.

The grouping and filter settings you specify will be saved under the current View name. You can
create multiple views and switch between them from the Views toolbar. For more information, see 
Working With Views.

When you are finishing selecting your grouping and filter options, click to OK to save and apply the
view.
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Filter Page

From the Filter page of the Views dialog, you can specify the conditions by which the extension will
be filtered. Only those items that match the conditions you specify will be displayed within the
extension. You can filter the extension by material condition, price, discount, labor condition, labor
hours, date, and/or price code. For example, you may want to see only those takeoff items with a
Budget material condition.

From here, you can also click the Group tab to group the extension by system, area, drawing, phase,
location, or labor factor.

The grouping and filter settings you specify will be saved under the current View name. You can
create multiple views and switch between them from the Views toolbar. For more information, see 
Working With Views.

The following options are available from this page:

Option Description

Material Conditions Select one or more material conditions. Items
that match any of the selected conditions (and
all of the specified value ranges, date range,
and price code criteria) will be displayed.

Labor Conditions Select one or more labor conditions. Items that
match any of the selected conditions (and all of
the specified value ranges, date range, and
price code criteria) will be displayed.

Values Enter one or more value ranges. Only items that
match all the specified value ranges, date
range, and price code criteria, and any of the
specified material and labor conditions, will be
displayed.

Date Select a date range. Only items that match all
the specified value ranges, date range, and
price code criteria, and any of the specified
material and labor conditions, will be displayed.

Price Code Select the price code criteria. You can limit the
displayed items to those that are blank, not
blank, or contains the text you specify (e.g. if
you enter "1234", only those items whose price
code include "1234" anywhere in the value will
be displayed.)

To clear all the filter options, so that all items will be displayed, click the Clear All button.

When you are finishing specifying your grouping and filter options, click to OK to save and apply the
view.
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While a filter is applied to the Extension screen, a filter indicator displays beside the word Totals at
the bottom of the screen.
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C H A P T E R13
Trimble Websites

The Trimble websites provide easy access to product information.

Trimble Corporate Website

Click here to visit the Trimble corporate website. This website provides information on various
industries and associated Trimble products.

Trimble MEP Website

To visit the Trimble MEP website, click here.

http://www.trimble.com/
http://mep.trimble.com/
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